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1 Preface

The purpose of this PDF document is to introduce and explain how to use the Director Software for the Artist system.

The document is divided into different parts including a general description of the Artist system, its capabilities and

typical applications, followed by an introduction to the Director Software, its makeup, purpose and functions. The first

part gets you started and provides all of the necessary information to enable the software to be set up and used. The

following sections provide typical examples of how to program and control the Artist system with the appropriate level

of detail to quickly and effectively achieve what is required. The last part is a troubleshooting guide to assist with any

problems that you might encounter getting started, programming and running the software.

This manual is available in additional formats:

CHM "Compiled HTML Help" is the standard format for Windows online help and .Net applications

EPUB "Electronic Publishing format" is a cross-platform e-book standard

For further information, please refer to the Riedel Website or contact your local distributor or the Riedel headquarters

in Wuppertal.

NOTICE

This manual, as well as the software and any examples contained herein are provided "as is" and are subject to change

without notice. The content of this manual is for informational purpose only and should not be construed as a

commitment by Riedel Communications GmbH & Co. KG or its suppliers. Riedel Communications GmbH & Co. KG gives

no warranty of any kind with regard to this manual or the software, including, but not limited to, the implied warranties

of merchantability and fitness for a particular purpose. Riedel Communications GmbH & Co. KG shall not be liable for

any errors, inaccuracies or for incidental or consequential damages in connection with the furnishing, performance or

use of this manual, the software or the examples herein. Riedel Communications GmbH & Co. KG reserves all patent,

proprietary design, title and intellectual property rights contained herein, including, but not limited to, any images, text,

photographs incorporated into the manual or software.
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1.1 Change History

A brief summary of the most significant changes in Director 7.20 is given in the following.

PTP Role

A new drop-down button 'PTP Role' allows setting a device actively into Slave mode.

This feature is available at AES67 cards and SmartPanels.

See chapter 'AES67 Card – Properties', 'AES67 – Client Card Properties' and 'AES67 – SmartPanel Properties'.

Higher 'PTP-Priority-2' at AES67 cards

The 'PTP-Priority-2' value at AES67 cards is increased to give AES67 cards a higher priority than panels.

See chapter 'AES67 Card – Properties' and 'AES67 – Client Card Properties'.

Dante 4-Wire split

The 'Dante 4-Wire split' is added as port type at Dante cards.

See chapter 'Port types Miscellaneous > DANTE client card'.

AES67 4-Wire split

The 'AES67 4-Wire split' is added as port type at AES67 cards.

See chapter 'Port types Miscellaneous > AES67 client card', ''AES67 Input' tab (Port/Panel)' and ''AES67 Output' tab

(Port/Panel)'.

AES67-Trunkline

The AES67 card can be used for trunking.

See chapter 'Defining Trunklines' and ''AES67 Trunkline' tab (Port/Panel)'.

NSA

The NSA (Network Switch Adapter) is an AES3/AES67 converter and allows integrating 1000/1100 series panels into

AES67 networks.

See chapter ''1000 series' Port types', ''1100 series' Port types' and ''AES67' tab (Port/Panel)'.

AES67 Statistic

· Improved AES67-Statistics-View for multichannel streams:

The Master port is displayed on top, while the slave ports are displayed below and indent. Only the Master port

shows values of IP statistics. The fields of the slaves remain empty. If the Master is connected and audio is/can

flow, the slaves are displayed green. The table is sorted by inputs and outputs. Client card statistics are shown

for master and slaves.

See chapter 'AES67 Statistic'.

· Following detailed Stream-TX information are added in the AES67 statistics: 

'Delay', 'Packet Lost Since Start', 'Packet Lost Last Min', 'Packet Lost Last Hour', 'Jitter', 'Jitter Min' and 'Jitter Max'. 

See chapter 'AES67 Statistic'.

VoIP-Auto Hangup

Possibility to deactivate the auto hangup feature of VoIP cards.

See chapter 'SIP Phone - Basic Setup'.

Windows XP® support discontinued

The Director Software will officially not support Windows XP® anymore.

See chapter 'Installation' and 'PC requirements'.
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1.2 About Artist

Artist is a powerful digital matrix platform for the transmission and distribution of analog and digital audio and data

signals. As a multimedia platform, Artist systems provide a new concept of intercom and talkback technology,

completely changing the general perspective of system design for applications in broadcast, theatres, event centers

and security systems. The decentralized system architecture supported by high bandwidth optical fiber

interconnectivity, high-speed digital signal processing and industry standard interfaces enable the Artist to offer state

of the art communication solutions. 

Decentralized matrix structure

Artist systems provide a distributed real-time, broadcast quality audio matrix comprising of either a single mainframe

or multiple frames, serving both small and larger applications. Each frame can act entirely independently or as a node

within a network forming a large, distributed matrix that is interconnected by a dual optical fiber ring.

Figure 1: Artists redundant dual ring topology
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Interfacing and connectivity

Artist systems offer a wide range of different connections and interfaces to quickly and easily adapt to local

requirements.

For example:

Figure 2: ARTIST – Interfacing and connectivity

The analog four-wire and digital audio interfaces enable audio signals to be distributed, mixed and routed through the

matrix as required. The broadcast quality audio distribution capability meets the demands of most professional

environments. The integration of radio base stations provides access to wireless communications. 2/4-Wire interfacing

provides access to traditional analog two-wire party line intercom systems. 

Connection and use of the public telecommunication services, both analog and digital, are achieved using codec

interfaces, allowing intelligent trunking as well as the making of and receiving calls from any PSTN, ISDN or mobile

phone. 

System Features

Point-to-point calls, group calls, conferences, party lines and call priorities are supported as standard. Freely

programmable panel keys with different names, signalizations, and key modes are offered to support today’s various

intercom, interphone, talkback and address standards. 

System setup, monitoring and remote control are achieved using the Director Windows® based software. Single or

multiple PCs have access to the Artist Mainframe using an existing 10BaseT Ethernet Network.
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Artist system overview

Figure 3: Example of an Artist system installation
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1.3 About Director

Access, setup and control of any aspect of an Artist system is handled using the Windows® based Director

configuration software. The software has been designed to offer quick access to important features and give a general

overview of what's going on in the system through its intuitive graphic user interface. Director provides the basic

functions, look and feel associated with most Windows® software products, so that the navigation, location and

operation of the standard features are familiar.

Networking

A single or multiple PCs (up to 4 per node) can be used to control and monitor an entire intercom system. PCs connect

to the Artist system via a standard Ethernet port, which enables all PCs to access and show the online configuration

simultaneously, as well as make configuration changes, if allowed. Moreover, if a fiber ring is used it is possible to

activate a transparent 10BaseT hub function in order to send additional Ethernet packets over the fiber to network the

connected PCs. This function can only be used if the PCs are not already members of an existing in-house network.

Figure 4: Artist Dual Ring Network with multiple PCs connected

User Management

Extensive rights management allows the creation of user groups with various access rights to the system. Different

levels of user rights can be established to prevent unauthorized system changes.

Send Configuration to Artist / Load from Artist

All information pertaining to the setup and operation of the system is contained in the form of configuration data files

that are shared and held by all nodes and PCs on the network. The configuration files can be completely uploaded or

downloaded between the PCs and the matrices for storage, editing or to load new setups. Partial changes to

configurations can be uploaded or downloaded automatically to handle regularly recurring changes such as the

switching of productions between various studios.

Remote Control

The software not only allows the control panels and keys to be programmed with nearly all imaginable functions; it also

allows keys to be controlled remotely. 

All functions which can be configured in the software, such as GPIs, logic functions, conference calls, etc., can also be

controlled remotely via Director. Even all of the volume controls on panels can be changed from a PC using the Remote

Control function. This provides a quick and easy way to test configurations or to find and correct user errors without

having to leave your desk.
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2 First steps

The DIRECTOR configuration software can be set up very quickly and easily. The next chapter describes how to connect

your configuration PC to the system.

2.1 Installation

The Director software doesn't need to be installed. It is sufficient to unpack the zip-file and to store the 'Director

xxx.exe'-file to a folder of your choice.

It is possible run multiple Director instances simultaneously on one PC. To do so, copy and run the Director in different

folders.

Do not store the Director in the following windows standard folders, because administrator rights are

needed for writing access:

· "C:\Program Files"

· "C:\Program Files (x86)"

2.2 What's needed?

The following items are required to establish a connection with an Artist network:

· PC workstation

· LAN connection

· Director software

· Artist system

· Director Software Manual

Details regarding each of these items, including how to set them up, will be described below to ensure a successful

connection to the system.

2.3 PC requirements

These are the minimum PC requirements to optimally run the Director software:

· Windows 7®, Windows 8®, Windows 10® (32/64 Bit) operating system

· 1 GB RAM (Windows 32 Bit) / 2 GB (Windows 64 Bit)

· 1 GB of free space on the hard drive

· Monitor resolution of at least 1024x768 capable of displaying 256 colors (recommended: 1920x1200 with 16 bit

color)

· Mouse or other pointing device

· 10BaseT Ethernet network adapter 

(LAN connection must support TCP/IP protocol and a bandwidth of 10 Mbit half-duplex or auto detection)



19

Director 7.20 User Manual A10

2.4 Network Configuration

There are different ways in which PCs can be connected together and connected to other equipment. An Ethernet

network, which is the most widely used network method, is required for connecting Artist systems to PCs, hence the

need for a Network Adapter card. 

Network cabling and adaptors

The Artist system requires a standard 10BaseT network cable with CAT5 connectors. Depending on whether the PC is

connected directly to the Artist or connected over a switch or hub determines whether a 1:1 or crossover twisted pair

cable is required (more information and pin-outs are available in the installation guide).

· A network hub/switch allows multiple PCs to access the same network, which may be required for either single or

multi-node systems

· If a single PC is to be connected to a single Artist node a network hub is not required. In this case, a PC can be

connected directly to the Artist using a crossover cable. However, if the system is equipped with redundant CPUs we

recommend using a hub/switch in order to ensure a working connection to the system in the case of a CPU switch-

over.

Figure 5: Network – Networking 2 nodes

If the PC is already part of a network you should consult your Network Administrator before continuing

with this installation. The PC requires a fixed IP address. 
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2.5 IP Addresses

Each Artist mainframe is delivered with a factory set IP Address of 192.168.42.100, where 192.168.42 is referred to as

the "Net ID" and 100 is the "Host ID." The complete IP address can of course be changed at any time to connect the

Artist with a pre-existing network.

The following is required for a direct connection between an Artist and a PC using a crossover cable or a

switch/hub:

The Net-ID of the PC’s IP address should be set the same net ID as that of the Artist mainframe (default: 192.168.42),

but with a different host ID (100 and 101 are reserved for use by Artist). For example, the PC could use the IP address

192.168.42.10.

Director is using TCP port 8192. Please make sure, that no firewall is blocking this port between

configuration-PC and Artist Matrix.

If the Artist and the PC are connected via a DHCP server, such as a router, the IP addresses of the system

and the Artist can be different. In this case, the corresponding routing must be handled by the router. If

this applies, contact your network administrator.

Further IP settings for Artist can be found in the chapter "Setup / Change the IP address in Artist nodes".

One should always chose an even numbered IP address for Artist since the next odd numbered IP address is

automatically used by the second CPU in the mainframe. For example:

 1. CPU: 192.168.42.100

 2. CPU: 192.168.42.101 (automatically)

It is recommended to test pre-existing networks with standard port scanners or ping tools in order to find possible

repeated IP address and other problems. This should be done before connecting the Artist to the network to avoid

possible IP address conflicts and collisions.
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3 How to...

This part of the document provides step-by-step details on how to configure and program all of the functions and

settings in the Director Software package. Each section describes a function and the requirements needed to configure

it.

3.1 Director Layout

Director is divided into two main sections: the Navigation Bar and the Workspace. In addition, there is also a toolbar

containing the standard Windows functions and special software tools, as well as a Status Bar showing the details of the

system's status.

Figure 6: Director – Layout
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3.1.1 Navigation Bar and the Workspace

The Navigation Bar is made up of a series of tabs, each one corresponding to a category of functions that can be

programmed in the Workspace. Each tab is labeled with a name and a symbol. Some of the tabs may require a

different window arrangement for optimal viewing.

The positioning of the Navigation Bar and the Workspace can be changed with the  button or by pressing <F10> in

order to more easily view and edit all required functions. In that case, the Navigation Bar and Workspace are displayed

one below the other (see figure below).

Figure 7: Director – Navigation Bar docked on top

A side-by-side view can be restored by pressing the  button or the <F9> key.

The window size of both areas can also be manually adjusted to show all available information.
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3.1.2 Changing the View

The appearance of Director can be changed in the "View" menu. The menu allows the various toolbars to be shown or

hidden. 

Standard Toolbar Windows function buttons and toolbars

Status Bar Director Status Bar

Artist Online-View Online Monitoring and Status Tool

Config Transfer Toolbar Director Download/Upload Bar

Navigation Bar Director Navigation Bar

Click on the menu "View" to display or hide the corresponding toolbars. A checkmark  will be shown when the

toolbar is active.

It is also possible to move the Workspace and Navigation Bar to other positions. To do so, place the mouse

pointer at the end of the bar or window, and reposition the window while holding down the left mouse

key. In addition, the Navigation Bar and Workspace can be detached and unlocked with a double click on

the outside of the bar or window. It is also possible to move the Workspace or Navigation Bar outside of

Director, for example to a second monitor. 

A double click on the detached window will return it to its standard position.

Figure 8: Director – Repositioned Navigation Bar and Update Button
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3.2 Creating a New Configuration

A new configuration is required when the system is being used for the first time. If a new configuration is being

created, an empty workspace opens based on the default settings for all functions and parameters.

In order to start a new configuration, select menu "File" > "New" or press the  button in the toolbar.

3.2.1 The Web and the Network

The Web and the Network are two hierarchical layers describing the architecture of the complete system. The top layer

called Web is used to trunk different systems to each other. Also the name of the "WEB" is shown in the title bar of the

Director Window, to identify the loaded configuration easier. The WEB consists of a NET, which is the second layer of

the system. A WEB may contain a maximum of one NET.

Figure 9: Director new workspace
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3.2.2 Labels for the Web and the Network

To provide the Web and Net with suitable names, do a right mouse click either on the Workspace or on the Web or Net

label in the Navigation Bar. This will display the corresponding properties window.

Figure 10: Open the "WEB" – Properties

Alternatively, you may click on the Web or Net and press the <F2> key to change the name directly.

The default Web name is "Untitled ARTIST Configuration" and the default Net name is "Net #1".

Change the name of the Web or Net in the General

tab. The name can be up to 32 characters long and

is only used in Director. The name entered will be

displayed in the Navigation Bar and Workspace.

Figure 11: Web properties window

Up from version 6.30 the title bar of the Director window is not

showing the name of the loaded file anymore. The title bar is now

showing the name of the "WEB" of the configuration. The advantage

is, that the title name is not changing to "untitled" anymore, when

changes in the configuration has been made. 

Up from Director 6.40D5: In "Extras" > "Options" > "Miscellaneous"

you can select if you want to see the Net-Name or the loaded File-

Name in the title bar.

Figure 12: Director – Display of the loaded configuration in the title bar
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Figure 13: Open the "NET" – Properties

Figure 14: Net properties window

The default settings in the Net properties window can be changed to apply the defaults globally. Details are found in

chapter "Net Properties".
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3.3 Open a Configuration

Accessing a pre-existing configuration file requires the file to be located and opened.

3.3.1 Open a File

When a previously saved configuration is opened, all of its settings and configured functions are available in Director.

The opened configuration can now be edited and saved to the Artist system.

A configuration is opened by selecting "Open..." from "File" menu or by using the  button in the Toolbar. 

· The file selection window will open in order to load a

pre-existing configuration file ending in "*.Art." 

· First, choose the drive and next choose the

corresponding folder in which the *.Art files are stored. 

· Choose the desired file by double-clicking or pressing

the Open button. 

Figure 15: Director – Selecting a configuration file 

Up from version 6.30, the title bar of the Director window

is not showing the name of the loaded file anymore. The

tile bar is now showing the name of the "WEB" of the

configuration. The advantage is, that the title name is not

changing to "untitled" anymore, when changes in the

configuration has been made. 

Figure 16: Director – Display of a loaded configuration

To load the current configuration from an Artist system to a PC, please see chapter "Upload a Configuration from

Artist".
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3.3.2 Login as a Predefined User

The Navigation Bar and the Workspace display the details of the opened configuration. The User Login window will be

displayed and the user must login before proceeding. Even if no password is required, one must still login by pressing

the  button. For details, see chapter "Login".

Figure 17: Director – User Login after opening a pre-existing configuration

If the configuration is opened and there are no errors reported, the configuration can be sent to the Artist system.

Details are found in chapter "Send a Configuration to Artist".
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3.4 Login

The User Login is a system security mechanism which ensures that only those users who have the required rights can

make changes to the system. The software always opens with the default user "Admin" selected, which has so-called

"super user" rights. That means that this user is allowed to create new users and define their user rights.

The default user is "Admin". No password is initially set for this user. We therefore strongly recommend

that the system administrator sets up a password at the first opportunity.

Every time that a new configuration is opened, either from a file or directly from Artist, the login window is displayed.

In order to gain access to the configuration and all of its functions,

users must login with their predefined name and password.

Figure 18: Director – User login window

The user login window can also be opened to switch to another pre-defined user. To open the user login window

either:

· Select the User Login option in the File menu

· Press the User Login Button  in the toolbar

· Read out the configuration from the system

The current user that is logged onto the system is shown in the Status Bar at the bottom of the Director window.

Figure 19: Director – Status Bar

If the user name is not available or access to the configuration data cannot be obtained, then the user

‘Admin‘ must log in and either create a new user or change the access rights of the existing user.
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3.5 Add or Change Users

The table in the "Users" tab lists all of the users and their assigned access rights.

The default user is "Admin", who possesses the so-called super user rights. This means that this user is

allowed to change all functions and setting in the configuration as well as create new users. 

In the tab "Users" new users can be created or existing uses can be edited.

Figure 20: Director – Navigation Bar Users tab

· The button "Add..." creates a new user.

· The button "Edit..." edits current users.

· A user can be named in their properties window 

· A distinct password can be given to each user. This

password must be entered the same twice or it will

not be accepted. 

Figure 21: Director – User Properties window

· In the field "Permissions" users can be given the

following basic user rights: (Active rights are indicated

by a  checkmark.).

· Allow Save to Artist (overwrite) 

· Allow Save Changes to Artist (merge) 

· Allow Save Configuration to Disk 

· Allow Open File from Disk 

· Restrict Properties for AV-Router (if installed) 

· Schedule Manager (if installed) 

· User Account Manager 

· Allow to edit the IFB-table 

· Allow System-Resets 

· Enable Partial Files (if installed) 
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3.6 Configure a "NET"

After a new configuration has been created (see chapter "Creating a New Configuration"), the next step is to define the

individual components of the Net.

The Net is an element of the Web and is comprised of one or more nodes that together form a matrix. The

Net must contain at least one Node that provides the audio and control interfaces. In a multiple node

system the individual nodes are connected over fiber and form a ring. 

3.6.1 Adding / Deleting and Connecting Nodes in a Network

Double clicking on the Net#1 label in the Navigation Bar opens the Net Workspace where new nodes can be added. If

Net#1 cannot be seen in the Navigation Bar, click on the plus sign (+) to expand the Web tree.

Figure 22: Director – Net Workspace without any nodes
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3.6.2 Adding a New Node

To add a new node click on the button  in the workspace that corresponds to the type of node

being used. Holding the mouse over the different node types will show what mainframe each node type corresponds

to. Using the left mouse key, click on the chosen node type and then point the mouse anywhere on the Workspace. The

mouse pointer will change to small cross lines. Click again anywhere that is empty in order to "place" the node in that

location. On the Workspace there is now a rectangle that represents the node. At the same time, a tree menu structure

will appear under NET#1 in the Navigation Bar. Clicking on the "+" displays the new node that has been added under

NET#1. Repeat the steps above until all of the nodes in your system have been added.

Figure 23: Director – Net containing nodes without links

The nodes in the Workspace can be moved around by clicking the button and then selecting the node that you wish to

move. The "+" and "-" buttons allows increasing or decreasing the display size of the nodes. 

· Active nodes which are detected by Director during online operation are green.

· Nodes that are red are not detected to be online, or Director is in offline mode and is not connected to any system.
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3.6.3 Connecting Multiple Nodes

Multiple nodes must be connected with one another. Each node must have both an input (upstream) and output

(downstream) connection.

Manual Connection3.6.3.1

The connections are added to the worksheet by selecting the fiber Link  button.

· The pointer will initially display a white-on-black 'From'

label when positioned over the worksheet (1).

· Move the pointer to the right side of a node (2). The

"From" label changes to a green background. If you

now click with the mouse a connection line

representing a fiber link will attach to the node.

· The label near the mouse pointer changes to a black

background (3). Pull the line to the left side of the next

node. The 'To' label will become green as soon as it is

placed above the correct area of the next node (4). Click

once to establish the connection between the two

nodes.

· The connecting lines (5) can be moved around as

necessary by clicking on them.

Figure 24: Director – Connecting nodes



34

Director 7.20 User Manual A10

Automatic Connection using the Magic Wand3.6.3.2

Alternatively, with the magic wand button  you can automatically connect all of the nodes with one another

independent of their assigned IDs. If this button is pressed, all of the nodes on the workspace will be connected with

each other beginning with the node with the smallest ID and connecting them in order by ID number.

Up-

stream

Down-

stream
Fiber

Up-

stream

Down-

stream
Fiber

Up-

stream

Down-

stream
Fiber back to

smallest ID
Node with lowest ID Node xx Node with highest ID

This automatically generated connection order might not reflect your actual physical fiber cabling.

Figure 25: Director – Net with 3 networked nodes

Once the Net has been configured the next stage is to configure each of the Nodes that comprise the Net. See chapter

"Hardware Configuration of a Node".
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3.6.4 Labels for Net and Nodes

It is possible to give the net and nodes meaningful names. Right mouse click in the Navigation Bar on the net or node

and choose "Properties". The window that opens has a space to change the names.

Alternatively, by selecting a net or node and pressing the <F2> key one can change the 'Long name' directly.

Enter a name for the Net or Node on the General

Tab. You can use up to 32 characters. This Long

Name will only be displayed in Director. The name

appears in the Navigation Bar and Workspace. 

Figure 26: Director – Node Properties window

3.6.5 Deleting Nodes

Before deleting a node it is recommended that you save the current configuration to the hard disk. For details see

chapter "Saving a Configuration".

The Node is selected using the  pointer button. A

right mouse click then displays the Delete Node and

Properties options. Clicking "Delete Node" deletes

the node.

Figure 27: Director – Edit Node Pop-up

If a node is deleted, all fiber connections to the node and everything configured in the node is completely

erased.
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3.6.6 Setting up Multi-Node Systems

Before connecting multiple nodes in a fiber ring, the configuration and the settings of each node must be checked and

adjusted, if necessary. Wait until all of the nodes have been configured correctly before physically connecting them

with fiber. Connect the PC (Director) to each node individually, for example by entering their individual IP addresses in

Director, assuming the nodes are connected on a PC network. If there is no IP network, connect the PC to each node

directly with a crossover Ethernet cable in order to change their settings one after another.

Setting the Net and Node Addresses3.6.6.1

Each node in a fiber ring must be assigned a unique node address.

Node ID Address Range 2, ... ,99

Node IDs "0" and "1" are reserved and cannot be used for normal operation.

Artist S

Artist S Mainframes have front panel accessible switches and LED displays to adjust and view the current Node and

Net IDs. Remove the left most of the four foam covers on the front panel. Hidden underneath are three HEX and

two push-button switches to make the necessary Net and Node ID adjustments. Set the desired node address with

SW1 (right) and SW2 (middle). For example, if you set SW2=3 and SW1=1 you get node address 31, which will be

shown in the display. The SW3 switch must always stay on address 1. The newly set address blinks in the display.

This means that the new address has not yet been accepted by the system. Give the key on the right a short press

to confirm the selection.

Figure 28: Artist S – Net and Node ID

After an address change, a node must be reset. A node reset can be accomplished by pressing both keys at the

same time. Hold both keys pressed for approximately 10 seconds until the countdown in the display reaches 0.

In order to receive a new node address the node must also be restarted by a power reset. Otherwise

the node will not be visible in Director.
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Artist 32, 64,128, M

Select the Network On  button from the Director Menu Bar to enable access to the fiber network (see chapter

"Enabling and disabling network access").

Node addresses can be changed in the Artist - Online View. Click on the  button or open the "Artist - Online

View" window via "View" > "Artist - Online View".

Figure 29: Director – Artist - Online View

· Open the Artist - Online View window.

· Select with a mouse click the node that you

wish to change under "ARTIST Nodes

detected". Then press the 

button.

· Click on the checkbox "Set Node Address".

· Change the node address.

· Pressing the button "Send changes and reset

the node" will implement the changes. The

node will automatically do a reset.

Figure 30: Director – Online View – Set Node Properties window
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Defining a Node as Ring Clock Master3.6.6.2

It is necessary to set one node of an Artist system to be the so-called "Ring Clock Master." The Ring Clock Master

provides the system clock that synchronizes all nodes connected over a fiber network. To set a node as Ring Clock

Master, click the checkbox "Set Ring Clock Master to" in the "Artist - Online View" > "Node Properties" and click the

checkbox "Enabled".

Figure 31: Director – Online View – Set Ring Clock Master to Enabled

If a ASM sync-module is installed in your node, you can choose "Set Synchronize to External Clock" to synchronize the

node, as well as the complete fiber ring, to the system clock of an external devise, such as a digital mixing console.

Figure 32: Director – Artist - Online View – Set Synchronize to External Clock to enabled

If you only have a single node, it should still be defined as the Ring Clock Master.

Up from version 6.60 a Node reset is not required anymore when changing the Ring Clock Master settings. The changes

will not interrupt the normal system operation.

The Artist - Online View will show up the current setting Clock Master setting.

Figure 33: Director – Online View – Clock Master
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Checking the Node IDs in the Configuration3.6.6.3

Add new nodes and fiber connections to your network (see chapter "Adding / deleting and connecting nodes in a

network"). The configuration should mirror your actual hardware installation. Set the Node ID in the Node Properties in

the Director configuration according to the hardware Node ID setup, which can be seen in the "Artist – Online View".

Choose a node using the pointer button .

Use a right mouse click to display the Edit

Node pop-up window. Choose "Properties"

to display the window with the node

properties.

Figure 34: Director – Edit Node Pop-Up

Adjust the node addresses to reflect your

hardware configuration.

Figure 35: Director – Node Properties window

Should it become necessary to change the node type without deleting its configuration (for example when a node is

replaced by a larger frame due to expansion), this is also possible using this pop-up window.

Figure 36: Director – Change node type to ...
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Connecting the Fiber Cabling3.6.6.4

Connect all fiber cables between the frames, according to your configuration.

Do not accidentally switch the Rx & Tx on the fiber. Details are found in the Installation Guide.

Check the fiber network

Press the Network  button from the Director Menu Bar to enable access to the fiber network. 

Artist - Online View

If you have successfully connected to the system and the fiber cabling is correct, all current nodes which are accessible

should appear as entries in the "Artist - Online View" window, which is opened using the  button.

Figure 37: Director – Online View window
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Net Workspace3.6.6.5

When you connect to the system by clicking the  button, and all addresses are set correctly, all of the available

connected nodes should be green.

If an Artist frame only has a single CPU installed but two CPUs in the configuration, or if the

second CPU is not functioning properly, half of the node will appear green and half red. The

left side shows the CPU in Slot A while the right side shows the status of the CPU in Slot B.

When redundant CPUs are installed and working correctly the node will appear completely

green. This also happens if there is only one CPU defined in the Director configuration.

Artist S offline Node; the Artist S does not support a redundant CPU so it will always be either

fully green or fully red.

The following example with an Artist 32, an Artist 64 and an Artist 128 shows that the Artist 32 only has its redundant

CPU active, the Artist 64 is functioning normally, and the Artist 128 is either not turned on or has a node address that

does not match the configuration. 

Figure 38: Director – 3 Node System: 1x CPU online, 2x CPUs online, Offline
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3.7 Merging separate Configurations into a single Configuration

A truly unique feature of Director and Artist systems is the possibility to import configurations. This means that two or

more configurations from different systems can be combined into a single large configuration, for example to directly

connect Artist systems from two outside broadcast vehicles for a large production. In this case, both trucks would be

networked over fiber and would have the ability to combine their systems into a single large matrix without having to

pull large numbers of audio cables between them.

If several Artist systems are to be combined, the same steps are involved as in the creation of a new

configuration with several nodes. This means that the node addresses of all of the nodes must be unique.

In addition, only one frame is allowed to serve as Ring Clock Master. The node addresses and Ring Clock

Master settings must be adjusted before physically connecting the nodes via fiber.

Step 1: Setting the net and node addresses (in the previous chapter)

If two identical configurations need to be combined (for example, two identical broadcasting trucks), it is

imperative that one of the configurations receives a new "Configuration-ID".

Be aware that existing Partial Files will no longer work with the configuration after this change. To change

the Configuration ID, click on "Extras" > "Assign new Configuration ID". The configuration then receives a

new unique internal ID. Save the configuration under a new name. Afterwards, the two configuration files

can be combined without any problems.

Figure 39: Director – Assign new Configuration ID
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Step 2: Prepare the new nodes for merging

Be sure to save the original configuration files of the individuals systems. As soon as all of the nodes have been

assigned a unique ID, a new merged configuration can be created. Open the original configuration from the hard drive.

The configuration of the second system, which should also be available on the hard drive or a USB stick, can then be

imported using "File" > "Import...".

Figure 40: Director – File / Import

Likewise, it is possible to import the configuration of the other system directly from Artist. To do so, connect Director

with the IP address that corresponds to the second system (if you have a direct connection between the PC and Artist

you must move the cable to the second system). Once there is a working connection, you can use the function "File" >

"Import from Artist" to directly import the second configuration into the original configuration.

Figure 41: Director – File / Import from Artist
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Regardless of the method you choose, after a successful import a window will appear in which you can give a prefix to

the names in the imported configuration. This name prefix will be added to the beginning of the name of every

imported object in the system. This will differentiate the imported objects from those contained in the original file and

prevent port names from being repeated. This prefix should be as short as possible.

Figure 42: Director – Configuration Import window

You can now change the node and port names in the new merged configuration as you like, and also add new

functions, conferences, calls, etc. between the two systems.

Step 3: Connect the fiber cabling

Connect all your fiber-cables according to your configuration. 

If the cabling and the node addresses are correct, you should be able to see the new nodes in the Artist - Online View

. Send the complete configuration with the  button to the newly connected system. Finally, reset all nodes via

"Extras" > "Reset all Nodes".

A merged system created in this way can be used and programmed as you like without any restrictions or bottlenecks

between the two individual systems.
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3.8 Hardware Configuration of a Node

A node is comprised of a set of audio and control interfaces, as well as fiber connectors to link to other frames. Each

node consists of a mainframe where cards with various interface capabilities are placed. These client cards provide

ports for panels, 4-wires etc. The CPU manages the system and provides the connection to both the computer network

and the fiber ring. GPI cards offer the ability to send and receive contact closures. For more details on the individual

cards please refer to the Artist manual.

Each node is populated with cards according to your requirements. The cards in the mainframe determine the number

and type of available ports in the node. It must be decided in advance how many panels and 4-wire ports are needed in

the system. In order to program a hardware layout in Director, double click on a node in the Network tab of the

Navigation Bar. Click on the plus signs (+) to expand the Web tree if no Nodes are shown. After double clicking on a

node the corresponding hardware configuration table is shown in the Workspace.

Figure 43: Unassigned Node Configuration Tables for Artist 128 and Performer 32-16 mainframes

To add a new card to the configuration, either right mouse click on a bay or left mouse click on the  symbol.
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3.8.1 Slot Arrangement of Artist Frames

The configuration table corresponds to the bay locations in the various mainframe types:

Figure 44: Artist M / 128 bay numbering, front view

Figure 45: Artist 64 bay numbering, front view

Figure 46: Artist 32 bay numbering, front view

Figure 47: Artist S bay numbering, front view
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3.8.2 Adding a New Matrix Card

In the Node Configuration Table, right click on any card type marked "<unused>" or open a list of available card types

by clicking on the  symbol. Different card types can be selected depending on the matrix type and on the used card

slot (bay). 

Figure 48: Choosing a new card type

As soon as a new client card is added, its 8 available ports are automatically displayed.

Figure 49: Node configuration – Client Cards selection

All available card types of the different matrix types are listed in the following chapters.
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'Artist G2 32, 64, 128' Client Cards3.8.2.1

Bay A

(Artist 32, 64, 128)

Bay B

(Artist 32, 64, 128)

Bays 1 to 4/8/16

(Artist 32, 64, 128)

Bays X and Y

(Artist 128 only)

PSU 1 and PSU 2

(Artist 32, 64, 128)

Figure 50: Node configuration – available card types Artist 32, 64,128
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'Artist M' Client Cards3.8.2.2

Bay A and B

(Artist M only)

Bay 1 to 16

(Artist M only)

Bay X and Y

(Artist M only)

PSU 1 and PSU 2

(Artist M only)

Figure 51: Node configuration – available card types Artist M

In Artist M configurations, the PSUs should be set to "unused," because Artist M does not support any PSU

monitoring. If this is not done, you will receive constant error messages.
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'Artist S' Client Cards3.8.2.3

Bay A

(Artist S only)

Bay 1 to 4

(Artist S only)

Bay X

(Artist S only)

Figure 52: Node configuration – available card types Artist S

'Performer 32-16, 32-80' Client Cards3.8.2.4

Bay A

(Performer 32-16/80)

Bay B

(Performer 32-16/80)

Bay 1 to 4

(Performer 32-16/80)

Bay 5 to 8

(Performer 32-80 only)

PSU 1 and PSU 2

(Performer 32-16/80)

Figure 53: Node configuration – available card types Performer 32-16, 32-80
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3.8.3 Adding a New Port

In the Node Configuration Table, right click on any port marked "<unused>" or open a list of available port types by

clicking on the  symbol. Different port types can be selected depending on the kind of client cards that are installed

and configured. Port types are organized by series.

Figure 54: Choosing a new port type

'1000 series' Port types3.8.3.1

Port types 1000 Series are available at following Client cards:

· COAX-108 G2

· CAT-108 G2

· MADI-108 G2

· AES67-108 G2 (via NSA – Network Stream Adapter, AES3/AES67 converter)

· VoIP-108 G2

 RCP-1012E

 RCP-1028E

 DCP-1016E

Figure 55: Port types 1000 series

If under "Settings" > "Options" > "Miscellaneous" the function "Show legacy Panels" is activated, the older "B-

series" panels of the 1000 panel series will also be displayed.
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'1100 series' Port types3.8.3.2

Port types 1100 Series are available at following Client cards:

· COAX-108 G2

· CAT-108 G2

· MADI-108 G2

· AES67-108 G2 (via NSA – Network Stream Adapter, AES3/AES67 converter)

· VoIP-108 G2

 RCP-1112

 RCP-1128

 DCP-1116   CCP-1116

Figure 56: Port types 1100 series
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'2000 series' Port types3.8.3.3

Port types 2000 Series are available at following Client cards:

· COAX-108 G2

· CAT-108 G2

· MADI-108 G2

· VoIP-108 G2

 RCP-2016 / RCP-2116

 DCP-2016 / DCP-2116

Figure 57: Port types 2000 series
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'2300 series' Port types3.8.3.4

Port types 2300 Series are available at following Client cards:

· COAX-108 G2

· CAT-108 G2

· MADI-108 G2

· AES67-108 G2

· VoIP-108 G2

 RSP-2318 Basic (The third touch Display cannot be configured)

 RSP-2318 Plus

 RSP-2318 Pro

 DSP-2312 Basic

 DSP-2312 Plus

Figure 58: Port types 2300 series (SmartPanels)
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'3000 series' Port types3.8.3.5

Port types 3000 Series are available at following Client cards:

· COAX-108 G2

· CAT-108 G2

· MADI-108 G2

· VoIP-108 G2

 RCP-3016

 DCP-3016

Figure 59: Port types 3000 series

'5000 series' Port types3.8.3.6

Port types 5000 Series are available at following Client cards:

· COAX-108 G2

· CAT-108 G2

· MADI-108 G2

· VoIP-108 G2

 DCP-5008  DCP-5108

Figure 60: Port types 5000 series
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'4-Wire' Port types3.8.3.7

Port types 4-Wire are available at following Client cards:

· COAX-108 G2

· CAT-108 G2

· AIO-108 G2

· MADI-108 G2

· VoIP-108 G2

 4-Wire

   4-Wire Split

Figure 61: Port types 4-Wire
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'Miscellaneous' Port types3.8.3.8

Port types Miscellaneous are available at following Client cards:

· COAX-108 G2

· CAT-108 G2

· MADI-108 G2

· AES67-108 G2

· Dante-108 G2

· VoIP-108 G2

 DBM-1004  Telephone Codec

 RIF-1032

 RIF-2064

 C3 Digital Beltpack  WB-2 Wireless Beltpack

 Aurus Panel

Figure 62: Port types Miscellaneous
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Port types VoIP client card

By using a VoIP client card it is possible to use also the software panels VCP-1004, VCP-1012 or a SIP-telephony

connection. Details see chapter "Softpanel VCP-1004/ VCP-1012" and "SIP-Telephony".

 VCP-1004

 VCP-1012

 SIP-Phone

Figure 63: Port types Miscellaneous – VoIP card
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Port types MADI client card

By using a MADI client card it is possible to select an ACROBAT – WB-2 Beltpack as port type. The minimum

requirements to connect an ACROBAT system is an ACROBAT Cell Controller CC-60 or CC-120, equipped with

a MADI Interface. The keys of every WB-2 can be programmed with any function like any other panel individually.

 WB-2

Figure 64: Port types Miscellaneous – WB-2 – MADI card

If you are using Acrobat Wireless Beltpacks connected to a CC-8, you have to use ordinary analog ports

in the configuration for every Partyline.



60

Director 7.20 User Manual A10

Port type AES67 client card

By using an AES67 client card with minimum version 7.20, it is now possible to select AES67 4-Wire Split and AES67

Trunkline as port type.

  AES67 Input/Output

Figure 65: Port types AES67 Input/Output – AES67 card
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Port type DANTE client card

By using a DANTE client card with minimum version 7.20, it is now possible to select a DANTE 4-Wire split as port

type.

  DANTE Input/Output

Figure 66: Port types DANTE Input/Output – DANTE card
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Expansion Panels3.8.3.9

If a panel should also have one or more expansion panels, add them in the panel's "Expansions" list. Choose the

expansion panel type and address. Addresses that have already been used will not be displayed. To add additional

expansion panels, repeat these steps.

Figure 67: Node configuration table Expansions

Available Expansions, dependent on the selected base-unit:

Expansion types 1000 series

 ECP-1016

 ECP1012-PT

 DCP-1016 ES  DEM-1006 (max. 6 per DBM-1004)

Figure 68: Expansion variation 1000 series
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Expansion types 1100 series

 ECP-1116  DEM-1106

Figure 69: Expansion variation 1100 series

Expansion types 2000 series

 ECP-2016

 ECP-2016 PT

 DCP-2016 ES  DEM-2008 (max. 1 per DCP-2x16, max. 3 per RCP-2016)

Figure 70: Expansion variation 2000 series

Expansion types 2300 series

 ESP-2324

Figure 71: Expansion variation 2300 series

Expansion types 3000 series

 ECP-3016

 DCP-3016 ES

Figure 72: Expansion variation 3000 series
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3.8.4 Configuring a 2-Channel Panel

The digital ports of the Artist system always use an AES audio format. However, only a single channel mono AES signal

is normally sent to each port. Nevertheless, it is possible to send 2 full-duplex audio channels to a panel. This can be

valuable for certain applications that make use of the audio patches and the analog I/Os on the panel. Thus, it is

possible to send an additional audio channel, such as program audio, directly to the panel without interfering with the

intercom communication.

In this case, the mono signal from the next port is internally routed to the second channel of the previous port.

Figure 73: Communication with 1 AES channel between Artist and a panel

Figure 74: Communication with 2 AES channels between Artist and panel

Odd numbered ports (1, 3, 5 and 7) must always be used when connecting 2 channel ports

(CAT5/AES/COAX). The next even numbered port must always remain unused.
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Place a panel on an odd numbered port of a client card. Check that the next port is not already being used. Open the

"Properties" of the panel with a double click on the panel. On the "General" tab, activate the option "Use 2nd audio

channel".

Figure 75: Activating the second audio channel

The next port will be automatically blocked in the node Configuration Table. 

Figure 76: Node configuration – second audio channel

The second channel can now be used in the configuration.

When a port is defined for use as a CCP-1116, "CONNECT SOLO/DUO/TRIO" or a "C3 Beltpack," the port will

automatically be set in 2 channel mode if the hardware configuration allows it – that is, when the port is an

odd numbered port and the next port is not being used.

If the second channel of a digital port is calling to a panel, the "Reply" key will always show just the first

channel of the source port. Therefore a talk back via the Reply key to the second channel is not possible.
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3.8.5 Configuring a 2-Channel 4-Wire Port (AES only)

To create a two channel 4-wire port (AES only!), you should proceed exactly as with a two channel control panel. In this

case, the first and second audio channels of the port will have the same name and can only be routed together. A

"Reply" key can only talk back to the first channel of the port.

However, since a digital 4-wire port is normally connected to a mixing console or a similar device, it makes sense for

each channel to use a separate name. Then the two channels can be configured and routed independently from

another. In this case, the single channels also show up and can be used separately in the "Reply" key.

Add a digital 4-Wire or 4-Wire Split on an odd port on a digital card in the node configuration just like you would do it

for an analog 4-wire. When you now create another 4-wire port on the following even port, the system automatically

recognizes that this port have to be used as the second audio channel for the preceding port.

Figure 77: Configuring a 2-channel AES 4-wire

The two channel AES port must be connected to an odd numbered port. The following port must remain

unused. It will be routed internally as the second AES channel of the previous port.
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3.8.6 Relocating a Port

It is very easy to move an already configured port type to another hardware port within the system. By moving the

port, all belonging commands and functions from and to the port, labels and special configurations are moving

together with the Port.

Therefore you have to open the Node configuration view of the Node you want to move the port to in the Director.

Do a double click on the Node in the  tab to open the hardware configuration.

Figure 78: Node configuration: Relocating a port – Node Configuration of the destination Node

Now expand the Node in the Network tab where the port you want to move is located at the moment. Now drag and

drop this port to the new unused hardware port on the right side.

Figure 79: Node configuration: Relocating a port – Moving a port by drag and drop
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Hint: It is also possible to drag and drop a Port from the  tab opened on the left side, when the Node

configuration is opened on the right side.

When sending this configuration change to the system, the port will wake up on the new assigned port exactly like it

was on its origin port before. Up from Version 6.60 a Node-Reset is not required anymore.

· Panels can only be relocated to unused ports of any digital card. It doesn't matter if you move this port

coming for example from a CAT5 card to a Coax, Madi or VoIP card.

· If you want to move a 2ch. Panel, you also have to move it to another odd port with the following even

port unused.

· 4-Wires (AES and analog) can be moved from an analog Port to a digital and vice versa (if the second

channel option of an AES 4-wire port is not enabled).

· You can move any port from one Node to an unused port on the correct card type of any other Node

within the System.

· GPIOs cannot be relocated.

3.8.7 Adding a GPI Card

When a GPI card is selected, the available 16 GPI and 16 GPOs are automatically displayed. To define the contact mode,

either right mouse click on the "<unused>" field or click on the  symbol. Inputs and outputs offer their corresponding

functions.

The 16 GPI inputs can be treated as normal

levels or can be inverted, for example, in the

case of incorrect wiring or inverted voltages.

The 16 GPI outputs can be defined as either

"Normally Closed" or "Normally Open",

depending on the requirements of the external

circuit.

Figure 80: Configuration of a GPI card
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3.9 Network Connection

Artist systems can be configured and monitored with the Director software. A configuration can be worked with either

online or offline. It is possible to create an entire configuration without being physically connected to a system.

However, to later use such a setup requires a network connection between the configuration PC and at least one node

of an Artist system. As soon as Director is connected with an Artist system it is possible to send a configuration to the

system, read out a configuration from Artist to the PC, as well as monitor the system in real time. 

A functioning Ethernet connection is required for online operation. For details on cabling and basic set up, see chapter

"Network configuration".

3.9.1 Setting the IP Address of the Local Node in Director

In order to connect to an Artist network, the IP address of the node to which Director is connected must be known. If

the IP address has not been manually changed, it is the factory default address of 192.168.42.100. Check to make sure

that you are connected to the active CPU of the node via a CAT5 cable (depending on whether the connection is direct

or over a hub, a 1:1 or at crossover cable must be used, respectively). Director can only be connected to one node at a

time. However, through this node Director has access to all other nodes that are connected via fiber and can also

access the complete system configuration.

Up to 4 Software instances can be connected simultaneously to a node. A software instance can be

Director, Trunk-Navigator, RRCS, SNMP and Juggler). So for example, two connected Directors and one

Trunk-Navigator eats up three connection slots on the Node.

Next, you must enter the IP address of the node that you

wish to connect to.

In the "Settings" menu, choose "IP Address of local

Node...". Enter the IP address of the node in the first

field.

Figure 81: IP address of local Node

If you are running your system with a redundant CPU, it is best to connect to both CPUs over a switch or hub. Click the

checkbox "This is an Artist M/32/64/128 node with a redundant node controller card." If the IP address of the first CPU

is unavailable because the card has failed or has been removed, Director will automatically look for the redundant CPU

at the next highest IP address.

The IP address of the redundant CPU card cannot be changed. The system automatically uses the IP

address of the first CPU card +1 for the IP address of the redundant CPU.
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3.9.2 Enabling / Disabling Network Access

Figure 82: Director – Toolbar 

The Director Toolbar has a dedicated Network On/Off button  to connect and disconnect Director from the Artist

system. Clicking the button will attempt to connect Director to the system. A successful connection will be shown in the

Status Bar. See the next chapter for details.

To disconnect Director from the Artist node, click the Network On/Off button again. The Status Bar still shows that there

is no longer a connection.

The Status Bar on the bottom of the Director window shows the connection status.

Figure 83: Status Bar, network not connected

3.9.3 Verifying a successful Network Connection

When a successful connection has been established it is reflected in the Status Bar as in the figure below. The blue

Connect indicator shows that a connection has been established. The green Rx and Tx indicators show that Ethernet

packets are being sent and received. The current bandwidth used is displayed in the red Network Traffic field. The

yellow area gives information on the number of nodes Director has found, including any nodes that are connected over

fiber. The yellow background also indicates that the connected system already has a valid configuration.

Figure 84: Status Bar, Artist connected 
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3.9.4 Setup / Change the IP Address in Artist Nodes

The IP address of a node can be changed via Director. To do so, Director must be online with the system. The changes

can be carried out in the "Artist - Online View," which can be opened by clicking on the  button. Next select the node

you wish to change and click on the  button.

Only change the IP address of a node if necessary. Errors made while entering an IP address will result in

the node not being found by Director. If this occurs, use a port scanner or reset the CPU to the default

factory settings in order to gain access to the system.

Open the Artist - Online View window .

In the Artist - Online View select the node you

wish to change, and open the Node Properties

window with the  button.

Click the corresponding check box  to set a

new address.

Change the IP address and the Subnet Mask and

Gateway, if necessary. For details, see your

network administrator.

To confirm the changes, click the

 button. The node

will automatically do a reset.

Figure 85: Set Node Properties 

If you change the IP address of the node that you are connected to, you must also change the IP address in

Director in order for that Director to re-establish a connection to the node.

See chapter "Setting the IP address of the local node in Director".
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3.10 Send a Configuration to Artist

Director can be used to program systems and generate

configuration data files independently of being connected

to a system. The majority of the configuration can be

prepared offline and checked for configuration errors

prior to sending it to a system.

A completed configuration without errors can only be sent

to an Artist system when Director is successfully

connected to the system.

Figure 86: Configuration change – Download a configuration

The following methods will send an entire configuration to the Artist system and will replace the existing configuration!

· Click on the  button in the Director Toolbar to send the entire configuration from the PC to the Artist system.

or

· In the menu "File," select "Save to Artist (Override)" to send the configuration to the system.

If several PCs are connected with the same Artist system at the same time, or when using special features

such as MCR, AV-Router or Events, it is strongly advised not to use the "Override" button , because

this will overwrite any changes that were made by other PCs or special features. Instead, only use the

"Transfer Changes" button . The "Override" button should only be used to send an entire new

configuration to the system.
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If you cannot press the  button because it is greyed out, or if after pressing it you receive an error

message, the following issues may be causing the problem:

· there are errors in the configuration

· the connection to the system has not been successfully established

· the user has insufficient rights to send a complete configuration to the system

· another PC is downloading a configuration at the same time. The system is therefore unavailable for further

downloads for a short period.

A progress window will display during the download to the system. This window will automatically close after a

successful download. The configuration that was sent will be active immediately.

Figure 87: Configuration change – Update successfully

The display of this window can be deactivated under "Settings" > "Options" > "Miscellaneous" > "Do not

show configuration transfer dialog for short, successful updates". If the window has been deactivated, it will

only appear in the case of an update error.

The following methods will make changes to a configuration in the Artist system. The current configuration in

the system will be modified!

· Click on the  button in the Director Tool Bar to send configuration changes to the system. Only changes to the

current configuration will be sent.

or

· In the "File" menu, select the option "Save to Artist (Merge)" to send the configuration changes.

If the  button cannot be pressed because it is greyed out, or if after pressing it you receive an error

message, the following issues may be causing the problem:

· there are errors in the configuration

· the connection to the system has not been successfully established

· the user has insufficient rights to send a configuration change to the system

A progress window displays during the download to the system. This window will automatically close after a successful

download. The configuration changes that were sent will be active immediately.
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3.11 Upload a Configuration from Artist

The complete configuration of an Artist ring can be read

with the Director software by any PC connected via

Ethernet to a node. This configuration can then be edited

and saved locally on the PC.

Figure 88: Configuration change – Upload a configuration

There are two different ways to upload the current Artist configuration to a PC. If you open a configuration

from the system, any other configuration open in Director will be closed. You will be asked whether or not you

want to save the open configuration.

· Click on the  button to load the Artist configuration to the PC

· From the "File" menu, select "Open from Artist..." to load the Artist configuration to the PC

If after attempting to load a configuration from the Artist to the PC you receive an error message, it may be for

one of the following reasons:

· The Ethernet connection is not yet established

· The software version of the Artist system is not compatible with your Director version

After the configuration has been successfully loaded onto your PC you must login with your user name and password

(if any). See chapter "Login".

The uploaded configuration can now be opened, edited and saved onto the PC. See chapter "Saving a Configuration".

You can also use Command Line Arguments, so the Director is connecting and reading out the current

system configuration automatically. See "Command Line Arguments".
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3.12 Saving a Configuration

A configuration file can be saved to a disk or network drive after it has been created or after it has been uploaded from

the system. A file can be saved at any time during the configuration process, irrespective of any unresolved

configuration errors or it being incomplete.

For the purpose of saving the configuration data the Director toolbar has a dedicated  button and the menu bar

"File" has a "Save" option. Clicking the button or selecting the "Save" option will save the configuration data to the

previously used "*.Art" filename.

If the configuration is untitled, the "Save As …" window will open. Alternatively, "Save As …" can be selected directly

from the toolbar file option in order to save the configuration under a new *.Art filename.

Assign a meaningful file name and click on

"Save" to save the file in the desired directory.

Figure 89: Configuration change – "Save As" window

Figure 90: Configuration change – Save Changes prompt

If you make changes in a previously saved configuration, an "*" appears on the window label after the name of the

configuration ("WEB" name). This means that changes have been made that have not yet been saved.

Figure 91: modified and unsaved configuration 
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3.13 System Snapshots

Up from version 6.70 it is possible to create system snapshots, so to backup and restore a complete system status

including key states, key volumes and IFB-Table volumes.

The snapshot functionality is independent from the configuration that is currently opened in the Director

software (also called "working configuration"). It only backup and restores the complete online

configuration of the connected online system.

3.13.1 Save System Snapshot to file

If you want to save the current system snapshot to a file, you have to select "Save system snapshot to file..." in the "File"

menu.

It only works, if an IP connection to the system is established, otherwise you will get an error-message:

Figure 92: Save system snapshot

When the  is activated and connected, you can create a snapshot of the current system status. So when you have

selected "Save system snapshot to file..." a new window will open were you have to select, from which system

components (Nodes/Cards/Ports) you want to save the current status. Therefore just click on the "+" symbols to

expand the tree structure of the connected system if you want to save only the actual status of selected ports.
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Figure 93: Save system snapshot – Expanding the system tree

Now you can select the ports on which you want to save the current key and volume status.

Click on the box prior the element you want to include. The box then looks like . If you click on an element which

also have other objects connected (e.g. a Node or a card) all objects subjacent are selected. When only some elements

of a node are selected the box shows .

After that you have to define which status-options should be included into the snapshot.

Key volumes Saves the volume setting for all keys of the selected panels (including the summary volume

for HS/SPK mode).

Key states Saves the actual key status (latched keys, Function keys "SHIFT" + "HS") of the selected

panels.

IFB-Table volumes Saves the Online XP-levels of the IFB-Table. This setting is related to the whole system /the

IFB-Table. No port selection is necessary for only including the IFB volumes into the

snapshot.
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Then press , select the destination and enter a filename for this snapshot. The extension of an Artist

snapshot file is .ash.

Figure 94: Save snapshot file

Please consider that a snapshot always saves the complete current online system configuration (included

the selected options) and also the current MCR status, active Partial Files etc. So in the background it is

reading out the online system configuration and save it to a file. It is not saving the working configuration

opened in the Director.

A snapshot file is NOT only saving the key states and volumes!

Press  to save the snapshot.

Now press  to close the "Save snapshot to file" window.



79

Director 7.20 User Manual A10

3.13.2 Restore System from Snapshot File

To restore a system to a previous status the Director has to be connected to a system. Go to "File" and select "Restore

system from snapshot file...".

Now press  and select a snapshot file you want to restore.

Figure 95: Restore snapshot

After the snapshot file is loaded, the window will show the file name and also the Web-name of the loaded system. By

clicking on the different "+" symbols you can flip open the system tree to see which objects are included with the

extended options. In the "Options" area you can also see, which status information are included.

Figure 96: Elements to restore
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You can also manually deselect Options you do not want to restore at this time. So as long the Options are

saved to the snapshot file, you can also deselect single options to restore, for example to just restore the

IFB volumes this time.

Now click on  to start the system restore process. 

A warning message will appear that a restore process will overwrite the complete system configuration.

Figure 97: System overwrite warning

Attention: Please consider that a snapshot file will NOT just send the selected key states and volumes to

the system. It will completely overwrite the system configuration, including the selected status options.

It will not send the working configuration that might be opened in the Director at this moment. It will open

the snapshot configuration in the background and send it completely to the connected system in the

background. The displayed working configuration that might be opened in the Director at this moment is

not affected and changing.

Also MCR settings are affected. The MCR assignment will be restored to the point in time when this

snapshot file was saved.

When you are aware about the risks, you can press  to start the restore procedure.

A new window will inform you about the restore process.

The complete base-configuration will be immediately sent completely to the system.

Then the restore process wait for 30 seconds before continuing to restore key states, volumes and IFB volumes.

This is just for safety reasons to make sure that all panels have booted correctly and the volume- and key stats can be

accepted by every panel.

If everything was ok and all hardware components (Nodes & Client cards) were online, the restore process reports

"success". Now all key stats, key volumes and IFB volumes are restored.

Figure 98: Restore success
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If a Node or a Client card is not running that is included in the snapshot file, you will get information that not all objects

could be restored. By pressing "Details" you get a description, which components were not online.

Figure 99: Restore status with errors (example)

In this situation, all selected options in the system are restored, expect for the panels connected to Client 2 on Node 3.

Attention: The restore window will NOT show an error, if selected panels are not connected and booted

during the restore process. When these panels are connected later on, the volumes are restored, but not

the key stats.

Attention: After restoring a snapshot file to the system, the Director software will NOT show the restored

configuration. It is still showing the last working configuration.

To see the current restored configuration in the Director, you have to read out the system by pressing the

 button.
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3.14 Configuration of Ports and Panels

The term "Port" refers to any device that can be connected to a matrix port. This can include control panels, 4-wires, 2-

wire I/Os, digital Beltpacks or telephone codecs. Simplex and duplex audio connections, groups, conferences, etc. can

be freely configured between ports in order to achieve the desired functionality.

Control panels can also be used for other functions such as:

· Activating central and local GPOs

· Connecting and using auxiliary audio sources and outputs

· Source assignment and routing operations

· Destination status and audio monitoring

· IFB sources and destination switching

· Panel re-programming

· Additional functions

3.14.1 Port Name

As soon as a port is created, the Director automatically assigns a unique system name to that port. Both, a distinct Long

Name (a unique description used in Director) and a distinct Local Name (Display text) are created. The Long Name is

shown as "Port baynumber.portnumber – Nodename" (For example: "Port 1.2 – Node 1 "). The Local Display name is

shown as "Port baynumer.portnumer" (for example: "Port 1.2"). This allows a fast allocation of the new ports.

In order to change the names, open the properties of the port. Right click on the port in the network list or port list and

choose "Properties." You may also double click in the workspace on the port to reach the properties.

Figure 100: Opening the properties of a port, variant 1
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or or 

Figure 101: Opening the properties of a port, variant 2+3

Both, the long name and display name can be changed in the "Properties" window. The length of the Long Name can be

up to 32 characters.

Figure 102: Properties window of a port – long name and 8-char name

Changing Port-list entries directly with Keyboard3.14.1.1

The most entries of the lists in the navigation area can be edited directly with the keyboard. For example, you can

directly edit the Long-, Display-, and Alias names in the Ports-list by pressing <F2>.

Following elements can be edited directly by pressing <F2>.

Label of the Web, Net and Nodes, Long Name of Ports

Long Name; Local 8 char. Label; Alias; Input Gain; Output Gain; Room Code; Trunking-Address

Long Name

Long Name; Disp 8 local

Long Name; Local 8 char.; Alias (not for Groups); GPIO Out; Trunking-Address

Long Name; Local 8 char (not for Logic Destinations)
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By pressing the <F2> key, or a right-click and choosing the function "Edit cell" you can enter the edit-mode.

With the arrow keys <UP> and <DOWN> you can jump easily from one cell to the next.

With the <TAB> key you can jump to the next column.

In columns like Room-Code (Ports) or GPIO Out (Groups+Confs) the elements can be chosen directly from an opening

list.

Figure 103: Editing table elements

With the <Esc> key you can stop the edit-mode.
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Alias Labels3.14.1.2

The "Alias" label is just a temporary 8-char name. You can use it, to show a different name of the port on all other

panels. For example, you can type in the forename of the user, without changing the general label of the port. When

you confirm a new Alias label with  or  and send it to the Artist, all displays in the system will show

now the Alias label instead of the 8-char. Label. All Alias labels are shown in "Port-List". The search filter is also looking

for the Alias labels.

Figure 104: Properties of Port – Alias labels

Trunking Labels3.14.1.3

Up from version 6.30 it is possible to give trunk enabled ports a separate label for Trunking. This means a port can have

2 labels. One is shown in the local system and the other one is shown in a trunked system. Because with Riedel's

"Actor" Interface it is possible to trunk an Artist system with a third party systems that do not support 8-character

labels. Therefore it is also possible, to give an additional 6-, or 4-character trunk label to an Artist port. In the

 tab of the port properties you can edit these labels. Please look at chapter "Labeling Trunkports" for more

details. If a trunk label is modified manually, it shows up in the column "Remote Labels" of the "Port" list. Unchanged

Trunklabels (= Local 8 character label) are not shown in this column.

Figure 105: Ports-List: Display of modified Trunklabels
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Transferring Port Names from an Excel® List3.14.1.4

As of software Version 5.91, it is possible to import a predefined list of all long names and local names from an Excel®

spreadsheet. To do so, it is necessary that the order of the names in the Excel® spreadsheet matches the order of the

ports in the configuration.

First, create a new table in Excel®. We recommend one column for long names and a second column for local names.

Next, copy the marked names into the Windows clipboard (  + ).

   >   + 

Figure 106: Excel® list with port names in the correct order

Open the port list in Director. Select the port from which you would like to begin importing names. Right mouse click on

the first port that should be renamed and choose "Paste ‘Long names’ from Clipboard". All of the long names following

this port will be renamed according to the names from the Excel® spreadsheet.

  >  

Figure 107: Importing names from an Excel® spreadsheet into Director
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The same process can be used for the "Local" names. Select and copy the entries from Excel® and paste them into the

desired location in the "Local 8-Character" column by using a right mouse click and the "Paste ´Local Labels´ from

Clipboard" command.

  >  

Figure 108: Pasting local display names from an Excel® spreadsheet
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3.14.2 Key Functions

Every key on a panel can be allocated one or more functions. Currently, up to 32 functions can be configured per key,

which will all be activated at the same time when the key is pressed. The following list contains descriptions of the

individual functions.

Call to Port Point-to-point call between two ports

Call to Conference Multipoint-to-multipoint call. Speak to a conference, listen to a conference

Call to Group
Point-to-multipoint call. Talk from a port to several others at the same time. Function

only from the source to destination

Call to IFB Enables a call to a pre-defined port from the IFB-Table with IFB functionality

Listen to Port Listen to an audio source (control panel, 4-wire, etc.)

Route Audio
Routes audio directly from a source in the system to a destination. In addition, the

crosspoint level can be adjusted (from a panel)

Switch GPI Out Activates a local or central GPI out

Select Audiopatch Loads pre-defined audio settings to a particular control panel in the system

Control Audiopatch Controlling any element of any Audiopatch

Remote Key
Remote control of control panel keys, option to lock keys, and the activation of the

signalization markers of a particular key

Reply Automatic reply key for point-to-point calls

Edit Conference Change conference members of a selected conference on a panel

Edit IFB Change IFB assignment on a panel

Dim Panel Speaker Dims the loudspeaker of a selected panel by a specified amount

Dim XP Level Dims the level of a selected crosspoint by a specified amount

Beep Panel Triggers an audible call signal at the selected panel

Clone Output Port Clones all output signals to a port to any other port

Telephone Dial Keypad /

Display
Keypad functions for dial-up and display phone numbers

Telephone Dial / Hang up Initiates the dial-up, hook control of a selected codec port

Logic Triggers a pre-defined logic source

Kill Partyline Mic
Deactivates all Partyline microphones in a selected Partyline (the Partyline must be

programmed as a member of a conference)

Auto Listen Off Deactivates a selected auto listen call

Set Input/Output Gain
Allows Input/Output Gain control of 4-wires, split 4-wires and digital Partyline ports

from a panel (only available on the 1000 series panels)

Sidetone Activates the Sidetone function on a panel and offers Sidetone level control

Send String
Sends a 256 character string to the RRCS interface for communication with higher

ordered systems (special feature)
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3.14.3 Virtual Port Functions

All ports have three so-called Virtual Functions. The Virtual Functions activate certain commands without the need to

press a key. 4-wire and 2-wire ports only have Virtual Functions. Most of the functions in the list above can also be

programmed on a Virtual Function. However, functions which require a key for operation, such as those that need a

volume control, are not available. Up to 32 functions can be programmed on a Virtual Function.

Always
As the name implies, the assigned functions are always active as soon as the port is connected to

the matrix

Vox
The assigned functions are activated when the input audio signal of the port is above a specified

level

On Call The assigned actions are activated when the port receives a call

3.14.4 Panel GPI Functions

All 1000 and 2100 series control panels are fitted with three GPI inputs and three GPI outputs. The same commands

that can be programmed on Virtual Functions can also be programmed on each GPI. The GPIs of the individual panels

are available for use throughout the entire system and work the same as GPIs on a GPIO card in the mainframe.

Figure 109: Panel GPIO

3.14.5 Panel Audio I/O

All 1000 and 2100 series panels are also equipped with auxiliary audio inputs and outputs for applications such as

external microphones, loudspeakers, a second headset connection etc. In addition, two AUX I/Os can be freely

programmed in the "Audio Patches". See chapter "Panel Audiopatch".

Figure 110: Panel Audiopatch
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3.15 Navigation

3.15.1 Navigation via the Network Tab

To open a port, double click on the port name shown in Network Tab of the Navigation Bar. Click on the "+" sign next to

a node to expand the navigation tree if no ports are shown. After the double click, the selected port is displayed in the

Workspace. If the port is a control panel, it will look like it does in real life. A total of two ports can be displayed in the

Workspace at the same time.

Figure 111: Navigation – Network with an open panel in the workspace

A port can also be opened in the Workspace by right mouse clicking on the port name in the node configuration table

and selecting the edit port option.
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3.15.2 Navigation in the Ports Tab

A double click on a port in the "Ports" tab of the Navigation Bar will also open the port in the Workspace. The ports tab

displays a list of all the ports in the entire system, sorted by name. If Director is connected to an Artist system the

status of the individual ports will also be indicated by color. A green background means that the port has a device

connected to it that has booted correctly and is available for use. A red background means either that nothing is

connected to the port or that the device has not booted.

Figure 112: Navigation – Port tab with workspace

The following columns are shown:

Figure 113: Port tab – Columns

Long Name Shows the Long Names (up to 32 characters) of a port

Local 8-char Label Shows the local 8-Character Display name

Alias Shows the local 8-Character Alias label

Input Gain
Shows the input gain settings of 4-wires in the Director configuration. (If the function "Set IO

Gain" is enabled for a 4-wire port, it shows <n/a>)

Output Gain
Shows the output gain settings of 4-wires in the Director configuration. (If the function "Set IO

Gain" is enabled for a 4-wire port, it shows <n/a>)

Port Type Shows the type of the port

Node Shows the Node, the port is connected to. The Node address is shown in ().

Port Shows the Port number (for example 14.7 = Client bay 14, Port #7)

Room Code Shows the configured Room Codes of this port

Trunking-Address Shows the configured Trunking-address

Active Source Channel Shows on which audio-channel audio is coming in (in real-time)

Status Shows the Online status of the port (Green = Online, Red = Offline)
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The port list can be sorted by other criteria, such as port type, number, etc., by clicking the label of one of the columns.

An arrow with a "1" next to it shows which criteria the list is sorted by and in what direction.

The list can be sorted by more than one criterion by clicking on a column while holding down the  key. All of the

criteria can be chosen and the order of sorting is shown by the numbers that appear on the column.

In addition, you can search for specific port names using a * filter. A yellow background indicates that a filter is active.

Names that match with the Long Name, the Local 8 Character name and the Alias name of the filter will be displayed.

Figure 114: Navigation – Active filter



93

Director 7.20 User Manual A10

Double-clicking this line opens the port in the workspace of the Director.

When you are doing a right-click in the line, an options menu shows up.

Figure 115: Navigate – Port List – Right click options

Open Opens the port in Directors workspace

Edit cell (F2) Activates the label editing mode for the selected cell.

Locate in configuration tree Shows the port in the "Network" tab

Locate in node config Shows the port in the hardware configuration view

Adjust Input/Output Gain* Only available for 4-wires Open the Gain tab of the port

Paste "long names" from clipboard
Paste the Long-Name from the clipboard ( "Transferring port names from an

Excel List")

Properties Opens the Properties of the port

Copy grid to clipboard
Copies the complete text content of the Port-List to the clipboard. All values

are separated with commas and can be imported into an Excel-List.
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3.15.3 Port Short Lists

In order to have a better overview of large systems, there is the possibility to create port short lists. Groups of ports

can be made and opened in the port list with a mouse click. In addition, user rights can be assigned to the individual

lists to limit the access of specific users to certain ports.

To manage port lists, click the  button in the port list view.

Figure 116: Navigation – Port Shortlist Management

Ports can be added or renamed by clicking on the  button on the left side of the port short list window. 

To add individual members to a list, first select a list from the left side of the window. Then click the  button on

the right side of the window to select ports to add to the list. 

You can also add port members using Drag and Drop from the network or port view by dragging them directly into the

port short list window.

Figure 117: Navigation – Assigning members to a short list
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The predefined short lists can be later selected in the "Ports" tab of the Navigation Bar.

Figure 118: Navigation – Selecting a short list in the port view

3.15.4 Control Panel Workspace

The workspace for programming ports and control panels, normally located on the right side of Director, offers several

tabs for configuration and monitoring. 

Configuration Configuration mode for assigning and editing functions.

Live State Monitoring the port in real-time (only available in Online Mode).

Remote Control Monitoring and remote control of a port via Director (only available in Online Mode).

Audio Patches Programming of the audio settings of the port. Only available for control panels.
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3.15.5 Key Assignment

There are different ways to program commands on control panels and Virtual Functions. A precondition for adding

functions is that the "Configuration" tab has been selected, as described above. The Navigation Bar and Workspace can

be adjusted so that one or more panels plus expansion panels are visible. The  and  buttons can be used to

adjust this view. See chapter "Director Software – Layout".

Figure 119: Navigation – Navigation Bar docked to the top of the window

All panels (except for the 3000 series and RIF panels) have 2 pages of keys: a main page and a shift page. Both of the

pages offer the same number of keys, according to panel type.

The shift page can be reached by clicking with the mouse on the "Shift" button located on the panel diagram or by

pressing  on your keyboard.
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3.15.6 Right Mouse Click Menus

A menu for editing key functions and properties appears when you right mouse click on a control panel key. The

following menu items are available:

Add Function Adds a new command to a key (maximum of 32 functions per key).

Edit Function Allows the editing of previously added commands on a key.

Delete Function Deletes one or all of the commands on a key.

Properties
Opens the key’s properties to change options such as key mode.

See chapter "Key Properties".

The "Edit" and "Delete" functions are only shown if there is at least one command programmed on the key. 
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3.15.7 Assigning a Function to a Key

· Right mouse click on the key and choose the

function to program under "Add Function".

· As soon as a function has been assigned to a key it

also appears as a new tab in the key’s Properties.

In the following example, a "Call to Port" command

has been selected.

Figure 120: Add function – 1000 series control panel key functions

Under "Destination" choose the port in

the system that should be called.

Figure 121: Add function – Control panel key, Call to Port destination

Reciprocal or return routes between sources and destinations are not made automatically and must be manually

assigned. An exception is the Auto Reverse Talk Option, available for 4-wires. See chapter "Settings" > "Options" >

"Miscellaneous" > "Enable Auto Reverse Talk option". 
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3.15.8 Drag & Drop Programming

Another, more efficient method of programming keys and virtual functions is offered by Windows® Drag & Drop

function. First, double click on a port to open it in Director’s Workspace. Ports, conferences, GPIs and logic sources can

be dragged directly to keys using Drag & Drop from the Navigation Bar. Open the corresponding tab in the Navigation

Bar. Click on a port or function and hold down the mouse key. Now pull the pointer to the key that should be

programmed and release button on the mouse.

· Drag & Drop a control panel, 4-wire or 2-wire Out

automatically programs a "Call to Port" function to that

port

· Drag & Drop a 2-wire In automatically programs a "Listen

to Port" function to that port

· Drag & Drop a group adds a "Call to Group" command

· Drag & Drop a conference adds a "Call to Conference"

function

· Drag & Drop a GPI Out adds a "Switch GPI Out" command

· Drag & Drop logic source adds a "Logic" command

Figure 122: Add function – Panel Drag and Drop Programming

Figure 123: Add function – View of destination panel
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3.15.9 Copying and Moving Keys

· All commands and properties of a key can be easily copied

to a key of another port via Drag & Drop

· All of the keys on the shift page of a panel can be copied by

> Drag, > press <F3>, > Drop

· To move a key, simply Drag & Drop it elsewhere on the

same page 

· Other ports can be shown in either the source or

destination position by manually selecting the port from

the drop-down lists. You can also open ports by Drag &

Drop from the Navigation Bar to a drop-down list. 

· The drop-down list can also be used as the source for other

Drag & Drop actions 

Figure 124: Add function – Key assignments on the destination panel

3.15.10 Multiple Assignments of a single Key

All keys, Virtual Functions and GPIs can be assigned multiple functions that are activated together. Additional functions

can be added via Drag & Drop or the "Add Function" menu. A maximum of 32 functions can be programmed to a

key/Virtual Function/GPI. All of the functions programmed on a key can be viewed, edited or deleted with a right mouse

click.

To get an overview of all of the functions and

properties of a key or Virtual Function, simply

position the mouse pointer over the key. A tool-

tip window will automatically be displayed with a

list of all functions and properties on the key.

Figure 125: Add function – Tooltip window showing all programmed functions

If you put several functions on a key with the same function type, the key is showing the label of the last added

function, or random. If you put different functions from different function types on the same button, the key will always

show the label of the function that is on a higher position in the "Add function" list.

Therefore it is recommended, to change the label of a key with multiple functions manually. Open the Properties of the

key, disable the checkbox "Define automatically" and enter the 8-character label you want to use.

Figure 126: Naming – "Define automatically" setting
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3.15.11 Assigning Virtual Functions

There are different ways to assign functions to Virtual Keys. A prerequisite is that the port has been opened in the

Workspace.

All port types have the same Virtual Functions. 2-wire and 4-wire ports have only Virtual Functions in lieu of keys.

Always
As the name implies, the assigned functions are always active as soon as the port has been

recognized by the system.

Vox
The functions configured are activated as soon as the incoming audio exceeds a pre-defined

level.

On Call
The functions configured are activated as soon as the port is called by another port in the

system.

Assigning Virtual Functions with a right mouse click menu: 

A right mouse click on a Virtual Function opens a menu with the following entries: 

Add Function Adds a new command to the Virtual Function (max. 32).

Edit Function Allows existing commands to be edited.

Delete Function Deletes one or all of the commands on the Virtual Function.

Properties Opens the properties of the commands on the Virtual Function. See chapter "Virtual Function

Properties".

The "Edit" and "Delete" functions will only be shown if at least one command has already been

programmed on the Virtual Function.
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Right mouse click on the Virtual Function and choose

the function to program under "Add Function".

 

As soon as a function has been assigned to a key it also

appears as a new tab in the key’s Properties.

Figure 127: Add function – Adding a command to a virtual function

Drag&Drop Programming

Another way to program Virtual Functions is with Drag & Drop. Call to Ports, Groups, Conferences and GPIs can be

dragged to a Virtual Function. Open the corresponding tab in the Navigation Bar, select a function, hold down the left

mouse key and drag the function onto the Virtual Function you wish to program in the Workspace.

· Drag & Drop a control panel, 4-wire or 2-wire Out

automatically programs a "Call to Port" function

· Drag & Drop a 2-wire it automatically programs a

"Listen to Port" function to that port

· Drag & Drop a group adds a "Call to Group"

command

· Drag & Drop a conference adds a "Call to

Conference" function

· Drag & Drop a GPI Out adds a "Switch GPI Out"

command

· Drag & Drop logic source adds a "Logic" command

Figure 128: Add function – Virtual Function Drag and Drop Programming

If a destination panel is dragged to a source panel via Drag & Drop, the destination panel automatically opens below in

the Workspace. This allows the quick configuration of a returning call command, if necessary.
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3.15.12 Enable Auto Reverse Talk option

A very useful tool allows a reverse call from a 4-wire to be automatically programmed as soon as the 4-wire port is

added as a "Call to Port" destination elsewhere. When this function is active, a call is automatically programmed to the

source panel on the VOX function of the 4-wire. The call is then automatically deleted as soon as the call to the 4-wire

from the source port is deleted.

Auto Reverse Talk for 4-Wires

· Select "Settings" > "Options" from the menu in Director.

The Option window will open.

· Select the tab "Miscellaneous"

· Checking the box next to "Auto Reverse Talk for 4-

Wires" will activate the function

· The activation of this tool only works with the copy of

Director on the local PC. It is not a part of the

configuration.

Figure 129: Settings – Options – Miscellaneous – Auto Reverse Talk for 4-Wires

· If "Auto Reverse Talk" is active, Director automatically

adds on the VOX function of the 4-wire called the

corresponding reverse call to the source panel.

· This works only, as soon this option is activated. It is

not working for already configured calls

· If the "Call to" the 4-wire is deleted from the source

panel, the reverse call will automatically be deleted

from the 4-wire’s VOX function.

· This function is only available for 4-wires. Reverse

routes between panels must be programmed

manually.

· The function "Auto Reverse Talk for 4-Wires at call to

group" automatically adds a "Call to" the destination in

its VOX function, if this 4-wire is member of a group,

and just a "call to group" function is added to another

port.

Figure 130: Example Auto Reverse Talk for a 4-Wire 
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3.15.13 Panel GPI

The GPI Input and Outputs of a panel can be accessed by opening the panel properties. (In the Workspace, right click

on the gray area around the panel and choose the GPIO tab). The GPIOs can also be opened by right clicking on one of

the GPIOs and choosing "Define GPIO." This window allows GPIOs to be made available for use in programming,

defined and named. 

The opto-isolated inputs can be inverted, if

required.

The GPI outputs can be set either as:

· normally closed

or

· normally open

depending on your interfacing requirements. For

more information, including pin-outs, please refer

to the Artist Installation Guide.

Figure 131: Panel GPIO – Panel Properties GPI tab

Once the GPIOs are defined, functions can be added to the individual inputs and outputs. 

The process of configuring the GPIOs is identical to configuring keys or Virtual Functions. 

Up to 32 functions can be added per GPIO either with a right mouse click and selecting "Add Function," or by using

Drag & Drop. 

As soon as the functions of the panel GPIOs are defined they will automatically appear in the list of GPIs found in the

Navigation Bar (GPIO tab). The panel GPIOs can be used throughout the system. For example, a local GPI input from a

panel can activate a function anywhere in the system, and anyone in the system can activate the local GPI outputs.

Figure 132: Panel GPIO – Add functions
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3.16 Panel Audiopatch

An Audiopatch is a local 6x6 DSP matrix located inside a panel. This matrix allows all of the panel’s inputs and outputs

to be freely programmed and adjusted. For example, Audiopatch presets can be used to activate different routing

configurations or amp settings with a key press.

Inputs

Panel Mic *1 *2 *3 *4 Front panel microphone

Headset A *1 *2 *3 *4 Front and rear panel Headset A microphone input (XLR, D-SUB)

External Mic *1 External microphone (via D-Sub connector on rear)

Headset B *1 *3 *4 Microphone input for Headset B (via D-Sub connector on rear)

Audio In A *1 *3 *4 Analog audio input 1 (D-Sub connector on rear)

Audio In B *1 *4 Analog audio input 2 (D-Sub connector on rear)

Matrix CH.1 *1 *2 *3 *4 First digital audio channel from the matrix

Matrix CH.2 *1 *2 *3 *4 Second digital audio channel from the matrix

Outputs

Speaker *1 *2 *3 *4 Integrated loudspeaker

Headset A *1 *2 *3 *4 Front and rear output for Headset A (XLR, D-SUB)

External Out *1 Active, external loudspeaker connection (D-Sub, rear)

Headset B *1 *3 *4 Output for Headset B (D-Sub, rear)

Audio Out A *1 *3 *4 Analog audio output 1 (D-sub, rear)

Audio Out B *1 *4 Analog audio output 2 (D-sub, rear)

Matrix CH.1 *1 *2 *3 *4 First digital audio channel to the matrix

Matrix CH.2 *1 *2 *3 *4 Second digital audio channel to the matrix

*1 available on 1000 and 2100 series Panels
*2 available on 2300 series panels with BASIC App, 2000, 3000 and 5000 series panels
*3 available on 2300 series panels with PLUS App
*4 available on 2300 series panels with PRO App

An Audiopatch stores all of the limiter, compressor and bandpass filter settings for the individual analog audio I/Os.

Any number of Audio Patches can be created for a control panel, but only one Audiopatch can be active at any given

time. These predefined audio settings can be activated by anyone in the system through a key press, VOX function or

logic source.

The Audio Patches can be accessed via the panel workspace. Choose the  tab.
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The Audio Patches tab displays the internal audio matrix of the panel for programming. There are always at least two

Sub-Patches, the Speaker and Headset Patch. The "HS" key on the front of the panel switches between the two Sub-

Patches. If the panel is being used in 2-channel mode, the source and destination of the second matrix channel will be

available.

Figure 133: Panel Audiopatch – default Audio Patches

The sources (inputs) are displayed on the left side (Y axis) and the destinations (outputs) are shown on the bottom (X

axis). All Audiopatch elements that can be changed are displayed in color. The colors have the following meanings:

off

active

The "Default Speaker Mode" Audiopatch, for example, shows that the microphone pre-amp is active while the headset

microphone is turned off. The crosspoint from the panel microphone to the first Artist AES channel is open so that the

audio is routed to the matrix. A crosspoint is also active from the first AES channel of the matrix to the loudspeaker

while the headset output is muted. This set-up enables standard intercom functionality.
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3.16.1 Example: Audiopatch 'Cough' or 'Mic-Mute'

Audio Patches are used to define a panel’s basic audio settings as well as other temporary audio presets for special

applications. These special presets can be activated using the "Select Audiopatch" command.

A so-called "cough key", which temporarily turns off the microphone, can be programmed using a new Audiopatch. The

crosspoint from the microphone to the matrix is turned off while the input from the matrix to the loudspeaker remains

open. It is recommended to modify the new Audiopatch to shut off the microphone in both speaker and headset mode

since one never knows which microphone the panel user will choose.

· Press the  button to display the "Add Audiopatch" window.

· Select an Audiopatch in "Copy Settings" to choose an existing Audiopatch from which to copy the initial settings for

the new Audiopatch.

· Enter a name for the new patch. In this example, the name is Mic Mute.

Figure 134: Panel Audiopatch – Add Audiopatch
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· In the "Audiopatches" list select the new "Mic Mute" patch.

· Select the crosspoint from the microphone to Matrix Ch. 1 with a mouse click.

· Change the crosspoint from active (green) to mute (red) by unchecking the box .

Figure 135: Panel Audiopatch – Audiopatch "Mic mute"
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3.16.2 Audiopatch 'Headset' for 3000 series control panels

Since a 3000 series panel does not have a dedicated headset button, switching to headset mode must be manually

configured to a key.

Figure 136: RCP-3016 panel

Again, the default Audiopatch can be used as the basis for the headset mode. Since this type of panel has no "HS" key

the headset mode of the standard Audiopatch has no effect.

This means that the speaker mode of the new Audiopatch must be rerouted for headset use.

The "Default (Headset Mode)" Audiopatch does not function in the 3000 series panels.

Figure 137: Panel Audiopatch – RCP-3016 panel – Audiopatch "Headset Mode"

This new Audiopatch can then be activated via a panel key (Latching, No Dim) with the "Select Audiopatch" command.

Figure 138: RCP3016 panel – Headset switching via "Select Audiopatch" function
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3.16.3 Audiopatch parameters

The following audio parameters can be set in an Audiopatch:

· Mic pre-amp

· Speaker / headset switch

· Amp

· Bandpass filter

· Limiter / compressor

· Crosspoint activation/deactivation, crosspoint level control

Click on the corresponding symbol in the matrix to change one of these parameters. The selected element will be

highlighted and its parameters will be displayed under the list of Audio Patches. To change a setting, move the level

indicator or click on the parameter value desired.

Figure 139: Panel Audiopatch – Audiopatch options
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'Mic Pre-amp' Audiopatch3.16.3.1

If the Mic pre-amp of the "external Mic" or a headset input is selected, the gain level can be changed. You can set the

pre-amp to 0 dB for electret microphones (default) or +20 dB for dynamic mikes. The panel Mic is always set to electret.

Figure 140: Panel Audiopatch – pre-amp options

'Panel Mic/Headset Switch' Audiopatch3.16.3.2

The setting of the panel Mic / headset switch can be manually changed. This is useful if, for example, a panel should

only be used in headset mode. Pressing the HS key will then result in no change in panel settings. To change the switch,

first select it in the Audiopatch and then change the settings in the box on the right side of the screen.

Figure 141: Panel Audiopatch – Mic / Headset switch
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'Amplifier' Audiopatch3.16.3.3

There is an amplifier element for analog I/Os that can be adjusted from 0 dB to +18.5 dB in 0.5 dB steps.

Figure 142: Panel Audiopatch – amplifier

If the function  is activated, the amplifier can later be adjusted from a control panel key

(available only on the 1000 and 2100 series panels). The amplifier symbol will be then turning to blue , signaling

that the amplifier is now available system-wide for control with the "Control Audiopatch" function. See chapter "Control

Audiopatch".

'Bandpass' Audiopatch3.16.3.4

The high and low bandpass filters in every I/O can be used to cut certain frequencies in noisy environments.

High-Pass Filter off, 40Hz to 240Hz on a logarithmic scale (default is off)

Low-Pass Filter off, 1kHz to 16kHz on a logarithmic scale (default is off)

Figure 143: Panel Audiopatch – bandpass options
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'Compressor/Limiter' Audiopatch3.16.3.5

A fully featured compressor/limiter is available for the panel Mic In and Speaker. They can be used to improve speech

quality, for example if the distance between the user and microphone is very far.

 

Compressor parameters

Threshold -48dB to 12dB in 3dB steps

Ratio 1:1 to 8:1 in an arithmetic progression

Attack 100ms to 100s in an arithmetic progression

Release 10ms to 1s in a logarithmic progression

Limiter parameters

Out-Level -33dB to 12dB in 3dB steps

Threshold 12dB to 0dB in 3 dB steps

Attack 100ms to 100s in an arithmetic progression

Release 10ms to 1s in a logarithmic progression

Figure 144: Panel Audiopatch – compressor/limiter input/output
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'Crosspoints' Audiopatch3.16.3.6

For every audio in and out there is a corresponding crosspoint that enables any source to be routed to any destination.

The individual crosspoints can be activated or muted by selecting the crosspoint and changing the  checkbox.

In addition, the crosspoint gain can be adjusted from -60 dB to +12 dB in 1 dB steps (default is 0 dB).

Figure 145: Panel Audiopatch – crosspoint options

If the function  is activated, the gain can later be adjusted from a control panel key (available

only on the 1000 and 2100 series panels). The crosspoint symbol will be then turning to blue , signaling that the

gain is now available system wide for control with the "Control Audiopatch" function. See chapter "Control Audiopatch".

off

active

adjustable by command

Crosspoints that are set to "Adjust from command" are permanently opened (active) in the entire panels

Audio Patches, regardless of which Audiopatch is currently selected. This means that the ability to switch a

crosspoint via "Select Audiopatch" with the additional capability to adjust it via "Control Audiopatch" is not

possible at this time.
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3.17 Copy Panels and apply Default Parameters

The "Edit" menu offers two very useful functions: The ability to copy an already configured panel, and the ability to

change default settings system wide.

3.17.1 Copy Panel

The "Copy Panel..." command allows quick and easy copying of all panel key functions and audio settings to other

panels of the same panel type. The command can be accessed by selecting "Copy Panel..." from the edit drop down

menu.

Figure 146: Copy Panel – Edit > Copy Panel

The "Copy Panel..." function can also be found in the properties menu of a panel.

Figure 147: Copy Panel – Panel > Copy Panel

If you open the copy panel function via the panel properties, the selected panel will automatically be added as the

source panel which can be copied to one or more additional panels. If you open the function using the "Edit" menu, you

must manually select the source panel from the source panel list.
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Now add the destination panels you want to copy some elements to.

With the "Add" button you can add single ports from a drop-down list. Also you can just drag and drop the ports from

the ports-, or network list into the "Destination Panels" area.

Figure 148: Copy Panel window

The source panel and the destination panels always need to be the same panel series. Otherwise you will

get an error message and copy is not possible. 

Figure 149: Copy Panel window – Add Panels

Now select the elements you want to copy from the source panel to the destination panels.

All other elements of the destination panels will be not affected.

By activating , you can select if you want also to copy the whole panel content to the destination panels. So

all keys, properties, Audiopatches, Room-Codes etc. will be copied and overwritten on the destination panels.
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Clicking the  button opens a window asking you to confirm before the destination panels will be

changed.

Figure 150: Copy Panel – confirmation

Copying an entire panel will overwrite all existing key commands/properties at the destination panel. If

you have special functions on the source panel, such as Remote Key commands, they will also be copied

one-to-one to the destination panel. After the copying procedure some key commands on the destination

panel may have to be manually adjusted in order to function correctly.

3.17.2 Apply Defaults to all existing Objects

The "Apply defaults to all existing objects..." command can be used to apply specific settings from the default settings in

the Net properties to all existing ports. First, you must adjust the parameters you wish to change in the Net properties.

Open the Network Tab in the Navigation Bar, right

mouse click on the "Net" and select "Properties".

Change the parameters that you wish to later copy to

all ports or panels in the system. For example the key

mode.

Figure 151: Apply defaults – Net Properties
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Example: Later on changing key modes for all already configured panels.

Figure 152: Net Properties – General tab

If items are changed in the Net Properties, the changes will only affect newly created ports. Already

existing ports will not be changed. Only by using the command "Apply defaults to configuration objects…"

can these changes be transferred to all of the existing ports in the system.

Figure 153: Apply defaults – Edit – Apply defaults to configuration objects ...

The "Apply defaults to all existing objects..." allows the parameters to be selected that should be transferred to all

existing ports.
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The "Apply defaults..." window is divided into 6 areas: Panel Defaults, Call Defaults, Key Defaults, VoIP Port Defaults, SIP

Defaults and Audiopatch Defaults.

Figure 154: Apply defaults – Apply defaults to configuration objects window

The parameters that should be changed on all panels are selected with a  checkmark. In this example only the key

modes. Clicking the OK button will overwrite these parameters in all ports of the system with the values in the Net

properties. 

If you choose a panel in the "Audiopatch Defaults to apply" field the audio settings of this panel will overwrite the

settings of all other panels in the Net. 

Individual port settings will be overwritten by this command.
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3.18 Configuration of typical Intercom Functions

3.18.1 Interrupted Foldback (IFB)

IFB is a typical intercom function that is used frequently. A source is permanently routed to a particular destination. If

someone makes a call to this destination the permanently routed source is either muted or dimmed. The dim level is

adjustable. The typical dimming range is from -15 dB to -30 dB. After the call to the destination is over, the permanently

routed source returns to its normal volume level. This application is used, for example, if a director wants to speak with

the talent over an earpiece that normally receives program audio or an N-1.

An additional option or requirement is the ability to listen to the talent’s return feed, normally their microphone output,

on a control panel. The volume control next to the call key then allows the incoming volume level of the talent to be

adjusted. If the volume control is pressed the incoming audio is either muted or re-activated.

If you intend to adjust the volume level of the talent’s return feed it is advisable to use a 4-wire port for the

talent. The 4-wire’s output will feed the talent’s earpiece. The output will also be used for the permanent

program audio or similarly as an IFB output. The 4-wire input will be used for the talent’s microphone,

which can also be connected to the 4-wire port of the Artist over an audio mixer. This setup allows IFB

functions to be programmed quickly and easily.

There are three different ways to program an IFB (Interrupted Foldback). The end results are the same, but the

programming approaches are different.

We recommend Method 3 (Using the IFB-Table), since it offers the most flexibility.
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Method 1: DIM Crosspoint On Call3.18.1.1

One way to program an IFB is to use the "Dim XP Level" function in conjunction with a 4-wire port’s "On Call" Virtual

Function. The right side of the diagram below summarizes the necessary steps.

Figure 155: IFB – configure IFB with DIM XP on call

Step 1

Figure 156: IFB – Adding the listen source

· First, select the 4-Wire or split 4-Wire

destination (output) port by double clicking

on the entry in the "Ports" tab in the

Navigation Bar.

· Right mouse-click on the Virtual function

"Always" and select "Listen to Port" from the

"Add Function" drop-down menu.

· In the properties window of the listen

function, choose the IFB source port that the

4-wire should always hear.

· Confirm with "OK" 

Figure 157: IFB – Select the listen source port
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Step 2

Figure 158: IFB – Adding Dim XP Level

·  Right mouse click on the 4-wire’s Virtual

Function "On Call" and select "Dim XP Level"

from the "Add Function" menu.

Figure 159: IFB – Setting the XP Dim Level

· In the properties window of Dim XP under

Source select the 4-wire of the IFB signal

(PGM, N-1, ...). For the Destination select the

talent’s port.

· Set the desired dim level, by which the IFB

signal should be dimmed when the talent

receives a call.

Step 3

The IFB function is now setup correctly. Simply drag and drop the talent’s port to a panel key or 4-wire Vox function for

everyone who should be able to speak to the talent. Calling the talent will activate the "Dim XP Level" function. The

talent’s return feed must be configured separately (like every 4-wire). If you activated the "Auto Reverse Talk for 4-Wire"

option in Director, the return will be automatically programmed. This setup enables the return communication of the

talent to be heard on the panel with the ability to adjust the volume.
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Method 2: DIM Crosspoint triggered by Priorities3.18.1.2

Another way to program an IFB is to use the various call and listen priorities. A higher priority will dim a lower priority.

The "Dim Level" is set in the Net properties window. This means that all IFBs programmed this way will have the same

dim level. The diagram below summarizes this method of creating IFBs.

Figure 160: IFB – configure IFBs with priorities

Step 1

· First, select the 4-Wire or split 4-Wire destination

(output) port, by double clicking on an entry in

the "Ports" tab on the Navigation Bar.

· Right mouse-click on the Virtual Function "Always"

and select "Listen to Port" from the "Add Function"

drop-down menu.

· In the properties window of the listen function

choose the IFB source port that the 4-wire should

always hear.

Figure 161: IFB – Adding the listen source

· Set the priority level for this function. Normally,

"Below Standard" is chosen since the rest of the

commands in the system usually have the

priority "Standard."

Figure 162: IFB – Select the priority of the listen command
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Step 2

· Right mouse click on the "Net" and choose "Net

Properties".

· Select the "Port Settings" tab in the "Net

Properties" window.

· If necessary, change the dim level for the

individual priority levels.

· For example, if you set "Standard" to -12 dB, any

crosspoint to a destination with "Below Standard"

will be dimmed by -12 dB as soon it is called by a

call that has the Standard priority.

· The priorities "High", "Paging" and "Emergency"

work the same way. Lower priorities will be

dimmed by the value set in this window.

Figure 163: IFB – Opening the Net Properties

Figure 164:IFB – Net Properties – Port Settings

Step 3

The IFB is now setup correctly. Simply drag and drop the talent’s port to a panel key or 4-wire Vox function for everyone

who should be able to speak to the talent. Make sure that the listen command on the IFB port is set to "Below

Standard" priority. The "DIM" command will be activated by a "Call to Port" with a higher priority (standard). The talent’s

return feed must be configured separately (like every 4-wire). If you activated the "Auto Reverse Talk for 4-Wire" option in

Director, the return will be automatically programmed. This setup enables the return communication of the talent to

be heard on the panel with the ability to adjust the volume.
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Method 3: Using the IFB-Tables (recommended)3.18.1.3

Up from Director Version 5.90, a new method has been included for quickly and easily creating, editing and seeing an

overview of IFBs. In the so-called IFB-Table, new IFBs can be quickly created and existing IFBs can be edited directly.

Right now it is not possible to use the enabled second audio channel of a Panel, or of an AES 4-wire (when

configured with activated "enable 2nd channel") as Input, Mix Minus or Output within the IFB-Table.

Therefore you have to choose Method 1 or 2 to create an IFB. In the IFB-table you can only work with the

first audio channel of a port (except an AES 4-wire with the two audio channels configured separately).

Click on the  button in the toolbar to open the IFB-Table.

Figure 165: IFB-Table – Empty IFB-Table

Click the  button to create a new IFB. The number you enter in the field next to the add

button  determines where the numbering of the IFBs starts. Create the desired number of

IFBs by pressing the  button repeatedly.

Figure 166: IFB-Table – new IFB entries
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The columns "Input," "Mix Minus," and "Output" can be renamed. Right mouse click on the column and choose

"Rename."

 

Figure 167: IFB-Table – Renaming the IFB columns

To rename individual IFBs, select the entry you wish to rename and double click on the name in order to change it. You

may also rename the selected IFB by pressing the <F2> key. The name can also be changed by right mouse clicking on

the name and selecting the function "Edit Name". The name can be up to 32 characters long. Confirm the new name

with the <Enter> key.

To delete an entire IFB entry, select the row you wish to delete and click the  button or

press <Delete> on the keyboard.

The selection of several IFBs at once is possible with the <Ctrl> or <Shift> keys. 

You can now assign ports or groups to the individual IFBs. For every IFB there is the possibility to assign an "Input," a

"Mix Minus" and an "Output."

Input

 (Name changeable)

Routes the selected sources to the ports that have the IFB assigned. For example, if a talent

is selected as an input, their microphone can be heard by everyone who has this IFB.

The input is not necessary for normal IFB functions.

Mix Minus

 (Name changeable)

Describes the input source that should be dimmed when the output is called. For example,

a program audio source that should always be heard as long as the talent is not called.

Output

 (Name changeable)

Describes the destination of the IFB. For example, the talent's earpiece.

Select the desired ports or groups to assign. Double click on the respective field and select a port/group from the drop

down list.

You can sort the list by ports or groups. By using the filter you can search for a specific port/group. The Director is

storing the last view per column.

Figure 168: IFB-Table – selection ports/groups
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For example, choose a program source for the "Mix Minus".

Figure 169: IFB-Table – Selecting the Mix Minus source

Select the desired output from the port list. You can select the output using Drag & Drop directly from the network tab

or port list.

Figure 170: IFB-Table – assignments by Drag & Drop

The contents of selected rows can be deleted by clicking the  button.

If desired, you can also drag the talent to the "Input". This will result in all ports using this IFB hearing the audio feed

from the talent directly.
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As needed, you can also set the "Dim Level" for the IFBs. This determines how many dB`s the "Mix Minus" is dimmed by

when someone calls this IFB. Double click on this field and choose the desired dim level. You can also change the dim

value using the <+> and <-> keys.

Figure 171: IFB-Table – Setting the dim level

In the "Number" column you can assign each IFB a number in order to sort the IFB-Table by number.

Enter a key label for each IFB. Double click on the field "Key Label" and enter a name with a maximum of 8 characters.

Confirm the name with the <Enter> key. The name can also be changed by pressing the <F2> key or with a right mouse

click and selecting "Edit Key Label". As soon as the name is changed in the table it will also be changed on all keys that

have been assigned the IFB.

The newly created IFBs can now be distributed throughout the system.

Add the new function "Call to IFB" to a key or Virtual Function using a right mouse click and "Add Function". Choose the

desired IFB from the list.

 > 

Figure 172: IFB-Table – Adding a "Call to IFB" function

You can also put IFB's from the IFB-Table directly to keys or virtual functions using Drag&Drop.
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If you drag and drop from "Input" or "Mix Minus" column, Director will create a "listen to" function, drag&drop from the

"Output" column will create a "call to" function.

Figure 173: IFB-Table – Drag & Drop an IFB

In the columns "Input Gain" and "Output Gain" you can directly set the gain level of the input and output ports. Double

click on the gain you wish to set and choose a level between -18 dB and +18 dB.

Figure 174: IFB-Table – Setting the gain

If a Group is used as Input, Output or Mix-Minus, this setting is not available.

There are also several submenus in the IFB-Table to help in editing IFBs and locating programming errors.
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If you right click on an IFB in the IFB-Table you can select "Usage selected IFB(s)". This displays a list of all locations that

can currently call this IFB.

Figure 175: IFB-Table – Usage selected IFB(s)

A right mouse click on a port offers the possibility to go directly to its properties or find its location in the various views

in the configuration.

Figure 176: IFB-Table – Properties of an IFB port
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IFB-Table: Online View3.18.1.4

If Director is online with the system the status of every IFB element will be shown. It is displayed whether or not each

element already exists in the online configuration.

a new IFB was created, but have not yet been sent to the system

the element has been changed, but the changes have not yet been sent to the system

the element is available in the online configuration

Click the  key or press <F5> to send changes in the IFB-Table to the system.

Figure 177: IFB-Table – Online view

In online mode, the current audio level of the crosspoint Mix Minus > Output is displayed graphically in the "Online XP"

column.

You can directly adjust this crosspoint level in the system in real-time. Double click on the XP level you wish to change

and adjust it with the control.

   

Figure 178: IFB-Table – Online XP level adjust

The level can also be adjusted with the  and  keys of your keyboard. An update with <F5> or  is not

necessary.

When you are using a group as in/output or Mix minus the gain-setting is not available.
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If you have assigned an input port this will be displayed and heard on the control panel. In our example, the volume of

the talent’s microphone can be adjusted via the corresponding encoder.

Figure 179: IFB-Table – IFB Crosspoint View input and no active "Call to IFB"

As soon as the "Call to IFB" key is pressed, you can speak to the talent and the "Mix Minus" will be dimmed the set level.

This can be recognized in the Crosspoint View  as follows:

Figure 180: IFB-Table – Crosspoint View with an active IFB

3.18.2 Using IFB-Table to create Audio Routes with direct XP-Gain

Using the IFB-table also for non-IFB allows using it for a fast way of creating XP in the matrix with the possibility to

directly adjust the gains of these crosspoints.
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3.18.3 Isolated Calls (ISO)

The ISO (Isolate Call) is a special intercom function. If an isolated call is made, all other audio paths (call, listen, route) to

the destination are muted. This is used to create a secure connection where the called port can only hear the ISO caller,

without being distracted by other audio sources. In addition, the microphone at the ISO call destination is activated and

automatically routed to the source of the call. The person called can answer without having to press a key.

No special function is needed to create an ISO call. ISO calls can be activated simply by clicking the "Isolate" checkbox

found on the "Call to Port" function.

Activating the ISO function

Open the properties of a "Call to Port" on a key.

Selecting "Isolate" with a . It activates the ISO

function for this call. As soon as this option has

been activated, the "Isolate Self" box can be

selected.

Figure 181: ISO – Activating the ISO function

Isolate:

· Only the destination will be isolated from all

other audio paths. The microphone of the

destination will be automatically routed to the

source.

Isolate self:

· Both the called destination and the originating

source will be isolated from all other audio paths.

Both microphones will be automatically opened.

Figure 182: Isolate options
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3.19 Programming GPIs

The General Purpose Interfaces (Input/Output) can be used to control internal and external system events, as well as

interpreting external information for use in the system. The GPIs can be programmed so that they can be used just like

control panel keys or Virtual Functions.

The GPI In and Out default states have to be defined for both the internal GPI cards in the mainframe (see chapter

"Adding a GPI card") as well as for GPIs in control panels (see chapter "Panel GPI"). The opto-isolated inputs can be set

as either normal or inverted, in case of incorrect wiring or inverted voltage. The solid-state relays outputs can be set as

either normally closed or normally open, depending on the requirements of the external devices. For further

information on pin outs and other technical details, please see the installation manual.

3.19.1 Navigation

The details of all GPIs in the system, both central and panel GPIs, are available in the GPIO list. The GPI tab is best

viewed with the Navigation Bar docked on the top, either by clicking the Toolbar button  or pressing <F10> on the

keyboard.

Figure 183: GPIO – Navigation Bar GPI tab

All of the columns can be adjusted to display the names and other information more clearly. Move the mouse pointer

to the line between columns until it changes to a , then hold down the left mouse button and adjust the column widths.

All entries in the GPIO list are sorted alphanumerically by column. In order to sort by another column, simply click on

the column label. Another click on the same column changes the sorting from ascending to descending. Clicking on

other column while holding down the <Ctrl> key allows sorting by more than one criterion. To edit the individual GPIs,

double click on the row or right mouse click and choose "Properties," to open the properties of the GPI in a separate

window for editing. For details, see chapter "GPI Properties".
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3.19.2 Assigning Functions to a GPI

To configure a GPI, right mouse click on the GPI to be programmed and select the desired function.

Add Function Adds a new function to the GPI (maximum 32)

Edit Function Changes an already existing function

Delete Function Deletes an existing function

Locate in Node config * Opens the hardware setup of the node and highlights the GPI

Properties Displays the GPI’s properties

* available only for central GPIOs

If the GPI does not yet have any functions programmed to it, only the "Add Function" command will be

displayed. Edit and Delete functions are not available.

Figure 184: GPIO – GPI functions

GPI Functions

Call to Port * Point-to-point call between two ports.

Call to Conference * Multipoint-to-multipoint call. Talk or listen to a conference (Partyline).

Call to Group *
Point-to-multipoint call. From one port talk to several at the same time. Operates only

from the source to the destination.

Listen to Port * Listen to an audio source (control panel, 4-wire, etc.).

Route Audio
Routes audio directly from a source to a destination. In addition, the crosspoint level can

be adjusted (only at panels).

Switch GPI Out Activates a local or central GPI output.

Select Audiopatch Loads predefined audio settings to a particular panel in the system.

Remote Key Remote control of control panel keys, lock keys or activation of key signalization.

Reply * Automatic call-back function for point-to-point calls.

Dim Panel Speaker Dims the loudspeaker of a selected panel.

Dim XP Level Dims a particular crosspoint in the system.

Beep Panel Triggers an audible call signal at the selected panel.

Clone Output Port Clones all output signals to a port to any other port.

Dial /Hang up Enables the dialing and hook control for a telephone number.

Logic Triggers a predefined logic input.

Send String * Sends a data command to higher ordered systems.

* available only for panel GPIs



136

Director 7.20 User Manual A10

All functions work the same way as if they were programmed on a panel key or Virtual Function. Up to 32 functions

can be triggered at the same time by a single GPI. All GPIOs, regardless of location, can be made available to any user in

the system.

As soon as a GPI has been assigned a new function, the properties window opens to the tab of the corresponding

function so that necessary details can be defined.

Assigning a new function to a GPI

Example: Assigning a "Dim Panel Speaker" function to a GPI.

Figure 185: GPIO – Dim Speaker tab

Right mouse click on the GPI and select "Add

Function".

Select the function "Dim Panel Speaker".

Choose the control panel where the loudspeaker

should be dimmed. Either select the panel from

the list or drag it to the destination field from the

network list or port list using Drag & Drop.

Figure 186: GPIO – Dim Speaker – level options

Select the desired Dim level of the panel speaker.

If the respective GPI is triggered, the speaker will

be dimmed by the selected value.

The 1000 and 2100 series control panels each have 3 GPI inputs and outputs that can be used just like a panel key, or

alternatively can be triggered by other users in the system (see chapter "Panel GPI").

A panel GPI can be used for functions that have nothing to do with the panel itself, such as closing a PTT

contact to trigger the transmission of a radio interface. Therefore it is not necessary to always create a

separate, often long, connection to a central GPI card. Instead, you can simply use the GPI contact on the

panel that is closest to the radio interface. This can greatly reduce cabling costs and hassles.
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3.20 Create and Manage Groups and Conferences

Definition of a Group

A group consists of a number of members that are addressed in a point-to-multipoint fashion. A single source talks to

multiple destinations with one key press. However, the return route of a group call is always a point-to-point

connection. This means that when a group member answers, only the port that initiated the group call will hear the

reply. This function is normally used to send a message to a number of people at the same time.

Definition of a Conference

A conference is made up of a number of ports which every member can hear. It is a multipoint-to-multipoint call similar

in function to a conference room where anyone in the room can contribute at any time. However, it is possible in Artist

to block certain members from speaking into the conference. These members are then only allowed to hear the

discussion. The signalization on the conference key becomes active as soon as anyone speaks into the conference. For

example, conferences are often used during rehearsals or planning exercises if it is necessary that various members

should be listening at the same time.

3.20.1 'Groups + Confs' Tab

The details of groups and conferences are displayed in the  tab. There is no separate workspace for

groups and conferences. The following information can be found in the table on this tab:

Long Name
Displays the long name of the conference or group (up to 32 characters long, only displayed

in Director).

Type Shows whether an item is a group or conference.

GPIO OUT Shows which GPI output is activated, if desired, when the group or conference is active.

Alias / Display 8 Shows the display names or the assigned alias names.

Member count Displays the number of members in the group or conference.

DynaConf

Director always includes a conference with 0

members. This DynaConf is used internally for the

"Edit Conference" function and cannot be used for

normal configuration purposes.

The "Edit Conference" function allows members to

be dynamically added or removed from a

conference using a control panel.

Figure 187: Groups + Confs – tab
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When the Director is connected to an online system, all active groups and conferences are shown with a green

background. A conference is only shown, if there are at least 2 members in the conference.

Figure 188: Groups + Confs – real-time activity display
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Creating a new group or conference3.20.1.1

To add a new group or conference click on either the "Add Group..." or "Add Conf..." buttons. This will display the

properties window of the new group or conference.

Figure 189: Groups + Confs – Creating groups and conferences

See chapter 

"Group Properties"

Figure 190: Groups + Confs – Group properties

See chapter 

"Conference Properties"

Figure 191: Groups + Confs – Conference properties

A GPI contact that is switched as soon as the group or conference is active can be assigned to a group or conference.

In order to delete a group or conference, select the group or conference you wish to delete and click the 

button.

Director does not ask for confirmation before deleting a group or a conference. Be sure you have selected

the correct item from the list before deleting it.
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3.20.2 Adding Members to a Group

Open the properties of the group by selecting the group and clicking the  button or simply double click on

the group you wish to open. Once the group properties are displayed, select the "Members" tab. New group members

can be added by clicking on the  button and choosing group members from the drop down list that appears.

Alternatively, you can simply drag new members from the network or port lists into the member's window using drag &

drop.

Using drag & drop will always use the first audio channel of a panel. If you wish to add the second audio

channel of a panel to a group, you must add this port using the  button and activate the "2nd

Channel" option.

Figure 192: Groups – adding members

Figure 193: Groups – Properties of the members tab

The member list shows all group members

with information on port type, name and which

audio channel is being used.

To delete a member from the group, select the

member you wish to delete and press the

 button.

Director does not ask for confirmation before deleting a group member. Be sure you have selected the

correct member from the list before deleting it.
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3.20.3 Adding Members to a Conference

New members are automatically added to a conference as soon as the conference is added to a port using the "Call to

Conference" command. The "Call to Conference" function has two sides to it. Separate "talk" and "listen" functions allows

members to be individually assigned whether they should hear the conference or should also be allowed to talk into it.

Control panels can be added to a conference by programming the "Call to Conference" function to one or more panel

keys or to one of the Virtual Functions on the panel. 4-wires can only be assigned to a conference by programming it on

a Virtual Function. It is also possible to assign members to conferences dynamically from a panel if the "Edit Conference"

function is used. The following example shows how a control panel or 4-wire is assigned to a conference.

Assigning a Panel to a Conference3.20.3.1

Figure 194: Conference – Assigning a conference to a panel key

Right mouse click on a panel key and choose "Add

Function" > "Call to Conference". The properties of

the key will automatically open to a new tab with the

conference function.

Alternatively, you can drag a conference to a key

from the "Groups+ Confs" list using Drag & Drop.

In this case, the "Call to Conference" function will

always be automatically configured for both "talk"

and "listen".

To later change the properties of the conference call,

right mouse click on the key and choose the

"Conference" tab.

Figure 195: Conference – Key properties – Conference tab

Choose a conference from the list of conference

destinations.

The "talk" privilege allows this member to speak into

the conference.

The "listen" privilege allows this member to listen to

the conference.

Select the talk and listen privileges as required.
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Assigning a 4-Wire Port to a Conference3.20.3.2

Figure 196: Conference – Assign a Conference to a 4-

Wire

Right mouse click on a Virtual Function and choose "Add

Function" > "Call to Conference". The properties of the Virtual

Function will automatically open to a new tab with the

conference function.

Alternatively, you can drag a conference to a Virtual Function

from the "Groups+ Confs" list using Drag & Drop.

In this case, the "Call to Conference" function will always be

automatically configured for both "talk" and "listen".

To later change the properties of the conference call, right

mouse click on the Virtual Function and select the "Conference"

tab.

Choose a conference from the list of conference

destinations.

The "talk" privilege allows this member to speak

into the conference.

The "listen" privilege allows this member to listen to

the conference.

Select the talk and listen privileges as required.

Figure 197: Conference – Virtual Function properties – Conference tab
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Room-Codes3.20.3.3

To avoid audio feedbacks between ports that are in the same conference and placed nearby each other, it is possible to

assign a "Room-Code" to every port. So if two or more ports are in the same room, they should use the same Room-

Code. So when one of the panels is talking into a conference, the conference-audio to the panel in the same room is

muted to avoid an audio loop.

Figure 198: Room-Code – schematic diagram

A Room-Code can be set for all Port-types. Also for 4-wires and 4-wire splits a Room-Code can be assigned.

Therefore open the Properties of a port. In the tab "General" you can choose the Room-Code. There are 254 different

Room-Codes available (A–Z and 1–228). All Ports, which are using the same Room-Code, are now muting the

Conference audio coming from ports within the same Room-Code.

Figure 199: Port Properties – Room-Code

On panels the Room-Code is basically working only in the speaker mode. If needed (because of a modified

Audiopatch for example) you can also enable the Room-Code for the Headset mode of this port.

A listing of all Room-Codes in your system can be found in the Port list in the Column "Room-Codes".

Room-Codes only work for "Call to conference" calls. For all other audio functions (Call to Port, Listen to

Port, etc.) the Room-Code has no effect.
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3.21 'Edit Conference' Function

The "Edit Conference" function allows users to modify conference members on a panel.

3.21.1 Edit Conference

1. Make sure that a PC is connected to the Artist system. "Edit Conference" requires that the Director software is

running, since Director handles all edit conference requests. 

One copy of the Director software must be defined for this purpose. In Director select "Settings" >"Options" >

"Miscellaneous". Click the option "Handle EditConf Requests".

Figure 200: EditConf – Activating the Edit Conference function

Only one copy of Director in the network should have this option activated.

2. Create conferences, as described above, that you would later like to edit.

3. Add a "Call to Conference" function to ports (keys or Virtual Functions) with the conference that should later be

edited. The quickest way to do this is to drag the conference from the list using Drag & Drop.

4. Choose one or more panels that should later have the ability to edit conferences. (NOTE: This function is only

possible on 1000 series panels) With a right mouse click open the properties of the conference key and select the

"Conference" tab. Select the check box next to "Use this command to select the destination conference during an Edit

Conference operation". 

The system now knows that this conference is allowed to be changed from the panel. 
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Figure 201: EditConf – Key properties – Conference tab – properties for Edit Conference

5. In addition, the panels that will be used to make conference assignments need a "Call to Port" command to each

member that should be available for dynamic conferences. Drag the members from the network or port lists to

panel keys using Drag & Drop. 

6. Add the "Edit Conference" function to an empty key by selecting it from the "Add Function" menu. The key will now

display "EditConf". To allow one-handed operation of the function, open the properties of the key and set the key

mode to Latching with a timeout of around 3 seconds. Deselect the "Dim Panel Speaker" option. The "Edit

Conference" tab contains no options to change. 

7. Finally, on all of the ports that should be able to be dynamically selected for conferences, the properties of the "Call

to Conference" command need to be adjusted. One after another, open each of the corresponding ports, right

mouse click on the "Call to Conference" key or Virtual Function and choose the "Conference" tab. Click the checkbox

next to the option "The destination conference on this command can be changed by Edit conference". 

Figure 202: Edit Conf – The destination conference on this command...
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3.21.2 Operating the 'Edit Conference' Function

With this configuration it is now possible to dynamically assign members to the enabled conferences from a panel. In

order to do so, press the "EditConf" key.

Figure 203: EditConf – Activating the Edit Conference function

Conferences that can be edited begin to blink. Press the conference that you would like to edit. Now all possible

members that are available light up. Red LEDs above a name indicate that the port is not currently a member of the

conference. Greed LEDs mean that the member is already assigned to the conference. Members can be added or

removed from the conference by pressing their corresponding keys on the panel. You can also assign whether the

member should be able to talk or listen. If you press the left side of the key, the member will be assigned the listen

option (L). Pressing the right side of the key will assign the talk option (T).

Figure 204: EditConf – Selecting the conference to edit

After you have made all of the changes you wish to make, press "Yes" in the EditConf key. Director will then send the

updated configuration to the system. The newly edited conference will now be available.

Figure 205: EditConf – Adding and deleting members

It is also possible to remove members from a conference with this function. As before, press the "EditConf" key, select a

conference, and press the key of the member to be removed as often as needed until "Remove" is displayed. Press "Yes"

to confirm.

The display on the conference key of the removed member changes to "DynaConf". This key is thus reserved with a

placeholder for when the member is again added to the conference.
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3.22 'Edit IFB' Function

With the "Edit IFB" Function it is possible to modify IFBs apart from the IFB-Table also on standard panels. All changes

are directly adopted to the IFB assignment and to the system.

For editing IFB on panels, you can only use 4-wires and 4-wires split Inputs as Mix Minus sources.

To use the "Edit IFB" function on panels it is not necessary to have a Director-PC connected to the system.

3.22.1 Configuration of the 'Edit IFB' Function

Create an IFB-Table in your Director-configuration. Details can be found in chapter "Using the IFB-Tables".

Because with the "Edit IFB" Function you can only assign or modify "Mix Minus" sources to predefined IFBs, make sure

you have already created some IFBs with outputs assigned in the IFB-Table.

Figure 206: Edit IFB – IFB-Table with predefined outputs

Also the "Dim Levels" and "Gain" settings need to be prepared in the IFB-Table.

Open the panel you want to edit IFBs (works only on 1000- , or 2000 series) and create the "Edit IFB" function on an

empty key. There are no further settings needed to use this function.

 > 

Figure 207: Edit IFB – Add function "Edit IFB"

Now open the IFB-Table by pressing the  Button.
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Drag&Drop the predefined IFBs you want to use on the panel to different empty keys of your panel.

Figure 208: Edit IFB – Drag&Drop IFBs

Following Drag&Drop the "Mix Minus" sources you want to use to different empty keys. Only 4-wire or 4-wire split ports

can be used with the "Edit IFB" Function afterwards.

Figure 209: Edit IFB – Add "Mix Minus" ports to the panel

If you are using pure 4-Wires as "Mix Minus", you have to configure a "listen to..." function for every "Mix

Minus" key.

That is all you have to do to configure the "Edit IFB" Function.

If you want, you can now also configure other panels with the same functionality.
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3.22.2 Operating the 'Edit IFB' Function

To use now the "Edit IFB" Function on a panel, you have to press the key "Edit IFB". All available IFBs on this panel will

show up with red markers (depending of the settings in the "Marker Definitions").

Now press the key with the IFB you want to edit. The marker will change to green.

Figure 210: Edit IFB – Selecting an IFB

After the IFB is selected, you can assign the Mix-Minus source to this IFB. Therefore press the key with the source

configured. The key will show "Waiting" for a short moment. Then the source-key changes to a green marker.

You can always assign just one source to an IFB. If there was another source assigned to this IFB before, it will be

deactivated and its marker changes back to red.

Figure 211: Edit IFB – Assigning of an IFB "Mix Minus"
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This example shows "IFB 0002" with assigned source "Extern 2". If you have the "Edit IFB" function also configured and

activated on other panels with the same sources, you can see the changes immediately on all these panels.

After pressing the "Edit IFB" Button, you can also press first a source button. When this source is already assigned to an

IFB, the according IFB-key will show a green marker. By pressing now another IFB key, the allocation for this source

changes to the selected IFB.

As soon as an IFB assignment has been changed on a panel, the IFB-table shows which port has been changed.

The modified IFB entry will be shown with a  in the IFB-table. The name of the new source port is not yet shown.

To display the latest source names assigned to the IFBs, you have to load the system-configuration to your PC by

pressing the  button.

Figure 212: Edit IFB – Display IFB-changes in the IFB-table

You can also modify the source assignment parallel on the IFB-table. When you send the changes to the system, all

panels with the "Edit IFB" Function enabled will show the latest assignment.
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3.23 Create and Manage Scroll-Lists

A Scroll-List can consist of up to 1000 different entries. They can include most commands, for example, "Call to Port",

"Route Audio", "Switch GPI" etc. One Scroll-List can be assigned to each panel. Using the scroll function of a key, a user

can select one of the commands from the Scroll-List directly from the panel. This provides access to a host of

commands that might only be needed infrequently without using a large number of keys. It is also possible to assign

individual functions a fixed ID number that can be used to activate them directly from a keypad.

Each panel can only have one Scroll-List assigned to it. However, any number of panels can access to the

same Scroll-List. A maximum of 100 Scroll-Lists can be created.

The internal scroll-list of the "Reply" function (last 20 callers) is independent and can be used additionally

only for Reply-keys. If the "Scroll enable" flag is activated on a Reply key, the port internally generates an

additional dynamic Scroll-List with up to 20 entries just for this key.

Attention: 2300, 3000 and 5000 series control panels DO NOT support Scroll-Lists.

Scroll-List details are found in the  tab of the Navigation Bar. 

3.23.1 Adding a New Scroll-List

To create a new Scroll-List, click on the  button in the  tab of the Navigation Bar. This

automatically opens a new window where the functions and settings of the list can be defined. To edit an existing list,

select the list and press the  button, or double click on the list. Pressing the  button will delete

the selected list. Please note that Director will not ask you to confirm before deleting a Scroll-List.

A unique name for the Scroll-List can be entered in the "Long Name" field. 

Figure 213: Scroll-Lists – tab and properties of a Scroll-List
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3.23.2 Editing Scroll-List Entries and Functions

Functions can be added to or deleted from the Scroll-List in the Scroll-List's properties. To add a new function click the

 button and choose the desired function from the list. To delete an entry from the list select it and click

the  button.

Figure 214: Scroll-Lists – Adding a new function

Standard functions, such as "Call to Port", "Call to Group", "Logic" and "Switch GPIO" can also be dragged to the Scroll-List

from the corresponding list in the Navigation Bar using Drag & Drop.
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To define or edit a function you have added, select the function and click the  button. Confirm your

changes with the  button to return to the Scroll-List view.

Figure 215: Scroll-Lists – example

To adjust the order of the entries, mark an item in the list and click the  or  buttons.

The corresponding key properties can be adjusted for every item in a Scroll-List. For example, key mode, key label and

dim function can be separately set for each list entry. Select an entry in the Scroll-List and press the

 button.

Figure 216: Scroll-Lists – Edit Scroll-List entry

In addition, each entry in the Scroll-List can be assigned a unique number (Keypad shortcut).

This number allows the function to be selected by entering the number on a numeric keypad.
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3.23.3 Assigning a Scroll-List to a Control Panel

Each control panel, except for the 2300, 3000 and 5000 series panels, can access a single Scroll-List. To assign a Scroll-

List to a panel, open the panel and its properties, for example by double clicking on the gray area on the panel view. In

the "General" tab you can choose a predefined Scroll-List that the panel should be able to access under "Scroll-List".

Figure 217: Scroll-Lists – Panel properties – choosing a Scroll-List

You can also just drag and drop a Scroll-List to a panel.

Figure 218: Scroll-Lists – Drag and Drop to panels
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Now individual keys on the control panel can be enabled to access the list. In order to do so, open the properties of a

key. In the "General" tab the option "Scroll enable" must be selected. Any number of keys on a control panel can be set

in this way.

You should only activate the scroll function on empty keys, since after the first time something is selected

from the Scroll-List the original functions on the key will be overwritten. The last function chosen from the

list will remain even after a node reset.

Figure 219: Scroll-Lists – Properties of a key – scroll enable
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3.23.4 Scroll-Lists - Panel Operation

To show the keys on a panel that have scroll capabilities, press the master volume control. The displays of any key that

can scroll will change to "SCRL KEY". To select an entry from a Scroll-List, double click on the volume control next to the

key where you want the function to be assigned. Functions can be selected in different ways:

· searching alphabetically by name

· using a keypad

· by type of function

Alphabetical Search3.23.4.1

Activate the scroll function by double clicking on the volume control.

Turn the encoder until "Search" is displayed. Press the encoder once to confirm.

The first position in the name blinks. Choose the first letter of the name by turning the encoder.

Confirm by pressing the encoder once.

The second letter in the name can now be chosen by turning the encoder.

Confirm your choice by pressing the encoder once, and so on.

A long press on the encoder selects the final name.

Ø The function can be used now.

Selection via Keypad3.23.4.2

Activate the scroll function by double clicking on the volume control. Turn the encoder

until "Search" is displayed.

Type an assigned "Keypad Shortcuts" number into the keypad (or on panel keys

configured as a keypad).

The number will be displayed directly on the scroll key.

As soon as the number has been correctly identified, the corresponding function will be

automatically assigned to the key.
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Selection by Function Type3.23.4.3

Activate the scroll function by double clicking on the volume control.

Choose the function type by turning the encoder.

"C2 Port" means "Call to Port".

"L2 Port" means "Listen to Port".

"C2 Group" means "Call to Group".

"Logic" means select a logic source.

Confirm by pressing the encoder once.

Choose an available function by turning the encoder.

Confirm by pressing the encoder once.

On 2000 series control panels the click function of the encoder is activated with the "SCR" key. To scroll in a

list on these panels use the master volume control. The rest of the procedure is identical to that of the

1000 series panels.
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3.24 Logic Functions

Logic functions offer the possibility to implement and combine various functions system wide based on particular

conditions. Each logic function can have up to 8 input variables that can be connected to one another by logic gates as

required. These inputs lead to a logic output which can activate one or more system actions, for example GPI outputs,

audio routes, signalizations, the activation of keys, further logic functions, etc. In a logic function, inputs (logic sources)

and outputs (logic destinations) are differentiated according to Boolean logic definitions. The logic inputs of a function

can be, for example, a GPI input, a Vox function, or a key press anywhere in the system.

3.24.1 Logic Workspace

In order to add or edit a logic function, click on the  tab in the Navigation Bar. Next, the inputs and outputs of

the logic function must be defined. Click on  to add a logic output in which the actual logic function will be

built. A window opens where you must select a node that will process the logic function. The logic function can also be

given a unique name.

Figure 220: Logic – Logic tab

Figure 221: Logic – Selection of a node

Since a node can only manage up to a maximum of 64 logic functions, the individual logic functions must be assigned

to a specific node. It is not relevant whether or not the logic inputs and outputs are actually carried out on the node

assigned. It is only being defined which CPU on the fiber ring makes the necessary calculations for the function.
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Create the desired number of logic inputs using the  button.

Figure 222: Logic – Properties of a Logic Source

In the "Properties of Logic Source..." window you can give the entry a unique long name as well as a display name. The

"Enable for Event use" is only for use in conjunction with the optional "Events" special feature. See chapter "Event: Logic

Source".

Double clicking on a destination will display a white piece of paper with a pink box in the Workspace. This box

represents the output of the logic function. Using Drag & Drop, pull the desired logic sources from the table to the

workspace. Later, you can create the actual logic function with the help of logic gates.

Figure 223: Logic – Drag & Drop a logic source
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3.24.2 Logic Gates

The logic gates can be selected in the logic function Workspace. The following functions are available: 

Pointer, to move items and lines

Create a new connection

Connection Splitter

AND gate

NAND gate

OR gate

NOR gate

XOR gate

XNOR gate

NOT gate

D-Flipflop

Monoflop (from 100ms to 24h, optionally retrigger able)

NOP gate (No Operation)

Clock generator (adjustable from 125ms–24h)

N A IN B
AND NAND OR NOR XOR XNOR NOT

0 0 0 1 0 1 0 1 1

0 1 0 1 1 0 1 0 --

1 0 0 1 1 0 1 0 0

1 1 1 0 1 0 0 1 --
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3.24.3 Building a Logic Function

Click on one of the logic gate buttons. The selected gate will be highlighted. Move the mouse pointer to the workspace.

The pointer changes to a  crosshair cursor. Click once on the workspace to place the gate in particular place. If you

click again somewhere else, another gate will be placed there as well. If there is not enough room to place an object the

mouse pointer will change to . To select another kind of gate, click on it and place it on the workspace.

To move a gate you placed earlier, choose the  button, click on the gate and hold the mouse button down. You can

now move the element as you wish. Letting go of the mouse button places the gate in its new position.

To delete an element, right click on it and choose "Delete Logic Gate".

Figure 224: Logic – Building a logic function
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Select the  symbol to connect the various logic elements with one another.

The word "From" appears on the mouse pointer in black. As soon as you place the pointer on an available output of a

source or gate, the "From" changes to green . Click with the mouse and a line will be docked to the output and the

pointer label changes to "To". As soon as you place the pointer over an available input, the "To" becomes green.

Another mouse click then creates the connection between the output and input.

Figure 225: Logic – Creating a new connection

Figure 226: Logic – Logic Workspace

By selecting the  symbol you can select and move an element or connection.
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Additional parameters can be set for the logic gates "Clock" und "Monoflop". Right mouse click on the gate and choose

"Properties".

In the properties of the monoflop you

can set its hold time in ms. In addition,

with the "Retrigger extends time" you can

extend the hold time by triggering the

monoflop again.

Figure 227: Logic – Properties of a Monoflop

3.24.4 Assigning Actions to a Logic Function

After the logic function has been built it must still be defined what happens when the conditions are fulfilled. Functions

are added to a logic destination with a right mouse click and selecting "Add Function" just like when programming a

control panel key or Virtual Function. You can add functions to a logic destination either in the logic list or on the

Workspace.

A maximum of 32 functions can be carried out by a single logic function. The configured function will be displayed in

the "Function" column of the logic tab.

 

Figure 228: Logic – "Add Function" on a logic destination

The functions "Call to Port", "Call to Conference" and "Listen to Port" are not available on logic functions

since a logic function is not a physical port but rather a type of virtual function.
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3.24.5 Logic Status Live View

Up from Version 6.40, the actual status of every Logic source and destination is displayed in real-time in the Logic tab,

when the Director is connected to the Artist-System. When a source or a destination is activated, it shows a green

background in the Logic list.

Figure 229: Logic – Live Status

Also you can display the current status of a logic circuit. Therefore double click on a destination to open the Logic

function in the workspace of the Director. In the list with the logic gates you can activate the live status function for the

selected logic. Just press the button  to activate the live state.

Figure 230: Logic – Live State On/Off Button
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When the live state is activated, you can now see in real-time all activated elements of the logic circuit in green. This

allows also a very quick and easy way to check the complete logic and see how the gates are working.

Figure 231: Logic – Live State

When the Director is not connected to an Artist system or the Logic does not exist yet in the online configuration, the

live state button is shown as . So the live mode is not available for this logic.

The Live-State mode needs to be reactivated manually, every time when you are changing to another logic

destination.
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3.24.6 Creating a Makro

Logic functions offer the possibility to quickly and easily create macros. Macros can be used if several functions need to

be carried out for every key press on a control panel, for example switching a particular GPI, dimming a panel speaker

and activating a particular signalization. All of these functions can be combined together in a single logic destination.

This saves lots of time when configuring the system. Changes to the macro can also be made very quickly and only in

one place.

· Create a new logic destination with a unique name

· Create a new logic source with the same name as the destination

· Create a logic function by double clicking on the new destination in the logic list

· Connect the output of the new source directly with the input of the destination

Figure 232: Logic – Macro logic 

· At the destination add the functions that should be carried out using the "Add Function" command.

· Open a panel that should carry out these functions and add the source for the macro function to the desired keys

either by drag & drop or "Add Function" > "Logic".

Figure 233: Logic – Macro sources programmed to panel keys
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3.25 Logging System Activity 'Director Log'

Director allows all system activities to be logged. This can be accomplished visually in Director and can be saved to a

hard drive, if desired. The log offers a rich overview of the current system status and records all system activity during

normal operation. In the case of system problems, the log file offers a good way to localize the issue. System Alarms are

shown in red.

Figure 234: Logging – Log tab
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3.25.1 Log Settings

Choose "Settings" > "Options" in Director. The log

settings can be accessed in the "Logging" tab. You

can set which information will be displayed in

"Screen logging" and which information will be saved

to disk in "Disk logging".

Figure 235: Logging – Settings / Options / Logging

Screen logging

Log Errors Logs hardware errors

Log Warnings Logs warnings

Log Special Interfaces Logs the optional software special features

Log Node Handler /Artist Config Update Logs configuration changes

Log Command Port Logs the Director connection to Artist

Log Panel active/online Logs the port status (online/offline)

Log Matrix Activity Logs matrix activities (every key press, GPI, etc.)

Log Configuration changes Logs configuration changes

Log MCR Panel Operation Engine Logs MCR panel operations (optional)

Log Scheduler Engine Logs automatic times (optional)

Disk logging

Disabled The log file will not be saved

Full log (recommended) Saves all log file details, independent of screen login settings

Same as Screen logging Only saves the log details that are set in screen logging

Split into number of rotating files Maximum number of log files (FIFO principle) (recommended: 6)

Maximum Size of each log file Size of individual log files (recommended approx. 10000kB)

The log-files are stored as "Director-Uxx.txt" files in the same folder, the Director is started from.

When you want to open several instances of Director on the same Computer, the "Disk logging" needs to

be disabled or you have to copy and start the different Directors from different folders of your hard disk.
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3.26 Node and Client Logging

In addition to the Director log, you can transfer the internal log files of individual system cards to the PC. Each CPU and

every client card generates its own log information recording the condition and internal processes of the card. In the

case of system errors this information is very important and is used to find the cause of the problem. Director must be

connected to the system to access the files.

Open the "Artist - Online View" with the  button or select "View" > "Artist - Online View" in the menu.

Figure 236: Logging – Artist - Online View

· Make sure that disk logging is activated (Settings/Options/Logging).

· Make sure that the file size of the log file is large enough (recommended: 6 files at 10MB).

· Click the  button. The system begins to read the log files of each individual card and saves them.

Figure 237: Logging – Transfer of Log

This process can take several minutes, depending on the size of the system.

All log information will now be saved in the Director Log file in the same directory as Director.
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3.27 Resolving Configuration Errors

During the configuration process small mistakes can occur, such as creating undefined functions. Since such errors

could have unknown effects on the system, Director provides a central list of all configuration errors.

Downloads and any changes to the current system are blocked if there are any unresolved configuration errors. Each

error reported must be corrected and removed from the error list prior to the software allowing a download or update

to take place. Following Error-message pops up in this case:

Figure 238: Cfg Error message

Figure 239: Cfg Errors – Navigation Bar – Configuration Errors tab

Clicking on the Navigation Bar "Cfg Errors"  tab displays any configuration errors that have been detected

and are unresolved.

The width of each column can be adjusted in order to read the complete error descriptions. Move the mouse pointer to

the edge of a column. The pointer changes to a . Hold the left mouse key pressed and drag the column to the

desired width. The table is divided into two columns. The first column describes the exact position of the configuration

error and the second describes the problem.

Double click on an entry to open the properties window of the misconfigured object directly. You can then correct the

problem.

As soon as the configuration error is corrected it disappears from the Cfg-Errors tab. Repeat this process for all further

errors in the Cfg-Errors list.

Only when all configuration errors have been corrected can the configuration be sent to the system.
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3.28 Monitor 'Live State'

Director offers the possibility to monitor all panels connected to the system in real-time using "Live State". For example,

this feature gives an exact picture of current volume settings and key presses for control panels. Director only offers a

visual monitoring of a port. The audio to and from a port cannot be monitored.

Communication and functions between ports are normally accompanied by a signalization on the panel. All incoming

and outgoing calls plus other active functions can be monitored on the basis of their signalization. Even the current

state of the function keys, like "Shift" or "HS", is displayed in real-time. This allows problems to be quickly found, such as

a pressed "HS" key when no headset is connected. The monitoring can be carried out from any PC that has Director and

that is connected via Ethernet with the Artist system. There is no limit to the number of PCs that can monitor the same

port at the same time.

Panel Workspace

The "Live State"  monitoring mode is accessible from the configuration view of a port.

Figure 240: Panel live state – workspace with panel configuration

Double click on the port you wish to open in the port or network lists found in the Navigation Bar. The port will be

opened on the right side of Director and the configuration view shown.

A second port can also be displayed below the first by selecting it from the drop down list or by dragging it to the list

from the Navigation Bar using Drag & Drop.
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Switching to Live State monitoring

The control panel worksheet contains four tabs that are used for different modes of operation or programming.

Depending on the user rights, fewer tabs may be available. If you cannot see all four tabs, please contact your Artist

system administrator.

Select the tab  to switch to the monitoring view. The panel opens in real-time view. As long as Director is

connected to the system, you possess the necessary user rights, and the panel is online this tab will show the current

state of the panel. If you have opened a second port in the Workspace its live state will be shown as well.

The panel will now be displayed with all of its current actions, volume levels and signalizations. The status of the Virtual

Functions and GPIOs will also be displayed. If one of these functions is active it will be indicated by a small red signal

next to the function.

In this mode the ports can only be visually monitored. In order to make changes to the 

configuration you must return to the configuration view by clicking the  tab.

Figure 241: Panel live state – Live state monitoring
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3.29 Remote Control of a Port

Using Director and the  tab it is possible to monitor and remotely control every port in the system in

real time. The panel can be operated completely online, as if you were sitting directly before it. However, only the panel

hardware can be monitored and controlled. The audio to and from the control panel is not available in Director.

Communication and functions between ports are normally accompanied by a signalization on the panel. All incoming

and outgoing calls plus other active functions can be monitored on the basis of their signalization. Even the current

state of the function keys, like "Shift" or "HS", is displayed in real-time. This allows problems to be quickly found, such as

a pressed "HS" key when no headset is connected, or muted incoming audio. The monitoring can be carried out from

any PC that has Director and that is connected via Ethernet with the Artist system. There is no limit to the number of

PCs that can monitor the same port at the same time.

Panel Workspace

The  monitoring is accessible from the configuration view of a port.

Figure 242: Remote Control – Panels tab with panel workspace

Double click on the port you wish to open in the port or network lists found in the Navigation Bar. The port will be

opened on the right side of Director and the configuration view shown. A second port can also be displayed below the

first by selecting it from the drop down list or by dragging it to the list from the Navigation Bar using Drag & Drop.
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Switching to Remote Control Mode

The control panel worksheet contains four tabs that are used for different modes of operation or programming.

Depending on the user rights, fewer tabs may be available. If you cannot see all four tabs, please contact your Artist

system administrator.

Select the tab  to switch to the remote control view. The panel opens in real-time view. As long as

Director is connected to the system, you possess the necessary user rights and the panel is online this tab will show the

current state of the panel. In addition to the  view, you have the possibility to remote control the panel

from Director. If you have opened a second port in the Workspace its live state will also be shown.

The panel will now be displayed with all of its current actions, volume levels and signalizations. The status of the Virtual

Functions and GPIOs will also be displayed. If one of these functions is active it will be indicated by a small red signal

next to the function. All key functions, volume controls, Virtual Functions, GPIOS and function keys can now be

operated from Director.

All remote control actions will affect the control panel in real-time. Make sure that you have the correct

port open.

If you press a panel key with the mouse this action will also take place at the panel. This will be visually signaled in

Director in that you can see the key being pressed. It is also possible to activate GPIOs and Virtual Functions. Click on

the small dot next to the Virtual Function or GPIO.

 

Figure 243: Remote Control – operating remote control
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You can also adjust all of the volume controls in real-time. Click on an encoder and hold the mouse button pressed.

Begin to slowly move the mouse in a circle in the desired direction. A line labeled "Turn" will be displayed that can be

moved to adjust the volume level. In addition, the level will be shown live in Director.

Figure 244: Remote Control – Volume Control

To use the function keys, for example "Beep Panel", right mouse click on the "Beep" key and select "Hold Pressed". The

key will remain pressed. Now you can also press the desired destination key. When you are finished, you can deactivate

the "Hold Pressed" by repeating the steps above.

Figure 245: Remote Control – Hold pressed

In this mode the ports can only be visually monitored. In order to make changes to the configuration you must return

to the configuration view by clicking the  tab.
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3.30 Crosspoint View

The Crosspoint View allows you to monitor the live state of all crosspoints in the system. It is activated by clicking the

 button or selecting "Crosspoint View" from the drop-down menu "View".

Figure 246: Crosspoint View – window before configuration

In order to use the Crosspoint View, you must first set up the display window to indicate which ports should be

displayed. There are several ways to do so:

Drag ports from the port or network list directly into the Crosspoint View. All of the active audio connections to or from

the port will be shown, depending on whether you drag the port to the "Scr" (source) column or "Dst" (destination) row.

Groups and conferences can also be dragged into the Crosspoint View to display all of their members’ audio routes.

To quickly add all ports in the system, click on the  button. All available members in the system will be

shown in both the "Scr" and "Dst". It does not matter if the port is online or offline. The port will be shown as red

(offline) or green (online).

Hint: Up from version 6.60 the font set has changed to fit the demands for Asian characters

Figure 247: Crosspoint View – example
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Depending on the system size, it can quickly become difficult to keep a clear overview of the system in the window. To

make this easier, you can activate the option "Show only Ports having active crosspoints". This option will dynamically

change the display to only show ports that have active audio routes.

Figure 248: Crosspoint View – Show only Ports having active Crosspoints

If you drag a port to "Scr" or "Dst", all other ports that are configured to have any audio connection with this port will be

automatically added.

Figure 249: Crosspoint View – Drag & Drop in the Crosspoint View
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To manually edit the Crosspoint View display, click the  button. In the configuration window you can add

ports either as sources or destinations using the  buttons. Using the  and 

buttons you can change the order of ports in the list. Ports, groups and conferences can also be dragged directly into

this window using Drag & Drop.

Figure 250: Crosspoint View – Configure crosspoint display window

In addition, there is the possibility to save the current view. Configure all the source and destination ports you want to

see, then press the button  and give the setup a unique name. To load a previously saved setup, click the

 button. The presets are saved in the nodes together with the configuration file.

Figure 251: Crosspoint View – Load crosspoint setup window
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The "Crosspoint View" displays all active crosspoints between the selected members using various symbols and colors.

The shapes of a crosspoint symbolize the activator and the color symbolizes the function type.

Figure 252: Crosspoint View – legend

If a crosspoint is active triggered by more than one function, the Crosspoint View will always display the function with

the highest order (the order is the same as the order of the functions list when using "Add Function").
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As soon as you hold the mouse pointer over an active crosspoint in the Crosspoint View, a window opens with details

about the crosspoint. Information includes the volume level, priority and the type of audio connection. In addition, the

"Reason" explains exactly why this crosspoint is active.

Figure 253: Crosspoint View – Crosspoint information

To get an overview of all active crosspoints related to a certain port, position the mouse pointer over the port. During

so in the "Scr" column will show all audio coming from that source, while doing so in the "Dst" row will show all active

audio going to that destination. After a brief delay, a popup window will show all active connections and their details.

Figure 254: Crosspoint View – Popup window
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If you need to figure out the reason for certain crosspoint that is just coming up for a very short time, you can freeze

the Crosspoint View as soon this crosspoint is active. Just press the  button. Up from this moment you have

time to figure out the reason of this crosspoint by showing with the mouse on top of it. The popup window will show

you the command type, priority and the reason for the selected crosspoint. The volumes are not shown in the freeze-

mode.

Figure 255: Crosspoint View – Freeze mode

To stop the freeze-mode, just press the  button again.

You can influence a crosspoint directly by right mouse clicking on it in the Crosspoint View, when you are in live mode.

The function "Kill Crosspoint" manually deactivates the crosspoint. Affected control panels will see "Ext.Off" in their

display, but users can reactivate the crosspoint from the panel if necessary. "Force Crosspoint" manually forces a

crosspoint between a particular source and destination without the crosspoint existing in the configuration. This can be

used for test and commissioning purposes. The volume level of each crosspoint can also be adjusted between 3 levels.

Figure 256: Crosspoint View – Manipulating a Crosspoint

Force Crosspoint, Kill Crosspoint and changes made to crosspoint levels are not intended for use in the

normal configuration and control of the system. Any changes made to crosspoints with these features are

not saved in the configuration and will not be available after a system reset. These options should only be

used for testing and troubleshooting purposes.
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3.31 Matrix Input Monitor

Up from Version 6.40 there is a new input monitor view for all audio inputs available. The selected input audio levels

can be shown in real-time level meters. Additionally also the "Vox Threshold" and activity of the selected ports are

displayed. For 4-wire Inputs the gains can be set directly in this view.

Because of the needed resources for this functionality, it is only possible to monitor only input ports of the

Node with a direct connection via TCP/IP to the Director. So it is not possible, to show input ports of other

Nodes, which are connected via fiber to this Director.

However, it is possible to open another or more Director instances on the same PC, which are connected

via TCP/IP to the other Nodes, to show the input level meters of these Nodes. Therefore, it is necessary to

start the other Directors from different folders, because of the log file writing mechanism.

3.31.1 Matrix Input Monitor - Range of Functions

To open the "Matrix Input Monitor" just click on the new Button  in the Director Toolbar.

Figure 257: Matrix Input Monitor – Button in the Toolbar

  

Figure 258: Matrix Input Monitor – Basic view, normally and inverted

Inverts the Background of the Matrix Input Monitor (black background)

Switch display mode to show all 8 Ports of the selected Client card

(max. 4 Client cards = 32 Ports at the same time)

Switch display mode to show 4 selected Ports from different Client cards

Display scale in dBFS

Display scale in dBu
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Every level meter element contains several display elements:

Vox active display (ON-Threshold level is reached)

Display of the last maximum peak

Display of the configured Input gains (for 4-wire ports)

Controller for direct gain changing for 4-wire inputs

(Only available when "Set I/O Gain" function is activated for this 4-wire port)

Changes of the controller are send directly into the Artist system 

Display of the configured VOX ON- and VOX OFF Thresholds

Selected Port (green border = Port online)

Figure 259: Matrix Input Monitor – Display elements

3.31.2 Selection of the Input Ports

Client-Card Mode3.31.2.1

In this mode  you can drag and drop any port of the Node, the Director is connected to from the Port-, or Network

list on one of the level meters. Automatically all other ports of the corresponding client card are shown in

chronologically order next to each other.

Do a click on the row between the level meters to open another 8 ports. Click again to hide them. At maximum the

Matrix Input Monitor can show up to 32 ports simultaneous (4 client cards x 8 ports).

 

Figure 260: Matrix Input Monitor – Rows in the Client mode

Now you can drag and drop a port to any level meter.

In the Card-view always all 8 ports of a client card will be shown, also when you drag and drop only one port to a level

meter.
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When dragging a 2-channel port to a level meter both channels are displayed separately.

Figure 261: Matrix Input Monitor – Add a new port (Client card mode)

In the row above each 8 level meters the selected client card is displayed.

Figure 262: Matrix Input Monitor – display of the selected Client card
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You can also drag and drop a port directly on one of the rows to add the Client card to the monitor:

Figure 263: Matrix Input Monitor – Add a new row

Telephone Pool ports (via Connect Solo/Duo/Trio or SIP telephony) are not displayed and monitored in the

Input Monitor when they are configured on the selected card.
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Figure 264: Matrix Input Monitor – Display of a new Client card

Click on the rows between the level meters to show or to hide the 8 corresponding level meters:

Figure 265: Matrix Input Monitor – Show/hide Level meters
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Figure 266: Matrix Input Monitor – View with max 32 enabled ports

Right-clicking on a level meter opens a dialog an offers further functions of the corresponding port. Within this context

menu you can directly open the properties of the port, show it in the Port, Network, or Node-Config or unassign the

client card.

Figure 267: Matrix Input Monitor- right click menu

If you are trying to put a port that is not located on the Node the Director is directly connected to, to the Matrix Input

Monitor, you will get the following error message:

Figure 268: Matrix Input Monitor – Error message
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Single-Port Mode3.31.2.2

By clicking on the button  you can switch to the single port mode. In this mode any 4 ports of the node, the

Director is connected to, can be dragged to a level meter. So up to 4 ports of different client cards can be monitored

directly.

Figure 269: Matrix Input Monitor – Assigning single ports

You can now switch between the two modes without losing the assigned ports.

The port assignment of the Matrix Input Monitor is NOT part of the configuration. Therefore you will lose

your current port-assignment when reading out the configuration from the system, or opening a new

configuration from a file. To save the port assignment is not yet supported.

Telephone Pool ports (via Connect Solo/Duo/Trio or SIP telephony) cannot be selected and monitored in

the Input Monitor.
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3.32 Software Updates

New software versions for Artist are periodically available and include new features and bug fixes.

 Every software release comes with release notes and update instructions describing any special update

procedures. Please read these documents carefully before updating your system.

Each software release consists of at least 3 components. A new version of Director always requires the current

firmware in the system cards. It is imperative to update all components to the latest version when performing a

software update.

Director Software PC configuration and control software

Node Firmware CPU operating system

Client Firmware Client card operating system

Panel Firmware Control Panel operating system (an update is not necessary every time)

Not following correct update procedures or using the wrong update files can damage the system and lead

to a total system failure. If this occurs, all matrix cards must be sent to the factory for service and the

system cannot be used. Disregarding update instructions will also void any warranty and service

agreements.

3.32.1 Before beginning the Update

Check the software versions that are currently installed on your system.

Director Version

The version number of Director is found under "Help" > "About" in Director. 

Figure 270: Software Update – About Director
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Node and client version

The version information for the CPU and client cards is found in the Artist - Online View.

Press  or select "View" > "Artist - Online View". 

Figure 271: Software Update – Artist - Online View

Before beginning an update, save your original configuration with the old version of Director!

Start the new version of Director and open a configuration from your hard drive.

If you receive error messages such as "duplicate commands", "missing calls", "MCR...", send your configuration file to

customerservice@riedel.net and DO NOT UPDATE YOUR SYSTEM.

3.32.2 Director Update

To update Director, simply copy the new Director.exe file to the directory of your choice. 

If you use Partial Files, XY-Matrix or the Partial Files Trigger you must also copy the files "Director_ETR.xml" and

"Director_RPS.xml " from the directory with the old version of Director to where the new version is located.

WARNING: Director, CPU firmware and client firmware always come together as a package!

Different versions are not compatible with one another. Please contact Riedel Customerservice if you are uncertain

about compatibility issues.

Old configuration files can be opened with the new Director, but older versions of Director cannot open configuration

files written with a newer version.

Therefore, always make a backup copy of your configuration files before performing an update. This will ensure that

you can still open the files with the old version of Director in case of an emergency.



191

Director 7.20 User Manual A10

3.32.3 Firmware Update

Open the "Artist - Online View" by clicking the  button.

Select one of the nodes and click the  button.

Figure 272: Firmware Update – Artist - Online View

Select the correct firmware file in the open "Select Firmware File" window. Director automatically recognizes whether the

firmware is for a node, a client card or a panel.
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Node Update3.32.3.1

After selecting a node firmware file select the node to update. You can choose to update nodes one at a time or update

them all together over the fiber ring. After selecting a node, click the  button. The CPUs indicate that an

update is taking place through the blinking of all of their LEDs. A progress bar in Director also displays the update

process. A message will appear after a successful update.

If there are 2 CPUs in a node, the redundant CPU automatically starts when the software is being updated.

Do not reset the node during this process.

Figure 273: Firmware Update – Selecting a node

Figure 274: Firmware Update – Update progress

Figure 275: Firmware Update – Successful node update
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Client Update3.32.3.2

When your current Client version is older than 6.30, maybe there are different steps necessary. See details in the

documentation of the latest update-package.

After selecting a client firmware file, you can choose to either update all of the cards together over the fiber ring or to

update cards individually. After selecting a card, click the  button. The client cards signal that an update is

taking place through the blinking of all of their LEDs. A progress bar in Director also displays the update process. A

message will appear after a successful update.

If you have VoIP cards in your system, the client card update can take longer than an update without VoIP

cards.

Figure 276: Firmware Update – Selecting the node and client cards

Figure 277: Firmware Update – Update progress

Figure 278: Firmware Update – Successful client card update
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If you have several nodes connected in a fiber ring and you did not select "All Nodes" during the update, repeat the

process above for each node. The update can be carried out from any PC that is connected to the Artist system.

After updating the firmware, open the previously saved configuration with the new version of Director and send it to

the Artist system. Reset the system ("Extras" > "Reset all Nodes").

The system update has been completed successfully.

When updating AES67-108 G2 cards you might need to update the additionally AES67 part of the card

separately. For details please see chapter "AES67-108 G2 firmware update".

Panel Update3.32.3.3

For the different Panel series different software-versions are required. Please double check, that you are using the

right version for your series.

· 10xx /20xx/21xx/3000 Panels : Firmware (Monitor and Artist version) is identically

· 1100 Panels: special Firmware for 1100 series

· 5x08 Panels: special Firmware for 5000 series

· 2318 Panels (SmartPanels): special Firmware for 2300 series (not possible to update via Director). 

Please see chapter "Firmware update RSP-2318 with AVB-Manager".

Do not disconnect the Panel-connection, PSU or Director connection during an update process. Otherwise

your panel might be damaged.

ATTENTION: An update of the Panel firmware via a CONNECT IPxX is NOT possible!

To update one or several panels at the same time, select a Node and press the  button in

the "Artist - Online View". Select the corresponding file for your panel series. The Director detects, that the file is for

updating panels and opens a window to select the ports to update. You can update all panels in your system at the

same time, or just some ports on one Client card or just a single port. Then press the "Update" button to start the

update process.

Figure 279: Firmware Update – Selecting the panels
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When an incompatible panel is connected to a single port you want to update, you will get an error message. The panel

will not update.

Figure 280: Firmware Update – Panel – Error message wrong panel type

When you updating multiple ports at the same time, where different panel series are connected, the update process

will start. The panels that fit to the selected software will show also the update process in the displays of the panel.

Panels that are not compatible with the selected software version will ignore the update and keep working normally.

Figure 281: Firmware Update – Panel – update progress
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In this case you will get an error window that tells you, which ports did not do the update.

Figure 282: Firmware Update – Panel – Error message incompatible panels

If all updated panels are from the same panel series, you will get an information window that the update was

successfully.

Figure 283: Firmware Update – Panel – update successfully

When you want to update the 1100 series to the latest version with the integrated icons, the firmware

update for these panels needs to be made twice. Otherwise the Icons will not show correctly on the

displays.

RSP-2318 - Update with AVB-Manager3.32.3.4

As on the SmartPanels a complete Linux is running on, it is not possible anymore to update the RSP-2318 Panels via

Director. There are 2 different ways to update the SmartPanels:

· Via the AVB-Manager (when the panel is connected to a network and Transport mode "AVB" is selected)

· Via an USB-Stick connected to the panel

If the firmware version of your SmartPanel is < 1.20, the Licensing functionality was not implemented. So if

you update to 1.20 or higher, make sure your Panel has got a valid license installed. Otherwise the Panel

will have no functionality after the update.

Please contact customerservice@riedel.net if you are not sure.

Updating the SmartPanels via the AVB-Manager Software allows updating several panels at once.
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Hint: It's not necessary, that the panels are connected via an AVB capable network. AVB-Manager can detect and

update AVB devices also in non-AVB networks.

Please make sure the transport mode of the SmartPanel is set to AVB/AES3 mode. If the panel is in AES67 mode please

change it for the update to AVB/AES3 mode.

Figure 284: Firmware Update – SmartPanels – Switch to AVB/AES3 transport mode

Start the AVB-Manager and open the Firmware update tab.

Figure 285: Firmware Update – SmartPanels – AVB-Manager

Now select the SmartPanels you want to update, select the firmware file and press "Start update". For details see

chapter "Firmware update of AVB devices".

When the panels are used in an AES67 environment, switch the Transport Mode of the panels back to AES67.
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RSP-2318 - Update with USB-Stick3.32.3.5

Another, very easy option is to update the SmartPanel with an USB- Stick.

This method has to be used, if the panel is not connected to any network (because only AES3 is connected). It is also

working if the panel is only connected to power.

Please use a FAT32 formatted, empty USB stick and create the following folder structure:

Riedel/RSP-2318/firmware/unattended

Now copy the new SmartPanel firmware file (e.g. SmartPanel_FW_release_1_xx_xx.xfw) to the folder "unattended".

Figure 286: Firmware Update – SmartPanels – Explorer – SmartPanel USB update folder structure

Now just plug this USB-stick into the USB plug of the SmartPanel (front or rear).

After a few seconds the SmartPanel automatically starts to upload the new firmware file into the internal memory. The

display is showing "Upload Firmware". The upload just takes 10-20 seconds.

Figure 287: Firmware Update – SmartPanels – USB-Stick upload

When the upload is complete, the panel automatically starts to update the firmware process.

The display is changing to "Update Firmware".

Now you can remove the USB-stick (also when the update process is still running) and you can plug the USB-stick to the

next panel that needs to be updated.

Figure 288: Firmware Update – SmartPanels – update

When the update is done, the panel is doing a reboot automatically.

Hint: If the USB stick is not removed before, the panel will again start the update procedure.
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4 Functions and Features in Details

This part of the document provides supplementary information on the functions and features of the Director software.

All functions and settings will be described in detail.

4.1 Menu Bar

The Menu bar provides the basic set of functions needed to manage the Director software.

Many of these functions are identical to those in other Windows programs. 

There are six main menus that each contains further functions. 

Figure 289: Menu bar

4.1.1 File

With the file menu you can open, save and manage configuration files. You can also send changes to the system and

read out configurations.

Figure 290: Menu bar – file options
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Menu Bar – File Commands

New Creates a new empty configuration (Keyboard shortcut: Ctrl + N)

Open... Opens an existing configuration file (Keyboard shortcut: Ctrl + O)

Import... Imports a configuration from a hard disk to the current configuration.

The current configuration and the configuration imported will be merged.

Compare with... Compares the current configuration with an existing configuration on hard disk.

Save Saves the active Director configuration with its current file name to hard disk.

(Keyboard shortcut: Ctrl + S)

Save as... Saves the active configuration under a different file name, location

Open Partial

Configuration...

Opens a partial configuration file *.PAR, which only makes partial changes to the

existing configuration (only available if the Partial File option is installed)

Save Partial Configuration

as...

Saves only a part of the configuration as a *.PAR file. The details to be saved can be

manually selected (only available if the Partial File option is installed)

Save Partial Mask as... Creates a Partial File mask to allow an easier way of saving Partial Files

Save system snapshot to

file…

Saves the current online configuration including key states, volumes and IFB volumes

to a file

Restore system from

snapshot file...

Restores a complete system to the loaded configuration including key states, Volumes

and IFB volumes

Open from ARTIST Loads the current configuration from an online Artist system to Director

Import from ARTIST Imports the current configuration in Artist to the configuration open in Director. The

current configuration and the configuration imported will be merged

Compare with ARTIST Compares the configuration in Director to the current system configuration in Artist

Save to ARTIST (overwrite) Sends the complete configuration in Director to the Artist system

Save Changes to Artist

(merge)

Sends only the changes in the configuration open in Director to the Artist system

Print... Prints system information such as port lists, GPIs, etc.

User Login Select user and password entry

Exit Closes Director
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Print4.1.1.1

With the command "Print" or with the Button  you can print out important basic information of the actual Director

configuration as a list.

When you start the print command, a selection window will appear where you can select which objects you want to

print out.

Figure 291: File – Print: Selection of the elements to be printed

Ports Print the actual view of the list in the  tab with all details

Groups + Conferences Print the actual view of the list in the  tab with all details

Scroll – Lists Print the actual view of the list in the  tab with all details.

GPIOs Print the actual view of the list in the  tab with all details

Node Configuration Print the list of all actual Node hardware configurations with all Client cards and

configured ports.

Logics Print all logic functions (destinations)

Grid Activates a dotted frame per line and column in the lists

Shading Activates an alternating background per line in the list

Ports, Groups+Conferences, Scroll-Lists and GPIOs lists are printed always like the actual view in the Director.

This means both, the sorting and the text filtering will also have an effect on the printed pages. So the

printed lists are always identically to the current Director view per tab.
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By pressing the  Button you can see and double-check the pages that should be printed.

Figure 292: File – Print – Preview

With the buttons , resp.  you can move through the different pages.

By pressing  you can zoom in or out the current view.

To print the lists you have to press the  button. Thereon the standard Windows Printer selection window will

appear, where you can select the printer, change the properties and select the pages you want to print.

Figure 293: File – Print: Printer selection

Panels and key functions cannot be printed directly. Therefore it is recommended to open the Panel in the

Director, print the screen ( ) to copy it to the clipboard and to paste this screen capture for

example into a new word document.
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Compare4.1.1.2

With the two functions "Compare with..." and "Compare with Artist" it is possible to compare 2 different configurations.

Compare with...

When using "Compare with..." you can compare 2 locally saved Director configurations. This means, the actually

opened configuration in the Director (working configuration) can be compared with another configuration stored

as a file.

Therefore first open a configuration file from hard disk or USB-Stick or read out the running system configuration

by using the  button from the connected system.

Now select "File" > "Compare with...". Thereon a file selection window will appear. Select the configuration file you

want to compare with the working configuration.

 > 

Figure 294: File – Compare with: Selection of the configuration to compare

A result window will appear which is showing all differences in both directions between the working Director

configuration and the selected file.

Figure 295: File – Compare with...: Result window
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All results are also listed in the Director-log. If there are too many differences between the configurations, the

result window will not display all. But all differences can be found in the Director log.

Figure 296: File Compare with...: Compare results in Director logs

Compare with Artist

By using "File" > "Compare with Artist" you can compare the actually loaded configuration of the Director (working

configuration) with the actual system configuration (online configuration).

Therefore open a configuration from a file. Now start "Compare with Artist".

 > 

Figure 297: File – Compare with Artist

The Director will automatically connect to the online system in the background, read out the system configuration

(online configuration) and will compare it with the loaded working configuration. Also here all results will be shown

in a result window and also listed in the Director log.

The opened Director configuration will not be modified by using "Compare...".

The configurations that are compared should not be complete different system configurations. It

should be files based on the same basic configuration, otherwise there will be too many results which

will also not being shown in the logs.
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4.1.2 Edit

The "Edit" menu can adjust some basic settings in order to make changes in the configuration.

Figure 298: Menu bar – Edit options

Menu Bar – Edit commands

Cut Only available on text editing operations

Copy Only available on text editing operations

Paste Only available on text editing operations

Special Interfaces Adds/removes Special Interfaces to/from the working configuration

Marker-Definition... Opens the marker (signalization) properties for panels

Copy panel... Copies a complete panel configuration or  Audiopatch to one or more panels

Apply defaults to

configuration objects...

Globally applies NET properties to all ports in the configuration 

(see chapter "NET Properties")

Update Trunking key labels This function updates port names in a trunked system (see chapter "Trunking")

Special Interfaces4.1.2.1

Figure 299: Menu bar – Edit – Add special features

Using the menu selection "Add" you can add the "Audio/Video Router" or "Master Control Room" option software

modules. Note that this will also require either a special USB dongle or an activation code (see chapter "Special

Features").
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Marker Definitions4.1.2.2

In "Marker Definitions", all panel signalizations

can be changed for each panel type (see

chapter "Marker definitions").

Figure 300: Menu bar – Edit – Marker definitions
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Copy Panel4.1.2.3

Figure 301: Menu bar – Edit -Copy Panel

Choose the source panel that should be copied. Add destination panels using the  button or Drag & Drop.

To delete panels from the list, select them and click the  button. To remove all panels, click the 

button.

Select the elements you want to copy from the source panel. If you want to copy for example only the Audiopatches

from the source panel, choose the option "Audiopatches".

None of the keys or other functions of the destination panels will be changed. To copy the panel, click

.

All settings and keys will be overwritten at the destination panel. Panels can only be copied to other panels

of the same type.
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Apply Defaults to Configuration Objects4.1.2.4

If you want to do basic changes on all already existing ports, you have to do this change in the NET-Properties.

When  you  want  to  change  for  example  the  display  brightness  of  all  panels,  change  the values in the "Port

Defaults 2" tab of the NET-properties.

Following you have to open the "Edit" > "Apply Defaults to configuration Objects..." window and select the elements you

want to change for all ports.

In this example we just mark the Objects for the Display brightness.

All unmarked objects will not be affected and will not be changed in the Port-properties.

All ports that are created new after the adaption of the brightness will get all basic settings made in the NET-properties.

Figure 302: Menu bar – Edit – Apply Defaults to configuration Objects

Update Trunking Key Labels4.1.2.5

This function is used to refresh local changed labels for the trunking system. For details see chapter "Trunking –

changing Port-Names".
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4.1.3 View

Figure 303: Menu bar – View options

Menu Bar – View commands

Standard Toolbar Displays or hides the Standard Toolbar

Status Bar Displays or hides the Status Bar

Artist - Online View Opens the Artist - Online View window

Config Transfer Toolbar Displays or hides the Artist Update button

Navigation Bar Displays or hides the Navigation Bar

Crosspoint View Opens the Crosspoint View

Alarms Opens the Alarm window

MCR - Online View Opens the MCR Tool (only available if this option is activated)

Events - Online View Opens the "Events" window (only available if this option is activated)

Interruptible Foldback (IFB) Opens the IFB configuration table

Scheduler - Online View Opens the Scheduler window (only available if this option is activated)

IP Statistics Opens the IP Statistic - Online View window 

(if the system contains a VoIP or AES67 card)

Audio/Video Router Interface Opens the Audio/ Video Router Interface window 

(only available if this option is activated)

Partial Files XY-Matrix Opens the XY-Matrix window (only available if this option is activated)

Partial Files Trigger Opens the Partial File Trigger window (only available if this option is activated)

Matrix Input Monitor Opens the Matrix Input Monitor

Dock Navigation Bar left Docks the Navigation Bar to the left side of Director (keyboard shortcut: <F9>)

Dock Navigation Bar top Docks the Navigation Bar to the top of Director (keyboard shortcut: <F10>)
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4.1.4 Settings

In Settings, system parameters and user options can be defined.

Figure 304: Menu bar – Settings

Menu Bar – Settings commands

IP address of local Node... Opens the IP address entry window

Connect (Network On/Off) Activates / deactivates the IP connection to the Artist or Performer system

Options... Opens the Options window

Colors... Allows changes to be made to the port list’s color scheme

IP-Address of Local Node4.1.4.1

Figure 305: Menu bar – Settings – ARTIST Node IP Address

Manually set the IP address of the node you wish to

connect to. The drop down menu contains the last 10 IP

addresses entered.

If you are connecting to a node with 2 CPU cards, check the

option "This is an Artist M/32/64/128 node with redundant

controller card". This ensures that Director looks at both IP

addresses and that it can switch to the second CPU if

necessary.
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Options - Logging4.1.4.2

Figure 306: Menu bar – Settings – Options – Logging

The various log parameters can be set in the

Logging tab.

Screen logging

Log Errors Logs hardware errors

Log Warnings Logs warnings

Log Special Interfaces Logs the optional software special features

Log Node Handler/Artist Config Update Logs configuration changes

Log Command Port Logs the Director connection to Artist

Log Panel active/online Logs the port status (online/offline)

Log Matrix Activity Logs matrix activities (every key press, GPI, etc.)

Log Configuration changes Logs configuration changes

Log MCR Panel Operation Engine Logs MCR panel operations (optional)

Log Scheduler Engine Logs automatic times (optional)

Disk logging

Disabled The log file will not be saved 

Full log (recommended) Saves all log file details, independent of screen logging settings

Same as Screen logging Only saves the log details that are set in screen logging 

Split into number of rotating files Maximum number of log files (FIFO principle) (recommended: 6)

Maximum Size of each log file Size of individual log files (recommended approx. 10000kB)

The log-files are stored as "Director-Uxx.txt" files in the same folder, the Director is started from.

When you want to open several instances of Director on the same Computer, the Disk logging needs to be

disabled, or you have to copy and start the different Directors from different folders of your hard disk.
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Options - Partial Files4.1.4.3

Partial Files is a special software feature that allows certain parts of a configuration to be saved to a file and later

opened. Partial Files must be activated with either an activation code or a special USB dongle before it can be used. For

details see chapter "Partial Files".

Figure 307: Menu bar – Settings – Options – Partial Files

Handle Partial Files Trigger

operations initiated by 

Logic Sources

By checking this box it is possible to load partial files with a Logic Source. Only one PC

in a network should have this option activated. That PC must then be permanently

connected to the Artist system. If a logic source triggers a partial file the PC will

automatically manage the configuration changes.

Restrict crosspoints When this checkbox is activated, you can only activate one XP at a time for every X- and

Y-axis. When you want to activate another XP, you first have to deactivate the active

one. When unchecked you can activate several XPs simultaneously within the same Y-

axis. Per X-axis also here only one XP is allowed. When changing a XP in the X-axis, an

already active one will be deactivated automatically. For more details please see

chapter "XY-Matrix".

Standalone mode All partial files are located on the local PC.

Server mode Only for use with Partial Files client/server. Activating server mode makes Partial Files

available to other computers. The control of the files will be handled by the client PC.

Client mode Only for use with Partial Files client/server. When client mode is activated, this PC takes

control of the partial files on the server PC. This allows remotely controlling the partial

files.

Server IP to connect to Only for Partial Files client operation. Enter the IP address of the server PC here.
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Options - Autosave4.1.4.4

Figure 308: Menu bar – Settings – Options – Autosave

Autosave the current Director configuration

Autosave working

configuration

Activating this option saves the current Director configuration at predefined intervals.

The files are saved in the directory where Director resides.

Time interval Defines how often the file is saved.

Number of rotating Sets the number of rotating backup files.

File name prefix Provides individual names for the backup files.

Set to Default Sets the names of the backup files to factory presets.

Open folder... Opens the folder where the backup files are stored (same directory as Director).

Autosave the online configuration 

Autosave online

configuration

Activating this option saves the current configuration from the Artist system that the

PC is connected to at predefined intervals. The files are saved in the directory where

Director resides. 

Time interval Defines how often the file is saved. 

Number of rotating Sets the number of rotating backup files 

File name prefix Provides individual names for the backup files 

Set to Default Sets the names of the backup files to factory presets 

Open folder... Opens the folder where the backup files are stored (same directory as Director).
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Options - Miscellaneous4.1.4.5

Figure 309: Menu bar – Settings – Options – Miscellaneous

Show live status in the panel

and GPI lists

Check this box to display the online status of ports and GPI activity.

Handle EditConf requests

triggered from panel keys

Tick this box to define this PC as the one handling the EditConf requests from the

Artist system (only one PC in a network should have this option activated at a

time).

Handle MCR operations

triggered by Panels / Logic

Sources

Tick this box to define this PC as the one handling MCR Tool requests (only one PC

in a network should have this option activated at a time).

Handle the Scheduler Tick this box to define this PC as the one handling scheduled events (only one PC

in a network should have this option activated at a time).

Ask for confirmation when

saving the configuration to

Artist with overwrite

Tick this box to require a confirmation prompt before performing the "Save to

Artist (overwrite)" command.

Auto Reverse Talk for 4-Wire Tick this box to activate this configuration tool. When active, a return audio

connection will be automatically programmed on 4-wire ports when a "Call to…"

command to the port is programmed elsewhere.

Auto Reverse Talk for 4-Wire at

call to group 

(new in Version 6.50)

Tick this box to activate this configuration tool. When active, a return audio

connection will be automatically programmed to 4-wires, when a 4-wire port is a

member of a group. A "call to port" to every port who can call to this group is

added automatically.

The Alarms window should

automatically pop up for new

important alarms

Tick this box to allow the Alarms window to open automatically when a new

system alarm occurs.

Do not show the configuration

transfer dialog for short,

successful updates

Tick this box to deactivate the transfer dialog for successful updates. The window

will only be shown if the configuration update was not successful.

Show panel key mode Tick this box to show key modes in the panel view (M: Momentary, L: Latching, A:

Auto).

Automatically adjust speaker

dim and key mode

When this option is active, Director automatically deletes the dim panel speaker

function for commands where the panel’s microphone is not used. The key mode

for special functions is also automatically set to latching.

Initial Tab in Panel View Defines the tab that is initially selected when opening a panel.

Show legacy Panels When this option is active, older panel types will also be displayed in the port type

list when defining matrix ports (ex. xCP, 10xxB). This function is normally

deactivated.
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Title bar You can select, if you want to see the name of the NET or the loaded Filename in

the title bar. See Labels for the Web and the Network.

Figure 310: Options – Miscellaneous – Show Panel Key Mode (Momentary, Auto, Latching)

Colors4.1.4.6

Allows changing the display colors in the Port-List.

Figure 311: Menu bar – Settings – Colors
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4.1.5 Extras

The Extras features provide the means to reset various aspects of the system and to register and activate special

features.

Figure 312: Menu bar – Extras

Menu Bar – Extras commands

Set System-Time on all Nodes Sets the system time in all nodes.

Reset all Nodes Reset all available nodes.

Reset Tree... Reset selected nodes.

Assign new Configuration ID Assigns a new "Configuration-ID"

Register special features... Enables purchased Director special features.

Set System-Time on all Nodes4.1.5.1

Synchronizes the internal clock on all nodes in the net to the PC's clock.

Figure 313: Menu bar – Extras – Set System-Time on all nodes

Reset all Nodes4.1.5.2

Resets all available nodes on a fiber ring, as soon as the reset command is confirmed. A complete system reset takes

approximately 20-40 seconds, depending on the system size.

Figure 314: Menu bar – Extras – Reset all Nodes

If a VoIP-card is installed in the node, the restart of this card can take up to 1 minute.
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Reset Tree4.1.5.3

The Reset Tree allows panels, client cards or nodes to be reset individually, without affecting the rest of the system.

Figure 315: Menu bar – Extras – Reset Tree...

Select the item that you would like to reset. Depending on where you mark the Reset Tree ( ), all components below

that point will be reset. You can choose to reset a complete node, only a certain client card or a particular panel.

Assign New Configuration-ID4.1.5.4

This command is only used when merging two configurations that were originally created from the same configuration

file (see also chapter "Merge"). Please note that a new configuration ID makes any Partial Files incompatible to the

merged configuration.

Figure 316: Menu bar – Extras – Assign new Configuration-ID
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Register Special Features4.1.5.5

Use this function to register any special features you have purchased. You will need an activation code from Riedel that

is only valid for a single PC. Special features include:

· Partial Files

· Audio Video Router

· Master Control Room

· Scheduler/Events

For details see chapter "Unlocking Software Add-ons".

Figure 317: Menu bar – Extras – Register Special Features
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4.1.6 Help

Here you can find additional information about the Director Software and Riedel support services.

Figure 318: Menu bar – Help options

Menu Bar – Help commands

Command line

arguments...

Allows an automatic startup of Director. Changes the options for the Director.exe shortcut.

Limits... Describes the system limits of Artist.

Support... Displays the contact information for Riedel support.

About... Opens the Director start up window (splash window), which displays information such as the

version number.

Figure 319: Menu Bar – Help – Limits Figure 320: Menu Bar – Help – About

Figure 321: Menu Bar – Help – Support
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Command-Line Arguments4.1.6.1

By modifying the link to the "Director  6.xx.exe" you can specify how the Director should start.

Figure 322: Menu Bar – Help – Command Line Arguments

Therefore just create a shortcut to the file "Director 6.xx.exe" for example to the Desktop.

By right-clicking on the shortcut, the properties of the shortcut are opened. Modify the destination of this link with the

arguments you want to use during Director Start-up.

Example: When the Director should connect automatically to the Artist-Network and read out  the  current  system 

configuration  you  have  to  modify  the  link  as  follows:  Behind "6.x0Dx.exe" just enter a blank followed by the option

with a hyphen: "...\Director6.50D5.exe –openconfigfromArtist".

 

Figure 323: Command Line Arguments – Modify the link

If you want to add more options, just enter the new argument after a hyphen. For example when Director should read

out automatically and should show no Splash start window:

Figure 324: Command Line Argument – example Auto read out without Splash screen
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4.2 Toolbar

The toolbar provides quick access to the most important and most often used functions.

Figure 325: Toolbar

New Opens a new blank configuration file

Open Opens an existing configuration file

Save Saves the current configuration in Director under its current file name

Print Prints selected information about the configuration

User Login Select user and password entry

Net Connect / disconnect the network connection to Artist

Dock Navigation Bar left Docks the Navigation Bar to the left side of Director window (= F9)

Dock Navigation Bar top Docks the Navigation Bar to the top of Director window (= F10)

Audio/Video Router Interface Opens the Audio/Video Router Interface window

Partial Files – XY Matrix Opens the Partial Files XY-Matrix

Partial Files Trigger Opens the Partial Files Trigger window

Master Control Room Opens the MCR user interface

Events Opens the Events window

IFB Opens the IFB-Table

Scheduler Opens the Scheduler window

Crosspoint View Opens the Crosspoint View window

Artist - Online View Opens the Artist - Online View window

Alarms Opens the Alarms window

IP Statistics Opens the IP Statistic - Online View for all VoIP/AES67 connections

Matrix Input Monitor Opens the Matrix Input Monitor

The Status Bar can be moved and placed outside of the Director window.
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4.3 Update Bar

The Update Bar manages the transfer of configuration data between Director and the Artist system. There are 3 ways

to transfer configurations. They can only be used if there is a working IP connection to the system, there are no

configuration errors, and the user has the necessary user rights.

Figure 326: Update Bar

Open Online Configuration

 (from Artist)

Loads the current configuration in Artist to Director (the existing

configuration in Director can be saved beforehand).

Save to ARTIST

 (overwrite)

Sends the complete configuration from the PC to the Artist system.

Save Changes to ARTIST

 (merge)

Sends only the changes made to the configuration to the Artist system.

If several Director PCs are connected to the same system at the same time, only the "Save Changes to

Artist" button  should be used. Otherwise, the changes made by one PC may be overwritten by

another PC.

It is strongly recommended to load the current system configuration to the PC with the  button

before making any system changes.

If you use "Partial Files", do not save the configuration from Artist for use as a template for other

configurations. Any active partial configurations may have changed the file from its original settings.

Before saving a file with "Partial Files", make sure that no "Partial File" is active.
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4.4 Navigation Bar

The Navigation Bar provides the basic functions for creating an Artist configuration. The individual tabs in the

Navigation Bar allow the programming and editing of the system.

Figure 327: Navigation bar

There are 10 different tabs on the Navigation Bar. Some are also associated with their own Workspace that is used for

the programming and display certain features. Only one tab can be selected at time, but other tabs can be selected

even if the workspace of a different tab is open.

Network Set up the net and the hardware configuration of the node

Ports Port and panel properties / view

Scroll-Lists Creation and management of Scroll-Lists for control panel keys

Cfg Errors Displays configuration errors

Log Displays log entries from Director

Logic Program and edit logic functions

Trunking Management of trunking assignments

GPI View and edit central and panel GPIs

Groups + Confs Create and edit groups and conferences

Users Create and edit users and user rights

The Navigation Bar can be repositioned by dragging it with the mouse. It can also be moved outside of the Director

window, for example to a second monitor. This provides the maximum viewing area in the Workspace.
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4.5 Workspace

The Workspace is used to program and view system functions in association with the Navigation Bar tabs. This includes,

among other features, the configuration of the system, ports and control panels and creating logic functions.

Figure 328: Director – Navigation bar – Workspace

The corresponding Workspaces are normally accessed by double clicking on an entry in one of the tabs of the

Navigation Bar.
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4.6 Status Bar

The Status Bar shows detailed information about the configuration status and the status of the connection to Artist.

Figure 329: Status Bar

A Ethernet data bandwidth and connection status

B Number of objects created in the configuration

C User currently logged in

D Network status and the number of nodes connected. The IP address of the node Director is connected to is

shown if the connection is active.

A yellow background when Director is connected to a node means that the Artist system contains an active,

functioning configuration.

E Network connection and data traffic icons

The Status Bar can be moved and placed outside of the Director window.
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4.7 Alarms

When you are connected to the system, you might see the Alarm window. It will pop up, if there are any alarm-

messages created by the system, like wrong firmware version of a card, a not working or present component, etc. All

alarms will be listed detailed with a timestamp when the problem appeared.

You can also open this window by pressing .

There are two differentiated alarm categories: 

Message in red Alarm (automatically pop up of the window)

Message in black just information (no automatically pop up of the window)

In the "Error mask" tab of the Node properties, you can select which hardware component should be monitored and

show up as a red alarm.

Figure 330: Alarms – Window

By double-clicking on an entry, you get detailed information. This is helpful for long error descriptions.

Figure 331: Alarm Details

Also if there are errors shown, you still can up- and download configurations to/from the system.

When all alarms are resolved, the Alarm-window stays open until you close it manually. So when an Alarm appears and

disappears by itself, you can see that there was a problem, also when you are not sitting all the time in front of the

Director. You can open the Director-Logs, to see what the problem was.

In "Settings" > "Options" > Miscellaneous" you can also disable the automatically pop up of the alarm window.
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4.8 Artist - Online View

Using the "Artist - Online View" window you can monitor nodes, change basic settings and update firmware in the cards

in the mainframe. This wondow is normally only needed during initial system setup, for software updates,

troubleshooting or when system parameters need to be changed. The current software version of individual cards in

the system as well as their IP addresses are also displayed. For day-to-day use, the Artist - Online View is not relevant.

You can open the "Artist - Online View" in "View">"Artist - Online View" or with the button .

The use of the Artist - Online View, changing system parameters and updating firmware should only be

done by trained personnel. Access to the "Artist - Online View" can be controlled using user rights.

The "Node Frame EEPROM" and "Client Card EEPROM" buttons are only for use by Riedel service personnel.

Figure 332: Artist - Online View
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4.8.1 Node properties

Basic settings for each individual node can be changed in the node properties window.

Select a node in the Artist - Online View and click the  button.

Figure 333: Artist - Online View – Node Properties

To change settings you must first tick the box next to the setting you would like to change.

Changes should only be made by trained personnel.

Set Node Address * Set the node address here (addresses begin at 2).

See chapter "Setting the Net and Node addresses".

Set Ethernet Address Shows the Ethernet MAC address. Changes are not possible.

Set IP Address * Set the IP address of the node.

Set Subnet Mask * Set the Subnet Mask.

Set Default Gateway * Set the gateway (if needed).

Set Ring Clock Master to Activates the node as ring clock master. This node will provide the audio clock to the

fiber ring. The green LED on the CPU of the clock master will blink. WARNING: Only

one node in a fiber ring should be set as ring clock master.

Set Synchronise to

 External Clock

If a node is set to Ring-Clock-Master, it can also be set to synchronize to an external

clock. This requires an optional sync module in the node.

Set Ethernet Hub feature * This function can tunnel an Ethernet signal over the fiber ring. WARNING: Only use

this option if the individual nodes are not running on the same IP network.

Set local Trunk-Controller * If you want to use trunking, one node on the fiber ring must be defined as the Trunk-

Controller. This node then communicates with the Trunk-Navigator and handles all

trunking requests in the local system.

* changes require a Reset
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After making changes, you have to send the changes to the Node. Depending which setting you have changed, (see the

table above) the transmit-button will show  or .

So "Ring Clock Master" and "Trunk Controller" settings can be changes "on the fly" without interrupting the normal

system operation. For all other settings, this Node will do an automatic restart when sending the changes.

4.8.2 Write log data

This button offers the possibility to read out the internal log files of all system cards in the mainframe. The information

will be placed in the Director log files. For details see chapter "Node and Client logging".

4.8.3 Update firmware

This button is used to update the internal operating system, firmware and the individual system components. This

includes the node, client and panel firmware. For trouble free operation, all system cards must have the same software

version. The corresponding version numbers are found in the Artist - Online View. For further details on updating

software see chapter "Firmware Update".
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4.9 'Net' Properties

The tabs of the "Properties of the Net" define the default settings that are applied to all nodes, panels and system wide

settings. Of course, these settings can also be adjusted individually for each panel, if required.

The properties window can be opened by right mouse clicking on the net in the "Network" Navigation Bar. Each tab of

the net properties can change different parameters.

Figure 334: Open the Net-Properties

4.9.1 'General' tab (Net)

The "General" tab allows you to give a meaningful name to the NET.

Figure 335: Net Properties – General tab

Long Name The net can be given a meaningful name in Director.

Up to 32 characters can be used.

Address The Address is a reference address assigned by the system; it cannot be changed by

the user.
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4.9.2 'Port Defaults 1' tab (Net)

Default volume level settings for control panels can be changed in the "Port Defaults 1" tab.

Figure 336: Net Properties – Port Defaults 1 tab

Min. Speaker Vol. Minimum speaker volume level on a control panel.

Min. Headset Minimum headset speaker volume level on a control panel.

Beep Volume Volume of the Beep tone.

Beep On Call Duration Duration of the initial beep tone prior to a call (if configured).

Speaker Dim Level Level that the control panel loudspeaker is dimmed when a key is pressed.

Fn key assignment Select the default behavior of the function keys (not available for 2300, 

3000 and 5000 series panels).

Possible functions: Norm, Beep, Monitoring and Copy reply.

Initial single volume Standard point-to-point volume.

Initial conference volume Standard conference call volume.

If changes are made to these global default settings, the changes will only affect new ports defined after

the changes were made.

If changes to the defaults should apply retroactively to all previously configured ports, you must select

"Edit" > "Apply defaults to configuration objects...". This will also overwrite all previously made changes to

individual port settings.
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4.9.3 'Port Defaults 2' tab (Net)

The "Ports Defaults 2" tab can change default settings for VOX sensitivity, LED brightness levels and busy signals.

Figure 337: Net Properties – Port Defaults 2 tab

Vox On-Threshold Signal level above which the Vox switch is activated.

Vox Off-Threshold Signal level below which the Vox switch is deactivated.

Vox Hold Time Duration a Vox switch remains active after the signal level falls below the Off-

Threshold.

Shift Key Mode Possibility to lock the Shift key on the panel. You can select, if the panel should always

show only the first or the second page.

Then the panel operator cannot switch between the pages anymore.

Headset Mode Possibility to lock the HS- key on the panel. You can select, if the panel should always

work only in Speaker-, or in Headset mode.

Then the panel operator cannot switch between Speaker and Headset mode

anymore.

Brightness of LEDs Brightness of the signalization LEDs.

Brightness of display Brightness of the displays.

Enable In-Use Indication ..., if

Panel receives a call...

Triggers a busy signalization on other panels when the panel receives a call.

Enable In-Use Indication ..., if

Panel makes a call...

Triggers a busy signalization on other panels when the panel makes a call.

Enable Mute Function Activates the "Press to Mute" function on the panels' rotary encoders.

Response Timeout Internal system timeout for panel response. This value must be increased on remote

panels connected via IP because of longer response times.

Response Timeout

Telephone Codec

Internal system timeout for panel response. This value must be increased on remote

panels connected via ISDN because of longer response times.

Response Timeout VoIP Port Internal system timeout for panel response. This value must be increased on remote

panels connected via VoIP because of longer response times.

If changes are made to these global default settings, the changes will only affect new ports defined after

the changes were made. If changes to the defaults should apply retroactively to all previously configured

ports, you must select "Edit" > "Apply defaults to configuration objects...".

This will also overwrite all previously made changes to individual port settings.
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4.9.4 'Port Settings' tab (Net)

The "Port Settings" tab manages the dim levels for the various call priorities and other miscellaneous port settings.

Figure 338: Net Properties – Port Settings tab

Dim lower Prios for "Standard" Volume level by which "Below Standard" calls are dimmed when a "Standard"

priority call is received.

Dim lower Prios for "High" Volume level by which calls with "Standard" or "Below Standard" priorities are

dimmed when a call with "High" priority is received.

Dim lower Prios for "Paging" Volume level by which calls with "High", "Standard" or "Below Standard"

priorities are dimmed when a call with "Paging" priority is received.

Dim lower Prios for "Emergency" Volume level by which calls with "Paging", "High", "Standard" or "Below

Standard" priorities are dimmed when a call with "Emergency" priority is

received.

Reply-Key Timeout Timeout after which the last call is no longer displayed on the "Reply" key.

Character set Enables Director to be switched to the Katakana (Japan) or Cyrillic character

set. An operating system in this language is required.

First keypress wakes up from

screensaver AND runs key

commands too

Only for 1100 series panels: Adjusting the system wide behavior of the wake

up from screensaver functionality. See also chapter "1100 series –

Screensaver".
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4.9.5 'Key Defaults' tab (Net)

The "Key Defaults" tab can change the default settings for control panel keys.

Figure 339: Net Properties – Key Defaults tab

Key Mode Specifies the key behavior Auto (latch/non-latch), Momentary, Latching.

Latching Timeout Defines the timeout for Auto and Latching mode keys.

Activate Speaker Dim Activates the "Speaker Dim" function as soon as a panel key is pressed.

Scroll Enable Allows the use of Scroll-Lists on the keys.

Restore Volume Level When activated, dynamically assigned conferences return with their last volume

level.

Restart Latching timer When this option is activated, latched keys with a timeout will restart the timer while

they are active, when another key on the panel is pressed.

Action when muted key is

pressed

Determines the behavior of a muted key when the key is pressed.

11xx series key text color Selection of the default text color for the OLED keys (manually changed keys will not

be affected). Also see chapter "Text color, fonts and Icons on 1100 & 2300 series

panels".

If changes are made to these global default settings, the changes will only affect new ports defined after

the changes were made.

If changes to the defaults should apply retroactively to all previously configured ports, you must select

"Edit" > "Apply defaults to configuration objects...". This will also overwrite all previously made changes to

individual port settings.
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4.9.6 'Call Defaults' tab (Net)

In the "Call Defaults" tab the default priorities for the various audio functions can be set.

Figure 340: Net Properties – Call Defaults tab

Call Priority Below Standard Lowest Priority

Standard |

High |

Paging |

Emergency Highest Priority

If changes are made to these global default settings, the changes will only affect new ports defined after

the changes were made.

If changes to the defaults should apply retroactively to all previously configured ports, you must select

"Edit" > "Apply defaults to configuration objects...". This will also overwrite all previously made changes to

individual port settings.
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4.9.7 'Trunking Defaults' tab (Net)

In the tab "Trunking Defaults" you can set start-addresses for different trunking elements in the local system. The

counting of every trunking element starts at the number defined in this tab.

Figure 341: Net Properties – Trunking Defaults tab

Port Trunking start-address for local Ports.

Trunkline Trunking start-address for local Trunklines.

Group Trunking start-address for local trunk-enabled Groups.

Conference Trunking start-address for local trunk-enabled Conferences.
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4.9.8 'VoIP Port Defaults' tab (Net)

In the "VoIP Port Defaults" tab the default priorities of VoIP connections can be set.

Figure 342: Net Properties – VoIP Port Defaults tab

Audio Settings

Audio codec Select the desired audio codec. Depending on the quality of the codec, a larger

bandwidth may be required. The following codec’s are currently available: PCM,

G.711, G.722 PLC.

Audio packet size Enter the audio packet size. Many transmission failures can be resolved by

choosing the smallest possible packet size.

Receive buffer size Set the receiving buffer size. The larger the value, the more information from the

stream is temporarily saved. This will also increase the audio delay. This value

should be adjusted depending on the quality of your IP connection.

Differentiated services code

point (DSCP)

Some network devices support "Quality of Service". That means that certain data

packets have priority over others, such as internet data.

Voice activity detection

(VAD)

This option reduces data transmission. Data will only be transmitted if it contains

an audio signal.

SIP Phone

Domain server (SIP PBX) Enter the DNS-Name or IP-address of your SIP Server (also called Registrar) the

VoIP card need connect to.

Proxy server If you are using a connection via a Proxy Server, enter the address here.

SIP transport protocol  Select if the UDP or TCP IP protocol is used for the communication with the PBX.

Depending on the used PBX.

Please refer also chapter "SIP Phone Basic setup".
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4.9.9 'AES67 Defaults' tab (Net)

In the "AES67 Defaults" tab the default priorities of AES67 connections can be set.

Figure 343: Net Properties – AES67 Defaults tab

PTP

PTP Domain PTP domains allow you to use multiple independent PTP clocking subdomains on a

single network.

Default PTP Domain: 0

Range: 0...127

QoS

DSCP All outgoing AES67 packets are tagged with a QoS value to allow prioritized

handling in a network (see QoS). Using the default DSCP value 34 classifies the

audio data in the same way as Video Conferencing. If there is AES67 together with

other traffic tagged with DSCP value 34 in the same network and you want to

differentiate between the two types of traffic you can change the DSCP value of

AES67 here. This allows you to configure two different priority classes for the

different types of traffic types.

Default DSCP: 34

Range: 0...63
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Connection Parameter (Clients)

SIP TCP/UDP port Choose a port for SIP request. This reflects the receiving SIP TCP/UDP port of the

Artist AES67-108 G2. Some endpoints may use other ports than the default for SIP

traffic.

Default SIP port: 5060

Range: 1024...65535

Settings Parameter

Bit Depth Selection of the Bit resolution. (L16, L24)

Packet Time Packet time is the real-time duration of media data in a packet. Samples per packet

are calculated from packet time and sampling rate. Short packet time allows for

lower latency, but requires more bandwidth due to overhead. Implemented for

interoperability reasons. (0.125, 0.250, 0.333, 1.000 or 1.333 ms)

Payload Type Selection of the Payload type. (96...127)

SSRC Selection of the synchronization source. (0...32)

Time Stamp Offset Selection of the Time Stamp Offset. (0...32)

Settings Parameter

Default Connection Method Selection between Manual and RTSP.

If Manual is selected, the session parameters must be entered manually to

establish AES67 connections.

If RTSP is selected, the session parameters can be negotiated automatically by the

AES67 clients.

SIP TCP/UDP port Choose a port for SIP request. This reflects the receiving SIP TCP/UDP port of the

Artist AES67-108 G2. Some endpoints may use other ports than the default for SIP

traffic.

Default SIP port: 5060

Range: 1024...65535
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4.9.10 'Marker-Definition' tab (Net)

The signalizations on control panels can be managed in the "Marker-Definition" tab. For every function available in

Artist, the corresponding signalization can be edited.

Marker Definitions are global settings and valid for all panels.

Figure 344: Net Properties – Marker-Definition tab

Set to defaults These buttons reset the markers for 1000 series, 2000 series and RIF-1032 / RIF-2064

panels back to factory default settings.

Preview level Shows how the markers will appear when the volume control on the panel is changed 

(only for 1000 series panels). Move the slide with the mouse.

Edit definition... Opens the edit marker window (can also be reached by double clicking on a marker).
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Edit Marker4.9.10.1

Click the  button or double click on a marker to edit the marker. Each marker can be set separately for

each control panel type.

Figure 345: Net Properties – Marker-Definition tab – Edit Marker

Persistence Timeout Defines how long a marker is displayed after the corresponding command has been

terminated.

User-defined name Allows a marker name to be entered (only available for the user defined markers 0-

17).

Priority Defines the marker’s priority (highest priority = 1). Used to define which marker is

visible when several functions are on a single key.

Background color For 1000 series panels: color of the marker (except for possible volume level display).

For each of the 8 LEDs one of 4 states can be chosen (off, red, yellow, green).

Show crosspoint level in

foreground

Activates the display of the volume level in the foreground.

Crosspoint level color Color of the volume control indicator.

Muted crosspoint level color Color indicating the volume level is set to mute.

Flash Sets the marker to flash on and off.

Base color Defines the default color for 2000 and 3000 series control panels.

Flash to color Sets the marker on 2000 and 3000 series control panels to flash to another color.

LED state Defines the marker for a RIF-1032 / RIF-2064.
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4.9.11 'Rights' tab (Net)

The "Rights" tab manages the user rights of the net.

See chapter "User Rights".

Figure 346: Net Properties – Rights tab
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4.10 'Node' Properties

In the "Properties of the Node" the default settings of the node are defined. The properties window can be opened with

a right mouse click on the node in the "Network" Navigation Bar.

Figure 347: Open the Node-Properties

4.10.1 'General' tab (Node)

The "General" tab manages the node identification details.

Figure 348: Node Properties – General tab

Long Name A unique description of the node (maximum 32 characters).

Address Enter a valid node address (except 0 or 1). The node address must match to the

address of the connected node. Range: 2–99.

SOA
Audio channels used. Automatically assigned by the system.

NOA
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4.10.2 'Error mask' tab (Node)

The "Error mask" defines which system components can cause an alarm. The alarms are displayed red in a pop-up

window in Director, when you are connected online. Choose the components that are included in your system.

Figure 349: Node Properties – Error mask tab

Client Card B Monitoring when bay B is used for a GPI-card instead of a second CPU-card 

(for example in Performer frames).

Client Card Bay 1–16 Monitoring of Bay 1-16. Also GPI cards on these bays will be monitored.

Attention: Also on smaller frames (Artist 32, 64, Performer) all 16 bays are

shown. In Artist S 

Client Card Bay X–Y Monitoring of GPI-cards on Bay X and Y (only for Artist 128).

Power Supply 1, 2 Monitoring of the Power supplies (AC, DC or fan errors).

Redundant Controller Monitoring of the redundant CPU.

Fiber UP- / Downstream Monitoring of the fiber connections.

Fiber transmission error Monitoring of fiber errors (Lost packages). This indicates a bad fiber connection

or fiber.

Configuration parse error Monitoring of the online configuration.

Hardware mismatch Monitoring of hardware mismatch between the configuration and the online

system.

Eeprom writeable Monitoring, if a jumper for writing the Eeprom on a card is still present (only

needed during production process of the card).

Error during bootup Monitoring of a general boot-sequence error during boot up of the system.
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4.10.3 'Relay 1 mask' tab (Node)

In addition to the alarms in Director, the alarm relays on the CPU rear cards can also be used to report errors. The

"Relay 1" tab defines which errors should trigger the hardware Relay 1 on the active CPU rear card to open (the relay is

normally closed).

Figure 350: Node Properties – Relay 1 mask tab

The option "This relay should only be triggered by errors in the local node" means that the relay will only be activated by

errors in the local node. If this option is not set, the relay will react to any of the defined errors in any node within the

fiber ring.
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4.10.4 'Relay 2 mask' tab (Node)

The "Relay 2" tab defines which errors should trigger Relay 2 on the active CPU rear card to open.

Figure 351: Node Properties – Relay 2 mask tab

The option "This relay should only be triggered by errors in the local node" means that the relay will only be activated by

errors in the local node. If this option is not set, the relay will react to any of the defined errors in any node within the

fiber ring.



247

Director 7.20 User Manual A10

4.10.5 'Rights' tab (Node)

Corresponding user rights can be managed in the "Rights" tab.

This tab is available at all Node types.

See chapter "User Rights".

Figure 352: Node Properties – Rights tab
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4.11 'Card' Properties

In the "Properties of a card" the default settings of the card are defined. The properties window can be opened with a

right mouse click on the card in the "Network" Navigation Bar or in the Net Workspace.

Figure 353: Open the Card-Properties

The Card Properties are available at following card types only and consists of a single tab "General":

· MADI-108 G2

· AES67-108 G2

· VoIP-108 G2 / VoIP-008

· DANTE-108 G2
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4.11.1 MADI Card - Properties

In the "General" tab you can set the frame length, which MADI channels are used, as well as the connection type to the

next MADI card or device ("Electrical" or "Optical").

Figure 354: MADI Card Properties – General tab

Frame length Defines whether a 56 or 64 channel MADI system is being used.

MADI Channels Selects which 8 audio channels this MADI client card uses 

(1-8, 9-16, 17-24, 25-32, 33-40, 41-48, 49-56, 57-64*).

MADI Up Interface Selects the uplink interface (COAX or fiber).

MADI Down Interface Selects the downlink interface (COAX or fiber).
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4.11.2 AES67 Card - Properties

In the "General" tab you can set the connection parameters for the AES67 card.

Figure 355: AES67 Card Properties – General tab
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IP-Address, 

Network mask, 

Default Gateway

Set the IP address, network mask as well as a default gateway of your AES67 card.

SIP TCP/UDP port Choose a port for SIP request. This reflects the receiving SIP TCP/UDP port of the

Artist AES67-108 G2. Some endpoints may use other ports than the default for SIP

traffic.

Default SIP port: 5060, Range: 1024...65535

DSCP All outgoing AES67 packets are tagged with a QoS value to allow prioritized handling

in a network (see QoS). Using the default DSCP value 34 classifies the audio data in

the same way as Video Conferencing. If there is AES67 together with other traffic

tagged with DSCP value 34 in the same network and you want to differentiate

between the two types of traffic you can change the DSCP value of AES67 here. This

allows you to configure two different priority classes for the different types of traffic

types.

Default DSCP: 34, Range: 0...63

PTP Domain PTP domains allow you to use multiple independent PTP clocking subdomains on a

single network.

Default PTP Domain: 0, Range: 0...127

PTP Priority 2 Definition of the Priority-2 of the PTP source.

The PTP master of AES67 cards shall be higher prioritized than PTP master of panels.

The highest possible priority of panels is 126. Thus the default setting of AES67 cards

is increased to 120.

Default PTP Priority 2: 120, Range: 0...255

PTP Mode Caution – expert setting!

Selecting the "hybrid" mode will reduce the multicast traffic in the network, because

a part of the slaves' synchronization protocols is sent in unicast mode.

All devices within one PTP subdomain must be switched to the same setting!

Default: multicast

PTP Role Caution – expert setting!

Selecting the "Slave" mode will block the device to be used as synchronization

master. At least one device must be enabled in each PTP subdomain as

synchronization master (setting: automatic).

Default: automatic
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4.11.3 VoIP Card - Properties

In the "General" tab you can set the connection parameters for the VoIP card.

Figure 356: VoIP Card Properties – General tab

Obtain IP address

automatically

Select to set the IP address of the VoIP card automatically by a DHCP server.

Use the following IP address Select to set the IP address of the VoIP card manually.

Enter the IP address that the card should use in your local network in the "IP-Address"

field. The local IP range can be set in "Network mask".

To enable access to other IP networks (i.e. internet access), enter the IP address of

your router in the "Default Gateway" field. Contact your network administrator for

details.

Obtain DNS server address

automatically

Select to set the IP address of the DNS server automatically by a DHCP server.

Use the following DNS server

address

Select to set the IP address of the DNS server manually.

Enter the primary and secondary IP address of the DNS server.

Ethernet link mode Select Autonegotiation to set the Ethernet link mode automatically or select a

defined speed and mode: 10/100 Mbit, full/half-duplex.
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4.11.4 DANTE Card - Properties

In the "General" tab the "Dante Device Name" is defined. 

The device name has to be unique within the Dante network. To guarantee the uniqueness, the default device name

will be constructed according following rules:

· Prefix "Artist"

· Node "Longname" (e.g. "Node #1")

· Bay address of the card (e.g. "Bay 1")

Not supported characters will be replaced by a "-" hyphen.

It is also possible to edit the "Dante Device Name".

Please take care of following restrictions:

· Dante labels are up to 31 bytes in length.

· Name comparisons are case-insensitive.

· Device names should follow DNS hostname rules. Legal characters are A- Z, a-z, 0-9, and '-' (dash or hyphen). Device

names cannot begin or end with a hyphen.

· Device names must be unique on the network.

Figure 357: DANTE Card Properties – General tab
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4.12 'Port/Panel' Properties

In the "Properties of a Port/Panel" the basic settings of the individual port/panel are defined. The properties window can

be opened with a right mouse click on the panel/port in the "Network" Navigation Bar or in the Net Workspace. Double

clicking on the panel in the Workspace also opens the properties.

The properties vary slightly by port type (panel, 4-wire, ISDN, etc.).

Figure 358: Open the Port/Panel-Properties

The available tabs and contents varying depending on the selected Port/Panel.

In total the following tabs are available:

General

Details / Details 1+2 *1

Trunking*1,2

GPIO*1,2,3

Port Pool *5

Telephone Number *6

Gain *1,4

Beep *7

Virtual Keys *1,2

VoIP *8

SIP phone connection *9

AES67 Input *10

AES67 Output *11

Bolero *12

Usage

Rights

*1 not at Normal/Inverted ports of a GPI-116 card
*2 not at Telephone Codec and Sip Phone Connection
*3 not at 1100 series, 2300 series with Basic-App, 4-Wire, WB-2, VCP, AES67, Bolero-Beltpack and Dante
*4 not at 1100 series
*5 only at Telephone Codec und Sip Phone Connection
*6 only at Telephone Codec
*7 only at 4-Wire-Output and AES67-Output
*8 only at Aurus and VCP
*9 only at Sip Phone Connection
*10 only at AES67-Input
*11 only at AES67-Output
*12 only at Bolero-Beltpack
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4.12.1 'General' tab (Port/Panel)

The "General" tab manages general settings like the port name, Scroll-Lists, etc.

This tab is available at all Port/Panel types.

Figure 359: Port/Panel Properties – General tab

In total the following contents are available:

Long Name Unique name for the panel that is used in Director (maximum of 32 characters).

Local *1,2 Display name, that appears on control panel keys (maximum 8 characters).

Alias *1,2 Allows the entry of a temporary name for the port that is used in key displays system wide

without changing the actual local name in the configuration.

Room-Code *2 Activates a Room-Code for conferences. Room-Codes are used when control panels in the same

conference are physically near each other.

This helps avoid feedback problems. Ports in the same Room-Code mutes the audio between

them as soon as a conference is active.

Room-Codes can be activated for both speaker and headset modes.

Scroll-List *1,2,3 Selects a pre-defined Scroll-List that can be accessed by the panel 

(maximum of one Scroll-List per panel).

Enable 2nd audio

channel *2,4

Activates the second audio channel of the control panel. This function is only available if the

panel is connected to an odd numbered port and the next port is unused.

*1 not at Telephone Codec and Sip Phone Connection
*2 not at Normal/Inverted ports of a GPI-116 card
*3 not at 2300 series, 3000 series, 5000 series, 4-Wire, C3-Beltpack, AES67, Bolero-Beltpack and Dante
*4 not at 4-Wire-Output, VCP, AES67, Bolero-Beltpack and Dante
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4.12.2 'Details' tab (Port/Panel)

Default audio parameters and functions can be set in the "Details" tabs of the panel properties.

This tab is available at all Port/Panel types, except at Normal/Inverted ports of a GPI-116 card and at AES67-Trunkline.

The available contents varying depending on the selected Port/Panel. Depending on the amount, one or two Details

tabs are available.

Figure 360: Port/Panel Properties – Details 1 tab

In total the following contents are available:

Min. Speaker Vol. *1 Minimum speaker volume level on a control panel.

Min. Headset Vol. *1 Minimum headset speaker volume level on a control panel.

Beep Volume *1 Volume of the Beep tone.

Beep On Call Duration *2 Duration of the initial beep tone prior to a call (if configured).

Speaker Dim Level *3 Level that the control panel loudspeaker is dimmed when a key is pressed.

Fn-key assignment *4 Allows assignment of the special function key layout for the function keys "Beep" +

"Norm" ("F1" + "F2" on 1100 series). In addition, the key functions of these keys can

be changed to a Monitoring function or Copy Reply (see chapter "Function-Key

Assignment").

Initial single volume *5 Standard point-to-point volume.

Initial conference volume *5 Standard conference call volume.

*1 not at 4-Wire, Telephone Codec, C3, WB-2, VCP, Sip Phone Connection, AES67, Bolero-Beltpack and Dante
*2 not at 4-Wire, Telephone Codec, Sip Phone Connection, AES67, Bolero-Beltpack and Dante
*3 not at 4-Wire, Telephone Codec, C3, WB-2, Sip Phone Connection, AES67, Bolero-Beltpack and Dante
*4 only at 1000 series, 1100 series, 2000 series, DBM-1004, Aurus and VCP
*5 not at 4-Wire-Input, Telephone Codec, C3, Sip Phone Connection, AES67-Input and Dante-Input
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Figure 361: Port/Panel Properties – Details 2 tab

In total the following contents are available:

Vox On-Threshold *6 Signal level above which the Vox switch is activated.

Vox Off-Threshold *6 Signal level below which the Vox switch is deactivated.

Vox Hold Time *6 Duration a Vox switch remains active after the signal level falls below the Off-

Threshold.

Brightness of LEDs *7 Brightness of the signalization LEDs (1000 series) or LCD keys (2000/3000 series).

Brightness of displays *8 Brightness of the OLED (1100 series) or TFT displays (2300 series).

Brightness of keys *9 Brightness of the 8 character displays.

Brightness of LCD *10 Brightness of the LC displays.

Shift Key Mode *11 Possibility to lock the Shift key on the panel. You can select, if the panel should

always show only the first or the second page.

Then the panel operator cannot switch between the pages anymore.

Headset Mode *12 Possibility to lock the HS- key on the panel. You can select, if the panel should always

work only in Speaker-, or in Headset mode.

Then the panel operator cannot switch between Speaker and Headset mode

anymore.

Font Rotation *13 Orientation of the displays in steps of 90°.

Invert Marker Position *14 When activated, the Volume/Signaling Marker is shown underneath the Key label.

Only on the panel, not in Director.

Font Rotation Expansions *15 Separate orientation of the displays of all connected expansion panels in steps of

90°.

Invert Expansion Marker

 Position *14

When activated, the Volume/Signaling Marker is shown underneath the Key label on

connected Expansion panels. Only on the panel, not in Director.

Enable In-Use Indication ...,

 if Panel receives a call... *16

Triggers a busy signalization on other panels when the panel receives a call.

Enable In-Use Indication ...,

 if Panel makes a call... *6

Triggers a busy signalization on other panels when the panel makes a call.

Enable Mute Function *17 Allows incoming volume levels to be muted by pressing the corresponding encoder.

Show on Reply With this function you can specify if this port is showing at other panels Reply keys or

not, if this port is calling.
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Key text color *8 Selection of the default text color for all keys on this panel (manually changed keys

will not be affected). Also see chapter "Text color, fonts and Icons on 1100 & 2300

series panels".

Response Timeout *18 Internal system timeout for the communication between the matrix and the control

panel (must be increased for connections with large delays, such as ISDN, VoIP, etc.).

*6 not at 4-Wire-Output, Telephone Codec, Sip Phone Connection, AES67-Output and Dante-Output
*7 only at 1000 series, 1100 series, 2300 series, DBM-1004 and RIF
*8 only at 1100 series and 2300 series
*9 only at 1000 series, 2000 series, DCP-5108, DBM-1004, RIF and Aurus
*10 only at 2000 series and DCP-5108
*11 only at 1000 series, 1100 series, 2000 series, 2300 series, DBM-1004 and VCP
*12 only at 1000 series, 1100 series, 2000 series, 2300 series and DBM-1004
*13 only at 1100 series, 2000 series and 2300 series
*14 only at 1100 series
*15 only at 1100 series and 2300 series
*16 not at 4-Wire-Input, Telephone Codec, Sip Phone Connection, AES67-Input and Dante-Input
*17 only at 1000 series, 1100 series, 2000 series, 2300 series, DBM-1004, RIF, Aurus and VCP
*18 not at 4-Wire, VCP, AES67 and Dante

Function-Key Assignment4.12.2.1

The functions of the function-keys of every panel (not available on 2300, 3000 and 5000 series panels) can be modified

individually for every panel in the properties of the panel > "Details 1" > "Fn key assignment".

For the 1000 and 2000 series panels, the function-keys "Beep" and "Norm" can be modified in different combinations.

Figure 362: FN-key assignment – 1000/2000 series

For the 1100 series panels, the function-keys "F1" and "F2" can be modified in different combinations.

Figure 363: FN-key assignment – 1100 series
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Monitoring Function4.12.2.2

Under "Fn-Key Assignment" there is the possibility to replace either the "Beep" or "Norm" (1000/2000 series) respectively

"F1" or "F2" (1100 series) function keys with a monitoring function.

Figure 364: Monitoring – FN key assignment

This makes it possible to monitor a selected port in the system. That means that as soon as the monitored panel talks

to a destination, the audio from the monitored panel will also be routed to the monitoring panel.

To activate monitoring, either the "Norm" or "Beep" ("F1" or "F2") key is pressed, depending on how the function is

configured. The key has a latching timeout of around 2 seconds. During this time, press a "Call to" key on your panel to

monitor this port.

It is not possible to monitor keys programmed with functions like "Call to Conference/Groups", "Listen", or

other functions.

Repeat the steps to deactivate the monitoring function.

As soon as the monitoring function is activated on a port, it is signaled by the marker "Call to port not activated,

monitoring activated". The appearance of the signalization can of course be changed in "Marker-Definition". When the

panel being monitored activates a call, it is signaled on the panel doing the monitoring with the normal "Call to port

incoming call" marker. The audio from the monitored panel will be routed through and its volume can be adjusted or

muted with the corresponding encoder. The monitored panel does not appear in the "Reply" key.

Figure 365: Monitoring – Marker-Definition
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Example:

1. Change the "Norm" key to a monitoring key:

Figure 366: Monitoring – Properties – Details 1 – FN-Key Assignment

2. Activate the monitor function on the panel:

Figure 367: Monitoring – Activating the monitor function on the panel

The red marker indicates an active monitoring function (you can monitor as many ports as you like at the same time).

As soon as the port being monitored activates a call, the call is also routed to the monitoring panel and signaled on the

corresponding key with the Marker "Call to Port incoming call, monitoring activated". The key can still be used for normal

calls to this port.

Figure 368: Monitoring – Activated monitor function

To stop monitoring, repeat Step 2.
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Copy Reply4.12.2.3

Up from Version 6.50 a new function "Copy Reply" is available for the function-keys of a panel (not for 3000-, 5000- and

2300 series panel available).

With this function it is possible, to copy the last caller showing in the Reply key to an empty key directly on the panel.

The panel operator can now copy the last caller to dedicated keys on his panel, if the operator needs this destination

just temporary and there is no direct call button to this caller configured. This function is generating a standard "call to

port" to the current Reply caller on the selected keys.

This local configuration change is not part of the system configuration. Keys, that were configured as Copy

Reply buttons by the operator are not showing in the Director software. Only in the "Remote" view of the

panel the administrator can see the assigned function. Also the key tooltip windows are NOT showing this

function.

For this reason it is recommended to reserve and label a number of keys on a panel for this functionality, if

you want to use it. This prevents the system administrator to use these putatively empty keys for other

functions.

However, sometime it can be also necessary to use this function on keys, where already some other functions are

configured. For example a Switch GPO, that has to be activated for external dimming by every keypress. The Copy-

Reply "Call to" function will be added to already existing functions on the selected key.

The key mode of these keys is depending on the Director configuration.

After a Node, Client or Panel reset, the copied keys will be preserved!

Example:

Open the properties of a panel and select the panel function-key you want to use for this functionality in "Details 1". In

this example we are using the "Norm" resp. "F2" key on the selected panel.

Figure 369: Copy Reply – Panel Properties – Details 1 – FN key assignment
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Tipp: Also open the Properties of the panel keys you want reserve for this functionality.

Enter a label for these keys, for example "Reserved" in the "General" tab.

Figure 370: Copy Reply – reserving keys

Operation:

As soon somebody was talking to the panel (only with a "Call to Port" command) the caller is stored in the reply key, as

long nobody else is calling. Also when the display text of the Reply-key is again showing "Reply", always the last caller is

saved on in the Reply-key.

To now copy the last caller to an empty key, just press the predefined function key on your panel (in this example:

"NORM").

The function key has a timeout of around 2 seconds. Within this time now press the key, you want to copy the last

caller to.

Figure 371: Copy Reply – Panel operation

The manually name of the key will be overwritten with the label of the last caller. Now you can use this key as a

standard Call-key, changing volume, muting, etc. You can copy this caller also on multiple keys (for example on the Shift

page) on your panel.

If you now press again the NORM (F2) key plus the key, a caller was copied to before, the Call to command to this port

will be removed and the previous label of this key is shown.

 If you copy the reply caller to a key with already other functions configured on, the new Call to function

will be added to key functions. The key will show the label of the caller.
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4.12.3 'Trunking' tab (Port/Panel)

In the "Trunking" tab of the port properties you can enable this port for Trunking. All basic settings for trunking, like

Trunking-Address and trunk names can be set in this window. For further details please see chapter "Preparing

individual Ports for trunking".

This tab is available at all Port/Panel types, except at Telephone Codec, Sip Phone Connection and Normal/Inverted

ports of a GPI-116 card.

Figure 372: Panel Properties – Trunking tab

In total the following contents are available:

Used as Trunkline *1 Enables the 4-Wire as trunking connection.

Enable for Trunk call Enables the port for a trunk call.

Trunking-Address Unique address in all trunked systems.

8-char trunking label Allows defining another trunking label for trunk calls.

6-char trunking label If 3rd party devices don't support 8 characters, this field can be used for a 6-char

label.

4-char trunking label If 3rd party devices don't support 8 characters, this field can be used for a 3-char

label.

*1 only at 4-Wire
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4.12.4 'GPIO' tab (Port/Panel)

The "GPIO" tab of the panel properties manages the panel's GPIOs. The behavior of the individual GPIOs can be defined

(GPI In: normal; inverted, GPI Out: normally open; normally closed) and the names of the GPIOs can be changed.

This tab is available at all Port/Panel types, except at 1100 series, 2300 series with Basic-App, 4-Wire, Telephone Codec,

WB-2, VCP, SIP Phone Connection, AES67, Bolero-Beltpack, Dante and Normal/Inverted ports of a GPI-116 card.

See chapter "Panel GPI".

Figure 373: Panel Properties – GPIO tab
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4.12.5 'Port Pool' tab (Port/Panel)

The "Port Pool" tab of the panel properties manages the telephone codec and SIP phone settings.

This tab is only available at the port type Telephone Codec and SIP Phone Connection.

See chapter "'Port-Pool' tab (Codec)".

Figure 374: Panel Properties – Port Pool tab
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4.12.6 'Telephone Number' tab (Port/Panel)

The "Telephone Number" tab of the panel properties allows entering the first and second telephone number if using the

telephone codec.

This tab is only available at the port type Telephone Codec.

Figure 375: Panel Properties – Telephone Number tab
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4.12.7 'Gain' tab (Port/Panel)

The "Gain" tab of the panel properties allows adjusting the gain of inputs and outputs.

This tab is available at all Port/Panel types, except at 1100 series and Normal/Inverted ports of a GPI-116 card.

See chapter "'Set Input/Output Gain' function".

Figure 376: Panel Properties – Gain tab

...the "Set Input/Output

Gain" function from a

panel...

Allows control of the gain settings by a control panel. See chapter "Set Input/Output

Gain". The settings in the tab then serve as default settings.

...the configuration... The gain settings are exclusively set in the Director configuration.

Input Gain Set the input gain level (coming into the matrix).

Output Gain Set the output gain level (going from the matrix).

Reset Resets the selected gain parameter back to 0dB.
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4.12.8 'Beep' tab (Port/Panel)

The "Beep" tab of the panel properties allows triggering a GPI output, because a 4-Wire and AES67 output cannot

generate a beep tone.

This tab is only available at the port type 4-Wire-Output, Dante-Output and AES67-Output.

Figure 377: Panel Properties – Beep tab
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4.12.9 'Virtual Keys' tab (Port/Panel)

The tab "Virt. Keys" allows creating additional virtual keys for the panel. Click on the individual keys to activate them.

The virtual keys will appear under the control panel.

This tab is available at all Port/Panel types, except at Telephone Codec, Sip Phone Connection and Normal/Inverted

ports of a GPI-116 card.

Figure 378: Panel Properties – Virtual Keys tab

The example below shows a control panel with all 10 virtual keys activated.

Figure 379: Panel – Virtual Keys

The keys can be configured just like any other key and can be assigned up to 32 functions. These keys can be activated

via the Remote Key command from any point in the system (for example, a Vox switch or GPI input). See chapter

"Remote Key".
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4.12.10 'VoIP' tab (Port/Panel)

The "VoIP" tab of the panel properties allows managing the connection and audio settings.

This tab is only available at the port type Aurus, VCP-1004 and VCP-1012.

See chapter "Creating VoIP Ports".

Figure 380: Panel Properties – VoIP tab
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4.12.11 'SIP Phone Connection' tab (Port/Panel)

The "SIP Phone Connection" tab of the panel properties allows managing the connection settings of SIP calls.

This tab is only available at the port type SIP Phone Connection.

See chapter "SIP Phone - Basic Setup".

Figure 381: Panel Properties – SIP Phone Connection tab
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4.12.12 'AES67' tab (Port/Panel)

The "AES67 Input" tab of the panel properties allows managing the connection settings to the Bolero Beltpack.

This tab is only available at 2300 series panels and at 1000/1100 series panels that are integrated via NSA into the

AES67 network.

Figure 382: Panel Properties – AES67 tab

IP-Address Set the IP address of the panel in the AES67 network.

SIP / TCP/UDP port Choose a port for SIP request. This reflects the receiving SIP TCP/UDP port of the Artist

AES67-108 G2. Some endpoints may use other ports than the default for SIP traffic.

Default SIP port: 5060, Range: 1024...65535

Packet Time Packet time is the real-time duration of media data in a packet. Samples per packet are

calculated from packet time and sampling rate. Short packet time allows for lower

latency, but requires more bandwidth due to overhead. Implemented for

interoperability reasons. (0.125, 0.250, 0.333, 1.000 or 1.333 ms)

Receive Buffer Selection of the size of the AES67 receive buffer to adapt the expected delay of

connected panels. The default buffer is 3 × Packet Time.

PTP Role Caution – expert setting!

Selecting the "Slave" mode will block the device to be used as synchronization master.

At least one device must be enabled in each PTP subdomain as synchronization

master (setting: automatic).

Default: automatic
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4.12.13 'AES67 Input' tab (Port/Panel)

The "AES67 Input" tab of the panel properties allows managing the settings of the AES67 connection.

This tab is only available at the port type AES67-Input and AES 4-Wire split Input.

Figure 383: Panel Properties – AES67 Input tab

AES67 Stream and Connection Settings

Mode Selection to enter separate settings for this channel or to use the settings of

another channel.

Connection Settings

Protocol Selection between Manual and RTSP.

If Manual is selected, the session parameters must be entered manually, to

establish an AES67 connection.

If RTSP is selected, the session parameters can be negotiated automatically by

entering the address of the RTSP-Server in the field RTSP URI below.

Import SDP File Button to load the SDP settings from a SDP file.

Renegotiate RTSP 1 Button to force a renegotiation of the RTSP settings.

Multicast IP 2 Field to enter the Multicast address of the RTP sender (224.0.0.0 ...

239.255.255.255)

Multicast Port 2 Field to enter the Multicast port of the RTP sender (0 ... 5004 ... 65535)

RTSP URI 1 Field to enter the RTSP address

1 only if Protocol=RTSP
2 only if Protocol=Manual
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Stream Settings

Bit Depth Selection of the Bit resolution. (L16, L24)

Packet Time Packet time is the real-time duration of media data in a packet. Samples per packet

are calculated from packet time and sampling rate. Short packet time allows for

lower latency, but requires more bandwidth due to overhead. Implemented for

interoperability reasons. (0.125, 0.250, 0.333, 1.000 or 1.333 ms)

Receive Buffer Selection of the size of the AES67 receive buffer to adapt the expected delay of

connected panels. The default buffer is 3 × Packet Time.

Payload Type Selection of the Payload type. (96...127)

SSRC Selection of the synchronization source. (0...32)

Time Stamp Offset Selection of the Time Stamp Offset. (0...32)

Samplerate Display of the sample rate (read only).

Channels Selection of the amount of used audio channels in the AES67 stream.

Port Settings

Selection Selection of the audio channel used for this port.
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4.12.14 'AES67 Output' tab (Port/Panel)

The "AES67 Output" tab of the panel properties allows managing the settings of the AES67 connection.

This tab is only available at the port type AES67-Output and AES 4-Wire split Output.

Figure 384: Panel Properties – AES67 Output tab

AES67 Stream and Connection Settings

Mode Selection to enter separate settings for this channel or to use the settings of

another channel.

Connection Settings

Protocol Selection between Manual and RTSP.

If Manual is selected, the RTSP-Server is not enabled. Hence, the session

parameters must be entered manually at the client, to establish an AES67

connection.

If RTSP is selected, the RTSP-Server is enabled and clients are able to negotiate

automatically the session parameters.

Export SDP File Button to save the settings to a SDP file.

Multicast IP Field to enter the Multicast address of the RTP sender (224.0.0.0 ...

239.255.255.255)

Multicast Port Field to enter the Multicast port of the RTP sender (0 ... 5004 ... 65535) 1

RTSP URI Display of the RTSP address (read only).
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Stream Settings

Bit Depth Selection of the Bit resolution. (L16, L24)

Packet Time Packet time is the real-time duration of media data in a packet. Samples per packet

are calculated from packet time and sampling rate. Short packet time allows for

lower latency, but requires more bandwidth due to overhead. Implemented for

interoperability reasons. (0.125, 0.250, 0.333, 1.000 or 1.333 ms)

Payload Type Selection of the Payload type. (96...127)

SSRC Selection of the synchronization source. (0...32)

Time Stamp Offset Selection of the Time Stamp Offset. (0...32)

Samplerate Display of the sample rate (read only).

Channels Selection of the amount of used audio channels in the AES67 stream.

Port Settings

Selection Selection of the audio channel used for this port.
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4.12.15 'AES67 Trunkline' tab (Port/Panel)

The "AES67 Trunkline" tab of the panel properties allows managing the trunking settings of the AES67 card.

This tab is only available at the port type AES67-Trunkline.

Figure 385: Panel Properties – AES67 Trunkline tab

Local SIP-ID Enter the name of the local port. By default AES67 cards use the name "Portx".

Remote Host Enter the destination IP address that this port should connect to.

Remote SIP-ID Enter the name of the destination port that should be connected to.

By default AES67 cards use the name "Portx".

Remote SIP-Port Enter the destination Port that this port should connect to.

Packet Time Packet time is the real-time duration of media data in a packet. Samples per packet are

calculated from packet time and sampling rate. Short packet time allows for lower

latency, but requires more bandwidth due to overhead. Implemented for

interoperability reasons. (0.125, 0.250, 0.333, 1.000 or 1.333 ms)

Receive Buffer Selection of the size of the AES67 receive buffer to adapt the expected delay of

connected panels. The default buffer is 3 × Packet Time.

SIP callee mode If the checkbox is enabled, the fields "Packet Time", "Receive Buffer" and "Remote Port

Address" are disabled and the respective settings are adapted to match the settings of

the incoming connection.
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4.12.16 'Bolero' tab (Port/Panel)

The "Bolero" tab of the panel properties allows managing the connection settings to the Bolero Beltpack.

This tab is only available at the port type BL-BLK-1006-19 Wireless BPK.

Figure 386: Panel Properties – Bolero tab

Bolero User ID Unique ID of the Beltpack.

Multicast IP Address IP address and port for the communication between the Bolero Net and the Artist

system. These settings in the Director must match the settings in the Bolero Net.Multicast port
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4.12.17 'Usage' tab (Port/Panel)

The "Usage" tab shows all of the sources that can talk to this panel or activate a function at the panel.

This tab is available at all Port/Panel types, except at Telephone Codec and Sip Phone Connection.

The table is divided into 3 columns. The list can be sorted by column by clicking on a column label. A double click on an

entry opens the corresponding function in the properties windows of the source's port.

Figure 387: Panel Properties – Usage
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4.12.18 'Rights' tab (Port/Panel)

Corresponding user rights can be managed in the "Rights" tab.

This tab is available at all Port/Panel types.

See chapter "User Rights".

Figure 388: Panel Properties – Rights



281

Director 7.20 User Manual A10

4.13 MADI

Figure 389: MADI-108 G2 Card

Each MADI card supports 8 MADI channels. The card can access any 8 channels from a connected MADI data stream

and bring them into the intercom system. Each card can also send 8 channels to a connected MADI data stream. If

more than 8 channels are required, individual MADI cards can be cascaded. The connection between cards is

accomplished with either 2 coax cables or a duplex fiber optic cable.

Figure 390: MADI – Cascading cards
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4.13.1 MADI - Client Card Properties

To add a MADI client card to the configuration, select the desired bay in the node configuration and choose the MADI-

108 G2 client card.

Figure 391: MADI – Adding a MADI card

All available port types can be selected on the individual ports of a MADI card.

MADI cards will also appear in the network view in Director. Do a right mouse click on a MADI card to set its default

properties.

Figure 392: MADI – Opening MADI properties
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General

In the "General" tab of each card you can set the frame length, which MADI channels are used, as well as the connection

type to the next MADI card or device ("Electrical" or "Optical").

Figure 393: MADI – Properties of MADI Client Card – General tab

Frame length Defines whether a 56 or 64 channel MADI system is being used.

MADI Channels Selects which 8 audio channels this MADI client card uses 

(1-8, 9-16, 17-24, 25-32, 33-40, 41-48, 49-56, 57-64*).

MADI Up Interface Selects the uplink interface (COAX or fiber).

MADI Down Interface Selects the downlink interface (COAX or fiber).
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4.14 AES67

When using AES67-108 G2 client cards you can connect SmartPanels via an AES67-capable network infrastructure to an

Artist matrix. Up to 8 panels can be connected to a single AES67 card.

Figure 394: AES67 network

This chapter is intended for those who will be setting up, installing and operating an AES67 network with RIEDEL

products. It will explain the available settings in the RIEDEL products as well as the settings that AES67 requires to be

set in the network devices. For more information on availability of those features and configuration instructions, please

refer to the documentation of your switch. This part of the setup may require the expertise of an IT professional.

4.14.1 Network - Switch Requirements for AES67 Traffic

General Information4.14.1.1

AES67 uses the following Traffic types:

Address Port Protocol Description

224.0.1.129 319 UDP/IGMPv2 Synchronization (PTPv2/IEEE1588:2008)

224.0.1.129 320 UDP/IGMPv2 Synchronization (PTPv2/IEEE1588:2008)

319 UDP Synchronization (PTPv2/IEEE1588:2008)

5060 UDP Session Initiation Protocol.

IP depending on configuration in Director.

1024 UDP AES67 Transport default port for Channel 1

1025 UDP AES67 Control default port for Channel 1

1026...1280 UDP AES67 default ports for Channels 2...128

Please ensure that these Ports do not get filtered in your local network.

Right now Riedel AES67 traffic uses Point-to-point connections for the audio transportation.

Nevertheless, the synchronization protocol "PTP" uses Multicast Traffic.

To ensure correct behavior of the Multicast Traffic Groups, IGMPv2 must be supported by all network equipment and

IGMP Snooping should be activated on all relevant ports. This ensures that the synchronization packets are not

distributed to ports without Riedel AES67 hardware.
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Quality of Service4.14.1.2

AES67 also provides three traffic classes:

1. Clock

2. Media

3. Best effort

The order of these classes should mirror the priority of this traffic in the network. One might ask, why the clock traffic

has higher priority than Audio, but without a working synchronization between clocks, the audio streams cannot be

played back correctly.

The traffic classes are labelled using the "DSCP" Value Field in Layer 3 and are classified using Differentiated Services

classes (DiffServ):

Class Name DiffServ class DSCP value

Clock EF 46

Media AF41 34

Best Effort DF 0

To use these classes in your local network, we suggest using the Layer 2 QoS mechanisms like IEEE802.1p. Most

manageable routers support QoS classes in Layer 2 and provide rules that can be applied to these classes.

As there are only 7 COS classes in 802.1p, please ensure that a mapping of Layer 3 Traffic classes to Layer 2 Traffic

classes is done.

The usual mapping of DSCP to COS is stated below:

Layer 3 Layer 2

Application DiffServ DSCP COS

Routing CS6 48 6

Voice EF 46 5

Video Conferencing AF41 34 4

Streaming Video CS4 32 4

Mission Critical Data AF31 26 3

Call Signaling CS3 24 3

Transactional Data AF21 18 2

Network Management CS2 16 2

Bulk Data  10 1 AF11 10 1

Scavenger CS1 8 1

Best Effort 0 0 0

You can see that both AES67 and PTP are rated very high compared to Best Effort Traffic.

These packets will be treated prioritized.

All Switches have to support configuring at least the three traffic classes marked bold in the above table.
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PTP4.14.1.3

The Switch does not necessarily have to support PTP operating modes. However, a Boundary clock mode Switch or

transparent clock Switch significantly improves timing behavior under load.

When Priority Queues are configured correctly, above Switches showed satisfying behavior even under high load (90%)

traffic on all ports.

IGMP Snooping4.14.1.4

The Switch shall support IGMP Snooping on all Ports (IGMPv3). This also guarantees operation with third party devices

in the same network, which use multicast traffic.

Bandwidth4.14.1.5

The Switch should be non-blocking on all ports. (Switching capacity in Gigabits per Seconds should equal minimum 2 *

Port count * Port speed).

Recommended Switches4.14.1.6

The following Switches have successfully been tested to work with Riedel AES67 devices:

· Extreme x440 24t (EOS v 16.1.3.6)

· Extreme x460-G2 24t (EOS v 16.1.3.6) without Clock features

· HP 2530-24G (J9776A)

· Hirschmann Mach1000 16 Port (MAR1140)

When using Extreme Switches please ensure that the AVB function of the Switches is disabled in order to use the

complete bandwidth for AES67 traffic.

The following Switches have been recommended by Cisco for AES67 traffic:

· Cisco Catalyst 3750

· Cisco Catalyst 3850

· Cisco Nexus 3000

· Cisco Nexus 9000
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4.14.2 AES67 - Client Card Properties

Add a new AES67-108 G2 card to an empty client card slot in your node configuration.

Figure 395: Adding an AES67 card to the Node config

Go to the "Network" tab and do a right click on the new AES67 card to open the card properties.

Figure 396: Open properties of an AES67 card

Figure 397: Properties of AES67-108 G2 card
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IP-Address, 

Network mask, 

Default Gateway

Set the IP address, network mask as well as a default gateway of your AES67 interface card

SIP TCP/UDP port Choose a port for SIP request. This reflects the receiving SIP TCP/UDP port of the Artist AES67-

108 G2. Some endpoints may use other ports than the default for SIP traffic.

Default SIP port: 5060, Range: 1024...65535

PTP Domain PTP domains allow you to use multiple independent PTP clocking subdomains on a single

network.

Default PTP Domain: 0, Range: 0...127

DSCP All outgoing AES67 packets are tagged with a QoS value to allow prioritized handling in a network

(see QoS). Using the default DSCP value 34 classifies the audio data in the same way as Video

Conferencing. If there is AES67 together with other traffic tagged with DSCP value 34 in the same

network and you want to differentiate between the two types of traffic you can change the DSCP

value of AES67 here. This allows you to configure two different priority classes for the different

types of traffic types.

Default DSCP: 34, Range: 0...63

PTP Priority 2 Definition of the Priority-2 of the PTP source.

The PTP master of AES67 cards shall be higher prioritized than PTP master of panels. The highest

possible priority of panels is 126. Thus the default setting of AES67 cards is increased to 120.

Default PTP Priority 2: 120, Range: 0...255

PTP mode Caution – expert setting!

Selecting the "hybrid" mode will reduce the multicast traffic in the network, because a part of the

slaves' synchronization protocols is sent in unicast mode.

All devices within one PTP subdomain must be switched to the same setting!

Default: multicast

PTP Role Caution – expert setting!

Selecting the "Slave" mode will block the device to be used as synchronization master. At least

one device must be enabled in each PTP subdomain as synchronization master (setting:

automatic).

Default: automatic

The basic settings of AES67 ports are defined in the port "Properties". The port properties can be opened with a right

mouse click on either the port in the network list or in port list, as well as by right mouse clicking on a port in the

Workspace. A double click on the port in the Workspace also opens the properties.

The AES67-Inputs/Outputs contains the general properties tabs and additionally the tabs "AES67 Input" and "AES67

Output". These tabs can be found in chapters "Port/Panel – 'AES67 Input' tab" and "Port/Panel – 'AES67 Output' tab".
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4.14.3 AES67 - SmartPanel Properties

Add a new SmartPanel to a port of the AES67 card in the Node configuration.

Figure 398: Adding a new SmartPanel to an AES67 card

Now go to the "Network" or "Ports" tab and do a right click on the new SmartPanel and open the properties of the panel.

Jump to the "AES67" tab.

Figure 399: Properties of a SmartPanel – AES67 tab

IP-Address Set the IP address of the SmartPanel that should receive this panel configuration.

SIP TCP/UDP port Choose a port for SIP request. This reflects the receiving SIP TCP/UDP port of the Smart Panel. It

must match the SIP port you set up in the AES67-108 G2.

Default SIP port: 5060

Range: 1024...65535

Packet Time Packet time is the real-time duration of media data in a packet. Samples per packet are

calculated from packet time and sampling rate. Short packet time allows for lower latency, but

requires more bandwidth due to overhead.

Default Packet Time: 1ms

Range: 0.125, 0.250, 0.333, 1.000 or 1.333 ms (implemented for interoperability reasons)

Receive Buffer The size of these settings dedicates how many ms of the incoming audio should be buffered to

avoid audio drops. In a bad network this setting can improve the quality of the audio but also

increase its delay. (Default: 3x packet time)

PTP Role Caution – expert setting!

Selecting the "Slave" mode will block the device to be used as synchronization master. At least

one device must be enabled in each PTP subdomain as synchronization master (setting:

automatic).

Default: automatic
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4.14.4 SmartPanel Basic Settings

The basic settings are illustrated in following example by a RSP-2318Pro. The key positions of the DSP-2312 are varying.

Press the Menu button for 2 seconds to enter the panels' setup menu:

Press "Set TM" (Transport mode):

Choose "AES67". The selected mode shows a red marker. Then press "SAVE":

The Panel will load the AES67 mode:

Press "Set IP" to enter a valid IP-Address:
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Select "Address (1)". With the buttons (2) you can select the blocks to modify (left and right). A red marker is showing the

selected. By turning the volume knob you can change the number. Do the same to adjust the Network, Gateway and

SIP Port and Packet Time settings if needed to match to your network and AES67 card settings.

Press "SAVE" when all settings are done:

Press "Quit" for leaving the setup menu:

The SmartPanel is now trying to connect to the AES67 card and starting if all settings and network is ok:

Figure 400: SmartPanel – AES67 Basic settings
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4.14.5 AES67-108 G2 Firmware Update

The firmware of an AES67 card consists of 2 parts:

· The standard Artist Client Firmware file (e.g. ArtistClientMultiImage-7.20.Cx.afw)

· An additional firmware for the AES67 chip (e.g. ArtistClientAes67-7.20.Cx.aes67fw)

The additional firmware for the AES67 chip must be updated before the standard Artist-Client Firmware

of the AES67 card is updated!

The update of the AES67 chip is done with a Web-Interface running on every AES67 card. Therefore the AES67 cards

have to be configured first with a valid IP-address in the Director configuration (see chapter "AES67 – Client Card

Properties"), so that a Web-Browser can connect to the IP address of the card.

Make sure, the PC is connected to the AES67 network, or directly to an AES67 card with cross-over cable.

The IP-address of the PC has to be in the same IP range of the AES67 card.

Open any Web browser and enter the IP-address of the AES67 card you want to connect to.

Select the firmware file (ArtistClientAes67-7.20.Cx.aes67fw) and press "Update Firmware".

Figure 401: AES67-108 G2 – Firmware update
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The firmware will now be uploaded to the card. You will receive a message, when the update is done.

Do not reset or power cycle the system at least for 3 minutes, also if the card is not visible in the Online-

View.

It's not possible to update AES67 chips on multiple AES67 cards simultaneously. Hence, you need to repeat the steps

above for further AES67-108 cards within your system.

After successful update of the AES67 chip, the standard Client firmware of the AES67 card can be updated together

with all other Client cards with the Director Update procedure. Refer chapter "Node-Update" and "Client-Update" for

detailed information about the standard client Firmware update.

4.14.6 AES67 Statistic

Using the "IP Statistics" function, you can monitor all AES67 connections by various criteria.

Click the  button in the tool bar to open the window and select the  tab.

Figure 402: AES67 Statistic

All available AES67 connections of the selected card will be displayed under "Detected AES67 Cards" on the left. If you

click on the Net symbol, all AES67 cards in the Artist network will be displayed. Ports with established connections will

be green.

If the option  is activated, only configured ports will be shown in the list.
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The Master port is displayed on top, while the slave ports are displayed below and indent. Only the Master port show

values of IP statistics. The fields of the slaves remain empty. If the Master is connected and audio is/can flow, the slaves

are displayed green. The table is sorted by inputs and outputs. Client card statistics are shown for master and slaves.

You can choose which statistics are displayed by clicking the  button. Press this button to customize the

view.

Figure 403: AES67 statistics configuration

Select the desired statistics from the overview window. By activating the  option, the statistics will

also be saved in the "Director.log" file, which is saved in the same directory as the Director program.



295

Director 7.20 User Manual A10

4.15 DANTE

The DANTE-108 G2 client card allows to route audio from and to Dante devices. 

It is not possible to connect Riedel panels to the Dante card.

Each Dante card supports 8 ports that can be configured as input or output.

Since version 7.20 it is possible to select a Dante split as port type.

Per default this device has 1 Channel per Stream and is occupying 1 port of the 8 in Director.

It is not possible to "enable the 2nd audio channel" feature at the port input.

The online state of input and output is always identical in the Dante world.

It is not possible to use the Dante interface as trunkline.

The channel names have to be unique within the Dante device. To guarantee uniqueness, the channel names are taken

from the Director generated Longname for Dante Inputs or Outputs. Not supported characters will be replaced by a "-"

hyphen. Changing names on the Artist side pushes the change to the Dante controller. Name changes on the Dante

side are not covered by the Director.

Please take care of following restrictions:

· Dante labels are up to 31 bytes in length.

· Name comparisons are case-insensitive.

· Device names should follow DNS hostname rules. Legal characters are A- Z, a-z, 0-9, and '-' (dash or hyphen). Device

names cannot begin or end with a hyphen.

· Device names must be unique on the network.

· Channel names may use any character (coding is UTF8) except '=' (equals), '.' (full stop or period), or '@' (at).

· Channel names must be unique on a device.

· Channel names do not need to be unique on the network, as they are always qualified by device (channel@device).

Not supported characters will be replaced by a "-" hyphen.



296

Director 7.20 User Manual A10

4.16 VoIP

VoIP-108 client cards are available for the Artist 32/64 and Artist 128. The VoIP card allows 8 ports to be distributed via

an Ethernet connection. You can choose whether you want to use the ports for 4-wires, 4-wire splits or control panels.

Sending 4-wire ports over VoIP cards is an easy way to connect two Artist networks with one another. For example,

using the "Trunk-Navigator", IP connections could function as "Trunklines" (for trunking details, see chapter "Trunking").

An additional interface on the panel side is required to remote a control panel over a VoIP connection (for example,

CONNECT IPx8, CONNECT IPx2). The interface converts the IP data to an Artist compatible AES signal.

Figure 404: VoIP – Application example
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4.16.1 VoIP - Client Card Properties

To add a VoIP client card to the configuration, select the desired bay in the node configuration and choose the VoIP-108

G2 client card.

Figure 405: VoIP – Adding a VoIP-108 G2 client card

After adding the card, you can define the port types for the 8 available ports. All available port types can be selected on

a VoIP card.

Switch to the "Network" view to set the default settings of the VoIP card. Right mouse click on the card and choose

"Properties".

Figure 406: VoIP – Opening the VoIP Properties
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In the "Properties" window you can enter the IP settings for the VoIP 108 card.

Figure 407: VoIP – Properties of the VoIP-108 card

Enter the IP address that the card should use in your local network in the "IP-Address" field.

The local IP range can be set in "Network mask".

To enable access to other IP networks (for example, internet access), enter the IP address of your router in the "Default

Gateway" field. Contact your network administrator for details.

Figure 408: VoIP – IP settings
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Automatic IP-Address - DHCP4.16.1.1

Up from version 6.30 all Riedel VoIP-products support the "Dynamic Host Configuration Protocol" (DHCP). This protocol

is assigning an automatic IP-address and Subnet mask to the network device. With DHCP you can connect any network

device to your local network without worrying about IP-addresses. The only thing you need is a DHCP-Server connected

to the network, the VoIP card is connected to. The DHCP-server administrates all addresses within the network. As soon

the VoIP card is connected to the network and the DHCP feature is enabled, it is asking the server for an IP-address.

The server will now forward an available address to the VoIP card.

The usage of a DHCP-server is usefully when you are managing big networks with changing topologies and network-

members, or just when you want to have an easy network setup. When you want to use a VoIP-card with DHCP in

different networks (for example OB-Vans), you don´t need to care about the ID-address anymore. All settings and

restrictions can be made in the setting of the DHCP-server by your network administrator. At the moment the VoIP

DHCP mode is working only in IPv4 networks. IPv6 is not yet supported.

To activate the DHCP function of a VoIP-card you have to open the "Properties" of the card in the Network tab. Now

enable the function "Obtain IP address automatically". The input mask for manually entered IP-addresses will be

deactivated. Any address in these fields will now be ignored.

Figure 409: VoIP card – Activating DHCP

When you activate the DHCP functionality while the VoIP card is already connected to a network, all connected SIP

connections will be disconnected. As soon the card gets its new IP-address and Subnet settings from the DHCP Server,

all SIP connections are reconnected automatically.

The IP-address of the VoIP card, assigned by the DHCP Server, is shown in the "IP Statistic - Online View" window.

Maybe you have to configure the IP Statistic - Online View to enable showing this information. For details see chapter

"VoIP-Statistics".

 

Figure 410: VoIP Statistic – Showing the allocated DHCP address

When DHCP is activated for a VoIP card, but no DHCP-Server is connected to the network, the card is

getting no valid IP-address. Also no Zeroconf address. In this case, the IP-address of the card is shown as

0.0.0.0.
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VoIP - DNS4.16.1.2

DNS serves as a "phone book" for the network by translating IP addresses into human-friendly computer hostnames.

DNS allows connecting to network members by entering the unique DNS-name. You can decide if you want to enter

the IP-, or the DNS address to connect to a device. Also if the IP- address of a device has been changed in the same

network, you can reach it always with the DNS name.

If your network supports the DNS (Domain Name System) functionality, you can enter the IP address of your DNS-

Server into "Primary DNS server". If you have also a secondary DNS Server, you can enter the IP in into "Secondary DNS

Server".

If DHCP is activated for the VoIP-card (see "Automatic IP-address – DHCP"), the card can also get the DNS-address

automatically from the DHCP server. To use this functionality enable .

You can enter the DNS host name of your VoIP card in "DNS hostname".

 

Figure 411: VoIP – DNS settings

DNS is only available for IPv4 networks. IPv6 networks are not yet supported.

VoIP - SIP Port4.16.1.3

If the standard SIP-port 5060 is already in use within your network by another SIP application, you can choose another

SIP port for the Artist VoIP communication. Contact your network administrator to get a usable port. You can enter the

new port setting in "SIP TCP/UDP Port".

The Sip port is related to all 8 matrix ports on this VoIP card. The settings of all devices connected to this

card (Panels, VCP-10xx, SIP-Phone, etc.) needs to be modified to the same SIP port setting (for VCP10xx see

chapter "Setup VCP-1004/VCP-1012").

Figure 412: VoIP – SIP Port
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VoIP - QoS4.16.1.4

Quality of service is the ability to provide different priorities in your network to different applications, users, or data

flows, or to guarantee a certain level of performance to a data flow. For example, a required bit rate, delay, jitter,

packet dropping probability and/or bit error rate may be guaranteed. Quality of service guarantees are important if the

network capacity is insufficient for applications such as voice over IP, since these often require fixed bit rate and are

delay sensitive, and in networks where the capacity is a limited resource, for example in cellular data communication.

Please contact your network administrator if there is already a QoS code for VoIP application available in your network.

You can enter this code in "Quality of Service" "Differentiated Services Code Point (DSCP)" to prioritize the Artist VoIP

packets. The default setting is "0", so no QoS support. For more details please see the "Riedel Network Planing Guide".

You can download this document at www.riedel.net, when you are logged in as member.

Figure 413: VoIP – QoS settings

VoIP - Ethernet Link Mode4.16.1.5

In the "Properties" of a VoIP-card you can also adjust the "Ethernet Link Mode". If the "Autonegotiation", so the automatic

network speed adjust, is not supported or not allowed in your network, you can set a fix speed settings for the

Ethernet-Interface of the VoIP-card. Please contact your network administrator if this is needed in your network. You

can also display the chosen network speed in the "VoIP-Statistics" window.

Figure 414: VoIP – Ethernet link mode

Figure 415: VoIP- Statistic- Ethernet Link Status
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4.16.2 Creating VoIP Ports

Create the port type you want to connect to the VoIP card in the hardware setup of a node. It is the same procedure

then creating a port type on a standard digital client card. On a VoIP card you have 4 different possibilities.

Þ 4-Wire / 4 Wire-Split

VoIP-connection to another Artist system (also an installed VoIP card required).

Only Audio is transmitted via VoIP. You can free route this audio in the destination system.

Þ Any hardware Panel type

You can connect any panel or analog/AES 4-Wires. A Riedel Connect IPx2/x8 is required on the opposite side.

A RIF-2064 cannot be connected via VoIP to the Matrix caused by technical protocol differences of the RIF-

2064.

Þ Software Panel

Any PC with the VCP-1004/1012 Softpanel, soundcard and network connection installed can be connected to a VoIP

card. You can use your PC as a full member of the intercom system. Per VoIP port you can use one Softpanel.

Þ SIP Telephony

Any PC with the VCP-1004/1012 Softpanel, soundcard and network connection installed can be connected to a VoIP

card. You can use your PC as a full member of the intercom system. Per VoIP port you can use one Softpanel.

You can completely free mix these possibilities within a VoIP card.

Select the port type you want to use for every VoIP port in the hardware setup:

Figure 416: VoIP – available port types

Now you can set the IP parameters for the individual ports. Right mouse click on a port and select "Properties". Choose

the "VoIP" tab.
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Figure 417: VoIP – Properties of a VoIP port

Remote Host Enter the destination IP address that this port should connect to.

Remote SIP-ID Enter the name of the destination port that should be connected to.

VoIP cards usually use the name "Port ‘number x".

Local SIP-ID Enter the name of the local port. VoIP cards normally use the name "Port ‘number x".

Audio Codec Select the desired audio codec. Depending on the quality of the codec, a larger

bandwidth may be required. The following codec’s are currently available: PCM, G.711,

G.722 PLC.

Audio Packet Size Enter the audio packet size. Many transmission failures can be resolved by choosing

the smallest possible packet size.

Receive Buffer Size Set the receiving buffer size. The larger the value, the more information from the

stream is temporarily saved. This will also increase the audio delay. This value should

be adjusted depending on the quality of your IP connection.

QoS Some network devices support "Quality of Service". That means that certain data

packets have priority over others, such as internet data.

Voice activity detection

(VAD)

This option reduces data transmission. Data will only be transmitted if it contains an

audio signal.

Enter the values required by the remote station to establish a connection.

To connect two Artist systems via VoIP-108 G2 cards, select a 4wire/4wire split as port-type and set the parameters in

the remote system using its Director software.

If you want to remote one or more panels/4-wires over VoIP using a CONNECT IPx2 or x8, you must first set the

parameters of the CONNECT IP and the individual ports using the corresponding web interface. For details, see chapter

"Distribute a panel/4Wire with Connect IP X2/X8". To remote a control panel over VoIP, a data rate of at least 80kB/s is

required, depending on the audio codec.

As soon as all of the parameters are correctly set up, the IP connection will be automatically established. If a

destination port is connected, it will appear green in the Director Port-List. The individual VoIP ports can be configured

and assigned functions like any other port in the system.
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4.16.3 Bandwidth Calculation

The VoIP transmission is based on two parts, control (signalization) data and audio data. The control data is very

constant and cannot be influenced by the user. The audio data depends on several factors:

· Configured audio codec

· Configured packet size

· Network type

· Jitter

· Voice activity (if enabled)

The bandwidth for the control data is quite constant: 20 kb/s.

Audio Bitrates required by the Codecs4.16.3.1

Each audio codec has different properties and one of it is the audio data bandwidth.

This is the data which is used for the raw audio excluding any network protocol overhead.

Codec

Required 

data bandwidth

Audio

bandwidth Notes

G711 µ-law 8k
64kB/s 3,5kHz

Mainly used in the USA

G711 A-law 8k Standard Codec

G711 µ-law 16k *
128kB/s 7kHz

Mainly used in the USA

G711 A-law 16k * Standard Codec

RARe µ-law *

64kB/s 3,5kHz

Riedel Codec. Similar to G711, 

but with better dynamics.

RARe A-law *
Riedel Codec. Similar to G711, 

but with better dynamics. (for USA)

G722 64kbps PLC * 64kB/s
7kHz

PLC= Packet Loss Concealment 

(automatic error correction) G722 48kbps PLC * 48kB/s

* not available for VCP-1004/VCP-1012 Softpanel

VoIP traffic is not streamed over the network. It is separated into packets.

For each VoIP channel the user can individually select the size of the packets: 20ms, 40ms, 80ms or 160ms. Default is

20ms. When the transmitter wants to send a packet, it has to wait until enough audio is available for sending, e.g. for a

40ms packet it has to wait 40ms. So the delay depends on the packet size. Small packets create less delay, but create

more protocol overhead, because you need to send more packets for the same amount of audio. E.g. 20ms packets

add 8 times the protocol overhead as 160ms packets.

UDP Protocol4.16.3.2

The audio data is encapsulated into UDP datagrams which adds protocol overhead.

Each packet UDP adds 64 Bits overhead resulting in additional bandwidth.

Audio packet size Packets/Second Bandwidth

bw UDP protocol

20 ms 50 3,2 kb/s

40 ms 25 1,6 kb/s

80 ms 12,5 0,8 kb/s

160 ms 6,25 0,4 kb/s
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IP Protocol4.16.3.3

The UDP packets are encapsulated into IP datagrams.

Each IP packet adds 160 Bits overhead.

Audio packet size Packets/Second Bandwidth

bw IP protocol

20 ms 50 8 kb/s

40 ms 25 4 kb/s

80 ms 12,5 2 kb/s

160 ms 6,25 1 kb/s

Ethernet Protocol4.16.3.4

The network protocol depends on the network type. E.g. Ethernet is using the Ethernet protocol. Wide area networks

are based on DSL, Cable, E1, T1 etc. and use other protocols and therefore create different overhead. Thus the same IP

traffic results in different network traffic between the LAN and the WAN. This example only handles Ethernet networks

as an example.

The Ethernet protocol adds 144 Bits overhead for each Ethernet packet.

Audio packet size Packets/Second Bandwidth

bw Network protocol

20 ms 50 7,2 kb/s

40 ms 25 3,6 kb/s

80 ms 12,5 1,8 kb/s

160 ms 6,25 0,9 kb/s

Jitter4.16.3.5

Jitter is the time variation of the VoIP packet transmission. It has an influence on the bandwidth, since the transmission

is not constant when there is network jitter. Regarding a limited timeframe, it can happen that there are less packets

transmitted, resulting in a lower bandwidth. Of course the opposite can also happen, resulting in a temporary higher

bandwidth. Theoretically the temporary bandwidth could be infinite. It’s nearly impossible to calculate the bandwidth

variation caused by Jitter beforehand. As an advice it’s a good idea to have 25% bandwidth reserve. The user should

check the Jitter and the bandwidth variation when the system is installed.

For more detailed information, please check the "VoIP Network Planning Guide", available for download in the

www.riedel.net member area.

Packet-loss Consequences like

0...5 % No changes

5...10 % Audible interferences, but communication is still possible

10...20 % Telephone booth at train station

20...40 % Conversation with mobile phone with poorest signal, near to be interrupted

40... % No communication possible 
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Calculation Example for a VoIP SIP-Port4.16.3.6

Audio Codec: G.722, 64kps

Audio Packet size: 20ms

Network type: Ethernet LAN

Bandwidth Total = bw Control Data => 20 kb/s

+ bw Audio Codec => 64 kb/s

+ bw UDP Protocol Overhead => 3.2 kb/s

+ bw IP Protocol Overhead => 8 kb/s

+ bw Network Overhead => 7.2 kb/s

102,4 kb/s

Artist VoIP channels have a configurable Voice activity detection (VAD) flag. Per default it is enabled, which means that

the audio transmission stops, when the audio drops below the Vox threshold. In this case the bandwidth is reduced to

bwControlData (20kb/s). The network should always be designed to transmit the bandwidth for a permanent audio

signal, but VAD is a nice feature to reduce the data volume in practice.

This calculation is just a theoretically example. It is not paying attention of any local network factors like

Jitter, etc. So you have to add around +25% bandwidth overhead to be on the save side.
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4.16.4 Distribute a Panel / 4-Wire with CONNECT IPx2/x8

Figure 418: CONNECT IP x2/x8

With the Interfaces CONNECT IPx2 and CONNECT IPx8 you can distribute 2-, resp. 8 – Matrix ports via VoIP. By defining

the hardware you can choose if you want to use digital Panel ports (AES) or analog audio ports as IO´s on the

CONNECT IPxX. Every port can be connected to another VoIP-client card. This means, you can connect one CONNECT

IPxX to different matrixes at the same time. The assignment of the ports is just done by the IP-address and the SIP-ID´s

in the different Systems.

Figure 419: CONNECT IPx2/x8 – Application example

Configuration of the CONNECT IPx2/x84.16.4.1

To edit the basic setup of the CONNECT IPx2/x8 you have to connect the device via a LAN to a PC. Please note, that the

PC and the CONNECT IPxX needs to be in the same IP range.

The Default IP-address of a CONNECT IPxX is 192.168.42.160.
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Open any Internet-Browser on the PC and enter the IP-address of the CONNECT IPxX to get into the web interface of

the device.

Figure 420: CONNECT IPxX – Open the web interface

Login to the web interface:

Username: Admin

Password: Admin

Figure 421: CONNECT IPxX Login

Now you have access to the web interface. On the homepage you get general information about the device, like IP-

address, software version and status.

Figure 422: CONNECT IPxX – Web interface – Info
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In "Network Configuration" you can change the IP-address, Netmask, Gateway, DNS-Server and SIP-Port manually. Also

the Ethernet link mode (Ethernet-Speed) can be set manually to a fix value if needed.

 

Figure 423: CONNECT IPxX – Web interface – Network Configuration

Only change the default SIP-Port, if the default Port 5060 is already used by another application in your

network. When you change the SIP-Port in the CONNECT IPxX, you also have to change the SIP-Port on the

connected VoIP-cards. In this case, the new SIP-Port is used for all 8 Ports of the VoIP-card. See chapter

"VoIP – SIP Port".
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Up from Client version 6.40C13 also DHCP is supported. If you want to use DHCP-mode, you have to enable the flags

"Obtain IP address automatically" and "Obtain DNS Server address automatically". It is necessary to enter a valid DNS

hostname for the IPxX in the network.

Figure 424: Connect IPxX – Web interface – DHCP Settings

Press "Apply" to accept the new settings. In the following window press  to

reboot the CONNECT IPxX with the new settings.

If needed, you can also change the Device name, Username and password in "Device Configuration".

Figure 425: CONNECT IPxX – Web interface – Device Configuration



311

Director 7.20 User Manual A10

In "Port Configuration" you can give different names (= SIP-ID) to the single ports of the Connect IPxX. The default-

names for the ports in the CONNECT IPxX and the VoIP-card is "Port1–Port8". With the button "Apply" you can accept

the new SIP-ID's per port.

Figure 426: CONNECT IPxX – Web interface – Port Configuration

Exactly the same names (SIP-ID´s) need to be used for the Director configuration of the ports. This is

necessary, because the configured port on the VoIP-card and on the CONNECT IPxX uses this ID to

connect. You can change the SIP-ID in the Director configuration in the "Properties" of the VoIP-Port.

When you are using a Stereo AES 4-wire with separated channels (see chapter "Configuring a 2 channel 4-

wire port"), you have to activate the flag "Insert the audio of the next port…" for the port in the web

interface. Then the audio of the following even port is routed to the second channel of the odd port. A 2-

channel Panel or 4-wire (with second channel flag active) will be detected and routed automatically. On a

Connect IPxX with an AIO rear card this function is not available.

The first AES channel needs to be configured on an odd VoIP-port. The second AES channel on the following even port.

Now the VoIP 4-Wire ports needs to be configured in the Properties to two following SIP-IDs of the destination Connect

IPxX t. Also on the Connect IPxX side the first AES channel have to use an odd, the second channel an even port.

Figure 427: CONNECT IPxX – Configuration of a 2-channel AES 4-Wire in Director
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In the web interface of the Connect IPxX you now have to activate the option "Insert Audio of the next..." to embed the

second channel to the previous port. Press "Apply" to confirm the changes.

Figure 428: CONNECT IPxX – Web interface – Port Configuration second Channel

In the status view of the Connect IPxX the merging of the 2 AES channels is shown:

Figure 429: CONNECT IPxX – Status AES 2-channels merged to one port

An already configured panel in 2-channel mode, or a 4 wire (with second channel activated in the properties) is

automatically detected and internally routed by the Connect IPxX. Also here the audio of the second port is merged to

the previous port, so that the even port cannot be used anymore.

Figure 430: CONNECT IPxX – status display of a 2-channel Panel
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When an even port is already used by another connection, the status view in the web interface will show a warning that

the port is already in use. In this case you have to reroute the even port to another port, or remove the flag for the

second channel.

Figure 431: CONNECT IPxX – Conflict message 2. AES channel

All further settings will be done in the Director configuration.

For more detailed information about the CONNECT IPxX please read the "CONNECT IPx2-8 Setup" guide, you can

download from www.riedel.net as registered user.

Configuration of the VoIP-Ports in Director4.16.4.2

When you have created a new port, for example a panel on a VoIP-card (see chapter "Creating VoIP Ports"), open the

"Properties" of the port with a right click on the port. Open the "VoIP" tab.

Now enter the IP-address and the exact SIP-ID of the port on the CONNECT IPxX that should be used.

Figure 432: CONNECT IPxX – Director – Port Configuration
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Choose the audio codec, audio packet size and receive buffer size for this port you want to use (see chapter

"Bandwidth calculation").

These settings only need to be set in the Director configuration. When the CONNECT IPxX is connected, all

settings are automatically set for this port in the CONNECT IPxX.

ATTENTION:  An update of the Panel firmware via a CONNECT IPxX is NOT possible!

When the CONNECT IPxX is connected, you can see the status of all ports in the VoIP Statistic of the Director or in the

Web interface > "Status" of the CONNECT IPxX.

Figure 433: CONNECT IPxX – Web interface – Status
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4.16.5 Softpanel VCP-1004/VCP-1012

Up from version 6.10 you can also use the free virtual Softpanel VCP-1004 and the fee required VCP-1012 to be

connected to a VoIP card.

With the VCP-10xx you can use any Windows® PC as a full intercom member. A soundcard and a connection to the

VoIP network are required. For audio in- and output the sound device of your PC is used, that is set as default in your

PC settings.

There are 4/12 keys on 2 layers available. They can be configured like any other panel key by the Director. To operate

the keys a PC-Mouse is required.

Figure 434: VCP-1004 / VCP-1012

For every Softpanel one port of the VoIP card is required. 

Installation of the VCP-1004/VCP-1012 Softpanel4.16.5.1

Download the VCP-1004 Softpanel from www.riedel.net. Unpack the file in any folder.

A double click on "VCP-1004-Setup.msi"/"VCP-1012-Setup.msi" will start the installation process.

The VCP-1012 is fee required. Starting and using the panel is only possible, if you have a Riedel USB-

Dongle installed and connected to your computer with this feature enabled.

The required "NET Framework 2.0" will be installed automatically if it is not yet installed on your PC. With "Setup.exe" you

can start the "Dotnetfx" installation also manually.

Figure 435: VCP-10xx – Softpanel Setup-Files in Explorer

  >  

Figure 436: VCP-10xx – Installation
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If you want you can select another folder to install the application. Select if this application should be installed for all PC

users or only the actual one.

  >  

Figure 437: VCP-10xx – Installation

When the VCP-1004/1012 is successfully installed, you can find the application in the program group "Riedel". A

shortcut on your Desktop will be automatically generated.

    

Figure 438: VCP-10xx – Starting VCP

Setup VCP-1004/VCP-10124.16.5.2

To start the Softpanel, double click the icon .

If your PC is not yet connected to any network the VCP-10xx will show "No Link" in the Displays.

Figure 439: VCP-10xx – No Link

Connect your network card with a LAN network. The VCP-1004 will show "Wait_for connect" automatically.

Figure 440: VCP-10xx – Wait for Connect
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Press the  button, to change to basic settings of your Softpanel. In the options window you can enter the SIP-

Username of your panel.

Figure 441: VCP-10xx – SIP-Name

The same SIP User name needs to be used later also in the Director configuration.

In "IP-Address" automatically the IP-Address of your PC network card is used. If you have more network cards installed,

you can select, which IP (>network card) should be used for the VCP-1004.

Figure 442: VCP-10xx – IP Address

Figure 443: VCP-10xx – SIP Port

In "Local SIP-Port" you can change the network port for the SIP connection to be used. For example, if the default SIP-

port 5060 is already used by another application on your PC.

The SIP-Port of the VCP-10xx and the Sip-Port of the VoIP-card the panel is connected to needs to be

identical.

In the properties of the VoIP-card you can edit the SIP-Port of the VoIP-card. If you change the SIP-Port, all

8 Ports of the VoIP card are affected!

See chapter "VoIP – SIP Port".
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Configuration VCP-10xx in Director4.16.5.3

Do a double click on a Node in the Network-Tab to open the hardware configuration. Select the port of the VoIP card

you want to use for the new Softpanel. Create a new VCP-1004 panel by selecting it from the drop-boxes

"Miscellaneous" > "VCP-1004".

Figure 444: VCP-10xx – Creating a new VCP-10xx

Afterwards the new panel will show up in the "Port" and also in the "Network" tab of the Director.

Open the properties of the new VCP-10xx with a double click on the displayed panel or by doing a right click on the

panel in the Network- or Port list. Select "Properties".

Figure 445: VCP-10xx – Director-View VCP-1004
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Select the tab "VoIP" to configure the connection settings to the VCP-1004. All other tabs are nearly identical with

standard panels.

Enter the IP-address of the PC with the installed VCP-1004 into "Remote Host".

Also enter the SIP-ID of the Softpanel into "Remote SIP-ID" and "Local SIP-ID". The ID needs to be identically with the ID

given in the settings of the VCP-1004 application.

Figure 446: VCP-10xx – Properties of VCP-10xx – VoIP

Depending of the quality of your network, you can now also adjust the audio-codec type and also the "Audio Packet

Size" and "Receive Buffer Size" if it is necessary to get a stable connection to the Softpanel.

Now you can configure the keys of the VCP-1004 in the Director like on all standard panels.

Send the configuration changes to your Artist system.

When all settings are correct and the Softpanel application is running and connected to the network, the VCP-1004 on

your PC should now connect to the Artist.

Figure 447: VCP-10xx – Connected VCP-1004 Panel

The panel will now also show a green online status in the "Port" tab of the Director.

You can now also monitor and control the VCP-1004 panel in "Live View" and "Remote Control" in the Director like every

other hardware panel.
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Operate VCP-10xx on the PC4.16.5.4

The VCP-10xx Softpanel is using the standard sound device installed in your PC for incoming and outgoing audio. If you

want to change the audio device (for example to an USB-Headset) you have to set the new device as default in your

Windows settings. Restart the VCP-10xx application to use the new device for your Softpanel.

To press a key on the Softpanel just move your mouse to the key and press the left mouse button.

Figure 448: VCP10xx – Activating a key on VCP-1004

To change the volume of a key, you have to click the rotary encoder and keep the mouse button pressed. Now move

your mouse in circles to change the volume. If you just do a short click on a rotary encoder, you can mute/unmute the

incoming audio of the key.

Figure 449: VCP10xx – Changing Volume on a VCP-1004

Press  button to switch to the second page of the panel. When the Panel shows the second page, the "Shift" button

is marked yellow .

Like on all other panels you can enter the option menus of the panel with the buttons  and  + .

On the "Opt" page the keys show on which Port of the Artist system this VCP-1004 is connected to and also the own

name.

The installed Client version and the used Room-Code for this panel is shown in the keys when you first press  and

then .

 

Figure 450: VCP10xx – Option Display

With the  button you can minimize the VCP-1004 to the Taskbar. Press the button  to minimize the application to

the system tray . In both situations the application is still active and incoming audio is coming out of your

speaker.

When the VCP-1004 is losing the connection to the VoIP card, it will show also up in the symbol of the task bar.

 > VCP-1004 not connected and  > VCP-1004 connected. Press the  button to close the VCP-10xx.
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4.16.6 SIP Telephony

To use IP telephony, an installed VoIP card and an available SIP Server is necessary.

Create a new port on a VoIP card in the node configuration table. Choose "Miscellaneous" > "Sip Phone Connection" to

create a new SIP Phone. This SIP phone is now working like a standard telephone codec with a straightforward

telephone number.

Figure 451: SIP phone – creating a new SIP Phone

The new SIP Phone shows up in the "Network" tab with its own symbol.

Figure 452: SIP Phone – SIP-Phone in the Network

SIP Phone - Basic Setup4.16.6.1

Before you can use IP telephony, you have to know the needed log-in information to your SIP Server. These account

information need to be entered into the Artist configuration.

Open the "Properties" of the SIP-Phone port and go to the "SIP Phone connection" tab.

Figure 453: SIP Phone – connecting to a SIP-Server
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Following data's need to be entered, that the VoIP port is able to connect and log-in to a SIP server. Please contact your

network administrator or phone provider to get all needed information.

Domain server (SIP PBX) Enter the DNS-Name or IP-address of your SIP Server (also called Registrar) the

VoIP card need connect to.

Proxy Server If you are using a connection via a Proxy Server, enter the address here.

Username (SIP ID) Enter the SIP-ID or Username for your phone port.

Display name Here you can enter a name, which should be displayed on other compatible

phones, when this port is calling. Not all PBX are supporting this feature.

Authentification username Login name for this telephone member on the PBX system.

Authentification password Login-password for this telephone member on the PBX system.

Reregister time(s) Enter the time, the port should reconnect and reregister to the PBX system.

Depending on the used PBX.

SIP transport protocol Select if the UDP or TCP IP protocol is used for the communication with the PBX.

Depending on the used PBX.

Policy By default the VoIP card evaluates the Username and Domain name of incoming

calls. Calls from Domain-Servers with different names will be refused.

If this checkbox is enabled, only the Username of incoming calls will be evaluated.

Calls from different Domains will be also accepted in this case.

Enable auto hangup If there there is no data transmission between the VoIP card and the remote

device for more than 30 seconds, the line is disconnected by default. The auto

hangup feature can be disabled by deactivating this checkbox.

When all settings are correct, the SIP port should connect to the PBX. The SIP port will show green in the "Ports" tab.

Also you can see the connection status in the IP Statistic - Online View window (see chapter "VoIP Statistic").

Figure 454: SIP Phone – successful log in to SIP Server

If your PBX is using a different SIP-Port, you can adjust it in the "Properties" of the VoIP card.

Creating of Pool-Ports4.16.6.2

Pool-Ports are the members that belong to a SIP Port. You can create several members with unique names, which can

use the connection of a single SIP port. All are using the same outgoing number but can have different destination

numbers configured. In "Phone No. Incoming" in "Properties" of the Pool-Port you can add a fix allocation to designated

incoming numbers. Only one Pool-Port can use the Sip-Phone connection at the same time.

To create new Pool-Ports open the "Properties" of the Pool-Port and go to the tap "Port Pool".
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Figure 455: SIP Phone Properties – Pool-Ports
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Press  to add a new Pool-Port. Minimum one Pool-Port is required per SIP Phone. The number of Pool-Ports per

Sip Phone is not limited.

Select one of the Pool-Ports and press  to define this Port as "Voice default". This settings tells the system,

which Pool-Port should be used, when a caller with an unknown number is calling into the system.

Figure 456: SIP Phone – creating Pool-Ports and defining Voice defaults

Also if only one Pool-Port is created, you have to define it as "voice default" to accept incoming calls with

unknown or not configured numbers.

If the Pool-Port should only accept incoming calls of a defined number, you have to enter this number into

"Incoming number" in the Properties des Pool-Port. All other incoming calls will be blocked.

You can see all created Pool-Ports also in the "Network" list of the Director underneath the SIP Phone port.

Figure 457: SIP Phone – Pool-Ports in the Network
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Configuration of Pool-Ports4.16.6.3

Open the "Properties" (right click->Properties) of a selected Pool-Port to edit the basic settings.

The tabs "General", "Details 1+2" etc. are identically to the settings of an ordinary 4-wire. To edit the telephony

connection settings open the new tab "SIP phone connection, pool port".

Figure 458: SIP phone – connection, pool port

In "Phone No. To dial" you can enter a telephone number to call, when this port is activated with the "Dial" function. If

you want to dial different numbers via a telephone keypad this field can also stay empty.

In "Phone No. Incoming" you can enter a number (or just a part of a number), that is allowed to call this Pool-Port. Now

only callers with this number (or part of the number) are accepted. All other callers will be blocked.

In "Audio Codec" you can select the audio codec and audio quality which should be used, when you are starting an

outgoing call. You can select G711 or G722 with a bandwidth of 64kBit/s each.

Figure 459: SIP Phone – Audio Codec's
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Depending of the quality of your network, you can adjust the size of the "Receive Buffer". The size of these settings

dedicates how many ms of the incoming audio should be buffered to avoid audio drops. In a bad network this setting

can improve the quality of the audio but also increase its delay. Default is 160ms.

Figure 460: SIP Phone – Receive Buffer

For details see chapter "Bandwidth calculation".

In "Invitation" you can choose the mode of the outgoing call.

If "Manual" (default) is selected, the destination number will be dialed only manually by using the "Dial" function.

If "Auto" mode is chosen, the defined number will be dialed automatically as soon the VoIP card is started. So it

establishes a permanent connection like a leased line. For example to use as a "Trunkline".

Figure 461: SIP Phone – Invitation

The configuration to use SIP PortPools on panels is identically to the telephony with CONNECT SOLO/DUO (see chapter

"Setting up a panel to use a CONNECT/SIP codec").
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4.16.7 VoIP Statistic

Using the "IP Statistics" function, you can monitor all VoIP connections by various criteria.

Click the  button in the tool bar to open the window and select the  tab.

Figure 462: VoIP statistic

All available IP connections for the card selected will be displayed under "Detected VoIP Cards" on the left. If you click on

the Net symbol, all VoIP cards in the Artist network will be displayed. Ports with established connections will be green.

If the option  is activated, only configured ports will be shown in the list.

You can choose which statistics are displayed by clicking the  button. Press this button to customize the

view.

Figure 463: VoIP statistics configuration
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Select the desired statistics from the overview window. By activating the  option, the statistics will

also be saved in the "Director.log" file, which is saved in the same directory as the Director program.

After you have selected a VoIP card, you can also generate an audio test signal to test the audio connection. Click the

 button.

Figure 464: VoIP statistics – Signal generator

This window allows you to set the test signal frequency that should be sent to or from the card. Also select the source

of the test signal and the channel.

To shut off the signal generator, click the  button.
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4.17 AVB

Audio Video Bridging over Ethernet (AVB) is a set of IEEE standards for transporting audio and other real-time content

over Ethernet using Layer 2.

To use the AVB protocol within your network, your Switches have to support AVB and also PTP (IEEE1588 Precise Time

Protocol). The protocol for allocating bandwidth is called the Stream Reservation Protocol (SRP, IEEE 802.1Qat). It forms

a fundamental building block of the AVB standard. All nodes in the system (switches and endpoints) must implement

SRP and shape traffic by sending real-time traffic.

When using a CAT5-108 or AES-108 front cards in combination with an AVB-108 G2 rear cards, panels or 4-wires can be

connected via an AVB capable network to the Matrix.

SmartPanels (2300 series) can be connected directly to an AVB-switch, as the SmartPanels supports the AVB-mode per

default.

1100 series panels (only 19"-versions) can be equipped with an optional CPX-AVB option card, to connect them directly

to an AVB.

DCP-1116, CCPs, older Panel types and 4-wires can be connected via a Connect-AVB interface to the Matrix, which

transforms AVB streams into 8x AES3 or 8x analog audio ports.

Figure 465: Artist AVB network
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4.17.1 Configuring an AVB port in Artist

An AVB client card in Artist consists of a standard CAT5-108 G2 front card + an AVB-108 G2 rear card. The management

and routing of the single AVB-streams is finally done with external Software called "AVB-Manager".

So from the Artist perspective there is no special configuration necessary.

To configure an AVB Client card to a Matrix, just select a standard CAT5-108 G2 card to your Node configuration. For

details see chapter "Adding a new matrix card".

Figure 466: Adding an AVB card to a Node

Now you can add your Panels or 4-Wires like on an ordinary CAT5 card.

4.17.2 AVB-Manager

To connect the AVB streams of Artist and Panels or Connect AVB interfaces, a separate Software called "AVB-Manager" is

required.

You can download this software for free from the Riedel Website when you are registered:

https://www.riedel.net/en/customer-support/downloads/avb-manager/

Following will just show the basic steps to create the needed stream connections in the AVB-Manager.

For detailed information about this software please refer to the AVB-Manager manual.
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Identify Connected Devices4.17.2.1

Please install and run the AVB-Manager on a PC that is also connected to the AVB-Network where all AVB-components

are connected to.

Figure 467: AVB-Manager – Splash Screen

When the AVB-Manager has started, please select the network interface which is connected to the AVB network.

Detection, configuration and firmware updates are also working if the AVB devices are connected to a non-

AVB capable network.

All AVB capable and to the network connected devices will show up in the list "Entity Properties" with their entity ID.

Figure 468: AVB-Manager – detected Entity IDs
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When selecting an entry in the Entity properties, you can find the device that is connected, when scrolling down in the

"Descriptor Values".

Figure 469: AVB-Manager – Finding Model name

In the "Descriptor Values" you can also enter a device name (e.g. panel Name) and a Group this device belongs to for

easier administration. When pressing "Enter", or selecting another field, the name is automatically taken and send to

the device.

The name and group label is stored inside the device. This means, next time the AVB-Manager is started also on

another PC, it directly shows the device name and group of the connected devices.

Figure 470: AVB-Manager – Name and Group labels

Routing the Streams4.17.2.2

Open the "Connection Management" to set the routings of the single streams.

Figure 471: AVB-Manager – open Connection Management
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All AVB Talkers and Listeners are shown in a XY- matrix. Make sure, "Bidirectional connection" in the "Connection mode"

is enabled.

Now you have to set the connections. Therefore just click on the corresponding XP, for example "AVB-108 OUT1" to

"RCP-1112 Light Intercom In". The corresponding mirrored crosspoint for the return path is set automatically.

Figure 472: AVB-Manager – Connection Management

Repeat this for all other needed crosspoints. As soon the crosspoint is clicked it is directly activated within the network.

When your AVB network is correctly setup, the panels will start.

Figure 473: AVB-Manager – creating crosspoints

The crosspoints are now saved within the AVB-devices. So it is not necessary to leave the AVB-Manager running all the

time, or restart it every time the system is restarted.

The AVB-Manager is only needed for the very first setup.

Firmware Update of AVB Devices4.17.2.3

If a firmware update of AVB devices (e.g. AVB-108G2 RC, CPX-AVB Module or AVB Connect) is necessary, this have to be

done with the AVB-Manager.

AVB-108G2 Rear card, CPX-AVB module (1100 series) and AVB Connect interfaces cannot be updated with

the standard Director Firmware update functionality.
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Start the Firmware update function of the AVB-Manager.

Figure 474: AVB-Manager – Firmware update

Select the device you want to update. By pressing "CTRL"+ Mouse-click you can also select more than one device to be

updated simultaneously. Press the "Load firmware file" button to select the right firmware file for the device you want

to update.

AVB-108 G2 rear card
AVB_108_ConnectAVB_1.xx.upg

AVB Connect Interfaces

CPX-AVB module CPX-H1.00.0-B03-S4.xx.upg

SmartPanel SmartPanel_FW_release_1_xx_xx.xfw

Figure 475: AVB-Manager – Firmware update

Press "Start update" to update the selected devices simultaneously. A progress bar shows the current status.

Figure 476: AVB-Manager – Firmware update

SmartPanel Firmware update:

After file transfer is complete, the file will be flashed to the panel’s memory (store).

Do not interrupt or power reboot the panels and wait until the panel reboots.

For details see chapter "Firmware update RSP2318 with AVB-Manager".
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4.18 Text Color, Fonts and Icons on 1100 & 2300 Series Panels

Up from version 6.50 it is now possible to change the text colors for all keys / panels and to show Icons for all panels of

the 1100 and 2300 series.

Therefore it is necessary, that all panels are running on the latest firmware version.

To update the 1100 series panels, connect them to the matrix and start the update via the "Online View"

window and select the firmware file and the Ports you want to update (details see chapter "Panel

Update").

For updating the 2300 series panels, please see chapter "Firmware update RSP-2318 with AVB-Manager".

ATTENTION: For using the Icon-set for the first time on the 1100 panels, it is necessary to run the update

process two times.

4.18.1 Changing Default Text color for all 1100/2300 Panels

To set up the default text color for all configured 1100 and 2300 series panels, you have to open the properties of the

"NET".

Figure 477: Open the NET-Properties

Select the tab "Key Defaults" in the NET-Properties.

Figure 478: NET-Properties- Key Defaults – 1100/2300 key text color
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Click the button "Default" to open the color palette and choose your favorite default color for all 1100 and 2300 series

keys.

Select one of the basic colors or mix your own color in the color mixer on the right side.

By pressing the button "Add color" you can add and select your favorite colors to the "user defined colors". Confirm

your selection with the "OK" button.

 > 

Figure 479: Color palette

As soon you confirm the new settings in the "NET-Properties" window with "OK" and you send the configuration to the

system, all default keys of the 1100 and 2300 panels will change to the new default text color.

If on the 1100 and 2300 series panels are already some manually color changed keys, or the panel default

is not the NET-default, these keys are not affected by changing the default text color.
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4.18.2 Setup Default Text Color for a single Panel

In the properties of the panel, you can also adjust the default text color for only this panel.

Just go to the "Details 2" tab in the properties of the panel.

Here you can set a default text color for all keys of this panel, as long there are not modified manually. The check mark

 will be deactivated.

Figure 480: 1100/2300 series – Properties of Panel – Details 2- Changing default panel color

If you later want to set the text color back to the NET default setting, just enable the check mark

"configuration default" again. The previous selected color will be lost for all Default keys on this panel.

Individual changed single keys on this panel will keep their text colors.
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4.18.3 Setup Individual Text Color for single Buttons

To change the text color for single keys on a 1100 or 2300 series panel, you have to open the "Properties" of the key you

want to change. To open the key-properties just do a right click on the key and select "Properties", or just do a double

click on the key.

Figure 481: 1100-series – Open key properties

Click on "Text color" and select the individual text color for this key from the color palette.

 > 

Figure 482: 1100/2300 series – key properties- select text color

The selected color is now used and shown for this key. The panel "Default" check mark disappears, as soon another

color as the default is chosen.

Figure 483: 1100/2300 series – Key properties – Color – Panel default

If you later want to set the text color back to the panel default setting, just enable the check mark "default"

again. The previous selected color will be lost.

When you apply your changes with "OK", the new text color for this key is also shown in the Director panel view.

Figure 484: 1100 Panel – changed text color in Director panel view

Repeat the procedure for all other keys you want to use individual text colors for.

Figure 485: 1100 series – Example with colored keys



339

Director 7.20 User Manual A10

4.18.4 Display Icons on 1100/2300 Keys

Up from version 6.50 it is possible to show additional predefined Icons on keys of the 1100 and 2300 series panels. So it

is possible to show an Icon + 8 characters per key.

To an Icon on a single key, you have to open the "Properties" of the key you want to show an Icon on. To open the key-

properties just do a right click on the key and select "Properties", or just do a double click on the key.

Figure 486: 1100-series – Open key properties

Click on the button "Icons" to select one of the predefined Icons for this key.

Figure 487: 1100/2300 series – key properties – General

You can choose from 39 available predefined Icons:

Figure 488: 1100/2300 series – Available Icons

The Icons are not combined with any functionality. If you change the functionality of a key, maybe it is

necessary to also manually change the Icon to a different suitable symbol.
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Choose the Icon you want to use from the list and press "OK". The selected Icon is also shown in the Directors panel

view.

Figure 489: 1100 series – Icon on a key

When you are using an Icon on a key, the font size of the label is automatically changed to a smaller size, so that the

Icon + the 8 characters are fitting on the display. To preserve the original font size, you can confine the labels to 6

characters only.

Therefore activate this check box: 

Now, the last 2 characters of the 8 character label will be cutted.

In the Director panel-view always only the first 6 characters of a label are shown on an OLED key with an

Icon. This is because this special font cannot be displayed in the Director software. The display on the

panel is showing all 8 characters, if the clip-function is not enabled.

Repeat these steps to show Icons also on other keys of the panel.

Figure 490: 1100 series – Example of different colors and Icons

The Icons are part of the firmware within the panels. To display the Icons correctly it is necessary to use

always the latest panel firmware version for the 1100 series. You have to update the panels two times in

order that the Icons are working correctly. See also chapter "Panel Firmware Update".

Note: When copying a key with Icon and text color with drag and drop to another 1100/2300 series panel, the Icon and

the text color are also copied.

If the key is copied to another panel series, only the label, key properties and the functions are copied. Text color and

Icons will be ignored.
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4.18.5 Kanji Support of 1100/2300 Series and Director

Up from Version 6.60 the Director Software and also the panels of the 1100 and 2300 series (Director 6.90) are able to

display kanji characters.

There is no special setting in the Director required, to switch to kanji. Responsible for the used character set is the

language setting of the Operating system, where the Director is running on and the Artist system is configured from.

The Director supports Unicode fonts. In Version 6.60 the internal font was adjusted, to display the Kanji characters

correctly in the Panel-View and the Crosspoint View.

Figure 491: 1100 series – display of Kanji characters

Figure 492: Director – display of Kanji characters 

ONLY the panels of the 1100/2300 series are able to display Kanji characters. If you put for example a call

to a panel with a label written in Kanji to a panel of the 1000/2000/3000 or 5000 series, it will only display

"????".

If you want to use Kanji on 1100/2300 series panels and you are using also some panels of a different

series within the same system, you have to adjust the key labels of these panels manually.

Figure 493: Kanji: other panel series do not support Kanji
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4.18.6 1100 Series - Screensaver

To expand the lifetime of the OLEDs, an integrated screensaver is started when the panel is not used for a designated

time. The screensaver has two states:

1. The brightness of the OLED is reduced to 50% of the configured brightness.

2. The OLED pixels are turned off and a jumping "R" indicates that the panel is still powered.

Figure 494: 1100 series – screensaver "Jumping R"

The screensaver reacts as follows: 

Panel is not connected to the matrix. After 5 minutes: jumping "R".

Panel is connected to the matrix. 

No active key-press, no incoming call.

After 20 minutes: reduced brightness.

After additional 160 minutes (2:40h): jumping "R".

When the panel is being called directly by a Call to Port, Call

to IFB output (port, no group), Call to IFB input (Vox).

(Call to Group, Call to conference, Route Audio, Listen to,

Remote key, Beep panel commands are not forcing the panel to

wake up from screensaver).

When the Panel is showing the jumping "R" it will

wake up to the reduced brightness. After 5 minutes

it will show again the jumping "R". Every call restarts

the 5 minutes timer.

A permanent direct call to the panel, 

no key-press on the panel.

When a permanent call to the panel is activated, it

will also show the jumping "R" after 160 minutes,

when no key is pressed.

Panel is on screensaver, now a permanent call starts. The Panel will wake up to reduced brightness. After 5

minutes it is showing again the jumping "R", even

when the call is still active.

Remote control of a panel in screensaver mode. The panel will wake up for 5 minutes with reduced

brightness.

Configuration changes send to a panel in screensaver mode.

The panel will not wake up. 

It will still show the jumping "R".

A local GPI IN is activated while the panel is in screensaver

mode.

A local GPI OUT is activated from external while the panel is

in screensaver mode.

Connecting/removing a Headset while the panel is in

screensaver mode (> Automatic HS detection switches the

"HS" button).

Panel in 4-Wire mode (without matrix). After 60 minutes: jumping "R".

The timings and settings cannot be modified. They are programmed fix inside the panel.

It is also not possible to completely switch off the screensaver.
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The panel keys will wake up with the configured maximum brightness as soon you touch any panel key, function key or

volume knob.

In the "NET-Properties" > "Port Settings" you can define the system wide behavior of the wake up scenario for the OLED

Panels.

Figure 495: NET Properties > Port Settings – Behavior of the 1100 series screensaver wake up

So you can decide what should happen, as soon you press any key or touch any volume knob on a 1100 panel with

activated screensaver (works up from Mainboard version 1.38).

Flag activated: When you press a key, the panel wakes up from screensaver and directly activates the function assigned

to the pressed key.

Flag deactivated: The first key-press (also for the function keys "Shift", "HS", "Opt", "F1", "F2" and all volume knobs) just

wakes the panel up from screensaver. No function is activated. So you have to press the key again to activate the

function.
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4.19 '4-Wire' Properties

The basic settings of a 4-wire port are defined in the port "Properties". The properties of a 4-wire can be opened with a

right mouse click on either the port in the network list or in port list, as well as by right mouse clicking on a port in the

Workspace. A double click on the port in the Workspace also opens the properties.

4.19.1 'General' tab (4-Wire)

The "General" tab manages the port names and other settings.

Figure 496: 4-Wire Properties – General tab

Long Name Unique name for the port that is used in Director (maximum of 32 characters).

Local Local Display name (maximum 8 characters). This name appears on control panel

keys.

Alias Allows the entry of a temporary name that is used system wide in key displays

where this port appears without changing the actual local name in the configuration.

Room-Code Activates a Room-Code for conferences. Room-Codes are used when control panels

or ports in the same conference are physically near each other. This helps avoid

feedback problems. Ports in the same Room-Code mute the audio between them as

soon as a conference is active.

Enable 2nd audio channel Activates the second audio channel of a digital port (this function is only available if

the port is connected to an odd numbered port and the next port is unused).
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4.19.2 'Details 1' tab (4-Wire)

The "Details 1" tab allows the parameters of incoming audio to be set.

Figure 497: 4-Wire Properties – Details 1 tab

Initial single volume Standard point-to-point and group call volume.

Initial conference volume Standard conference call volume.
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4.19.3 'Details 2' tab (4-Wire)

The "Details 2" tab allows Vox settings, signalization options and some miscellaneous options to be set.

Figure 498: 4-Wire Properties – Details 2 tab

Vox On-Threshold Signal level above which the Vox switch is activated.

Vox Off-Threshold Signal level below which the Vox switch is deactivated.

Vox Hold Time Duration a Vox switch remains active after the signal level falls below the

Off-Threshold.

Enable In-Use Indication ..., if Panel

receives a call ...

Triggers a busy signalization on other panels when the port receives a call.

Enable In-Use Indication ..., if Panel

makes a call ...

Triggers a busy signalization on other panels when the port makes a call.

Show on Reply With this function you can specify if this port is showing at other panels

Reply keys or not, if this port is calling.
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4.19.4 'Trunking' tab (4-Wire)

In the "Trunking" tab of the port properties you can enable this port for trunking. All basic settings for Trunking, like

Trunking-Address and trunk names can be set in this window. For further details please see chapter "Preparing

individual Ports for trunking".

Figure 499: 4-Wire Properties – Trunking tab

Used as trunkline Uses this port as a trunkline to another system.

Enable for Trunk call Allows the use of this port in a trunked system; only available if "Used as

Trunkline" is not activated (see chapter "Trunking").

Trunking-Address For the entry of a unique Trunking-Address for this port. The address is

normally assigned automatically (see chapter "Trunking").

Trunking Labels Possibility to enter different label, which is showing in the trunked

systems. You can use also different 6 and 4-charater labels for, when using

trunking with other compatible intercom systems.
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4.19.5 'Gain' tab (4-Wire)

The "Gain" tab allows the input and output gain levels to be set for the port. In addition, you can select whether the

gains for this port can be controlled by a panel using the "Set Input/Output Gain" function. See chapter "Set

Input/Output Gain".

Also for the direct gain adjustment of 4-wire inputs within the "Matrix Input Monitor" the option "Set

Input/Output" function has to be enabled.

Figure 500: 4-Wire Properties – Gain tab

...the "Set Input/Output

Gain" function from a

panel...

Allows control of the gain settings by a 1000 series control panel.

See chapter "Set Input/Output Gain". The settings in the tab then serve as default

settings.

...the configuration... The gain settings are exclusively set in the Director configuration.

Input Gain Set the input gain level (coming into the matrix).

Output Gain Set the output gain level (going from the matrix).

Reset Resets the selected gain parameter back to 0dB.
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4.19.6 'Beep' tab (4-Wire)

Since a 4-wire cannot generate a beep tone, it is possible to instead activate a GPI output when the port is beeped.

The selected GPI contact will be activated as soon as the 4-wire is beeped by a control panel.

Figure 501: 4-Wire Properties – Beep tab
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4.19.7 'Virtual Keys' tab (4-Wire)

The tab "Virt. Keys" allows the creation of additional virtual keys for the port. Click on the individual keys to activate

them. The virtual keys will appear next to the 4-wire.

Figure 502: 4-Wire Properties – Virtual Keys tab

The example below shows a 4-wire port with 2 virtual keys activated.

Figure 503: 4-Wire Port – Virtual Keys

The keys can be configured just like any other key and can be assigned up to 32 functions.

These keys can be activated via the Remote Key command from any point in the system (for example, a Vox switch or

GPI input). See chapter "Remote Key".
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4.19.8 'Usage' tab (4-Wire)

The "Usage" tab shows all of the sources that can talk to this port or activate another function at the port.

The table is divided into 3 columns. The list can be sorted by column by clicking on a column label. A double click on an

entry opens the corresponding function properties windows of the sources port.

Figure 504: 4-Wire Properties – Usage tab

4.19.9 'Rights' tab (4-Wire)

Corresponding user rights can be managed in the "Rights" tab. A "Rights" tab is found in all "Properties" windows. See

chapter "User Rights".

Figure 505: 4-Wire Properties – Rights Tab
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4.20 Key - Properties

The "Properties" of a key can set basic key parameters for each individual key on a control panel. To open the

"Properties", right mouse click on a key and choose "Properties", or double click on a key. There will be one tab for every

function the key has been assigned. The tabs "General" and "Rights" are also always present.

The "General" tab can set the key label, key mode, whether a key press causes the loudspeaker to dim, etc.

Figure 506: Key Properties – General tab

Key Label If the option "Define automatically" is activated, the pre-assigned display name for the

programmed function will be used. Uncheck this box if you want to manually assign

the display text for the key.

Key Mode Specifies the key behavior: Momentary (PTT), Latching (switch); Auto (momentary or

latching, depending on how long the key is pressed. >350ms: Momentary, <350ms

Latching).

Latching Timeout If the key mode is set to "Latching" or "Auto", the key can be set to automatically

deactivate after a specified period.

Radio Button Places the key in one of 50 available groups. Each key on the panel in the same group

is deactivated as soon as another key in the group is pressed. That means that only

one key from each group can be active at the same time. Radio buttons groups only

function on a single control panel.

Action when muted key is

pressed

Describes what happens when a key that was previously muted by pressing its

corresponding encoder is pressed.

No Volume change on key

activation/deactivation

The volume level does not change when the key is pressed. It remains muted.

Unmute on key activation If the key is pressed, the volume control jumps back to its last position. The volume

remains to mute after the key is released.

Unmute on key activation

and mute again on key

deactivation

If the key is pressed, the volume control jumps back to its last position. The volume is

muted again as soon as the key is no longer active.

Scroll enable Allows the key to access the panel’s Scroll-List (a Scroll-List must have been previously

defined and assigned to the panel). See chapter "Scroll-Lists".

Dim the panel speaker... Dims the panel loudspeaker as soon as the key is pressed 

(NOTE: not recommended for latching keys).

Restore volume level When activated, dynamically assigned conferences on this key are always shown with

their last stored volume level.
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Restart latching timer If this option is activated, the timer of activated latching keys with timeout is restarted,

when another key on this panel is pressed.

Text color (only for 1100

series available)

Selection of the individual text color for this key on a 1100 series panel (on other

panel series this functionality is grayed out). Also see chapter "Set up individual text

color".

Panel default (only for

1100/2300 series available)

Changing the individual text color back to the panel default. Also see chapter "Set up

individual text color".

Icon (only for 1100/2300

series available)

Selection of a predefined Icon for this key on a 1100 series panel (on other panel

series this functionality is grayed out). Also see chapter "Display Icons".

Clip label to 6 characters

(only for 1100 series

available)

When an Icon is used, the 8 character label can be cutted to 6 characters. Then a

bigger font is used on the 1100 series display than it is used when using an Icon and

an 8 character label.

4.20.1 Key Modes

Auto If the key is tapped quickly (>350ms) it acts like a latching key. If the key is held pressed for

longer than 350ms, it acts like a momentary key.

Momentary (PTT) The functions on the key are only active as long as the key is pressed.

Latching The functions on the key are turned on and off by pressing the key.

Latching Timeout To a latched key (or Auto in latching mode) you can add a timeout. So after activating the key,

it is self-releasing after the set time (1 sec.-24h).

Restart latching

timer

When this function is activated, the timer of the timeout functionality is restarted, when

another key on the panel is pressed, while this latching key is active.

4.20.2 Rights

Corresponding user rights can be managed in the "Rights" tab. A "Rights" tab is found in all "Properties" windows. See

chapter "User Rights".

Figure 507: Key Properties – Rights tab
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4.21 Virtual Functions - Properties

The properties of the Virtual Functions can be opened by right mouse clicking on the Virtual Functions of a control

panel or 4-wire port. Only the user rights can be changed in the properties window. To change other settings, such as

the Vox parameters, open the properties of the port and select tab "Details 2".

4.21.1 Rights

Corresponding user rights can be managed in the "Rights" tab. A "Rights" tab is found in all "Properties" windows. See

chapter "User Rights".

Figure 508: Virtual Function – Rights tab
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4.22 Overview of Functions (Commands)

Functions (commands) are the actions that are triggered by key presses, virtual functions, logics functions and GPIs.

Each function receives its own tab in the properties of the object that activates it where further options of the function

can be defined.

This chapter describes in detail each function and its available options.

Available commands:

Keys Virtual Functions Logic Outputs GPI Inputs/Outputs

Figure 509: Add function – function overview depending of the activator

 only available on 1000 series control panels

 only available on 1000- and 2000 series control panels
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4.22.1 'Call to Port' function

The "Call to Port" function is a point-to-point call from a caller (source) to a target (destination). It is the standard

function for communication between two individuals.

Figure 510: Call to port – Call tab

Destination Defines the target port to be called

Local Port Selection of a port of the local system

Trunking-Address Possibility to enter a Trunking-Address, to configure a trunkcall offline (see

chapter "Offline-configuration of trunkcalls").

To 2nd channel Defines whether the call should target the second audio channel of the

destination port (if available).

Trunking net address Only available in trunked systems (see chapter "Trunking").

Trunking port address Only available in trunked systems (See chapter "Trunking").

Priority Defines the priority level for this call (see chapter "Call Defaults").

Trunkcall priority Only available in trunked systems (see chapter "Trunking").

Isolate Blocks all other calls to the destination port as long as this call is active. When

calling a control panel, the microphone at the destination will automatically be

activated and the audio routed to the calling port.

Isolate self Blocks all other calls to the local port while this call is active.

Disable Crosspoint volume

adjust at Destination

The destination panel is not allowed to change the volume level of the incoming

call. The crosspoint will be set to 0dB, regardless of other volume settings or

priorities.

Use 2nd channel on this port as

the audio source

Selects the second audio channel of the port as the audio source for the call (if a

second channel is available).

Beep destination on Call Triggers a short beep tone at the destination panel before the source microphone

is activated.

Autolisten from Destination Activates the "Autolisten" function for this call (see chapter "Autolisten").

Allow the "Set Input/Output

Gain" function to adjust the

source port from this panel

Enables the use of the I/O gain control on this panel for the selected port (only for

2 and 4-wires). The function "Set Input/Output Gain" is required on another panel

key (see chapter "Set Input/Output Gain").
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Autolisten4.22.1.1

The Autolisten function allows hands-free duplex communication to a destination port.

When called by an Autolisten call, the return path is activated automatically and stays open until it is deactivated by

using the "Autolisten OFF" command from either side (see chapter "Autolisten OFF"). If the destination port makes an

Autolisten call to the source, the automatic return path is activated. This means that the audio from the original source

is automatically routed to the destination. The microphone LED on the destination panel will indicate that the micro is

activated.

The "Autolisten" functionality is useful for example, if you want to communicate with a technician in a machine room. So

when the technician is busy and cannot always press a key to talk back, you can start an "Autolisten call" to this

destination. When you press the call key, with the "Autolisten" flag enabled, you can talk to this destination. At the same

time, the microphone from the destination is permanently routed back to your panel. So the technician can talk

without pressing a button. To stop this communication, one side has to press the "Autolisten OFF" button + the active

call, to stop this functionality.

Activate the Autolisten-function, by activating this function for the "Call to Port" command, you want to use it by

.

Figure 511: Call to Port – Autolisten

Additionally you can activate the function . Then the destination panel is generating a beep-tone,

when this function is enabled by this source panel. So the user is informed that his micro is activated. The length of the

Beep tone can be adjusted in "Details 1" "Beep on call duration" of the Destination panel.

If the Autolisten function is used on a 4-wire port, a permanent "Listen" to the destination command will be triggered as

soon as the 4-wire’s Vox is activated. This listen function can only be deactivated from a control panel using the

"Autolisten Off" command. Therefore, it is imperative that the panel also has an Autolisten command to the 4-wire port.
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4.22.2 'Call to Conference' function

A "Call to Conference" is a multipoint-to-multipoint function between the multiple members of a conference. Every

member can talk into the conference at the same time and hear the sum of all active members (if they have the

necessary privileges).

Figure 512: Call to Conference – Conference tab

Destination Select the conference to speak to (Conference must be defined in

advance, see chapter "Add Conference").

Priority Sets the priority for the call (see chapter "Call Defaults").

Trunkcall priority Only available in trunked systems (see chapter "Trunking").

Talk privilege Allows the member to speak into the conference.

Listen privilege Listen privilege Allows the member to hear the conference.

Use 2nd audio channel on this port

(instead of the 1st)

Sets the second audio channel of the port as the audio source (can

only be selected if a second audio channel is available).

Use this command to select the

destination conference during an Edit

Conference operation

Allows the Edit Conference command to change the members of this

conference. The command "Edit Conference" is also required on the

control panel (see chapter "Edit Conference").

The destination conference on this

command can be changed by Edit

Conference

Allows the edit conference panel to dynamically add or delete this

member to a conference.
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4.22.3 'Call to Group' function

The "Call to Group" function is a point-to-multipoint call. A single port calls several ports at the same time. This method

of communication always goes in only one direction. Any answers to the call from group members are always point-to-

point calls back to the source.

Figure 513: Call to Group – Group tab

Destination Selects the group to be called (the group must have been previously created). (See

chapter "Add Group").

Priority Defines the priority level for this group call (see chapter "Call Defaults").

Trunkcall priority Only available in trunked systems (see "Trunking").

Disable Crosspoint volume

adjust at Destination

The destination panel is not allowed to change the volume level of the incoming

call. The crosspoint will be set to 0dB, regardless of other volume settings or

priorities.

Show incoming Marker / Enable

volume adjust

Activates the incoming marker and the incoming volume control when a group

member answers the call. This option should not be used if group members are

also programmed on the same panel as individual calls. Doing so would link

together their incoming level controls and thus prevent individual volume control

for calls coming from these ports.

Use 2nd channel on this port

(instead of the 1st) as the audio

source

Selects the second audio channel of the port as the audio source for the call (if a

second channel is available).
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4.22.4 'Call to IFB' function

The "Call to IFB" function allows IFBs to be quickly configured using the IFB-Table. To use an IFB it must have been

previously defined in the IFB-Table (see chapter "Using the IFB-Table").

To program IFBs, select a previously defined IFB from the list or drag an IFB from the IFB-Table to a key or Virtual

Function.

Figure 514: Call to IFB – Call to IFB tab

Local IFB Selects a predefined IFB from the IFB-Table.

Trunking-Address When you want to configure offline a call to an IFB of a trunked system, you can

set up the Trunking-Address in this field.

Disable Crosspoint volume adjust

at Destination

The destination panel is not allowed to change the volume level of the incoming

call. The crosspoint will be set to 0dB, regardless of other volume settings or

priorities (this function is only available when a control panel is the destination).

Use 2nd channel on this port as

the audio source

Selects the second audio channel of the port as the audio source for the call (if a

second channel is available).

Beep destination on call Triggers a short beep tone at the IFB (only available when the destination is a

control panel).
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4.22.5 'Listen to Port' function

The "Listen to Port" command is a point-to-point function. It routes the audio from the target port (Source) to the port

activating the command.

Figure 515: Listen to Port – Listen tab

Source Select the port that should be listened to.

Local Port Selection of a port of the local system.

Trunking-Address Possibility to enter a Trunking-Address, to configure a listen to trunkport offline

(see chapter "Offline-configuration of trunkcalls").

From 2nd channel (instead of 1st) Listens to the second audio channel of the target port (only available if a second

audio channel is available).

Priority Sets the priority level for the listen command (see chapter "Call Defaults").

Disable Crosspoint volume adjust The incoming volume level from the port being listened to cannot be changed.

The crosspoint will be set to 0dB, regardless of other volume settings or

priorities.

Use 2nd channel on this port

(instead of the 1st) as the audio

destination

Sets the second channel of the port as the destination for the audio being

listened to (only available if a second audio channel is available).

Allow the "Set Input/Output Gain"

function to adjust the source port

from this panel

Enables the use of the I/O gain control on this panel for the selected port (only

for 2 and 4-wires). The function "Set Input/Output Gain" is required on another

panel key (see chapter "Set Input/Output Gain").



362

Director 7.20 User Manual A10

4.22.6 'Route Audio' function

The "Route Audio" function can route audio from a source to a destination within the system. If the command is

programmed on a control panel the panel can also adjust the volume level and mute the audio route. Route Audio is

also a point-to-point function.

If different panels have the same route audio command configured on any key, the volume indicator is synchronized

on all panels if the volume is changed on one key.

Figure 516: Route Audio – Route tab

Source Defines the source port.

From 2nd channel (instead of

1st)

Routes the audio from the second channel of the source port (only available if a

second audio channel is available).

Destination Defines the destination port (output).

To 2nd channel 

(instead of 1st)

Routes the audio to the second audio channel of the destination port (only

available if a second audio channel is available).

Priority Sets the priority level of the audio route (see chapter "Call Defaults").

Disable Crosspoint volume

adjust

Deactivates the crosspoint level control. The crosspoint will be set to 0dB,

regardless of other volume settings or priorities.

Attention: Also in this software version the volume indication on a key still shows a

volume change when this option is enabled, but the volume is fixed to 0dB.
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4.22.7 'Switch GPI Out' function

The "Switch GPI Out" function can activate any GPI output in the system, whether on a GPI card or a control panel.

Figure 517: Switch GPIO – GPI-Out tab

GPI-Out  Sets which GPI output will be triggered.
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4.22.8 'Select Audiopatch' function

The "Select Audiopatch" allows a predefined Audiopatch to be activated on a control panel.

For information on creating audio patches, see chapter "Panel Audiopatch".

Figure 518: Select Audiopatch – Select Audiopatch tab

Panel Selects the panel where the Audiopatch should be changed.

Audiopatch Selects which predefined Audiopatch on the panel should be activated.
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4.22.9 'Control Audiopatch' function

The function "Control Audiopatch" allows particular crosspoints or amp gain settings in an Audiopatch to be adjusted

from a control panel key.

This function is not available on 3000 and 5000 series control panels.

Before an Audiopatch crosspoint is available for control with the "Control Audiopatch" function, it must first be unlocked

in the Audiopatch. Open the Audiopatch of a panel. Select the crosspoint or the amplifier that you like to adjust and

check the option . The crosspoint or amplifier will turn blue  /  and is now available for control

with the "Control Audiopatch" function.

Elements that are unlocked for use with the "Control Audiopatch" function are permanently activated,

regardless of the settings in the current Audiopatch.

On a control panel key, under "Add Function" select the command "Control Audiopatch" (this command is not available

for use on virtual keys or Virtual Functions).

A new window opens where you can select the Audiopatch element that you would like to control.

First, choose a control panel from the drop down menu, or drag one to the menu from the port or network lists using

Drag & Drop.

Only panels that have an Audiopatch element unlocked will be available for selection or can be dragged

into the menu.

Figure 519: Control Audiopatch – panel choice
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Select the type of element that should be adjusted from the panel. Choose  for an input amplifier, or choose

 for an output amplifier. To adjust a crosspoint gain in the Audiopatch matrix, select . Next, choose

the exact element that you would like to adjust. Only unlocked elements will be shown in the list.

Figure 520: Control Audiopatch – element selection

The panel key will display . You can also change the display name on the key in the key’s properties.

To adjust the gain level, turn the corresponding encoder. On 1000 series control panels the level can also be reduced

by pressing on the left side of the key and increased by pressing on the right side of the key. As soon as the gain level is

adjusted it will be displayed in "dB" on the key display. After a timeout of approximately 3 seconds the display will

return to the original display name.

On 2000 series control panels the level is adjusted using the "XP" function key. Press the "XP" key and select the key

with the Audiopatch gain you would like to adjust. The gain can now be changed using the panels master volume

control.

If the ability to adjust a particular crosspoint is available from several keys or on several panels, the gain

displays will not be synchronized. A change in the gain made from one position will only be displayed at

other locations when the gain is changed from these locations.

It is strongly recommended not to add any additional functions to the key.
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4.22.10 'Hot Mic' function

With "Hot mic" it is possible, to directly activate a microphone on a panel.

It is useful for example, if you want to use the microphone signal permanently on the Audio out of the panel. Until now

there was always the problem that you have to activate a "call to" function to a dummy port to route the microphone

signal into the Audiopatch of a panel. So an unused physical port on the matrix was needed.

With the function "hot mic" you can now directly activate the microphone and so the signal is permanently available on

the Audiopatch input of the panel.

So you can configure the "Hot mic" function to a key, virtual function, Logic destination or GPI to activate the

microphone on the selected panel. Mostly it is used to activate the microphone of the own panel.

Figure 521: Hot mic

Just create via "Add function" the new function "Hot mic" wherever you want to activate it.

Now select the Panel you want to switch on the microphone.

When the "Hot mic" function is activated, always the microphone LED is indicating that the microphone is

active.
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4.22.11 'Remote Key' function

The "Remote Key" function can influence or remote control any key in the system.

Figure 522: Remote Key – Remote Key tab

Destination Selects the panel with the key to be controlled.

Expansion Panel Selects whether or not the key is on the main panel or an expansion panel.

Key Page Selects whether the key is on the main page or the shift page.

Key Selects the key to be controlled by key number and current display name (key numbers are

counted from left to right and from top to bottom).

Press the Key Press the Key Activates the selected key (the key will be remotely controlled).

Lock the Key

 (so that ... press it)

Locks the selected key on the panel.

Set the Signaling

Marker

Displays the selected marker above the key (standard or user defined markers. See chapter

"Marker-Definition").

Set key text Displays the entered text in the selected key, as long the Remote Key function is active. The

existing text on the key will be overwritten temporary.

When you move the mouse on top of a "Remote Key" function, a tooltip window with detailed information about this

function will show up.

Figure 523: Remote Key – tooltip
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4.22.12 'Reply' function

The "Reply" command offers an easy-to-use call-back function for control panels. The last incoming call is automatically

displayed in the reply key.

Up from Version 6.50 it is now possible to define, if a port should show on the Reply keys on other panels or not in

general, when this port is calling. You can define it for each port individually in the "Properties of a Port", "Details 2" >

"Show on Reply".

The default setting is activated, so all ports are showing on Reply keys.

Figure 524: Reply – Panel Properties – Details2 – Show on Reply

"Call to Conference" calls do not appear in Reply keys. Only when the option  on the Reply

functions on the panels is activated. In this case, the port who is calling into conference is showing up in the Reply key,

when this panel is also a member of the same conference. By pressing now the Reply key a standard Call to Port to this

source is activated.

The duration that calls are displayed can be adjusted (see chapter "Net Properties > Port Settings"). Pressing the reply

key always calls back the last destination that called, even if the key has switched back to displaying "Reply". If the

destination that called is already programmed on another panel key, the reply key will reflect the volume level

previously set.
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If in the "Net-Properties"> "Port Settings" the "Reply-Key Timeout" is set to 24 hours, the last caller will remain displayed

on the key until the call is answered. Afterwards, the key will revert to "Reply" in its display.

Figure 525: Reply – NET Properties – Reply Key timeout

If the reply key is also set to "Scroll enable" (key properties, general tab), the last 20 calls can be accessed in

chronological order by using the scroll function (see chapter "Scroll-Lists – operation from a panel").

Figure 526: Reply – Reply Scroll enable
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Priority Sets the priority for reply calls (see chapter "Call Defaults").

Enable Reply for calls from

conference

If this option is activated, ports that call using conference calls will also be displayed in

the reply key.

The last caller can also be copied with the function-key mode "Copy Reply" to empty keys directly on the panel. For

details see chapter "Copy Reply".

When the second channel of a port is calling to a panel, the "Reply" key on the panel will always show only

the first channel of this port. Also when you want to talk back via the "REPLY" key, only the first audio

channel is called. So a talk back to a second channel via the "REPLY" key is not possible at the moment.

Only exception is an AES 4-Wire with 2 separate created channels (see chapter "Configuring a 2 channel 4-

wire port").

4.22.13 'Edit Conference' function

This function is only available on 1000 series control panels. The "Edit Conference" function allows the user to add and

remove members to and from a conference, as well as assigning talk and listen privileges to these members. All

conferences and members to be assigned must be available as keys on the users' panel (see chapter "Configuring "Edit

Conference" Function").

Figure 527: Edit Conference – Edit Conference tab

The "General Properties" of the "Edit Conference" key should be set to "Latching" (with a short timeout) and without the

"Dim the panel speaker..." option activated.
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4.22.14 'Edit IFB' function

The "Edit IFB" Function is only for panels of the 1000- and 2000series available. With the "Edit IFB" Function you can

easily assign IFB-sources to IFBs directly on panels without using the Director software.

For further details about configuration and operation see chapter "Configuring and Operating the "Edit IFB" Function".

To use this function on a panel, you need to add the "Edit IFB" function to an empty key of your panel. There are no

further parameters to set up.

Figure 528: Edit IFB – Edit IFB tab
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4.22.15 'Dim Panel Speaker' function

The "Dim Speaker" function allows the volume level of a particular control panel speaker to be reduced.

Figure 529: Dim Speaker – Dim Speaker tab

Destination Selects the panel where the loudspeaker should be dimmed.

Dim speaker by Defines the dim value (in dB).
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4.22.16 'Dim XP Level' function

The "Dim XP-Level" function allows a particular crosspoint in the matrix to be dimmed by a certain amount or muted.

Figure 530: Dim XP Level – Dim Level tab

Source Selects the crosspoint source.

Destination Selects the crosspoint destination.

Dim by Defines the amount of dimming (in dB).



375

Director 7.20 User Manual A10

4.22.17 'Beep Panel' function

The "Beep Panel" generates a beep tone at the destination panel or triggers a GPI contact for 4-wires. The function is

identical to the "Beep" function key + destination on a panel.

Figure 531: Beep Panel – Beep tab

Destination Select the port to be beeped.
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4.22.18 'Clone Output Port' function

With the "Clone Output Port" function it is now possible, to duplicate all active audio signals to a matrix-port to another

defined output port of the system. This output can be another panel or a 4-wire/ 4-wire split.

The output to clone can also be a panel or a 4-wire/4-wire split. All signals to this port are duplicated to another port, as

long the "Clone Output Port" function is activated and a crosspoint to the origin port is active.

Another port of the system is now able to hear exactly all signals like the origin port when this function is activated. So

you can use the "Clone Output Port" function as a monitoring function

Also all crosspoint volume levels of the cloned port are 1:1 duplicated to the clone output port. That means for

example, when the volume of an incoming call on a key is changed on the origin panel, also the volume from the same

source to the clone output is changing in real-time.

With "Add function" you can create the "Clone Output Port" function on a key, on a virtual function, Logic destination or

a GPIO.

Figure 532: Adding a "Clone Output Port" function

Figure 533: Properties of the "Clone Output Port" function
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First select in "Matrix Output to clone" the origin port, which should be cloned to anther port in the system.

In "Cloned matrix output" you have to select the port, all signals from the origin panel should be duplicated to, as long

the "Clone Output Port" function is activated. This means the activation location for this function, and the output for

the cloned signals can be different.

There are some limitations:

Every port can be cloned only once by other ports Every port can clone maximum 1 port A port that is

already cloning another port cannot be cloned by another port anymore.

When the function is activated, all crosspoints and also all crosspoint levels of the origin port are duplicated to the

selected output port. In the "Crosspoint View" this functionality is shown with extra symbols.

 – Clone Output Port as Call to Port (e.g.: activated by a key or virtual function)

 – Clone Output Port as Route Audio (e.g. activated by a Logic Destination)

 – Clone Output Port as Listen to Port (e.g. activated by an IFB)

 – Clone Output Port as transparent Route Audio function (> "Disable Crosspoint Volume Adjust at Destination" is

activated > Level changes at destination are ignored)

Figure 534: Clone Output Port – functionality
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4.22.19 'Telephone Dial Keypad / Display' function

The "Keypad" function allows the creation of a telephone keypad on a control panel without a dedicated hardware

keypad and also provides other telephone functions. For further details, see chapter "Setting up a panel to use a

CONNECT/SIP codec".

Figure 535: Telephone Keypad – Keypad tab

The key function can be selected in the drop-down menu.

0 – # Selects a keypad digit to assign. Only one number can be assigned per key.

CL Clear – each key press deletes the previous digit.

DisplayH Displays the telephone number entered. The digits "scroll" on to the key as they are dialed. If the

telephone number has more than 8 digits, they "scroll" on to the Display H key.

DisplayL Displays the telephone number entered. The digits "scroll" on to the key as they are dialed. The

Display L key shows the last 8 digits of the number dialed Numbers can also be entered manually by

pressing the corresponding level control and scrolling Pressing the display key dials the number

entered (comparable to Dial/Off). Any preset telephone numbers will be temporarily ignored and

the manually entered telephone number will be dialed.

ReplyH Shows the first 8 digits of an incoming telephone number (if available).

ReplyL Shows the last 8 digits of an incoming telephone number (if available). The number of the last caller

will always be displayed. Pressing the key dials the last incoming telephone number (Dial/Off).

Phone No Allows the entry of a telephone number that is dialed when the key is pressed. (This function is

perfect for multiple uses in Scroll-Lists to create a telephone book).
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4.22.20 'Telephone Dial / Hang up' function

The "Dial" function is used in conjunction with CONNECT SOLO or CONNECT DUO. It enables a control panel to call a

preset telephone number from the configuration.

Figure 536: Telephone Dial/Hang up – Dial tab

Dial only With this function it is possible to dial a preset telephone number. The command can

only be used in combination with a separate "Call to" key that is set to a telephone port.

Hang up only It is possible to end a telephone connection with this function. The command can only be

used in combination with a separate "Call to" key that is set to a telephone port.

Dial and Hang up Combines the functions "Dial only" and "Hang Up only" in one key. The command can

only be used in combination with a separate "Call to" key that is set to a telephone port.

Stop Connection Allows a remote panel connected via ISDN to break the connection. This command is

only available on remote panels that are connected via ISDN using a CONNECT

DUO/TRIO.

Details how to operate the dialing function on a panel see chapter "Dial a connection with a fix number".
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4.22.21 'Logic' function

The "Logic" function assigns a Logic Source to a key, Vox or GPI. A logic source can be assigned any number of times

within the system (see chapter "Logic Functions").

Figure 537: Logic – Logic tab
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4.22.22 'Kill Partyline Mic' function

The "Kill Partyline Mic" offers a way to shut off the microphones on a connected Performer Partyline system. The

function only works if the Partyline is a member of a conference and the conference key is also programmed on the

control panel. For example, to kill the mikes on active C3 Beltpacks the "Kill Mic" key and the key for the corresponding

conference must be pressed at the same time.

Figure 538: Kill Partyline Mic – Kill Partyline Mic tab

To operate this function with only one finger, it is useful to set the "Kill Mic" key as "Latching" with a Timeout.

When you now activate the "Mic Kill" key, all keys with an active "Call to Conference" function will show a flashing marker

as long the timeout is set. Now press the key you want to switch off all microphones. All mikes of the Partyline(s) in this

conference will be switched off.

Always all mikes for both channels of the complete Partyline will be switched off. It is not possible to just

switch of the Mic for only one channel of the Partyline.

Figure 539: Kill Partyline Mic – Panel operation



382

Director 7.20 User Manual A10

4.22.23 'Autolisten Off' function

The "Autolisten Off" function turns an active Autolisten off. The "AL OFF" key and the corresponding "Call to..." key that

has "Autolisten" activated must be pressed at the same time.

Figure 540: Autolisten Off – AL Off tab

To operate this function with only one finger, it is useful to set the "AL Off" key as "Latching" with a Timeout.

When you now activate the "AL Off" key, all keys with an active Autolisten function will show a flashing marker as long

the timeout is set. Now press the key that should stop the Autolisten function.

Figure 541: Autolisten Off – Panel operation



383

Director 7.20 User Manual A10

4.22.24 'Set Input/Output Gain' function

For every 4-wire in the system you have the choice of how you would like to control the I/O gains (Properties> Gain).

You can choose whether the gain should only be set in the Director configuration or whether it can also be adjusted

from a control panel. To adjust the input and output gains from a control panel, select "Set the Input/Output Gain

function from a panel..." on the 4-wire port that the panel should control.

Figure 542: Set Input/Output Gain of a port to Panel control / RRCS control

The "Set Input/Output Gain" function is only available on 1000 series control panels because the function

requires keys with separate left and right contacts. This key type is currently only available on 1000 series

control panels.
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The "Set Input/Output Gain" function can be configured in two different ways.

Version 1: Set Input/Output Gain of a particular port

Figure 543: Set Input/Output Gain: "Adjust following Port"

In this version, the key is assigned to a specific port. The key display will show the name of the port, but with a different

marker. It is recommended to set the key to "Latching" (possibly with a timeout) and to deactivate the "Dim" option.

To adjust the input gain of the 4-wire, press the left side of the key. The key will now show "In Gain" and the volume LED

will begin to flash. As soon as the encoder next to the key is turned, the gain level will change with the current gain

displayed in dB. To adjust the output gain, press on the right side of the key. The display will change to "Out Gain". The

volume LED will likewise correspond to the approximate gain level.

  >    >  

  >    >  

Figure 544: Operating "Set In/Output Gain" on the panel (direct access)



385

Director 7.20 User Manual A10

Version 2: Another way to program this command uses a special function key.

Pressing the "I GAIN O" key switches all "Call to" and "Listen to" 4-wire keys, which are available for gain control, to gain

adjust mode.

Figure 545: Set I/O gain – Set Input/Output Gain with a dedicated function key

Either the input or output gain can be changed, depending on whether the "I GAIN O" key was pressed on the left or

right side. The respective gain levels will be displayed both in dB and by the position of the volume control LED. To

enable one handed operation, set the Set Input/Output Gain key to "Latching" with a short timeout.

Adjust the following port Defines this key as the I/O-Gain control key for the selected 4-wire port (Key

mode Latching, short Timeout, no Dim).

Select the destination port(s)

with another panel key

Defines the key as a function key that toggles 4-wire ports between Call/Listen

and Gain Adjust (Key label: "I Gain O").

Suggested key behavior: Latching with a short timeout, no Dim. If the key is

pressed on the left side (input) or right side (output), the volume LEDs of all of

the 4-wire keys on the panel that are available for gain adjust will begin to flash.

The key displays will show their port names. Turning the corresponding

encoders will adjust the gain with the current gain shown in dB (range: mute, -

18dB to +18dB).

Pressing the encoder toggles between mute and the last gain level set. If you

double click on the master volume control when in Gain Adjust Mode, all of the

4-wire gains on the panel will be set to the norm level (independent of whether

the input or output gain had been selected). A second press on the "I Gain O" key

returns the 4-wire keys to their original "Call" or "Listen" function.

  >    >  

Figure 546: Operating I/O gain on a panel (indirect access)
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4.22.25 'Sidetone' function

This function key is used to activate the "Sidetone" feature on a panel and to control the Sidetone level. "Sidetone" is the

volume level at which users hear themselves (useful in headset mode). Once the command has been placed on a panel

key and the microphone is active, the panel’s audio will also be routed back to its own output. The level can be

controlled using the rotary encoder next to the "Sidetone" key. Pressing the "Sidetone" key allows users to talk to

themselves so that they can adjust their own "Sidetone" levels.

Figure 547: Sidetone – Sidetone tab

Enable for speaker mode Activates Sidetone in speaker mode (only useful if the speaker mode has been

routed to the headset in the Audiopatch).

Enable for headset mode Activates Sidetone in headset mode.

Norm sidetone level Initial Sidetone level when the command is placed on a key.

Applies to 2nd audio channel Activates the Sidetone on the second audio channel of the panel (if available).
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4.22.26 'Send String' function

This function key is used to send a data string of up to 256 characters to RRCS (Riedel Router Control Software). When

activated, the command sends the data string to a third party control system to activate a particular function. For more

information, please refer to the RRCS documentation.

Figure 548: Send String – Send String tab



388

Director 7.20 User Manual A10

4.23 'Group' Properties

The "properties" of a group contains all of the group settings and information. To create a new group, click the

 button in the  tab of the Navigation Bar.

4.23.1 'General' tab (Group)

The "General" tab sets basic parameters such as names and GPIOs assignments to the group.

Figure 549: Group Properties – General tab

Long Name Unique group name used in Director (up to 32 characters).

8-char Label Group name that appears on key displays (max. 8 characters).

Assigned GPI Out Allows the assignment of a GPIO that is always triggered when this group call is

activated.

Enable for trunk call Allows the group to be used between trunked systems (see chapter "Trunking").

Trunking-Address Entry of a unique Trunking-Address. To use a group in a trunked system, the groups in

the systems must have the same Trunking-Address (see chapter "Trunking").
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4.23.2 'Members' tab (Group)

The "Member" tab manages the list of members that makes up the group.

Group members can be added by clicking the "Add Port..." button and then selecting members from a drop down

menu. Members can also be dragged into the group from either the network list or the port list using Drag & Drop. By

default, this will add the first audio channel of the port to the group. If you want to add the second audio channel of a

port, the member must be added using the  button and selecting the "2nd Channel" option. Selected

members can be deleted from the group using the  button.

Figure 550: Group Properties – Members tab

Figure 551: Group Properties – "Add Port..." window

Members that are already used within this group will not show up any more in the "Add Port" list. 2-

channel enabled ports will only disappear from the list, if both audio channels are already used within the

group.
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4.23.3 'Usage' tab (Group)

The "Usage" tab lists detailed information on all locations that have a "Call to Group" command to this group. The port

name and the exact location of the group call are shown. If you double click on an entry in the list, it will open the

corresponding properties of the command on that port so that you can make adjustments.

Figure 552: Group Properties – Usage tab

4.23.4 'Rights' tab (Group)

Corresponding user rights can be managed in the "Rights" tab. A "Rights" tab is found in all "Properties" windows (see

chapter "User Rights").

Figure 553: Group Properties – Rights tab



391

Director 7.20 User Manual A10

4.24 'Conference' Properties

In the properties of a conference you can define basic conference parameters as well as see a list of all conference

members.

4.24.1 'General' tab (Conference)

The name of the conference is entered in the "General" tab. The conference can also be assigned a GPIO contact. In

addition, this tab can be used to unlock the conference for use in trunked systems or with the "MCR" or "Events"

software add-ons.

Figure 554: Conference Properties – General tab

Long Name Unique conference name used in Director (up to 32 characters).

8-char Label Local conference name that is displayed on keys (max. 8 characters).

Alias As soon as it is entered, this 8 character display name temporarily overrides the "8-

char Label". If the Alias name is deleted, the "8-char Label" will again be displayed on

panel keys.

Assigned GPI Out Allows a GPIO to be assigned to a conference. The GPIO will always be triggered as

soon as a member speaks into the conference.

Enable for trunk call Activates the conference for use in trunked systems (see chapter "Trunking").

Trunking-Address Assigns a unique Trunking-Address. To use a conference in a trunked system, the

conferences in the systems must have the same Trunking-Address (see chapter

"Trunking").

Enable for Master Control

Room use

Allows the conference to be used in the "MCR" software add-on (see chapter

"Master Control Room Software").

Create an associated logic

source for MCR use

A logic source will be automatically created for this conference. This is required to

control the "MCR" software add-on from a control panel.
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4.24.2 'Usage' tab (Conference)

The "Usage" tab lists detailed information on all locations that have a "Call to Conference" command to this conference

and who are thereby conference members. The port name, the exact location of the conference call, and conference

privileges (talk, listen) are shown. If you double click on an entry in the list, it will open the corresponding properties of

the command on that port so that you can make adjustments.

Figure 555: Conference Properties – Usage tab

4.24.3 'Rights' tab (Conference)

Corresponding user rights can be managed in the "Rights" tab. A "Rights" tab is found in all "Properties" windows (see

chapter "User Rights").

Figure 556: Conference Properties – Rights tab



393

Director 7.20 User Manual A10

4.25 'Scroll-List' Properties

The properties of a Scroll-List allow individual functions to be added to the list as well as offering an overview of who

can use the list. Double click on a Scroll-List in the "Scroll-List" tab of the Navigation Bar to open the lists properties.

4.25.1 'General' tab (Scroll-List)

The "General" tab allows all Scroll-List functions and their options to be defined and changed. The list can also be given

a unique name. For details on creating a Scroll-List see chapter "Creating and Managing Scroll-Lists".

Figure 557: Scroll-List Properties – General tab

Long Name Unique Scroll-List name used in Director (up to 32 characters).

Members Members All Scroll-List functions and details are defined in this window.

Move up Changes the order of Scroll-List entries. Select an entry from the list and click the "Move up"

button to move the entry one position higher with each mouse click.

Move down Changes the order of Scroll-List entries. Select an entry from the list and click the "Move

down" button to move the entry one position lower with each mouse click.

Add... Adds a new function. The same functions are available that can normally be used on control

panels.

Edit Scroll-List Entry... Allows a Scroll-List entry to be edited. This includes changing the name, key mode, etc. (see

details below).

Edit function... This button allows the selected function to be customized. The available options for

functions are identical with those that are normally available when the function is

programmed to a panel key.

Delete Deletes the selected entry from the Scroll-List.
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Figure 558: Scroll-List Properties – Edit Scroll-List entry

Key Mode Defines the key mode that the function should use: "Auto", "Momentary" or "Latching".

Latching Timeout If the key mode is set to "Auto" or "Latching", an additional timeout can be added. After

the timeout period, the key will automatically be deactivated.

Dim the panel speaker... Defines whether the control panel loudspeaker should be dimmed when the function

is active.

Key Label If the "Define automatically" option is activated, the default name for the function will

be used on the key. When deactivated, a custom name of up to 8 characters can be

assigned.

Keypad shortcut A unique ID number can be assigned for each Scroll-List entry. This allows the entry to

be retrieved by using a telephone keypad.
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4.25.2 'Usage' tab (Scroll-List)

All the panels that can access this Scroll-List can be seen the "Usage" tab. Double clicking on an entry opens the

properties of the selected control to allow a different list to be assigned.

Figure 559: Scroll-List Properties – Usage tab

4.25.3 'Rights' tab (Scroll-List)

Corresponding user rights can be managed in the "Rights" tab. A "Rights" tab is found in all "Properties" windows (see

chapter "User Rights").

Figure 560: Scroll-List Properties – Rights tab
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4.26 'GPI In' Properties

The default parameters for the GPI Input can be set in the properties tab. Choose a GPI Input from the "GPIO" tab in the

Navigation Bar. Double click on the GPI or right mouse click and select "Properties".

4.26.1 'General' tab (GPI In)

The name and type of GPI Input are entered in the "General" tab.

Figure 561: GPI In Properties – General tab

Long Name Unique name used in Director (up to 32 characters).

Type Defines the behavior of the input.

Select whether an incoming external signal switches the input to active (normal) or

inactive (inverted).

The "Usage" tab is always empty for GPI Inputs, because no member of the system can activate an input.

4.26.2 'Rights' tab (GPI In)

Corresponding user rights can be managed in the "Rights" tab. A "Rights" tab is found in all "Properties" windows (see

chapter "User Rights").

Figure 562: GPI In Properties – Rights tab
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4.27 'GPI Out' Properties

The default parameters for the GPI Output can be set in the properties tab. Choose a GPI Output from the "GPIO" tab in

the Navigation Bar. Double click on the GPI or right mouse click and select "Properties".

4.27.1 'General' tab (GPI Out)

The name and type of GPI Output are entered in the "General" tab.

Figure 563: GPI Out Properties – General tab

Long Name Unique name used in Director (up to 32 characters).

8-char Label Local 8 character name for the GPI out used on key displays.

8-char Label Remote 8 character name for the GPI out for use in trunked system (not supported at this time).

Type Type of GPI output (when not activated). You can choose between normally open and

normally closed.

Off Delay The relay can be assigned a release delay time. Enter the amount of time the output

should remain active after the GPIO function is turned off.

HINT: The Off-Delay time of a GPO is not shown in the GPIO live view in the GPIO List or

by a GPO marker on a panel. The live view and the marker are just showing the activation

impulse of the GPO. So when the off delay is set for example to 5 sec., the live view and

the marker just show the trigger impulse and not the 5 sec. of the active GPO.
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4.27.2 'Usage' tab (GPI Out)

The "Usage" tab lists all ports, groups and conferences that can activate this GPI.

Double click on an entry to edit the function directly.

Figure 564: GPI Out Properties – Usage tab

4.27.3 'Rights' tab (GPI Out)

Corresponding user rights can be managed in the "Rights" tab. A "Rights" tab is found in all "Properties" windows (see

chapter "User Rights").

Figure 565: GPI Out Properties – Rights tab
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4.28 User Rights

The "Users" tab, found on the Navigation Bar, allows Director Users to the created and managed.

Figure 566: Users tab

New users can be added using the  button. However, this is only possible if the current user is the

administrator or has "Account Manager" rights. Double click on a user or press the  button to open the

properties of the user.
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4.28.1 'General' tab (User)

The "General" tab of the User Properties manages the name, password and basic rights for the user.

Figure 567: User General tab

Long Name Unique name used in Director.

Description Additional field to enter a user description.

Password Password Enter a password for the user.

Repeat Password Re-enter the password.

Users can be assigned the following general rights:

Allow Save to ARTIST (overwrite) Allows the use of the "Save to Artist" button.

Allow Save Changes to ARTIST(merge) Allows changes to be sent to the Artist system.

Allow Save Configuration to Disk Allows the configuration in Director to be saved to the PC.

Allow Open File from Disk Permits configuration files to be opened from the hard disk.

Restrict Properties for AV-Router Restricts access to the AV-Router properties (if the AV-Router has

been added).

Scheduler Manager Allows the user to create and edit entries in Scheduler/ Events (if

available in Director).

User Account Manager Allows this user to create new users. New users can have max the

same rights as the user that created them. The "Acc Mgr" field in the

"Users" tab will display "Yes".

Interrupted Fold Back Manager

 (new in 6.50)

Allows the user, to edit the IFB-table.

Allow System Resets Allows the user, to reset the system.

Enable Partial Files Allows partial configuration to be loaded (if Partial Files has been

added to Director).

Allow Update Activates the "Update" button in the Partial Files Tools XY Matrix (if

Partial Files has been added to Director).

Allow Update All Activates the "Update All" button in the Partial Files Tools XY Matrix (if

Partial Files has been added to Director).
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Allow Load Offline Activates the "Load Offline" button in the Partial Files Tools XY Matrix

(if Partial Files has been added to Director).

Allow Load All Offline Activates the "Load All Offline" button in the Partial Files Tools XY

Matrix (if Partial Files has been added to Director.

Allow Save Partial File to Disk Allows Partial Files to be saved to the PC.

Allow PF Configuration Allows the configuration of Partial File Event Triggers.

In addition, each "Properties" window in Director has a "Rights" tab where individual user rights can be assigned for that

object.

User rights are organized hierarchically. This means that the user rights apply as well to all lower level objects on the

system configuration tree. Individual objects in the configuration can of course have access rights to them later

removed.

Normally, rights are only present that were previously given at a higher level unless they are manually added at the

lower level.

The user rights hierarchy levels are:

· Web

· Net

· Node

· Port

· Taste / Virtual Function

For example, you can give another user rights to a complete node, only certain panels or particular keys. This is

dependent on which hierarchy level you assign rights to the user. Rights to levels below that level are automatically

granted.

To change user rights, open the Properties window at the desired hierarchy level. Rights can be managed in the 

 tab.

Only the administrator cannot have rights taken away. The administrator always has unlimited access to all functions

and objects in the configuration.

Figure 568: Panel Properties – Rights



402

Director 7.20 User Manual A10

The following columns are available in the Rights window:

Owner Displays the user who "owns" or created the object. The current user can change the owner

of an object if he/she has the necessary rights. The new owner is automatically granted the

same rights in regards to the object.

USER List of available users.

Create children * Allows the current user to assign user rights to the marked users up to the amount of rights

that he/she possesses.

Delete children * Allows the current user to remove rights from the marked users.

Edit Allows the marked users to edit the function (including all lower objects in the rights

hierarchy).

Live Allows the marked users to open the Live States tab (including for all lower objects in the

rights hierarchy. For example, all ports on Node 2).

Remote Allows the marked users to open the Remote Control tab (including for all lower objects in

the rights hierarchy. For example, all ports on Node 2).

* These options are not available in the lowest hierarchy levels, for example at the key level

If rights are changed then the changes will be marked with a  star. This shows that the changes have not yet taken

effect. As soon as either the  or the  button is pressed the star disappears. Previously assigned rights are

marked with a .

If users attempt to configure objects without the necessary user rights they will see the following error message:

Figure 569: User Rights – error message
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4.28.2 'Usage' tab (User)

The "Usage" tab on a user shows which special functions, such as "Master Control Room", the user can use. 

Figure 570: User Properties – Usage
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5 Spezial Configurations

5.1 Setting up CONNECT Codecs and Remote Panels

The Artist product range currently offers 5 types of codec interfaces:

· CONNECT DUO

· CONNECT SOLO

· CONNECT TRIO

· CONNECT IP

· CONNECT IPx2 / Connect IPx8

All codecs are delivered with their own configuration software for basic setup and stand-alone use. The individual

software packages are not described in this manual. Further information can be found on the installation CD that was

delivered with the codec.

The use of the CONNECT IP codec is completely transparent. This means that no configuration in Director is required.

Do not mix up the Connect IP with the new Riedel CONNECT IPx2 and x8. The IPxX interfaces need to be

configured via the Director/Web interface. For details see chapter "Distribute a Panel with Connect

IPx2/x8". For the older Connect IP interfaces a separate software is required. Please refer the manual for

this product.

The configuration procedure for CONNECT SOLO, DUO and CONNECT TRIO is identical. The only difference is that

CONNECT DUO/TRIO offers the possibility to remote a control panel over ISDN. The CONNECT TRIO also supports VoIP

telephony. In the configuration instructions below, CONNECT DUO is used as an example since the operation of digital

connected CONNECT SOLO, DUO and CONNECT TRIO from a panel is identical.

The following instructions apply only to when a codec is connected digitally to a CAT5 or an AES card. This type of

connection allows the codec’s to be used and configured by Artist.

If a codec is connected analog to an AIO card, the codec functions like a normal 4-wire port. An intelligent connection to

the matrix is not possible in this case. The codec must be controlled directly on the device itself.
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5.1.1 Adding a Codec to the Configuration

To add a new codec to a configuration, open the configuration view of a node. To do so, double click on the node or

select the node in the "Network" tab of the Navigation Bar.

Select the CAT5 or AES card that the codec will be connected to. Click on a port and choose the device type "Telephone

codec" from the list. 

If possible, you should connect the codec to an odd numbered port. If the next port is unassigned, it will be

automatically reserved for the codecs second audio channel. This allows both of the available telephone lines on the

codec to be used at the same time. 

Figure 571: Connect – Adding a codec

For details on setting up the codec for connection to an Artist system please refer to the codecs instruction manual.

After the codec has been added to the node configuration, it appears in the network list with a  symbol. It also

appears in the port list.

Figure 572: Connect – Codec in the Node configuration
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5.1.2 'General' tab (Codec)

To adjust the codecs properties, right click on the codec in the port list or network list and select "Properties".

Figure 573: Connect – Properties of Telephone Codec – General tab

Long Name Unique name used in Director (up to 32 characters).

Room-Code Allows a Room-Code to be assigned to avoid feedback when using conferences on

ports that are physically near each other.

Enable 2nd audio channel Activates the second audio channel (this function is only available, if an odd

numbered port is used and the next port is free. As of Director 5.90, this option is

automatically selected when possible).
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5.1.3 'Details' tab (Codec)

The "Details" tab allows the basic setup of the port. Normally, no changes need to be made here.

Figure 574: Connect – Properties of Telephone Codec – Details tab

Response Timeout Internal system timeout for panel response.

Enable for Trunk call Enables this port for trunking calls (see chapter "Trunking").

Trunking-Address Unique Trunking-Address for the port (see chapter "Trunking").
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5.1.4 'Port-Pool' tab (Codec)

This tab sets up the codec destinations. Each telephone destination, whether it is a control panel or a 4-wire, becomes

a so called "Pool-Port". There is no limit to the number of pool ports that can be added. However, a maximum of two

members can be connected to a single codec at the same time. Each pool port could, for example, be a predefined

telephone destination with a fixed telephone number.

Figure 575: Connect – Properties of Telephone Codec – Port-Pool tab

Click the  button to add a new pool port.

Choose the destination type in the pop up window. If a CONNECT SOLO is being used, only "4-Wire" should be selected

because CONNECT SOLO does not support remote panels.

Figure 576: Connect – Add Port to Pool
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To create a connection to a telephone or a simple audio connection to another codec, select "4-wire". Repeat these

steps until you have created all of your virtual pool members.

Figure 577: Connect – 4-Wires in Port-Pool

Select a 4-wire port and click the  button. All incoming calls without CLIP (Calling Line

Identification Presentation) or with CLIR (Calling Line Identification Restriction) will be switched to this port.

If you only have a single 4-wire pool port, it must be set as the "Voice Default".

If no "Voice Default" is defined, audio from incoming calls will not be routed into the system.

CONNECT SOLO, CONNECT DUO and CONNECT TRIO supporting the CLIP function. However, it is only used by

CONNECT DUO in ISDN mode and CONNECT TRIO in ISDN and VoIP mode.

To add a control panel as a pool port, click the  button and select the panel type that is to be connected to

the remote CONNECT DUO/TRIO via ISDN.

Remote panels only work with an ISDN connection between 2 CONNECT DUOs/TRIOs.
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Figure 578: Connect – 4-Wires and panels in a Port-Pool

It is also imperative to define a panel as the "Panel Default" for the Port-Pool. Select a panel and click the 

button. In the "Default" column the word "Panel" will appear. This signals that incoming panel calls without a

recognizable telephone number will be routed to this panel. Even if there is only 1 panel in the Port-Pool, it must be

defined as the "Panel Default".

Figure 579: Connect – Pool-Panels in the network view
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5.1.5 'Telephone Number' tab (Codec)

The "Telephone Number" tab is used for entering the MSN telephone number of your own telephone connection. If you

are using an ISDN connection, it is very important to enter these numbers. The MSN numbers will then be transferred

to the codec.

Figure 580: Connect – Properties of a telephone codec – Telephone number tab

Telephone number 1st Channel MSN number for the first channel, or Pots Line 1.

Telephone number 2nd Channel MSN number for the second channel, or Pots Line 2.
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5.1.6 'Rights' tab (Codec)

Corresponding user rights can be managed in the "Rights" tab. A "Rights" tab is found in all "Properties" windows (see

chapter "User Rights").

Figure 581: Connect – Properties of Telephone Codec – Rights Tab
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5.1.7 4-Wire Properties (Pool-Panel)

Right mouse click on a pool port and select "Properties" to open the properties of the pool port.

All of the tabs and settings of a pool port are identical to a normal 4-wire port. The only difference is that a pool port

also has an additional "Telephone Codec" tab where the number to be dialed by the pool port can be entered.

Figure 582: Connect – Properties of Pool Port – 4Wire Telephone Codec tab

Phone No. to dial Enter the telephone number to be dialed. If no number is entered, it is also possible to

manually dial a number later from a control panel.

Phone No. incoming Enter the incoming telephone number. This is normally identical to the telephone number to

be dialed. It enables the caller to be assigned to the correct panel keys. If no telephone

number is entered, the Voice Default port will be used for incoming calls.

Hang up timeout Automatic hang up after a certain time has passed (10s–4h).

Protocol Select the type used by the destination codec. For 4-wire connections with a CONNECT

DUO/TRIO using an ISDN connection either the G.711 codec (normal telephone codec, 3,5kHz)

or G.722 codec (digital codec for connection to another codec, 7kHz) can be used. The

G722/Artist Code is only used for the connection of panels over ISDN. CONNECT SOLO only

supports the G.711 codec.

Codec-Channel Select the channel that the port should use to dial.
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5.1.8 Panel Properties (Pool-Panel)

Right mouse click on a pool port and select "Properties" to open the properties of the pool panel.

All of the tabs and settings of a pool panel are identical to a normal panel port. The only difference is that a pool panel

also has an additional  tab where the number to be dialed by the pool panel can be entered.

Figure 583: Connect – Properties of Pool Port – Panel Telephone Codec tab

Phone No. to dial Enter the telephone number to be dialed. If no number is entered, it is also possible to

manually dial number later from a control panel.

Phone No. incoming Enter the incoming telephone number. This is normally identical to the telephone number

to be dialed. It enables the caller to be assigned to the correct panel keys. If no telephone

number is entered, the Panel Default panel will be used for incoming calls.

Hang up timeout Automatic hang up after a certain time has passed (10s–4h).

Protocol To remote a panel over ISDN, select the G722/Artist Codec.

Codec-Channel Select the channel that the port should use to dial.
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5.1.9 Setting up a Panel to use a CONNECT/SIP Codec

The following examples show the various ways to operate a codec from a control panel.

Dialing a connection with a fixed number5.1.9.1

This is the easiest way to dial a number from a control panel. It requires that all pool ports have a fixed telephone

number assigned to them in their "Properties".

Choose a key to handle dialing functions. Right mouse click on the key and select the "Dial/Hang-up" function under

"Add Function" > "Telephone Dial/Hang-up". Set the key mode to latching with a short timeout and without a dim

function. If this is not done, the dial and destination keys must always be pressed together.

Pull pool ports to panel keys using Drag & Drop. They will automatically be added with the standard "Call to Port"

function.

 

Figure 584: Connect – Assigning a dial function

To create a connection, press the "Dial/Off" key. The markers above all available telephone destinations (pool ports) will

begin to flash.

Figure 585: Connect – Panel – Dialing with a Pool-Panel

While the "Dial/Off" key is still active, press the key of the pool port that you would like to call. The marker above the

pool port indicates that it is dialing. As soon as a connection has been established, the marker changes to the normal

"Call to Port" marker. As long as the connection is active the key functions like a normal "Call to Port" key. You can adjust

the incoming volume level and talk to the destination by pressing the key. If you call a voice Port-Pool, make sure that

the 4-wire has a Vox connection back to your control panel.

Figure 586: Connect – Panel – Number is dialed

To stop the connection, press the "Dial/Off" key and key of connection you would like to disconnect. The pool port will

then revert to displaying the standard "Pool Port Offline" marker (see chapter "Marker Definitions").
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Manually dialing a telephone number without a built-in keypad5.1.9.2

With the help of the "Telephone Dial Keypad" function it is possible to create a keypad on any panel. Add a function to a

key by selecting "Add function" > "Telephone Dial Keypad". In the properties of the function you can select the exact

digit or function to add to the key.

Figure 587: Connect – Telephone Dial Keypad – Keypad tab

The key functions can be selected from the drop down menu.

0–# Selects a keypad digit to assign. Only one number can be assigned per key.

CL Clear – each key press deletes the previous digit.

DisplayH Displays the telephone number entered. The digits "scroll" on to the key as they are dialed.

If the telephone number has more than 8 digits, they "scroll" on to the Display H key.

DisplayL Displays the telephone number entered. The digits "scroll" on to the key as they are dialed.

The Display L key shows the last 8 digits of the number dialed.

Numbers can also be entered manually by pressing the corresponding level control and

scrolling.

Pressing the display key dials the number entered (comparable to Dial/Off). Any preset

telephone numbers will be temporarily ignored and the manually entered telephone

number will be dialed.

ReplyH Shows the first 8 digits of an incoming telephone number (if available).

ReplyL Shows the last 8 digits of an incoming telephone number (if available).

The number of the last caller will always be displayed.

Pressing the key dials the last incoming telephone number (Dial/Off).

Phone No Allows the entry of a telephone number that is dialed when the key is pressed. (This function

is perfect for multiple uses in Scroll-Lists to create a telephone book).
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Figure 588: Connect – Panel – Example of a keypad configuration

Press the digits to enter the telephone number. The number dialed will be displayed in the "DisplayL" (digits 1-8) and

the "DisplayH" (digits 9-16) keys. The normal display text in the keys may be temporarily overwritten.

Pressing the "CL" key will delete the previous digit.

To dial a number that was entered manually, press the number in the "DisplayH" or "DisplayL" keys. The markers of all

available pool ports on the panel will start to flash.

Press the pool port that you wish to dial the number. This will temporarily override any preassigned number on the

port. From this point on the panel functions just like it did when using the "Dial/Off" key.

Figure 589: Connect – Panel – Dialing of a manually entered number

To break the connection, press either the "DisplayL" or "DisplayH" key and the key of the connection you would like to

end.

If the panel receives an external call from someone who transmits their telephone number, it will appear in the

"DisplayL" or "DisplayH" keys. In any case, these keys will display the number of the last caller. Press the "ReplyL" key +

an available pool panel to call the number back.

The "DisplayL" key offers another way to dial a telephone number without a built-in keypad. Telephone numbers can

be entered by pressing and turning the encoder next to the key.

Press the encoder once. The digit "0" will appear in the display. Turn the encoder until it displays the number you wish

to enter. The next number can now be entered by pressing the encoder again.

 >  > > > >

Figure 590: Connect – Panel – Entering a number by using the volume encoder

The number entered in this way is dialed exactly like a number entered on a keypad.
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You can also use the "Telephone Keypad" function to assign a phone number to a key. In this case the "Phone No." key

behaves exactly like a "DisplayL" key. This means that pressing the key along with a pool port will dial the number. This

will temporarily override any previously assigned number the pool port was assigned. It is recommended to manually

define the key’s display.

Figure 591: Connect – Telephone Keypad – Phone No. function

To dial, press the telephone number key + the pool port to be used.

Figure 592: Connect – Panel – Dialing of a preset number
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Manually dialing a telephone number with a built-in keypad5.1.9.3

Expansion panels with built-in keypads are available for 1000 and 2000 series control panels. These expansion panels

allow telephone numbers to be dialed quickly. Some of the keys on the expansion panel keypad do not currently have

functions assigned ("M" keys, plus "P","R" and "S" keys).

The "C" key deletes the last digit entered. It works just like the "Clear" command from the keypad function.

To use the keypad, you must still program the "DisplayL" and "DisplayH" keys to the panel, as well as the pool ports to

be used.

Figure 593: Connect – Keypad panel setup

The number entered on the keypad will appear in the "DisplayL/H" keys. To dial the number press the "DisplayL" + a

pool port key. The rest of the procedure is the same as that for a panel without a built-in keypad.
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5.1.10 Setting up a Remote Panel using CONNECT DUO/TRIO (ISDN)

To remote a control panel with CONNECT DUO/TRIO (with enabled ISDN option), create at least one pool port panel in

the properties of the codec. The control panel will appear in the network list and the port list as a normal panel. Open

the panel's properties to enter the telephone settings.

In the "Telephone Codec" tab of the pool panel select the G.722/Artist protocol. You can also optionally assign the ISDN

channel to be used, a hang up timeout and a fixed telephone number for the panel.

Figure 594: Connect – Properties of an ISDN panel – Telephone Codec tab

Make sure that the "Response Timeout" for the ISDN panel is at least 200ms ("Details 2" tab of the panel properties). This

increases the stability of the data connection between the matrix and the control panel, which can be disrupted by the

longer delays on ISDN lines.

Figure 595: Connect – Properties of an ISDN panel – Details 2 – Response Timeout
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You can now configure the ISDN panel just like any other control panel. All of the functions are available that are

available for panels connected directly to the matrix.

A RIF-2064 cannot be connected via ISDN to the Matrix caused by technical protocol differences of the RIF-

2064.

However, the panel requires a special key to terminate a standing ISDN connection from the remote panel.

Select the option "Stop Connection" from the "Telephone Dial/Hang up" function and add it to a key.

Figure 596: Connect – Dial Function – Stop Connection

Figure 597: Connect – ISDN panel

To establish a connection to the matrix from an ISDN panel, you must dial the telephone number directly on the

CONNECT DUO/TRIO.

As long as there is not an active ISDN connection, the remote panel will remain in "waiting mode". The display will show

"Wait for CAT5/Coax". As soon as a connection is established, the panel will boot and receive its configuration from the

Artist matrix. When the keys show their function the system is connected and ready for use.

The Director does not support the 2-channel mode for remote panels connected via ISDN.

So it is not possible to use the second audio channel on remote panels.
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5.2 Configuration of a CCP-1116 Commentary Panel

When you want to use the CCP-1116 Commentary panel with its full functionality for 2 commentators, you have to

adapt some configuration settings in the Director.

First you have to create a new CCP-1116 on a digital port (for 2channel operation on an odd port with the following

even port unused).

If you add the CCP-1116 panel to an odd port and the following even port is not used, the Director enables

the second channel automatically. If you don't want this, you have to remove the flag "enable 2nd audio

channel" in the Properties > General of the CCP-1116 manually (see chapter "Configuring a 2-channel

Panel").

Figure 598: CCP 1116 – Creating a new CCP1116

Open the Panel view with a double click on the port.

Figure 599: CCP 1116 – Display in Director
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5.2.1 Key Assignment Commentator A/B

The commentator Function buttons, like "ON AIR, MIC MUTE, AUX1, AUX2", etc. cannot be configured and

monitored in Remote control in the Director. They are just showing the Design of the CCP-1116.

Now you can add all needed functions to the keys of the CCP-1116 with drag and drop.

When you want to use the panel with 2 commentators you can virtually split the keys in the middle and configure

functions for Commentator A on the left and for commentator B on the right keys.

It is useful, to set up different text colors for Com A and B in the properties of each key (see also chapter

"Set up individual text color for single buttons").

Figure 600: CCP 1116 – Example of partitioning Commentator A/B

Please keep in mind, that on all functions for the commentator B the second audio channel as source has to be

enabled as source. You can find this option in the properties of the audio functions.

So open the properties of the keys with audio functionality for commentator B one after the other and enable the

second audio channel as source for "Call to..." functions, and as source for "Listen to..." functions.

Figure 601: CCP 1116 – second audio channel for Commentator B functions
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When Commentator-A needs to talk directly with Commentator-B and reverse, just drag and drop this CCP-1116 panel

to both sides of the panel to create "Call to port" functionality.

Afterwards it recommended editing the key label of both keys manually.

The other possibility is to activate the keys "MIC-B ON", resp. "MIC-A ON" direct on the CCP-1116 to route

the Mic signal of the other commentator permanently to the own Phone-mix.

Figure 602: CCP 1116 – Setup Comm A<>B 

Commentator A > B

Figure 603: CCP 1116 – Setup Commentator A>B
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Commentator B > A

Figure 604: CCP 1116 – Setup Commentator B>A

Please keep in mind, that on audio functions on other ports to call/listen to the Commentator B also the second audio

channel of the CCP-1116 have to be used. Therefore you have to activate the flag "to 2nd channel" in the properties of

the function. It is useful to manually label the key in "Com B" or similar.

For the Commentator B there are some limitations at the moment:

· Reply is not working correctly for the Commentator B (for the second audio channel)

· It is not possible, to use an IFB from the IFB-Table for the second Commentator. Here you have to

configure an IFB in the "manual" way for the second audio channel.
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5.2.2 GPIO Functions

Open the "Properties" of the CCP-1116 to define the GPIOs.

'GPIO In 1' and 'GPIO In 2' can be used within the Artist system to signalize activated 'ON AIR' buttons on the CCP-1116

somewhere and somehow in the system.

'GPIO Out 1' and 'GPIO Out 2' are used internally in the CCP-1116 to activate the 'MIC MUTE' buttons, for example when

the Commentator is talking to an Intercom destination while he is on air.

Both GPIOs will be labeled automatically with the panel name and functionality.

Figure 605: CCP 1116 – GPIO configuration

'GPIO IN 3' and 'GPIO OUT 3' are the only ones, which can be used individually. The GPIO 3 is available on a XLR5 pin

connector on the rear side of the CCP-1116.

Now you can drag and drop GPO 1 and 2 to all the intercom buttons, that are able to activate the microphone of the

panel (Call to Port, Call to Group, Call to Conference), to automatically activate the on-air 'MIC MUTE' button of the

corresponding Commentator-side.

For only listen functions (Listen to) an assigned GPO is not necessary.

Figure 606: CCP 1116 – Allocation of the mute GPOs
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5.2.3 'On-Air' Audio Routing

On a CCP-1116 the on-air audio is routed in general to the analog on-air outputs on the rear side of the CCP, when the

'ON AIR' button is pressed.

But it is also possible to use the on-air audio additional within the Artist system, for example at an analog/AES or MADI

output of the system, that is directly connected to the mixing console (in this case the analog outputs on the panel can

be used as backup).

Therefore you have to add just one "Route Audio" command to the GPI INs 1 and 2 (for commentator A and B) of the

CCP-1116.

So for the 'ON AIR A' audio do a right-click on the GPIO IN 1 and add a new "Route Audio" command. Select as source

this CCP-Panel (first channel) and as destination the output port within the Artist system you want to use.

Figure 607: CCP-1116 – Route on-air audio

Figure 608: CCP-1116 – ROUTE on-air from COM A



428

Director 7.20 User Manual A10

Repeat this step for the Commentator B by adding a "Route Audio" command to GPIO IN 2.

Just activate the option "From 2nd channel (instead of first)" when selecting the CCP as source. The destination can be

another output of the system and/or also the same output which is used for on-air audio A.

The "MIC MUTE" button of the CCP also works in this mode like expected. If you put the GPIO OUTs to the

Intercom-keys like described before, the "MIC Mute" will also work for these keys.

5.2.4 Commentary Audiopatch Settings

Finally you have to adjust the internal audio routing of the Audiopatches in the CCP-1116.

The audio in-and outputs of the Audiopatches are used inside the CCP-1116 as follows:

Audiopatch INPUT CCP-1116

Panel MIC Standard panel gooseneck microphone

 (only when the CCP-1116 is used as a pure intercom panel).

Headset Intercom A Headset-A Intercom (XLR 5pol. front side)

 (only when the CCP-1116 is used as a pure intercom panel).

Line In LINE-IN Input (XLR 3pol. rear side) only available when Panel Mic is set to be active in

the Audiopatch. For a permanent Audio routing (without activating a Call key) a "Hot

mic" function is required for example on the virtual Function of the CCP-1116.

Headset Intercom B Headset-B Intercom (XLR 5pol. front side)

 (only when the CCP-1116 is used as a pure intercom panel).

MIC A MIC-A (XLR 3pol. front side) 

The key "MIC MUTE A" takes effect always on this input signal. Exclusive this signal is

routed hard wired to the XLR "AIR A OUT" and "AIR A+B OUT" analog outputs and can

be affected by the "ON AIR A" key.

MIC B MIC-B (XLR 3pol. front side) 

The key "MIC MUTE B" takes effect always on this input signal. Exclusive this signal is

routed hard wired to the XLR "AIR B OUT" and "AIR A+B OUT" analog outputs and can

be affected by the "ON AIR B" key.

Matrix CH. 1 Audio-Ch.1 (Commentator-A)

 Intercom coming from the matrix to the CCP-1116.

Matrix Ch. 2 Audio-Ch.2 (Commentator-B)

 Intercom coming from the matrix to the CCP-1116.

Audiopatch OUTPUT CCP-1116

Speaker Standard panel loudspeaker

Headset Intercom A Headset-A Intercom (XLR-5pol. front side)

External Speaker Ext. Speaker (XLR-3pol. rear side)

Headset Intercom B Headset-B Intercom (XLR-5pol. front side)

Phones A Phones-A (Stereo-jack, front side)

Phones B Phones-B (Stereo-jack front side)

Matrix CH. 1 Audio-Ch.1 (Commentator-A), Intercom from the CCP-1116 to the matrix

Matrix Ch. 2 Audio-Ch.2 (Commentator-B), Intercom from the CCP-1116 to the matrix
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For the basic commentator functionality the Audiopatches of the CCP-1116 are adjusted by the Director to the

Commentator Headset In/Outputs automatically. These settings are identically for Speaker- and Headset mode:

Figure 609: CCP 1116 – Basic configuration CCP1116 Audiopatch

Internal audio circuits of the CCP-1116:
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Figure 610: CCP 1116 – internal audio circuits of the CCP1116
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5.3 Using RIF-Interfaces as GPIO Extension

5.3.1 RIF in General

The RIF-Interfaces were primarily developed to be able to use third party or custom-made keys (e.g. a Buzzer) and

signalization (Lights) as ordinary panel-keys. Therefore the RIF-Interfaces offer a high number of GPI-Inputs and

Outputs. In this case, the RIF-"Buttons" can be configured like any other panel key.

5.3.2 Configuring a RIF-1032, Connected to a DIF-1000

The RIF-1032 is designed as an expansion panel and will not work stand-alone. To connect a RIF-1032 to an Artist Node,

a DIF-1000 Panel or another intercom panel with an expansion port is required. In case of the DIF-1000 the RIF-1032 is

connected from the DIF-1000 "Exp." to the RIF-1032 "Exp.IN".

In this constellation the address of the first RIF-1032 device connected to the DIF needs to be set to "0" 

Figure 611: RIF-1032 – How to connect

It is not possible and not necessary to add a DIF-1000 Panel to the configuration as this is transparent to the system.

In the Hardware setup of a Node, just select the Card and Port number and add the RIF-1032 from the "Miscellaneous"

range of devices. If more than one RIF-1032 is connected to the DIF-1000, you need to add them as expansions.

Maximum 6 additional RIF-1032 can be connected as expansions, which is 7x RIF-1032 in total with the one connected

to the DIF-1000 (> 224x GPIO max).

Figure 612: RIF – Adding a RIF-1032 connected to a Dif-1000
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The RIF-1032 will be shown as a panel with 32 keys in the Panel-View.

Figure 613: RIF – Display RIF-1032 connected to a DIF-1000 in Director

5.3.3 Configuring a RIF-1032 as a Panel Expansion

When connecting a RIF-1032 to an existing key panel, you need to connect it to the "Expansion" connector of the main

panel. You then need to set the address (ID) of the RIF-1032 to the same address selected in the configuration (>0).

A RIF-1032 can only be connected on RCPs of the 1000, 2000 and 3000 series panels (NOT 1100 series!).

The RIF-1032 does not have a SHIFT page. Also when the main panel is switched to the Shift page, the RIF-

1032 stays on its single page.

The lowest address (ID) of a RIF-1032 as an expansion is "1".

Just select a RIF-1032 as an expansion in the "Expansions" column.

Figure 614: RIF – Adding a RIF-1032 as extension
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The RIF-1032 will be shown as an expansion panel with 32 keys. The selected expansion-ID is displayed on the right

side of the RIF-1032.

Figure 615: RIF – Display of a RIF-1032 connected as expansion in Director

5.3.4 Configuring a RIF-2064

The RIF-2064 is a discontinued product, but it is still supported by the configuration software. The RIF-2064

is only equipped with a CAT5 connector. If you want to connect it to a COAX port, you will need a "CIA"

COAX to CAT5 converter incl. power supply.

A RIF-2064 cannot be connected via VoIP or ISDN to the Matrix caused by technical protocol differences of

the RIF-2064.

To add a new RIF-2064 to a configuration, you need to add it to the selected client card / port by choosing

"Miscellaneous" > "RIF-2064".

Figure 616: RIF – Adding a new RIF-2064

The RIF-2064 will be shown as a panel with 64 keys.

Attention: There are no Audiopatches and no Expansions available for the RIF-2064.

Figure 617: RIF – Display of a RIF-2064 in Director
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5.3.5 Using/Configuring the RIF as a GPIO Expansion

The RIF-Interfaces were primarily developed to be able to use third party or custom-made keys (e.g. a Buzzer) and

signalization (Lights) as ordinary panel-keys. Therefore the RIF-Interfaces offer a high number of GPI-Inputs and

Outputs. In this case, the RIF-"Buttons" can be configured like any other panel key.

But very often the RIF-Interfaces are used to get more common GPIOs to a dedicated location. For this application, the

configuration within the Director software for these RIF-GPIOs is different to conventional GPIOs of a GPI-card or Panel

GPIOs.

5.3.6 Activating a GPI Output of a RIF Interface

To be able to switch a dedicated contact of a RIF, you need to think in the ordinary Panel-key world.

The RIF output contacts will NOT show up in the GPIO list of the Director, because normally each output contact

belongs to an external panel key and is normally used to activate a signaling light dedicated to this key.

So to trigger an output of a RIF, you have to "activate the signaling light of a key".

Example: A panel should be able to trigger the RIF contacts 1, 4 and 9.

5.3.7 Editing the Marker-Definition

Because you need to show a signalization on this RIF to trigger a GPI output, it is necessary to use the "Remote key"

command with the activated option "Set the signaling Marker".

But first you need to define this "marker", so that the GPI output will react exactly like you want it to.

Therefore go to "Edit" and open the "Marker Definitions".

Figure 618: RIF – Open Marker Definitions
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Select one free "User definable" marker out of the list and double click this entry.

Figure 619: RIF – Marker Definitions – RIF User defined

Enter a Name for this new Marker, for example "RIF – GPIO activated".

Then select in the "RIF" section, if the light (thus the GPI output) should be on or flashing.

Figure 620: RIF – Edit free definable RIF-Marker
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5.3.8 Switch RIF GPI Outputs by Command

Now you need to go to the position in your configuration (Panel key, Vox, OnCall, Logic ...) from which you want to

trigger the RIF GPI output. In our example this is a Panel key.

Right click on this panel key and add a new "Remote key" function.

Now select the exact position and number of the RIF-Button you want to activate, enable "Set signaling Marker" and

select the new Marker "RIF-GPO activated".

Figure 621: RIF – Add function – Remote key

Figure 622: RIF – Trigger GPI out with remote key – signaling
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When you want to add this as a single function to a panel key, it is useful to manually edit the label of this key.

Otherwise it will only show the label "Remote".

Figure 623: RIF – Edit key label

Repeat this procedure also for all the other RIFs outputs you want to activate.

Figure 624: RIF – Example panel configuration to switch RIF-GPIOs

5.3.9 Using a GPI Input of a RIF Interface

To use and activate a command or a set of commands within the system by an incoming contact into the RIF-Interface

is quite easy.

Again these GPI inputs are NOT shown in the Directors GPIO list, because for the system these GPI inputs are just

ordinary Panel keys.

All you need to do is place the functions you want to activate with a RIF-Input on the corresponding RIF -"Panel key", by

drag and drop or with a right click to select the function you want to use. Like everywhere else in the Artist system you

can put up to 32 functions on each individual key (GPI Input).

You can adjust the properties of this key (Momentary, Latching, Auto, Radio button...) like any other key, so you are very

flexible about how your "GPI Input" is working.

Figure 625: RIF – Adding a command to the RIF GPI Input
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5.3.10 Changing Markers

On ordinary Panel keys (also on RIF keys), every key-press will also show a signalization on the same key as

confirmation, depending on the function. This marker will indicate that the function is activated.

Example: If you press a key with a "Call to Port" function, the same key will show the "Call to Port activated" marker.

If you want to use the RIF-interface as GPI Input device, it is necessary to adjust also the RIF-Markers for the activated

functions you want to use on the RIF-keys. Otherwise every RIF "GPI input" will activate the corresponding "GPI output",

depending on the function.

Figure 626: RIF – RIF Markers for activated functions
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Open the "Marker definitions" ("Edit" > "Marker definitions"), select the functions you want to use on RIF "GPI inputs" and

set the RIF-Marker to "off". Repeat this for every function you want to use on a RIF.

Figure 627: RIF – editing RIF markers for activated functions

It is not recommended to combine different RIF-Interfaces used as ordinary key panels and also as GPI-

extension within the same system. In this scenario the RIF markers, used as Panel keys, will be off. To get a

signalization in this situation, you have to create an additional "Free definable marker" (RIF: ON). Then you

have to add this marker to every configured key of the RIF keys manually.



439

Director 7.20 User Manual A10

5.3.11 RIF to RIF GPIO

When combining both directions it is also possible to "transmit" a RIF – GPI Input to a GPI output of another RIF

Interface.

Special example:

RIF-1032 GPI Input 7+8 should trigger RIF-2064 Output 7+8 and vice versa:

Figure 628: RIF – Example configuration RIF to RIF

Do not forget to adjust the markers in the "Marker-Definition".
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6 System Parameters

6.1 Default Settings

Parameter Minimum Maximum Default

Min. Speaker Vol. -45dB 0dB -45dB

Min. Headset Vol. -45dB 0dB -45dB

Beep Volume mute 0dB -30dB

Beep On Call Duration 0ms 1000ms 250ms

Speaker Dim Level mute 0dB -18dB

Initial single volume mute +6dB 0dB

Initial conference volume mute +6dB 0dB

Vox On Threshold permanent +12dBu -24dBu

Vox Off Threshold -69dBu +9dBu -27dBu

Vox Hold Time no delay 6400ms 800ms

Brightness of LEDs / LCD Keys 10% 100% 50%

Brightness of LED Keys / LCD 10% 100% 30%

Response Timeout 0ms 1000ms 32ms

Response Timeout ISDN 0ms 1000ms 200ms

Dim lower Prios for "Standard" mute 0dB -12dB

Dim lower Prios for "High" mute 0dB -18dB

Dim lower Prios for "Paging" mute 0dB -24dB

Dim lower Prios for "Emergency" mute 0dB mute

Reply Key Timeout 0s 24hrs 3s

Minimum XP Volume mute 0dB mute

Input Gain* -18dB +18dB 0dB

Output Gain* -18dB +18dB 0dB

GPIO Out Off Delay no delay 5s no delay

* When controlling the I/O gain of a port using a panel, the gain can also be muted.
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Parameter Minimum Maximum Default

Audiopatch Input Mic Pre-Amplifier Gain 0dB +20dB 0dB

Audiopatch Input Amplifier Gain mute, 0dB +18,5dB +3dB

Audiopatch Input High Pass Filter Cut-Off off, 40Hz 640Hz off

Audiopatch Input Low Pass Filter Cut-Off off, 1kHz 16kHz off

Audiopatch Input Compressor Threshold -48dB +12dB -15dB

Audiopatch Input Compressor Ratio 1:1 8:1 2.5:1

Audiopatch Input Compressor Attack 100µ s 100ms 20ms

Audiopatch Input Compressor Release 10ms 1s 500ms

Audiopatch Input Limiter Out-Level -33dBU +12dBU +9dBU

Audiopatch Input Limiter Threshold -6dBr +6dBr -3dBr

Audiopatch Input Limiter Attack 100µ s 100ms 200µ s

Audiopatch Input Limiter Release 10ms 1s 200ms

Audiopatch Crosspoint Level -60dB +12dB 0dB

Audiopatch Output High Pass Filter Cut-Off off, 40Hz 640Hz off

Audiopatch Output Low Pass Filter Cut-Off off, 1kHz 16kHz off

Audiopatch Output Compressor Threshold -48dB +12dB +12dB

Audiopatch Output Compressor Ratio 1:1 8:1 1:1

Audiopatch Output Compressor Attack 100µ s 100ms 50ms

Audiopatch Output Compressor Release 10ms 1s 500ms

Audiopatch Output Limiter Out-Level -33dBU +12dBU +6dBU

Audiopatch Output Limiter Threshold -6dBr +6dBr +6dBr

Audiopatch Output Limiter Attack 100µ s 100ms 100µ s

Audiopatch Output Limiter Release 10ms 1s 100ms

Audiopatch Output Amplifier Gain -27,6dB 0dB 0dB
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6.2 Specifications / System Limits

Parameter Node Net Notes

Nodes - 128

Ports 128 1024 Any combination of 4-wires and panels is possible.

Max number of simultaneous software

connections per Node (Director/Trunk-

Navigator/ RRCS/SNMP)

4 - Maximum 4 software instances can be connected

at the same time to a Node (for example: 

2 Directors, 1 Trunk-Navigator = 3 connections).

Groups 500

Group members 100

Conferences 500

Conference members 100

Keys per control panel 124 RCP-1028 with 6 x ECP-1016

Functions per key or Virtual Function 32

Reply key entries 20 Lists the last incoming calls to the panel.

GPI inputs 1000

GPI outputs 1000

Logic functions 64 8192

Logic inputs no limit

Logic inputs per function 8

Scroll-Lists 100

Entries per Scroll-List 1000

Scroll-Lists per panel 1 Not available for RSP-2318, 3000 and 5000 series.

Users per configuration 50

Available user rights per user 255

Port Short lists 100

Events 1000

Actions per Event 100

Scheduled tasks 1000 Max task auto end: 24h, Resolution 1 Minute.

IFBs 1500

Active audio sources per audio crosspoint 20

Simultaneous activations per audio

crosspoints

255

Forced Crosspoints in the crosspoint view 1024

Active trunk calls 2048

Active RRCS actions 12287

Maximum volume level +18dB
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The Director limits can be opened in the menu Help > Limits...

Figure 629: Director Limits
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7 Special Features (Software add-ons)

7.1 Unlocking Software Add-ons

This part of the manual describes the four optional software add-ons that are currently available in Director. Generally,

all functions and add-ons are implemented in Director.

However, in order to use the add-ons they must be first unlocked. The unlocking process always takes place only on the

local PC. If several configuration PCs are used on an Artist system, each PC must be unlocked separately in order to use

the add-ons.

There are two ways to unlock special features:

· Manual activation key > (not supported anymore, please use a USB dongle)

· USB dongle

You must be logged in as the Administrator in order to activate special features.

7.1.1 Manual Activation Key

On the basis of various PC components, such as the hard drive ID and MAC address, Director generates a unique code

for each software add-on. To unlock one of the special features, the codes were generated and sent by Riedel in the

past.

This code is only valid for a particular software add-on used on a particular PC. If you change PCs or

replace your hard drive the codes from the past will no longer be valid. In that case, you have to use the

USB-Dongle method.

You only have to activate a special feature on a PC once because the code is saved in the Windows registry. Upgrading

to a new version of Director does not require a new registration.
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7.1.2 USB Dongle

The dongle automatically activates all special features that you have ordered as long as it is connected to the PC. This

activation method has the advantage that you can quickly change the configuration PC without causing any problems

with the software registration, for example in an emergency situation.

Depending on your operating system, you may have to first install the corresponding USB driver. The driver is delivered

along with the USB dongle. After the installation, restart Director.

It is not necessary to activate the dongle in Director. Director automatically recognizes whether the dongle is installed

or not. All special features that you have ordered will be immediately available for use. Registration using the "Extras"

menu is not necessary.

Open "Extras" > "Register Special Features" window, to see which Add-Ons are activated by the dongle.

Figure 630: Register Special Features

If features in Director were already manually unlocked in the past is no problem. The dongle has priority. If the dongle

is removed the manual registration remains active.

USB dongles DO NOT support any kind of VM-ware. So when using for example "Remote-Desktop" or any

other Remote software, the USB dongle is deactivated.
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8 Partial Files

8.1 Purpose

The special feature "Partial Files" enables you to save and load only a certain part of a configuration. For example, you

can switch back and forth between different assignments for specific keys or complete configurations for panels. When

needed, these partial configurations can be sent to the system to change the functionality of one or more control

panels. These partial configurations only affect certain objects, such as particular panels, and can be loaded to the

system without changing the entire configuration. The partial configuration files are saved on a hard disk and called up

as needed. The use of a base configuration in conjunction with partial files, that are either manually or automatically

loaded, offers maximum flexibility in the use of the system.

Partial files can be loaded in various ways. They can be manually opened from a hard disk and sent to the system.

Partial files can also be loaded using a XY-Matrix in Director. Activating a crosspoint in this matrix automatically loads a

corresponding partial file into the system. The easiest way to load a partial file is with the "Partial File Trigger". Using this

tool a partial file can be loaded via a logic function placed on a panel key or GPI. In this case, it is necessary that the PC

where the saved partial files are located is permanently online and connected to the system.

8.2 Creating Partial Files

When using partial files, you should always create a pair of files – an "ON" file and an "OFF" file. This means that before

you begin to make changes on a panel to save as a partial file, you should first save the current status of the panel as

its own partial file. This allows a return to the original configuration state. The "ON" file represents the temporary

configuration change, and the "OFF" file allows the return to the basic configuration.

A partial file may be assigned nearly any element or function that is available in Director, from a complete node to

individual keys, conferences, groups, logics users, Scroll-Lists, etc.

Attention: IFBs from the IFB-Table cannot be modified by Partial Files.

In the File menu, select "Save Partial Configuration as ..." to save a certain part of the base configuration as a partial file.

Figure 631: Partial Files – File – Save Partial Configuration as ...
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A window opens in which all nodes, users and functions in the base configuration are displayed in a tree structure.

Figure 632: Partial Files – Define Partial Configuration selection

Director automatically marks items that were changed since the configuration was last saved.

A box filled red  indicates something that was changed. A box that only has a red dash  means that the change

took place in a level below that point. Click the  symbol to expand.

To select an item manually, click on the box next to it. If the box is filled in red, the item will be included in the partial

file.

If you are using different Users within your configuration with the right to load the partial file, you have to

click on the users, so that they are highlighted. Otherwise only the Administrator is allowed to load this

Partial File.

All of the items marked with the red box can then be saved as a partial file. Click  to save.
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If you are working with a system that already has existing partial files, it is imperative to create any partial

files from the base configuration. If you were to simply load the current configuration from the matrix to

create a new partial file, it could be that an existing partial file was already active within the Artist system.

This would result in it no longer being possible to remove all of the partial files to return to the original

configuration.

Before creating a new partial file it is therefore necessary to deactivate all existing partial files by loading

their corresponding "Off Files" to the system. Afterwards, the configuration can be read out of the system

or you can load the base configuration from a hard disk to create a new partial file.

Please take note that when you load a configuration from the system to the PC in order to save it, it may

contain an active partial file. If this configuration were then to be saved as a complete configuration file,

any active partial files would also become part of the configuration. The base configuration would then be

unusable. Before saving the configuration make sure that all partial files have been deactivated.

8.2.1 Creating a Partial File Mask

Up from version 6.40 it is possible to generate and use a Partial File Mask to simplify the generation and editing of

Partial Files. The mask allows to create, define and save a preselect ion of elements in the Partial File tree.

To create a new mask, click on "File" > "Save Partial Mask as...".

Figure 633: Partial Files – opens the "Save Partial Mask" window



449

Director 7.20 User Manual A10

The new window "define mask file" looks nearly similar to the "Save Partial configuration as..." window.

It shows a tree-structure of your current system configuration. Just mark the elements that should later be used in a

Partial File. The selected elements show a  symbol. Depending on which position you are selecting an element, all

other elements in the same branch are included.

Figure 634: Partial Files – Define Mask File

When you have done your selection, just click , to locally save the new mask to your PC.

The new file is labeled as "Name.PartialFileMask" and saved in the selected folder.
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8.2.2 Using a Partial File Mask

When you now want to create a new Partial File, or to modify an existing file, you can do the necessary configuration

changes in the base configuration.

When you have done all changes, just open "File" > "Save Partial Configuration as..." as wonted to save a new Partial File.

In the configuration tree all changes since the last saving are marked with , resp. .

Now click on the button , to open a before created partial file mask.

Figure 635: Partial Files – Open a Partial mask
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When the mask has been loaded, only the preselected elements of the mask are shown.

Figure 636: Partial Files – Save a masked Partial Files

Now click on , to save the new Partial File. Now the Partial File contains only changes that

have been predefined in the Partial File Mask.
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8.3 Download a Partial Configuration File

"Partial" configuration files only include a part of a complete configuration. These partial files only affect, for example, a

single panel and can be loaded into the system without changing the rest of the configuration. The partial files are

saved to a hard disk and opened as needed. The use of a base configuration in conjunction with partial files, that are

either manually or automatically loaded, offers maximum flexibility in the use of the system.

The hardware setup of ports that are used in partial files cannot be changed in the base configuration

afterwards. If you do that, the partial file cannot be loaded completely anymore. Also when you change for

example a DCP-2016 that is used in a partial file to a DCP-2116 in the base configuration, the partial file

cannot be loaded completely to the base file. All other changes on other ports in this partial file are still

loaded. A warning message will inform you about the elements, which cannot be loaded.

A partial file may be assigned any element or function that is available in Director, from a complete node to individual

keys, conferences, groups, logics users, Scroll-Lists, etc. (see chapter "Creating Partial Files").

To manually load a partial file, select "File" > "Open Partial Configuration...". A window opens where you can open

previously saved partial files ending with "*.Par".

Figure 637: Partial Files – Opening a partial configuration file

Select the partial file you wish to load and click

"Open", or simply double click on the file. The

file will be opened and added to the base

configuration.

Using the  button, the partial file can now be loaded into the system. 

Note: Director does not ask for confirmation before loading the file. Make sure that the corresponding base

configuration is already open in Director.

Partial Files do not support the "Auto Reverse Talk for 4-wire" function which automatically programs a

return audio path from a 4-wire to a control panel. If you add a call from a panel to a 4-wire in a partial file,

you must manually configure the return audio route to the panel as a part of the partial file.

Partial Files are always adding. This means for example, when you want to change all functions of a panel

key by loading different partial files, all new functions of the partial file are just added to the already

existing functions. If you want to remove other functions before, it is necessary to create a corresponding

OFF-Partial file. This means you have to create a new Partial file where you have to remove all functions of

the key first. This OFF-file has to be loaded, before you can load the Partial File with the new key functions,

to prevent the adding function of Partial files.
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8.4 Open Partial Files

There are three different ways to open partial files. The easiest way is to load the partial file via the "File" menu, as

described above. To open complex combinations of partial files, for example to automatically load files for particular

studio assignments, the "Partial XY-Matrix" can be used. It allows pre-defined partial files to be loaded or deactivated by

setting a crosspoint in the matrix. Another possibility to open partial files is with the "Partial File Trigger" function. This

function allows partial files to be connected to a logic source. When the source is activated, for example by a key press

or GPI input, the partial file is loaded automatically.

Figure 638: Partial Files – File – Open Partial Configuration ...

The "XY-Matrix" and the "Partial File Trigger" require Director to be permanently connected to the system.

Director must be open and the files required should be saved locally on the hard drive of the PC. Only one

Director PC in a network can have this option active.

These options can be set in the "Partial Files" tab found under "Settings" > "Options". With the XY matrix it is possible to

only use the local Director as a server while the setting of the actual crosspoints in the XY-matrix takes place on

another "Client" PC. This has the advantage that the PC with the partial files can be located in a machine room while the

control of the partial files can be carried out at a regular workspace. In this case, the partial files remain on the server.
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Figure 639: Partial Files – Settings / Options / Partial Files

Handle Partial File

Trigger...

Selects whether Director will load partial files that were triggered by a logic source.

WARNING! The partial files must be saved on the local PC. Only one Director PC in the

system can have this option active at a time.

Restrict crosspoints When this is selected only one crosspoint is allowed to be active in each row or column. In

order to set a new crosspoint, previous crosspoints must first be removed. If this option is

not activated, only one crosspoint may be set in each row, but multiple crosspoints can be

set in a column.

Standalone mode The XY-Matrix is controlled from the local PC.

Server mode This PC acts as a server. The partial files are controlled by the client PC.

Note: All partial files must be saved locally on the hard drive of the sever PC.

Client mode This PC acts as a client and controls the server PC. The individual partial files should not be

located on this client PC.

Server IP to connect to If your PC is set to be a client, you must enter the IP address of the server PC where the

partial files are located.
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8.4.1 Belated Changing of Partial Files

When you need to do changes on an already existing Partial File, you have to load the base configuration first in the

Director.

Now select "File" > "Save Partial Configuration as..." and remove all  resp.  markers.

When you have created a Partial Mask before, you can also load the corresponding mask (see chapter "Partial Mask").

When you now select "File" > "Save Partial Configuration as..." the "Define Partial Configuration" window shows you all

elements that have been changed by loading the Partial file. All elements that have been changed are marked with the

symbols (everything in this tree) or (just some parts of the tree). This helps to see all changes that already have been

made in the loaded Partial file.

Cancel the operation now with .

 > 

Figure 640: Partial Files – Define Partial Configuration – Display of changes

Now you can edit the loaded Partial file.

All new changes are added to the already existing changes. You can also find them now in the "Define Partial

Configuration" window with the symbols  resp.  on the modified positions, as long you do not save the

configuration. When you are done editing the Partial File, open again the window "Define Partial Configuration" by

selecting "File" > "Save Partial Configuration as..." and press the button . Now save the

edited Partial File with the same name like the already loaded file. Press "Yes" when you get the message "Overwrite

existing File".

All new made changes + all changes of the complete loaded Partial file are saved together into one Partial file.

When the Partial file has been saved, all markers in the "Define Partial Configuration" window will be removed.
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8.4.2 XY-Matrix

The "XY-Matrix" is a convenient tool for handling partial files in a variety of production settings. Each row and column of

the matrix can be customized. This is useful, for example when a number of control rooms must be dynamically

assigned to several different studios. Depending on the situation, crosspoints in the XY-Matrix are set and the

necessary configuration is automatically loaded into the system.

You can open the XY-Matrix by selecting "View" > "Partial Files XY-Matrix" or by clicking on the  button in the toolbar.

Figure 641: Partial Files – Open "View" > "Partial Files XY-Matrix"

The XY-Matrix window will be empty the first time you open it.

Figure 642: Partial Files – XY-Matrix (not yet configured)
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Update Loads the required partial files of the last changes and sends them to the Artist

system.

Update All First loads all of the "Off Files" in the background without sending them to the Artist

and then it loads all the actually activated "On Files" from the hard disk and sends

them to the Artist system.

This allows removing different active partial files, changing the same Members/keys

without failures when removing a single partial file.

Load Offline Loads the required partial files locally in the configuration without sending the

changes to Artist.

Load All Offline Loads all of the "Off Files" and the required "On Files" from the hard disk without

sending the changes to Artist. This option can be used to test whether the partial

files load correctly.

Edit XY-Matrix setup... Opens the edit window for editing the XY-Matrix.

Close Closes the XY window.

Click the  button to customize the XY-Matrix according to your requirements. It is only necessary to

set up the XY-Matrix on the server if running in client-server mode. The view from the server will be shown in the XY-

Matrix on the clients as soon as there is a connection.

Figure 643: Partial Files – XY-Matrix setup

You can create entries on both the X and Y axes by clicking the corresponding  button.

Figure 644: Partial Files – Adding an entry in XY matrix
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Assign the row or column a name. For each entry you can assign 2 GPI inputs that will trigger a signal next to its name

in Director. These signals can be used to indicate on-air or rehearsal status in a studio. This way you can see in the XY-

Matrix if certain studios are being used, and thus avoid changing their configuration. Create all of the entries necessary

on the X and Y axes.

You can change the order of items by selecting them and using the  and  buttons.

Figure 645: Partial Files – Example XY-Matrix setup

Close the configuration window by clicking "OK" to see the updated XY view.

Figure 646: Partial Files – XY-Matrix
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After the basic matrix layout has been created, you must assign partial files to the individual crosspoints. Right mouse

click on a crosspoint and select the corresponding partial file. The files should have already been created.

Figure 647: Partial Files – XY Matrix – Selecting Partial Files in XY matrix

Select "Select new On-File for..." the crosspoint. A window opens where you can select the corresponding ".Par" file.

Repeat for the respective off file and all other crosspoints in the XY-Matrix.

Figure 648: Partial Files – XY-Matrix – Selecting the Partial Files

All XY-Matrix settings, including the assignment of partial files to crosspoints, are saved in the same

directory that Director is located in. A file called "Director_RPS.xml" is automatically created which contains

this information. The XY-Matrix setup is not a part of the standard configuration file. If you move Director

to another directory or to another PC, you must also move the "Director_RPS" file.
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To make an assignment in the XY-Matrix, click on the corresponding crosspoint. The crosspoint will be highlighted

yellow. (If you are running the XY-Matrix in server-client mode, you must first click the  button to connect

to the server. The XY-Matrix settings will then be directly displayed on the client PCs.)

Figure 649: Partial Files – XY-Matrix – Switching Crosspoints

The corresponding partial files will be loaded to the Artist system by clicking on the  or  buttons.

The yellow highlighting will then disappear. This indicates that the crosspoints are currently active in the system.

Figure 650: Partial Files – active Crosspoints

In "Settings" > "Options" > "Partial Files" you can change the behavior when selecting several Crosspoints.

Figure 651: Partial Files – Options – Restrict crosspoints



461

Director 7.20 User Manual A10

When the checkbox "Restrict Crosspoints" is activated, you can only activate one XP at a time for every row- and column.

When you want to activate another XP, you first have to deactivate the active XP.

When unchecked you can activate several XPs simultaneously within the same column. Only one XP is allowed per row

here as well.

When activating a XP in the same row, the already active one will be deactivated automatically.

Figure 652: Partial Files – XY Matrix – possible active Crosspoints when restrict Crosspoints deactivated

Client/Server Mode8.4.2.1

The XY-Matrix setup and the partial Files are stored only locally on one Director PC.

When you want to use the XY-Matrix from different PC´s simultaneously to switch between different partial files, you

need to set up a XY-Matrix Server PC.

On the XY-Matrix Server PC, a Director has to be running and be connected to the Artist system all the time. All partial

files and also the setup of the XY-Matrix (X/Y -axis labels, the partial files and the XPs with the assigned partial files) are

locally located on the Server PC.

The setup of the XY-Matrix is saved in the "Director_RPS.xml" file, located in the Director folder.

The Director PCs, configured as "XY-Matrix Clients" can access the XY-Matrix of the Server Director and remote control

the matrix. All changes in the XY-Matrix setup and also partial file modifications have to be done on the Server Director.
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Setting up the XY-Matrix Server PC8.4.2.2

In "Settings" > "Options" > "Partial Files", you have to change the setting to "Server Mode".

Figure 653: Partial File – Options – Server mode setup

Now you can configure the XY-Matrix like it is described in the previous chapter.

When you open the XY-Matrix, you can see that the matrix is now running in "Server mode".

Figure 654: Partial Files – XY-Matrix – Server mode activated

You can also use the XY-Matrix of the Server PC to switch between different XPs.
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Setting up the XY-Matrix Client PC8.4.2.3

In "Settings" > "Options" > "Partial Files", you have to change the setting to "Client Mode".

Also you have to enter the IP-address of the Director PC, which is set as Server.

Figure 655: Partial Files – XY-Matrix – Client mode setup

There is no limitation in the number of XY-Matrix client PCs.

When you now open the XY-Matrix on one of the Client PCs, you have to enable the Network in the XY-Matrix by

pressing the  button, to establish a connection to the Server Director. When the connection is

successfully established you get a green message "Client Mode: Ready!". Then you can see exactly the setup of the XY-

Matrix of the Server PC.

If the Server Director is not reachable, you get the message  and the network will be

disabled after some seconds.

The XY-Matrix network-button  is independent from the Director  button. So you can

access the Server PC without connecting to the Artist system.

The Server Director needs to be connected to the Artist system, because it is sending finally the partial files

to the Artist system.

Figure 656: Partial Files – XY-Matrix – Client mode activated and connected



464

Director 7.20 User Manual A10

On the Server PC the XY-Matrix will show the number of connected clients.

Figure 657: Partial Files – XY-Matrix – Server Mode – connected clients

All XP-changes that are made on one of the Client PCs or also on the Server PC will be shown immediately

on all connected XY-Matrices.

8.4.3 Partial Files Trigger

The "Partial File Trigger" offers a completely different approach to handling partial files.

This tool allows partial files to be assigned a logic source. As soon as this logic source is activated anywhere in the

system, for example by a key press or GPI input, the corresponding partial file is loaded to the matrix. This allows

configuration changes to be made quickly from any point in the system.

To use this option, first activate it under "Settings" > "Options" > "Partial Files".

Only 1 PC in an Artist system should have this option activated. This PC must permanently have Director

open and always be connected to the system. All partial files required must also be located on this PC.

Figure 658: Partial Files – Partial File Trigger – Settings > Options > Partial Files
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First, create the necessary logic functions. A logic source will be needed for each partial file.

In the "Logic" tab of the Navigation Bar, click the  button to create a new logic source. Give the source a

distinct name.

Figure 659: Partial Files – Partial File Trigger – Logic Sources

Figure 660: Partial Files – Partial File Trigger – Properties of a Logic Source
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Next, open the "Partial File Trigger" via "View" > "Partial File Trigger" or click the  button in the toolbar.

Figure 661: Partial Files – View – Recall Partial Files – Partial File Trigger

The "Partial File Trigger" window will open.

Figure 662: Partial Files – Partial File Trigger

To create a new connection between a logic source and a partial file, click the  button. The "Add/ Change

Partial File Trigger" window will open.
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In the field "Logic Source", select the logic source that should trigger the partial file.

Figure 663: Partial Files – Partial File Trigger – Add or Change Partial File Trigger

In the field "Panel which triggers the Logic Source" you can define which panels are allowed to trigger the partial file. You

can assign this privilege to a certain port by selecting it from the drop down menu. If multiple ports should be able to

load the file, check the  box.

Select the partial file that should be loaded when the logic source is activated. Click the  button.

Figure 664: Partial Files – Partial File Trigger – Selecting the Partial Files

Choose the corresponding ".Par" file and click the open button.

The "Add/Change Partial File Trigger" window will now display the logic source and partial file assignment. Click

 to close the window and confirm the changes.

Figure 665: Partial Files – Partial File Trigger – Add or Change Partial File Trigger
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An entry will now be displayed in the "Partial File Trigger" window. Repeat the steps above to make further assignments.

Figure 666: Partial Files – Partial File Trigger

To edit an assignment, double click on the entry or select it and click the  button.

To delete a selected entry, click . All assignments can be deleted by clicking the  button. Note: the

entries will be deleted without asking for confirmation.

These logic source / partial file assignments will be automatically saved in the "Director_ERT.xml" file

located in the same directory as Director. The assignments are not a part of the standard configuration

file. If you change the location of Director on your PC, you must also manually move this file to the same

directory.

You can now assign the logic sources as usual to keys, Vox, GPI inputs, etc. When the logic source is activated, the

corresponding partial file will be automatically loaded to the system.

Figure 667: Partial Files – Partial File Trigger – Assigning a Logic Source
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9 Master Control Room (MCR)

The "MCR" software add-on provides a convenient way to manage conferences and their members. It is normally used

in a master control room to dynamically assign various members to individual conferences. The "MCR" offers an

overview window where conferences can be easily monitored and changed. Individual members can be added to

conferences using Drag & Drop. The interface also shows which members are currently speaking into a conference and

what conferences are being spoken into. It can directly adjust 4-wire gain levels and use presets to manage member

assignments. The "MCR" can also be used by multiple users on different PCs and changes will be synchronized between

the PCs. The activation of "MCR" features from multiple control panels is also possible.

Figure 668: MCR – Typical MCR view

A comprehensive system of user rights allows different parts of the "MCR" to be accessible to different users, as well as

the creation of multiple user specific views. All settings and user rights are a part of the standard configuration and are

therefore independent of any specific PCs.
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9.1 Adding the MCR

To use the MCR, the special feature must first be unlocked on all of the Director PCs (see chapter "Unlocking Software

Add-ons"). Afterwards, the MCR must be added to the current configuration. Select "Edit" > "Special Interfaces" > "Add"

> "Master Control Room".

Figure 669: MCR – Adding the MCR

The symbol will appear in the network view. The  MCR can now be configured and used.

Figure 670: MCR – MCR in the Network View
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9.2 Creating the MCR Conferences

When setting up the MCR, there are a few prerequisites that must be taken care of first. It is necessary to create new

conferences that are to be used in the MCR. Open the  tab in the Navigation Bar.

Click on the  button to create a new conference. Give the conference a unique name. In order to

use the conference in the MCR, you must select the option "Enable for Master Control Room use".

Figure 671: MCR – Creating a MCR conference

If you also intend to control the MCR interface using a control panel, you must select the option "Create an associated

logic source for MCR use". This will automatically create a logic source for this conference, which is necessary for

controlling the interface from a control panel. If you only intend to use the MCR interface on the PC, this option is not

required.

Repeat the steps above for all the conferences that should be used in the MCR.

To assign a member permanent to a MCR-conference, you can add a standard "Call to conference"

command to this MCR-conference on the selected port. This member is then permanently linked to that

MCR-conference and is NOT shown in the MCR-View.
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9.3 Configuring the MCR

The MCR must be set up in advance before you use it. Right mouse click on the MCR in the Network View and select

"Properties". 

Figure 672: MCR – MCR Properties

You can also open the MCR by clicking on the  button in the toolbar and right clicking on the MCR window and

selecting "MCR Properties". Since the MCR is an online tool, the user interface will only be shown when there is an active

connection to an Artist system.

Figure 673: MCR – Properties of the MCR

A properties window will open where all of the basic settings can be made.

Figure 674: MCR – MCR Properties window
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9.3.1 Creating MCR Members

All members to be used in the MCR tool must be added and defined in advance. On control panels, this reserves an

empty key for MCR use. Each element of an MCR member corresponds to a fixed key. Each MCR member can consist of

several elements spanning multiple ports. For example, an MCR member could include different ports or just two

identical MCR keys located on the main page and shift page of a particular control panel. Because an MCR member

element corresponds to a specific key, it provides a way for a panel to be assigned to different conferences on different

keys at the same time. In this case, each key would be a separate element for the MCR member. In the members tab,

click on the  button.

Figure 675: MCR – Edit MCR Member

Every Port can be used only for one MCR member. To use the same port for different members is not

possible.

In the field "8-char Label", give each member a unique name. Using the "Alias" field, you can later assign each member

a temporary name. If you want to later remote control the MCR from a control panel, you must also activate the "Create

an associated logic source for MCR use" option. This will automatically create a new logic source for this member in

Director.
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You can now add elements to this member. Press the  button. Select a port from the "Destination" list. 

Figure 676: MCR – Add new member

If you select a control panel as a port, you must specify the exact position of the key that should later serve as a place

holder for conferences. To do so, the physical location of the key has to be defined. Under "Expansion Panel" select

whether the key is located on the main control panel or on an expansion panel. Under "Key Page", select the page

where the key is located. Under "Key", the actual key is selected. All of the key labels are shown in the drop down list.

This allows an empty key to be selected easily. If you are adding a 4-wire or 2-wire port, you do not need to specify a

key. In that case, the conferences will be programmed on the VOX function of the port.

Figure 677: MCR – Choosing the MCR key
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Assign whether the member element should be able to listen and/or talk into the conference. To do so, select the

corresponding options  and .

If you want to use the second audio channel of a panel in the MCR, select this option on

. This is only available if the panel was previously configured for 2 channel use.

Using the option , you can select whether the MCR user interface should

indicate when audio from this panel is active.

You can edit a selected entry using the  button. Using the  button deletes the selected entry.

Repeat the steps above for each member and for each member element required in the MCR tool.

Figure 678: MCR – Add new MCR Member – example

Using 4-Wires in Multiple Conferences9.3.1.1

Up from Director Version 6.0 you can choose, if you want to use a 4-wire (or 4-wire split) member in different

conferences at the same time or not.

Up to Version 5.91 all MCR 4-wire members always could be used simultaneously in different conferences.

If you now open an older configuration with Director 6.x this function is now deactivated for all 4-wires. If

you want to use a 4-wire simultaneously in different conferences, you have to enable this function for

every member individually.

If you want to allow using a 4-wire simultaneous in different conference, you have to enable

 in the "Edit MCR Member" window.
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A panel-port is always used in max. one conference at the time. If you are trying to enable the panel to be used in

multiple conferences, you get an error-window.

Figure 679: MCR – Error message when trying to use a panel in multiple conferences

If you want to have the possibility to use all new 4-wires as default in multiple conferences, you can enable this

functionality in the  tab for all 4-wires.

This setting has only an effect, when you add new 4-wire members to the MCR. Already existing members

you have to modify manually.

Figure 680: MCR – Misc – Default settings for new 4-wires
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All 4-wire/4-wire split, that are enabled to be used in multiple conferences are shown with "yes" in the column

"MultiConf" of the Member list.

Figure 681: MCR – Members-table – Multiconf

9.3.2 MCR Setup - Layouts

Open the "Conf.Layout" tab in the MCR properties to setup the MCR layout for each user.

Figure 682: MCR – Layout – Add new Port

Select the user whose view you would like to define in the "Layout for user" drop down list.

Note: you must be logged in as the Administrator.

Create pages for conferences that should appear in the MCR user interface in the "Conference Pages" field.
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Up to 20 pages of conferences can be added per user with a maximum of 48 conferences per page. However, each

conference can be assigned its own page.

Click on the  button to add a new page.

Figure 683: MCR – Layout – Add page

Enter a unique name for the page (max. 32 characters). Define the number of rows ("Row count") and the number of

columns ("Column count") for the page. There can be a maximum of 4 rows and 12 columns per page.

You can edit a previously created page by selecting it and pressing the  button. A page can be deleted by

selecting it and clicking .

Repeat these steps until all of the pages you need have been created for each user.

Figure 684: MCR – Layout – Create MCR pages

Conferences must now be assigned to the pages. Click the  button. Select a conference from the drop

down list. The list only shows conferences that are setup for use with the MCR interface (see chapter "Creating MCR

Conferences"). You can also change the position of the conference on the page, if needed. To do so, manually change

the "Row" and "Column" number. Otherwise, Director will automatically choose the next free cell for the conference.

Figure 685: MCR – Layout – Assign a conference to a page
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Distribute the available conferences as you like by repeating the steps above.

Figure 686: MCR – Layout – MCR Properties

You can also add conferences to this window by dragging them from the "Groups+Confs" tab directly using Drag &

Drop. Selected conferences can be edited or deleted by using the  and  buttons.

Close the properties window by clicking . If you are online with Artist, press <F5> or the  button to send

the changes to the system. Since MCR is an online tool, the user interface will only be shown when you are online with

the system. After sending the changes to Artist, the new MCR interface setup is available to all PCs connected to the

system.
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9.3.3 Monitoring Setup

The MCR allows certain ports in the system to be used as monitor ports. This enables you to monitor individual MCR

members or conferences and to speak to them directly, if necessary.

The monitor view can also be configured separately for each user. The monitor ports are always available for their

users independent of which MCR page is being viewed.

First, the monitor ports must be defined. Open the MCR properties by right mouse clicking anywhere on the MCR

window and selecting "Properties".

Select the "Monitors" tab in the properties window. 

Figure 687: MCR – MCR Monitor – MCR Properties > Monitors

Click on the  button to add a new monitor port.

Figure 688: MCR – Adding a new monitor port

Next, the monitor port must be given a unique display name. Enter a name up to 8 characters long.
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If you later want to access the monitor ports from a control panel, select the 

option.

A port can now be defined as a listen port. The individual members and conferences can be monitored from this port.

Select the port from the drop down list. It can be a 4-wire, 2-wire or panel port. If the monitor port should be the

second channel of a port, select the  option (if the port has a second channel available).

Figure 689: MCR – MCR Monitor – Add new MCR Monitor – Listen Port

If you talk to a monitor destination via a monitor port, you can add an additional "Talk Port".

This port does not have to be the same as the "Listen Port" and can be any port in the system. To add a new "Talk Port",

press the  button.

Figure 690: MCR – MCR Monitor – Adding a Talk Port
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Select the desired port from the "Port" list. Depending on whether the port is a 4-wire, 2-wire input or a control panel,

you can define how the talk command is triggered. On a panel the exact position of the talk key must be defined. On a

4-wire port the function will be automatically programmed on the VOX function of the port.

Confirm your selections with the  button. You can add further members to this monitor setup, if needed.

Otherwise, you can return to the properties window by clicking  and add further monitor setups, if required.

Figure 691: MCR – MCR Monitor example

Now these newly created monitors must be added to the MCR layout. Open the tab "Monitor Layout".

Figure 692: MCR – MCR Monitor Layout
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Choose the user who should use the monitor functions. Click the  button to assign the monitor ports.

Figure 693: MCR – MCR Monitor – Add a monitor

Repeat these steps for all monitor ports that the selected user should have access to.

Afterwards, send the changes to the matrix with the <F5> key or the  button. When Director is connected to the

system, the configured monitor ports will be displayed, depending on which user is logged on.

9.3.4 Creating MCR Presets

The MCR feature lets you to create presets. This provides a way to pull a group of members into a conference at the

same time.

Select the "Presets" tab from the MCR "Properties" window.

Figure 694: MCR – MCR Presets – Properties of the MCR > Presets
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Press the  button to create a new preset. Give the preset a unique name.

Figure 695: MCR – MCR Presets – Creating a new preset

Choose the members for this preset group by selecting them in the member list. Members who are not currently

online will be marked red. They can still be added to the preset.

Figure 696: MCR – MCR Presets – Selecting the preset members

As soon as the changes are sent to Artist, the preset is available for all PCs connected to the system.
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9.3.5 Other Settings (Misc)

Other general settings can be defined in the "Misc" tab of the MCR "Properties".

Figure 697: MCR – MCR Properties > Misc

With the  option you can activate a place holder that appears on MCR keys in the system

when they are not assigned to a conference. This lets the MCR keys be identified quickly and helps prevent accidentally

adding additional functions to these keys.

You can choose the place holder. Enter up to 8 characters. As a default the name "-MCR----" is used.

If you want to later use the MCR interface from a control panel, you can have the necessary logic sources created

automatically by making the appropriate selections under "Create logic sources for...". This would allow, for example, a

panel to send MCR changes to the system directly via an "Update" key. It is also possible to control the monitor

functions entirely from a control panel. The corresponding logic sources are simply pulled to keys to make their

functions available on the panel.

You can also change the standard key mode for these keys on the panels to operate the MCR. You can choose between

"Latching" and "Momentary". Depending if you first press a conference- or a member key on the panel, the key mode is

using the setting made here (see chapter "Using the MCR from a control panel for Details").

Figure 698: MCR – MCR Misc Key mode
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If you choose "Momentary" a two hand operation is necessary. You have to press the selected conference- or member

button as long you select the corresponding members / conferences. The key mode configured in the single "Properties

of Key" will be ignored.

Figure 699: MCR – MCR Misc – Scheduled Tasks

If you also using the "Scheduler" to activate conferences controlled by a timer, you can set time periods when to show a

special clock symbol.

You can set the time in minutes to show a  symbol on the affected conferences and members before an automatic

conference activation starts and before the event will be deactivated automatically.

Prerequisite for using this functionality is the activated "Events/Scheduler" tool of the Director and an existing event

"MCR Conference". For Details see chapter "Display of time controlled conferences" and "Event: MCR Conference".

Figure 700: MCR – MCR Misc – Multiple usage of 4-wires

With the option "Default for all new MCR members" you can set the behavior for new added 4-wires, if you want to use 4-

wires in multiple conferences simultaneous (see chapter "Using 4-wires in multiple conferences").
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9.4 Using the MCR

After all of the settings are configured and sent to the system, the MCR interface can be used in Director from all of the

PCs that are connected to Artist. Because the MCR is an online tool, its user interface is only available when Director is

connected online with an Artist system.

As soon as you have connected to the system using the  button and obtained the online configuration using the

 button, you must log on with your username and password. To open the MCR interface, click the  button in

the toolbar. The MCR window corresponding to the current user will appear.

Figure 701: MCR handling – Active MCR tool (example)
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9.4.1 MCR - Overview

Figure 702: MCR handling – function overview (example)
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9.4.2 Assigning Memers to a Conference

To add a MCR member to a conference, simply pull the member into the conference using Drag & Drop. Select the MCR

page with the conference you want to use and pull the member into it.

 

Figure 703: MCR handling – Members Drag & Drop

Control panel members are only allowed to be in one conference at a time. If the member is currently

available, it will be marked by a  in the member list. As soon as the member has been assigned to a

conference the symbol will change to a . If you attempt to pull the panel into another conference, an

error message will appear.

4-wires and 2-wire splits work slightly differently. These port types can be in multiple conferences at the

same time.

Since an "MCR Member" can consist of several member elements, the elements that make up a member are listed in

the "Member Ports" field when you click on a member. The "Member Ports" cannot be dragged directly into a

conference.

Figure 704: MCR handling – Members with corresponding Member Ports

As soon as any changes have been made, the update  button turns red and flashes. This means that the changes

have not yet been sent to the system. If you press this button, the changes will be sent to Artist and reflected on all of

the other MCR interfaces connected over other copies of Director.

Figure 705: MCR handling – Sending changes
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If a member is assigned to one or more conferences (4-wires only) you can see an overview of the assignments in a

small pop-up window. Place the mouse pointer over a member in the MCR member list. After a short delay, an info

window will automatically appear showing the conferences that the port is a member of and how many members are

in each conference.

Figure 706: MCR handling – Assignment information. Example 4-wire port

You can also drag individual members from one conference directly into another conference. Click on a member in a

conference and pull the member to another conference. Send the changes to the system with the  button.

Figure 707: MCR handling – Moving a member

As soon as a member sends any active audio, this will be indicated either by a red  or  in the port list and in the

conference. If someone is actively speaking into a conference, the name of the conference will be highlighted red.

Figure 708: MCR handling – Active audio in a conference. Source is "N-1"
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9.4.3 Using Presets

A preset is a predefined group of members. A preset allows the group to be assigned to a conference together using

Drag & Drop. If you hold the mouse pointer on a preset all of the members in the preset will be displayed.

Figure 709: MCR handling – Presets- Member Info

Pull a preset from the "MCR Presets" list into a conference. Send the changes to the system using the button.

Figure 710: MCR handling – Drag & Drop- presets

The individual members will now be listed in the conference.

Figure 711: MCR handling – Preset members in a conference

If you want to remove the members of a preset from a conference, you must remove the individual

members separately.
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9.4.4 Removing a Member from a Conference

There are two ways to remove a member from a conference.

Method 1

Pull the member from the conference back into the "MCR Member" list. The hand  symbol changes back to a green

dot  (for 4-wires, it only changes if the member has been removed from all conferences). Send the changes to the

system using the .

 > 

Figure 712: MCR handling – Removing a member from a conference

Method 2

Right mouse click on a member to remove the member from one or more conferences. You have different options

depending on whether you right click in the active conference or in the "Member List". If you right click on a member in

a conference, you can select the entry "Remove from conference". You can also select "Remove all members" to remove all

members from the conference with a single click.

Figure 713: MCR handling – Remove a member with a right click in the conference

If you right mouse click on a member in the "MCR- Members" list you can automatically remove the member from all

conferences by selecting "Remove from all Conferences". For control panel members method 1 and 2 are identical.

However, 4-wire ports can be in more than one conference at a time, and method 2 can remove them from all

conferences at once. Transfer the changes to the system using the  button.

Figure 714: MCR handling – Remove from all conferences
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9.4.5 Using an Alias Name

All conferences and members normally have a fixed name. However, in many situations it is useful to assign a

temporary name to a member or conference to provide a better overview and your workflow easier. For these

applications a so-called "alias" name can be used. The alias temporarily overrides the normal name of the port or

conference without having to change the basic configuration of the MCR. As soon as the alias is deleted, the original

name is used again.

To assign an alias, right mouse click on a conference or member in the "MCR Members" list. Select "Set Alias" in the

popup menu that appears. Enter an alias name with up to 8 characters.

 

Figure 715: MCR handling – Select and enter an alias for a conference

 

Figure 716: MCR handling – Select and enter an alias for a MCR member

As soon as you click the  button, the alias name will be applied and also immediately sent to the system. The

new alias will also appear on all other MCR interfaces running on other copies of Director. It is not necessary to

manually press the update  button.
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All conferences and members in the MCR interface with an active alias will be highlighted green. This indicates that the

normal name has been changed.

Figure 717: MCR handling – Display of alias names

If you wish to change an assigned alias, right mouse click on a member or conference. Select "Rename alias" to change

the name. The change will be automatically sent to the system.

To delete an alias and return to the original name, right mouse click on a conference or member. Select "Remove alias".

The name will change back to the original name and will be automatically sent to the system. The green highlighting

will disappear.

Figure 718: MCR handling – Rename or remove an alias
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9.4.6 Changing a 4-Wire I/O Gain Level

The MCR interface offers a way to graphically display the input and output gain of a 4-wire port and change the gain, if

necessary. A small arrow  symbol is displayed next to 4-wire members in the "MCR Members" list and in the

"Member Ports". This indicates that the input and output gains can be manually changed.

To change the gain settings of a 4-wire port in the MCR interface, first select the port in the "MCR Members" list. The

"Members Port" list will display that members corresponding ports. Right mouse click on a member port and select "Set

Input/Output Gain...".

Figure 719: MCR handling – Opening the I/O gain function

The gain control must be assigned to Director. Set the desired input and output levels for the port. Afterwards, press

the  button. The changes will be sent to the system.

Figure 720: MCR handling – Setting the input and output gain levels
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The changed gain settings will be indicated by the green arrow in the "Member Ports" and "MCR Members" lists. 

Figure 721: MCR handling – display of changed input and output gain levels

9.4.7 Using the Monitor Function

The MCR offers a way to monitor selected conferences or members using ports assigned as monitoring ports (see

chapter "Monitoring setup"). It is also possible to talk to the conference or port being monitored from a monitor port.

To monitor a conference, simply pull the conference to the monitor port. To monitor a port, drag it from either from a

conference or from the "MCR Members" list to the monitor port. This change will be immediately sent to the system.

You do not have to press the update  button.

 

Figure 722: MCR handling – Monitoring a conference (red= audio currently active in the conference)
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Figure 723: MCR handling – Monitoring a member

Pressing the  button temporarily mutes the monitor audio to the port. The changes are immediately

sent to the system. If "Mute" is active, it will be indicated by a red  button.

The  button indicates that the monitor is currently listening to a port. This means that the input of

the port is routed to the monitor output. As soon as the button is pressed, it changes to . The

change will be immediately sent to the system.

Now the audio that is routed from an MCR conference to the output of the port can be heard at the monitor output.

This button is only available if a single port with an input and output is being monitored. This function is not available

for conferences or 4-wire splits.

To stop monitoring, right click on the monitor and select "Cancel monitoring". The change will be immediately sent to

the system.

Figure 724: MCR handling – Ending the monitoring function

You can also set the input and output gain level of the monitoring port in this menu.
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9.4.8 Undo Changes

Changes to the conference or port assignments in the user interface are only visible locally until the  is pressed.

The MCR interface documents all changes since the last update was sent.

Open the "Status" tab from the MCR interface.

Figure 725: MCR handling – Master Control Room – Status

The "Local MCR Status" list shows all changes that have been made since the last transfer of changes to the Artist

system (with the exception of gain changes and the monitor function). Click the 

button to undo all of these changes. You will be asked to confirm your choice. This option can also be reached from a

MCR page with a right mouse click.

Figure 726: MCR handling – Discarding changes

If you wish to reset all MCR assignments and end any monitoring, press the  button in the "Status"

tab. After being asked to confirm, the MCR will be reset.

The reset also affects all other online MCR interfaces.
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This option is also available in the network view of Director. Right mouse click on the  symbol.

Figure 727: MCR handling – Network tab – Reset MCR

The "Reset (Online)" function will reset the complete MCR system. That means that all currently active conferences and

monitor functions will be emptied.

If you save a configuration with an MCR interface to a hard disk, a snapshot of the current MCR assignments will also be

saved. If this configuration is read out from a system or opened from a hard drive, you can locally reset these saved

assignments with the command "Reset (working configuration only)". The online system will not be affected.

9.4.9 Display of Time Controlled Conferences

Starting in version 6.10 it is possible to highlight timer controlled Conferences and Members in the MCR which will be

switched by the "Scheduler".

To use this functionality "Events/Scheduler" must be registered and enabled in the Director.

First create a new Event "MCR Conference" in the properties of Events  (for details see chapter "Event MCR

Conference").

Now open the "Scheduler"  and select the new "MCR Conference" Event created before. Select the time and dates

when this Event should be activated/deactivated automatically (for details see chapter "Configuring the Scheduler").
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Open the "Properties" of the "MCR" by a right click in the MCR-window and select  to adjust the display settings

for timer controlled conferences.

Figure 728: MCR Scheduler – Misc tab

Here you can set up the time to see a  symbol on affected conferences and members before a timer controlled

conference will start.

The same symbol will show up, before an activated timer will be deactivated. You can set up both settings individually.

Following symbols are used for timer controlled conferences. These symbols show up on affected conferences and also

on the affected members:

Member / Conference will soon be used for Scheduler controlled conference.

If the timer is already running, the symbol shows up before the scheduled conference will be stopped

automatically. (Depending of the settings in "Misc").

Member / Conference is used in a running scheduled conference.

Member / Conference should now be used in a scheduled conference, but it is not.

Causes:

· The start time of a new generated timer was in the past.

· The event was stopped manually in the Events – tool .

View chapter "MCR – Overview" to get an overview of the displays for scheduled conferences.
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A short tool-tip window will show up, when you show with the mouse over a conference or a member with a clock-

symbol. It will show the actual status and which timer is or will be used:

Member will soon be used for a scheduled event.

Figure 729: MCR Scheduler – Member will be used soon

Member is part of an actual running scheduled conference.

Figure 730: MCR Scheduler – Member is used in a scheduled conference

The running scheduled conference will be stopped soon.

Figure 731: MCR Scheduler – Scheduled conference ends soon

Scheduled timer could not be started.

Figure 732: MCR Scheduler – Scheduled task could not be started
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9.5 Setting up and Using the MCR Interface from a Control Panel

The MCR tool can be controlled from multiple PCs as well as from control panels. Any control panel type can be used.

9.5.1 Setting up the MCR and Panels

You must assign an online Director PC to handle MCR requests in order to use the MCR interface from one or more

control panels.

Go to "Settings" > "Options" and then select the tab "Miscellaneous". Activate the option "Handle MCR operations

triggered by Panels / Logic Sources".

Figure 733: MCR – Panel control – Settings > Options

Only one Director PC in the network should have this option activated. The control of the MCR interface by

control panels only works when this copy of Director is online with the system.

To enable the MCR interface to be controlled from a panel, every function, member, monitor and conference is

assigned a logic source. This means that control panels are only sending logic commands to the Director PC which then

converts these to MCR commands.

It is therefore necessary when creating conferences and MCR members that the

 option has been set in the "MCR Properties" (see chapter "Creating

MCR Conferences", "Configuring the MCR" and "Other settings (Misc)").
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Open the  tab in Director. The MCR sources generated automatically will be listed with their automatically

generated names "MCR...".

Figure 734: MCR – Panel control – Logic Sources
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Double click on a port in the port list or network list to open a control panel that should be used to control the MCR

interface. Pull the logic sources onto unused keys. Repeat for each panel that should control the MCR.

Figure 735: MCR – Panel control – Adding MCR logic sources to a control panel

After you have sent these changes to the system the MCR can be controlled from both the software interface and

control panels.
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9.5.2 Using the MCR from a Control Panel

To assign a member to a conference, first press the conference key. All available members will be indicated by a red

marker.

Figure 736: MCR – Panel control – Selecting the conference

Select the members to add. Newly selected or already existing members will be indicated by a green marker. Press the

"MCR Upd" key. The changes will be sent to the system and also reflected in all MCR software interfaces.

Figure 737: MCR – Panel control – Selecting members

If you press a conference key again, the panel returns to the display mode. Conferences that are being spoken into are

highlighted with several red LEDs.

Figure 738: MCR – Panel control – Marker signaling of an active conference
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You can also press a conference key to display all of the members assigned to the conference. Members that have

green markers are assigned to the conference, members with red markers are not assigned to the conference.

You can also first select the member to assign it to a conference. Press the member and then press the conference that

the member should be added to.

Figure 739: MCR – Panel control – Selecting a member

Assign the member to conferences by pressing conference keys (note: only 4-wire ports can be assigned to more than

one conference). Confirm your changes by pressing the "MCR Upd" button.

Figure 740: MCR – Panel control – Assigning members to conferences

You can also press a member key to display all of the conferences that the member is a part of (displayed with a green

marker).

The monitor function is operated in the same way. Select the monitor and then the member or conference to monitor.

The assignment will be immediately sent to the system. It is not necessary to press the "MCR Upd" key.

If several control panels are controlling the MCR, each key press will be simultaneously shown on the other control

panels. All panel users have the same user rights.
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10 Events / Scheduler

The software add-on "Events/Scheduler" is a versatile tool that can trigger pre-defined events or configuration changes

automatically according to a schedule or with a simple mouse click. For example, functions on a key can be easily

changed or MCR conferences can be automatically activated at certain times.

Figure 741: Scheduler / Events – example

10.1 Adding the Events / Scheduler add-on

The Events/Scheduler software add-on is already present when a new configuration is created. It appears as the 

 symbol in the network view of the Navigation Bar.

Figure 742: Scheduler / Events – Events in the network view

However, the feature must be unlocked before it can be used. Follow the directions in chapter "Unlocking the Software

Add-ons".
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10.2 Creating Events

You must open the "Events-Online View" in order to create events. Click the  button in the tool bar or double click on

the  symbol in the network view of the Navigation Bar. The window can also be opened via "View" > "Events - Online

View". The "Events-Online View" window is also used to start and stop individual events.

Figure 743: Events - Online View window

10.2.1 Event - Properties

To create a new event or to edit an existing event, click the  button. The "Event Management" window

will open.

Figure 744: Events – Event Management window
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Next, create a new event using the  button found in the "Event List" area on the left side of the window. The

event list will display the new event and assign an automatically generated name "Event #001". Enter a new name for

the event in the "Name" field found on the right side of the window under "Properties of the selected Event". The name

can be as long as you like.

Figure 745: Events – Enter a name for the event

Now you can begin to set up what the event will actually do. On the right hand side of the window, click the 

button and select the type of function that should later be triggered by the event.

The maximum number of functions that can be carried out at the same time in an event is 100.

Figure 746: Events – Adding a new event



510

Director 7.20 User Manual A10

10.2.2 Event - MCR Conference

If you also use the "Master Control Room" add-on and have already configured it, you can create an event that will

automatically add members to a conference. The event can then be later triggered by a key press or set to be

automatically activated at a certain time.

Select the function "MCR Conference". The "Event Action: MCR Conference" window will open.

Figure 747: Events – Event Action: MCR Conference

All MCR members will be displayed in this window along with their online status and any current aliases being used.

Select a conference from the "Conference" drop down menu. Then select the members that should be placed into the

conference when the event is activated.

Figure 748: Events – Selecting a conference and its members



511

Director 7.20 User Manual A10

Confirm your choices with the  button. The new event now appears as "Modified: new" in the "Event

Management" window. As soon as the change you made to the configuration has been sent to the system using the

 button, the word "new" disappears from the list and the event is available for use.

Figure 749: Events – New MCR Conference – event

10.2.3 Event - Call to Conference

This function places a "Call to Conference" command on the keys of selected ports when the event is active. Create a

new event in the "Event Management" window, as described above, or add this function to an existing event.

Click the  button on the right-hand side of the window and select the function "Call to Conference". A new

window will open where you can specify the details of the function.

Figure 750: Events – Event Action: Call to Conference

First, choose the conference that should be used by the event. You can also select a conference from a shortlist, if any

are defined. Select the conference privileges for the member.
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Next, choose the conference member. Click on the  button.

Figure 751: Events – Call2Conf – Function location

Decide who can trigger this "Call to Conference" function and whether it should be activated from a port or a GPI.

If you choose , select the port and the exact location where the function should appear. If you selected a control

panel, you can choose between placing the call on the  or on a . If you selected a 4-wire port,

only the  will be available.

Figure 752: Events – Call2Conf – Choosing a panel key

If you selected "Panel Key", you must specify the exact key where the function will appear. If the key that

you chose already has a function assigned, this other function will not be removed. The command

triggered by the event will be added as an additional function to the key.
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After you confirm your selection with the  button, the key or Virtual Function will appear in the "Event Action"

window.

Figure 753: Events – Call2Conf – Event Action

You can use the second audio channel of a port as the source of the call, if available, by selecting the

 option.

After closing the window with the  button, the new function will be listed in the "Event Management" window.

Repeat the steps above if you want to add additional functions to the event.

Figure 754: Events – Event Management window – Call to Conference Event

Send the changes to the matrix with the <F5> key or the  button in Director. 
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10.2.4 Event - Call to Group

This function places a "Call to Group" command on the keys of selected ports when the event is active. Create a new

event in the "Event Management" window, as described above, or add this function to an existing event.

Click the  button on the right-hand side of the window and select the function "Call to Group". A new window

will open where you can specify the details of the function.

Figure 755: Events – Event Action – Call to Group

Select the group and then specify the exact location where the "Call to Group" command should appear with the

 button.

For a description of how to select a panel key or Virtual Function please see chapter "Event: Call to Conference".

Figure 756: Events – Event Action – Call to Group

The new function is now available in the event list.

Figure 757: Events – Event Management window – Call to Group Event

Send the changes to the matrix with the <F5> key or the  button in Director.
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10.2.5 Event - Port to Port

When this function is activated it places a "Call to Port" command on the keys of two control panels. Create a new event

in the "Event Management" window, as described above, or add this function to an existing event.

Click the  button on the right-hand side of the window and select the function "Port to Port". A new window

will open where you can specify the details of the function.

Figure 758: Events – Event Action: Port to Port 

You can manually enter a display name for the ports that will appear on the panels after the event has been activated.

If you leave this field empty, the default name for the ports will be used.

Press the  button to set up which ports will be used for the event and the exact position of the key or Virtual

Function where the command will appear.

For a description of how to select a panel key or Virtual Function please see chapter "Event: Call to Conference".

Figure 759: Events – Event Action: Port to Port

The new function is now available in the event list.

Figure 760: Events – Event Management window – Port to Port Event

Send the changes to the matrix with the <F5> key or the  button in Director.
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10.2.6 Event - Call to Port

This function places a "Call to Port" command on the key of a selected port when the event is active. Create a new event

in the "Event Management" window, as described above, or add this function to an existing event.

In contrast to the "Port to Port" function, this command only sets up communication in one direction.

Click the  button on the right-hand side of the window and select the function "Call to Port". A new window

will open where you can specify the details of the function.

Figure 761: Events – Event Action: Call to Port

You can manually enter a display name for the port that will appear on the panel after the event has been activated. If

you leave this field empty, the default name for the port will be used.

Select the port to be called from the "Destination" list.

Press the  button to set up which port will be used for the event and the exact position of the key or Virtual

Function where the command will appear.

For a description of how to select a panel key or Virtual Function please see chapter "Event: Call to Conference".

The new function is now available in the event list. 

Figure 762: Events – Event Management window – Call to Port Event

Send the changes to the matrix with the <F5> key or the  button in Director.
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10.2.7 Event - Listen to Port

This function places a "Listen to Port" command on a key of a selected port when the event is active. Create a new event

in the "Event Management" window, as described above, or add this function to an existing event.

Click the  button on the right-hand side of the window and select the function "Listen to Port". A new window

will open where you can specify the details of the function.

Figure 763: Events – Event Action – Listen to Port

Select under "Source" the port that you would like to listen to.

Press the  button to set up which port will be used for the event and the exact position of the key or Virtual

Function where the "Listen to Port" command will appear.

For a description of how to select a panel key or Virtual Function please see chapter "Event: Call to Conference".

When using the event function "Listen to Port" on a panel, it is recommended to set the properties of the

key you select to "Latching" and deactivate the "Speaker Dim" function.

The new function is now available in the event list.

Figure 764: Events – Event Management window – Listen to Port Event

Send the changes to the matrix with the <F5> key or the  button in Director.
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10.2.8 Event - Logic Source

This function places a "Logic Source" on a key of a selected port when the event is active. Create a new event in the

"Event Management" window, as described above, or add this function to an existing event.

To allow a logic source to be used in events, open the properties of the logic source in the  tab with a double

click. Check the box for the "Enable for Event use" option.

Figure 765: Events – Properties of a Logic Source

Click the  button on the right-hand side of the "Event Management" window and select the function "Logic

Source". A new window will open where you can specify the details of the function.

Select the logic source you would like to use. Only the logic sources that were unlocked for use with the event add-on

will be shown.

Figure 766: Events – Event Action – Logic Source
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Press the  button to set up which port will be used for the event and the exact position of the key or Virtual

Function, where the "Logic Source" function will appear.

For a description of how to select a panel key or Virtual Function please see chapter "Event: Call to Conference".

The new function is now available in the event list.

Figure 767: Events – Event Management window – Logic Source Event

Send the changes to the matrix with the <F5> key or the  button in Director.

10.2.9 Configuration using Drag & Drop

You can also set up most event functions using Drag & Drop. Create a new function, for example a "Port to Port". Click

on the  button on the right-hand side of the window and select the "Port to Port" function. A new "Event

Action" window will open where you can specify the details of the function. Close the window by clicking the 

button without finishing the function setup.

Figure 768: Events – Event Action

Figure 769: Events – Undefined function
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Open the two ports in the Workspace that you wish to use and drag the command to keys directly from the "Event

Management" window.

Figure 770: Events – Drag & Drop to keys

The keys will be added to the function.

Figure 771: Events – Configured function
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You can also use the same process when setting up all of the other functions.

For example, when programming a "Call to Conference", you can drag the conference directly from the 

tab to the event window. Then you can drag the event command from the event window to a panel or 4-wire port.

Figure 772: Events – Drag & Drop a conference to a port

Figure 773: Events – Configured function

If you need to add a number of different events with the same source but with different destinations, we recommend

using the copy function. Create an event with the source you want to use and then press the  button. Every

time you press this button a new copy of the original event will be created. Simply drag these copies to the destinations

you need.

The original destination will be replaced with the new one you chose.

 

Figure 774: Events – Creating and modifying using the copy command
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10.3 Starting and Stopping Events

After you have created and configured the events they can be started and stopped directly from Director.

Open the "Events - Online View" window by clicking on the  button in the toolbar.

Figure 775: Events - Online View

All events that you have created will be listed in this window.

Because the events function is an online tool, only the events that have been sent to the system with a

configuration update will be shown. This requires an active connection to the matrix. If you are running

Director in offline mode, no events will be shown in the "Events - Online View".

If you have created a large number of events, you can use the filter function to search for specific events.

Figure 776: Events – Events with a filter active

To start an event, select the event and press the  button or simply double click on the event. 

You do not have to manually send the configuration to the system. As soon as an event is started or

stopped, the configuration change is automatically sent directly to the system.
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Active events will be highlighted green and their status will be listed as "active".

Figure 777: Events – Active events

The functions defined by the event will then appear on the corresponding panels and keys.

Events can be stopped by double clicking on an active event or by selecting the event and clicking the  button.

Pressing the  button will end all events that are currently active. A pop up window will ask you to confirm that

you wish to end all events.

Figure 778: Events – "Stop all" confirmation

Multiple PCs can be online with Director at the same time and still use the Events / Scheduler. Each PC shows the current

status of all of the events. However, be sure to read the current configuration from the matrix before checking the

event status.
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10.4 Scheduler

The scheduler is an extension of the event function. It allows events to be automatically triggered at specific times.

Scheduling events by time is controlled by the internal clock of a configuration PC. For this reason, a copy

of Director needs to be running and connected to the system to control scheduled events.

To ensure that the clock in the PC is accurate, it is recommended to use an auxiliary DCF card or regularly

synchronize the PC clock via the internet.

10.4.1 Activating Director for the Scheduler

Choose which PC running Director will control the scheduled events. This PC must always remain online with the

system.

Open the Options window in Director. Select "Settings" > "Options".

Figure 779: Scheduler – Opening the options window

In the "Options" window, select the  tab and activate the function .

Figure 780: Scheduler – Activating the Scheduler function in Director
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10.4.2 Configuring the Scheduler

To configure the Scheduler, click on the  button in the toolbar. This will open the "Scheduler - Online View" window.

Figure 781: Scheduler – Scheduler - Online View

Press the  button to add a new timer. A new entry will appear with a pre-assigned name. Enter a new unique

name for the timer in the "Name" field.

Figure 782: Scheduler – Naming a timer

Select the event in the "Event" field that should be activated by the timer. The event must have been previously

configured.

Figure 783: Scheduler – Selecting an event
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If you would like to change the event, you can access the event’s configuration window directly by clicking the

 button.

Enter the time when the event should start and how long it should last. If the event should end at a specific time, select

 and enter the time when the event should end.

The scheduler automatically calculates how long the event will last.

Figure 784: Scheduler – Enter the start time of the event

Select if and how often the timer should repeat this event. You can either select a single date for the event or set up a

reoccurring event by selecting the days of the week when the event should be active.

 or 

Figure 785: Scheduler – Entering a date

All timers and their details are listed in the "Scheduled Tasks" area of the "Scheduler - Online View" window.

Figure 786: Scheduler – Timer
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As soon as the PCs internal clock reaches the activation time for an event, the event will be automatically started. Active

events will be indicated by the word "active" in the "Status" column.

You can also open the "Events - Online View" window to show all active events by pressing the  button.

Figure 787: Scheduler – Active Timer

If the timer, for example, starts a timed conference in the "Master Control Room" interface, the members will be placed

into the conference in the MCR window.

Figure 788: Scheduler – Automatic MCR conference
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11 Audio Video Router

11.1 General

This special feature can monitor up to two external routing switchers and make changes to conferences in the Artist

system based on the routers’ status.

The monitoring of the external lines is handled by a specially developed software interface that can assign

communication paths to the same locations as the routers send their audio and video.

The routers are connected over a serial COM port to a computer that runs the "DMX Driver" software. The software is

supplied by Riedel Communications GmbH.

The Audio Video Router (AVR) feature requires a computer to be permanently connected to both systems.

11.2 DMX Driver

The "DMX Driver" software is used to interface between the router and the Artist system. The router is connected to a

serial COM port of the computer.

To start the software, double click on the "dmxdrv_com1.exe" file. The software will open and initialize COM 1 port on

the computer, to which the router should be connected.

Alternatively, COM ports 1–4 can also be used.

Please note that if you use a different COM port, you must also open a different file on your PC.

The file "dmxdrv_com1" is used for COM port 1. 

The file "dmxdrv_com2" is used for COM port 2. And so on...

Figure 789: AV Router – DMX Driver

After starting the DMX Driver the software reads out all of the information required from your system. You do not need

to do anything further at this point.

The DMX Driver will then display a list of all available sources and destinations.
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11.3 Adding the Audio/Video Router (AVR) to Director

To add the AVR in Director, right mouse click on the Web in the network view and select "Add Audio/Video Router

Interface". You can also add the AVR to the configuration under "Edit" > "Special Features" > "Add".

Figure 790: AV Router – Adding the AVR

The AVR appears in the network view as a green icon with the letters "AV".

Figure 791: AV Router – AVR in the configuration

To configure the AVR, the current user must have the necessary user rights. Open the  tab. Select a user and

click the  button.

Figure 792: AV Router – Properties of a user

Deactivate the option "Restrict Properties for AV-Router".



530

Director 7.20 User Manual A10

11.4 Connecting Director to the DMX Driver

The following steps will make the information from the "DMX Driver" available in Director:

Open the AVR interface in Director by double clicking on the AVR  icon. First, activate the option "Enable Audio/Video

Router Interface". Next, choose the option "Enable DMX Driver" to establish the connection to the "DMX Driver".

 > 

Figure 793: AV Router – AVR Online View

As long as there is an active connection between the "DMX Driver" and your router system, the individual sources and

destinations will appear in the "Active Crosspoints" list.

The option "Enable ZMX" is for a special feature developed for a specific customer and is not normally used (it stands

for "Zentrale" [central] Video Matrix and would be activated instead of the "DMX Driver", which stands for

"Dezentrale" [decentralized] Video Matrix).

The option "Force Configuration Updates periodically" is only used for debugging purposes.



531

Director 7.20 User Manual A10

11.5 AVR Configuration

To configure the AVR, press the <F8> key or click the  button in the AVR online view. This opens the

AVR configuration window.

11.5.1 AVR - 'Router-IF objects' tab

Figure 794: AV Router – Properties of the AVR

The AVR allows you to automatically add members to a conference depending on the status of the external router.

You will need at least one conference and one group that were previously created in the Director configuration. Create

as many groups and conferences as you will need (see chapter "Create and Manage Groups and Conferences").

Add the panels that should later be added to a particular conference to the members list of a group.
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Next, using Drag & Drop pull the conferences from the "Groups + Confs" tab to the AVR field "Router-IF Objects >

Conferences". Drag the groups to the "Router-IF Objects > Groups" field.

Figure 795: AV Router – Adding groups and conferences to the AVR

After you have added the groups and conferences, you must confirm the additions with the 

key. Failure to do so will result in the changes not being saved.
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11.5.2 AVR - 'Router-IF source' tab

You have now assigned a conference and a group of members to the AVR. The next step is to configure the "Router-IF

Src" sources and the "Router-IF Dst" destinations.

Figure 796: AV Router – Router-IF Scr

If you make a change to the router, the conferences in the intercom system should also be changed to reflect the new

status of the router. You must configure the AVR so that a router change assigns a certain group of members to a

conference.

The tabs "Router-IF Src" and "Router-IF Dst" refer to the sources and destinations of the external router.

Example:

If the router assigns Source 1 to Destination 2, the Artist system should automatically assign a group of panels to a

predefined conference. To achieve this, the AVR needs to be configured accordingly.

Add a source by clicking the  button. This will open a new window where you can enter the sources

details.

Figure 797: AV Router – Adding a new router source



534

Director 7.20 User Manual A10

In the "Matrix" drop down menu you can choose between "ZMX" and "DMX". Always select "DMX".

As in our example, we will configure the Input Port 1.

Now tell the AVR which conference should be activated by this action and confirm with the OK button.

After you have finished making changes to a tab always confirm by clicking the  button in the

AVR "Properties" window. Failure to do so will result in the changes not being saved.

11.5.3 AVR - 'Router-IF destination' tab

After you have assigned the sources in the system you must also configure the destinations.

Select the tab "Router-IF Dst".

Figure 798: AV Router – Router- IF Dst

To add a new destination, click the  button. A new window will open where the destination can be

configured.

Figure 799: AV Router – Adding a new destination

In the "Matrix" drop down menu you can choose between "ZMX" and "DMX". Always select "DMX". As in our example, we

will configure the Output Port to 2.
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Assign a predefined group of members to the destination using the  button.

Select a group and assign which key will be reserved on all of the panels of the group, Enter the exact key number to be

used on the panels in the group.

Figure 800: AV Router – Editing a panel group

"Key-Nr" designates the panel key to be used.

Make sure that this key is unused on all of the panels in the group before assigning it to the AVR.

When the group is assigned to a conference, the conference will appear on the designated panel key.

"Shift Page" refers to the shift page of the panel. This option determines whether the key is on the first or second page.

In our example, all panels in the AVR GRP group will be assigned the conference key on the main panel, main page, Key

# 1.

If a panel group is not assigned to a source, a place holder will appear on the keys.

Figure 801: AV Router – Placeholder panel key
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Confirm the settings by clicking .

The new entry will be listed in the "Router-IF Dst" tab.

Figure 802: AV Router – Entry in the Router-IF Dst tab

After you have finished making changes to a tab always confirm by clicking the  button in the

AVR "Properties" window. Failure to do so will result in the changes not being saved.

To complete our example: If you now routed Source 1 to Destination 2 on the router, then all members of the group

"AAVR GRP 1" would be assigned the conference "AVR CONF 1" on their main panel, standard page, Key # 1.
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11.5.4 AVR - 'Router-IF ext. Lines' tab

The tab "Router IF.ext.Lines" is not for assigning groups of panels to a conference, as described above, but rather for

assigning a 4-wire.

Drag a 4-wire from the port list into the "Router-IF Objects > Panels" field in the AVR window.

Figure 803: AV Router – Adding a 4-wire

This will assign a 4-wire to the AVR. 

After you have finished making changes to a tab always confirm by clicking the  button in the

AVR "Properties" window. Failure to do so will result in the changes not being saved.
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In the "AVR Properties" window open the "Router-IF Src" tab.

Figure 804: AV Router – Router-IF Scr tab

Click the  button to assign a new 4-wire as an AVR source. Select "DMX" under matrix and enter the input port

number of the router. Activate the option "Allow External Line". Enter a name for the 4-wire in the "Description" field.

Figure 805: AV Router – Add new Router-IF Source

If you added a conference in "Router-IF Objects" and it was not assigned to a group of control panels, it will be available

under "Router-IF ext Lines".
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Select which 4-wire should be used for the conference by double clicking on the conference or selecting the conference

and clicking the  button. Confirm with OK. 

Figure 806: AV Router – Settings for the External Lines

The tab "Router-IF ext. Lines" lists the external 4-wires conference with the corresponding port and display text. Send

the configuration to the Artist by clicking the  button.

Figure 807: AV Router – Router-IF ext. Lines

The 4-wire can now be assigned a group of members. In our example, this is done by assigning router input port 10 a

destination. 

After this assignment there will be a command on the Vox function of the 4-wire. 
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11.5.5 AVR - 'Router-IF external Lines defaults' tab

In the "Router-IF ext. Lines defaults" tab you can create a default setting for each conference that is used for external

lines. Double click on a conference or select the conference and press the  button. The "Def. Settings for

‘Conference Name’" window will open.

Figure 808: AV Router – Def. Settings for ‘AVR Conference’

In this window you can select the source responsible for the switching as well as the default 4-Wire for this conference.

You can also edit the display text. When finished confirm with "OK". 

Figure 809: AV Router – Router-IF ext. Lines defaults

The defaults can be applied to selected conferences in the "Router-IF ext. Lines" tab by clicking the 

button or pressing <F6> on the keyboard. 

Repeat the steps above for all of the inputs and outputs on your router. Afterwards, send the configuration to the

system using the  button. 
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11.5.6 Testing the AVR

The intercom system will be automatically reconfigured according to the AVR settings as soon as the AVR and DMX

drivers are active and connected to the router. 

All paths currently active in the router are listed in the "Audio/Video Router Interface – Online View" under "Active

Crosspoints". 

Figure 810: AV Router – Online View

It is possible to undo an active AVR connection in Artist. Select an item from the list and click the  button. All

changes will be periodically sent to the system. 

To test the AVR configuration or to manually force a connection, you can click the  button. 

Figure 811: AV Router – Add Crosspoint

Enter a source and destination. "DMX" should always be selected under "Matrix". As soon as you have made the

changes, confirm with "OK" and this manually activated crosspoint will be listed in the AVR online view. Press the 

button to send the new crosspoint to the system. 

All of the corresponding control panels of the selected group should now display the conference name for that route

on their pre-defined key. 
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In this way the AVR can be tested without having an active connection to an external router. 

Deactivate the option "Enable DMX Driver" and select the option "Force Configuration Updates periodically (DEBUG)". 

Figure 812: AV Router – Online View

Manually force a crosspoint, as described above. The new crosspoint will be periodically automatically sent to the

system. This allows you to simulate any particular router crosspoint selection and test the Artist configuration. 

Do not forget to reactivate the option "Enable DMX Driver" as soon as the external router is reconnected. 
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12 Trunking

In certain applications it is not possible to connect individual Artist mainframes over fiber. For example, fiber

connection is not an option when the distance between two frames is too far, or if the maximum number of ports

within the fiber ring would exceed 1,024. In this case, two or more systems can be intelligently connected together via

trunking. Up to 50 Artist systems can be trunked together. The control of the system and its dynamic routing is handled

by the Trunk-Navigator software. A second instance of the Trunk-Navigator may run for redundancy reasons on

another PC.

To start the Trunk-Navigator, a RIEDEL USB dongle must be connected to the trunking PC to unlock the

software. 

Figure 813: Trunking – Example trunking network (Soccer World Cup 2006)
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12.1 Requirements

Trunking requires the Riedel Trunk-Navigator software, a RIEDEL USB-Dongle and a few additional configuration

changes in Director on systems to be trunked together. The Trunk-Navigator can be installed parallel on two PCs for

redundancy. The PCs should be connected to one another over an IP network. The Trunk-Navigator can run without

any problems on the same PC as the Director used for local configurations. However, please note that the Trunk-

Navigator must be permanently online with the system in order to manage the trunking feature. 

Always make sure that the software version of the Trunk-Navigator is compatible with the firmware and

Director versions used in the trunked system. The firmware in all of the systems to be trunked must be the

same version. 

The Trunk-Navigator normally has the same version number as Director. 

For example: Director 6.60Dxx compatible with Trunk-Navigator 6.60TNxx 

In addition, there are a few hardware requirements for trunking. There must be at least one audio connection between

the systems to be trunked. The number of audio connections later determines the possible number of simultaneous

trunk calls. These connections may be analog, AES, ISDN, VoIP or other audio formats. 

The other requirement is an IP connection from the Trunk-Navigator PC to each trunked system in order to dynamically

manage the trunk line assignments. A bandwidth of at least 64kB/s is adequate. 

Figure 814: Trunking – Building a trunked network 
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12.2 Setup in Director

Before activating the Trunk-Navigator software some preparations need to be made in each of the systems which are

to be trunked together, otherwise the Trunk-Navigator cannot dynamically assign trunk lines. In addition, all of the

ports of each system (both panels and 4-Wires) which will be allowed to use trunking need to be set up for this feature. 

12.2.1 Defining the Trunk-Controller

In each system one of the nodes must be defined as the "Local Trunk-Controller". This node collects all commands from

the Trunk-Navigator. The "Local Trunk Controller" capability is already integrated into CPUs' firmware and must simply

be activated. However, only one node on a fiber ring can be defined as the "Local Trunk-Controller". It does not matter

whether or not this node is also defined as the Ring Clock Master. 

The node that is set to be the "Trunk-Controller" must be connected to an IP network, preferably over a

switch or hub. The IP addresses of the trunked systems must be reachable by the Trunk-Navigator PC.

Note the IP addresses of the "Trunk Controller" node in each system. They are needed to configure the

Trunk-Navigator. 

To define a node as the "Trunk-Controller", open the "Artist - Online View" by clicking the  button in the toolbar.

Select the node you wish to define and open its "Properties". 

Figure 815: Trunking – Director – Artist - Online View

Figure 816: Trunking – Director – Online Bar – Set local trunk controller to enabled
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Activate the option "Set Local Trunk Controller to enabled" and click the  button. The node will be

defined as the "local trunk controller", without interrupting or resetting the normal system operation. 

The trunk controller will be indicated in the "Artist - Online View" with the entry: "Trunk Controller" "YES". There is only

one trunk controller allowed within an Artist fiber ring. 

Figure 817: Trunking – Director – Artist - Online View with active Trunk Controller

Repeat the steps above for each Artist network that should be enabled for trunking. 

12.2.2 Preparing the Configuration

In order to distinguish the individual systems in the Trunk-Navigator, a unique "Web" name should be given to each of

their configurations. 

Select the  tab, right mouse click on  and select "Properties". 

You can also change the name by selecting the Web and pressing <F2> on the keyboard. 

Figure 818: Trunking – Director – Web Symbol
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In the properties of the "Web" you must also assign a unique Trunking-Address. The Trunking-Net-Address must be

different in each system to be trunked. The Trunking-Net-Address is similar to a postal code for the system. 

Figure 819: Trunking – Director – Properties of the Web

"0" is not a valid address for trunking and trunking will not work. You have to use a unique address up or

equal "1". 

The Trunking Net address will also be shown in the trunking tab in () next to the Net label.

Figure 820: Trunking – Trunking Tab displays Net label and address
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12.2.3 Defining Trunklines

So called "Trunklines" are used for the audio connections between the trunked systems. A trunkline is always a 4-wire.

Either an analog or AES 4-wire (for example, ISDN, VoIP) can be used. Since version 7.20 it is also possible to use AES67

cards as trunklines. The more trunklines there are per system the more simultaneous calls can be carried out between

the systems at the same time. 

Define at least one 4-wire in your system as a trunkline. Open the properties of the port by double clicking on it in the

Workspace. Or select the port in the port list or network list, right mouse click and select "Properties". It is also

recommended to name the port as a trunkline. 

If you use an AES 4-wire as a trunkline, remember that 2 ports must be used in Director although the

physical connection is only to the odd numbered port. Both ports are defined as mono ports (see chapter

"Configuring a 2 channel 4-wire port".

Open the "Properties" of the individual trunk ports and select the option , located in the  tab.

The rest of the parameters of the 4-wire will be grayed out. A unique Trunking-Address will appear in the "Trunking-

Address" field. This address can only be used once in the local system. However, the address may be used in one of the

other trunked systems, since the Trunking-Address always corresponds to a particular Web-Trunking-Address. 

The Trunking-Address is normally assigned by Director and increases by 1 for each additional trunk port. 

Figure 821: Trunking – Director – Properties of a trunkline

Repeat these steps for all ports that should be used as trunklines. 

Make sure that there are no audio functions programmed on the Virtual Functions of the trunklines.

Delete all functions if necessary. The dynamic assignments for the port will be handled by the Trunk-

Navigator and the Local Trunk Controller. 
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12.2.4 Preparing Individual Ports for Trunking

All ports (panels or 4-wires), that should be able to communicate to a trunked system must first be defined in the

configuration. Only these ports will be listed in the Trunk-Navigator and be available as destinations to the trunked

systems. 

Open the properties of the port by double clicking on it in the Workspace. Or select the port in the port list or network

list, right mouse click and select "Properties". Select the  tab. Activate the  option. A

Trunking-Address will automatically be assigned by Director and appear in the "Trunking-Address" field. 

Figure 822: Trunking – Director – Enabling a port for a trunk call

Repeat the steps above for all of the ports that should later be allowed to use trunking. The procedure is identical for 4-

wires and control panels. Remember to define ports for trunking in the other trunking systems as well. 



550

Director 7.20 User Manual A10

Labeling Trunkports12.2.4.1

Up from version 6.30 it is now possible to use different display labels for a trunkport. This means, a port that is enabled

for trunking can be shown in the local system with a different name than it is shown in a trunked system. Because with

Riedel's "Actor" Interface it is also possible to trunk Artist also to third party systems, which do not support 8 character

labels, you can also give a 6-, and 4- character label to every trunkport. In the  tab of the properties of every

port you can edit these trunking labels. 

Figure 823: Trunking – Director – Labeling of trunk ports

When for the trunking labels  is activated, the labels for trunking are automatically created by the

Director. For the 8-character label the local and trunk name are the same. For the 6-, and 4-character label, the Director

is using the bay- and port number of the selected port. 

To edit a trunk label manually, just deactivate the  option on the name you want to edit and enter the

new Label. 

Figure 824: Trunking – Director – Edit trunk names

Repeat these steps for all trunkports. The procedure is identically for 4-wires and panels. 
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In the "Ports" list, all manually edited 8-character Trunklabels are shown in the column "Remote Label". Default labels for

trunkports (local label =trunk label) are not shown in this column. 

Figure 825: Trunking – Director – Trunklabels in port list

Please keep in mind, changing a trunk label can take up to 2 minutes until the new name appears in the

"Trunking" tab of trunked system. The Trunk-Navigator is polling all labels only every 2 minutes. Following

it is necessary to update all trunking labels in the Director of the trunked systems with "Edit" > "Update

Trunking key labels". For details please see chapter "Trunking: Changing Port Names".

12.2.5 Preparing Groups and Conferences for Trunking

Groups and conferences can also be enabled for trunking and can be shared throughout the trunked systems. For

example, if 3 Artist networks use the same conference each can speak into the conference and listen to the replies.

This creates a large group or conference that spans all of the trunked systems and uses the same Trunking-Address. 

To use a group or a conference in a trunked system, open the "Properties" of the group/conference in the

 tab by double clicking on an entry. 

In the  tab, activate the  option. The "Trunking-Address" will be assigned automatically. 

Groups and conferences must use the same Trunking-Address in all trunked systems. 

It may be necessary to manually assign the trunk addresses for groups and conferences. 



552

Director 7.20 User Manual A10

Figure 826: Trunking – Director – enabling conferences

Figure 827: Trunking – Director – enabling groups

Repeat the steps above for all groups/conferences that should use trunking. Remember to enable the corresponding

groups/conferences in the trunked systems and to match their trunking addresses. 
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12.2.6 Preparing IFBs for Trunking

Up from version 6.30 it is also possible, to use a "Call to IFB" to a trunked system. 

This means you can call from a trunked system to an IFB of the local system. On the local IFB also the "Mix Minus" will

be dimmed, when it is called from a trunked system. This functionality works only when you use the IFB-table for the

IFB configuration. 

To enable an IFB for trunking, open the IFB-table by pressing the  button. The new column "Trunking" shows the

actual trunking status of every configured IFB. 

To enable an IFB for trunking, the used ports for this IFB have to be enabled for trunking. See chapter

"Preparing individual ports for trunking". If an IFB-port is not enabled for trunking, an error message will

show up in the  tab and the configuration cannot be downloaded to the system. 

Figure 828: Trunking – IFB-Table – Trunking disabled

To enable an IFB for trunking just make a double click on the status in the "Trunking" column of the IFB-table. The

status "disable" will change to "enable". The marker will then show a yellow dot. This means, the changes are not yet

sent to the Artist system. 

 > 

Figure 829: Trunking – IFB-Table – activate IFB
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When you download the configuration-changes with the  button to the system, the marker will change to green (

). The IFB is now shown also in the  tab after a short period of time in all connected systems. 

Figure 830: Trunking – IFB-Table -IFB available for Trunking

Now you can use this IFB and just Drag&Drop it the needed ports in the trunked system, to activate a "Call to IFB" of the

local system. For details please see chapter "Trunking: Call to IFB".
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12.3 Trunk-Navigator Software

The Trunk-Navigator software is required to network all of the predefined trunklines and trunk ports with each other

and dynamically manage call requests. In order for trunking to function, the Trunk-Navigator must be permanently

online and connected to the individual trunked systems over an IP connection. 

The Trunk-Navigator does not need to be installed in Windows. It simply consists of an ".exe" file that should be copied

to the directory of your choice. From there it can be started with a double click on the  icon or via a shortcut. A Riedel

USB dongle is required to use the software. After the software is started an empty Trunk-Navigator window opens. 

Hint: Trunk-Navigator is using TCP port 8192 (same as Director). For WAN connections make sure, that this port is not

blocked by any firewall.

At first an empty Trunk-Navigator window is opened.

Figure 831: Trunking – Trunk-Navigator (not configured)

Figure 832: Trunking – Trunk-Navigator (example)
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12.3.1 Changing the background image

To better customize the Trunk-Navigator to reflect where it is being used, the background image can be changed. For

example, it could be set to display a map of your choice. Any *.bmp, *.jpg, or *.gif file can be used. For optimal

appearance, a resolution of 760 x 900 pixels is recommended. 

To change the background image, select the function "Select Background..." in the "Admin" menu. Choose the directory

where the file is saved and pick the file type in the "Files of Type:" drop down menu. Select the file and click the "Open"

button. 

 > 

Figure 833: Trunking – Selecting a new background image

The new image is now linked to the Trunk-Navigator background. It will be displayed each time the program is started. 

Figure 834: Trunk-Navigator – with a custom background
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12.3.2 Connecting Trunk-Navigator to an Artist system

Once a network connection to all trunked Artist systems is established, you need to connect the Trunk-Navigator to the

systems. 

Make sure that you know the IP addresses of all nodes that are set as a "Trunk Controller" before

proceeding. 

In the Menu "Admin" select the function "Connect to Artist System...". Enter the IP address of the first Artist system in the

window and confirm by clicking . 

   >      >   

Figure 835: Trunk-Navigator – Connect to Artist

The first trunked system will appear at first as red, followed by yellow and finally as a green  icon labeled with its

Web name. When newly added, systems normally appear first in the upper left corner of the background image. You

may have to scroll in order to see the icon. However, you can move the icon to any location on the background image. 

Successful connections will be logged in the log area of the software. The previously created trunk configuration will be

displayed in the configuration area. 

Figure 836: Trunk-Navigator – Successful connection to a trunked system
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Repeat these steps for all additional trunked systems.

If a red  icon is shown, this means that the Trunk-Navigator cannot establish a connection to the IP address entered

for this Web. Check the IP address and contact your network administrator to see whether or not the address is being

routed correctly. The corresponding error messages will be shown in the log field. 

Figure 837: Trunk-Navigator – No connection to the trunked system

If a connection  icon is light yellow, this means that a connection was established to the system, but the node with

that IP address is not defined as a Trunk Controller. Change the IP address to the address of the systems Local Trunk

Controller. An error message will be displayed in the log area. 

Figure 838: Trunk-Navigator – The connected node is not a Local Trunk Controller

Once all systems have been connected to the Trunk-Navigator, all of their available ports will be displayed in the

configuration area. 
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The Trunking-Address will be displayed in parentheses ( ) behind the Port/Group/Conference name. 

Figure 839: Trunk-Navigator – Ports shown in the Trunk-Navigator

12.3.3 Setting up trunklines

Once all of the systems have been connected to the Trunk-Navigator, the trunklines between the individual systems

must be assigned. In the "Admin" menu, select "Trunkline Setup". The "Trunkline Setup" window will open. 

To create a new trunkline, click the  button. A new window will open where all of the systems are listed. 

Figure 840: Trunk-Navigator – Trunkline setup, no trunk lines available
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Click on the  symbol to show all available trunklines in a system. 

Figure 841: Trunk-Navigator – Trunkline setup

Select a trunkline from both a system on the right and a system on the left to create a connection between them. If

known, you can also enter the NET and Port address. Confirm your selections with . 

Figure 842: Trunk-Navigator – Select trunk ports
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The new trunkline will be listed in the "Trunkline Setup" window. Continue adding trunklines with the  button

to connect the rest of the trunklines with each other. Trunklines that are already configured will no longer be available

for selection. 

Figure 843: Trunk-Navigator – Configured trunkline connection

After you have connected all of the trunklines with each other they will all be listed in the "Trunkline Setup" window. 

Figure 844: Trunking – Trunkline setup

The  and  buttons can be used to delete a single trunkline or all trunklines. 

With  you can set up a hold time in ms for the trunk-audio connection, after the call has

stopped, to prevent a hard audio cut in special circumstances. The maximum hold time is 1second. 

To save this trunkline setup, click the  button. The trunkline assignments can be saved to a file on the

hard drive ending with ".tls" and opened later using the  button. 
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To edit the Telex-Artist Mapping Table manually, the buttons  and  can be used (see chapter

"Telex-Artist Mapping Table").

As soon as a setup has been saved, the last setup used will always be loaded when the Trunk-Navigator is started. The

name of the file that is being automatically loaded is shown in the "Setup file..." line. 

Figure 845: Trunk-Navigator – Load trunkline setup

As soon as the "Trunkline Setup" window is closed using the  button, all of its settings will be implemented

and the configured trunkline will be displayed along with its capacity. All of the details of the trunklines are displayed in

the trunkline area of the software. A green background to the line indicates that the trunk ports are online. 

Only the trunk ports of the systems are monitored. The correct physical audio connection between the

trunk ports is not monitored. 

Figure 846: Trunk-Navigator – Successful trunkline connection

The configuration of the Trunk-Navigator is now completed. 
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12.3.4 Trunk-Navigator details

The following buttons in Trunk-Navigator can hide or show different areas in the software: 

Log area

Configuration area

Trunkline area

(Trunk) Calls area

The software also features the following menus for configuring the software: 

File

Figure 847: Trunk-Navigator – drop-down menu "File"

Exit Closes Trunk-Navigator.

View

Figure 848: Trunking – drop-down menu "View"

Toolbar Activates/ deactivates the toolbar in the Trunk-Navigator window.

Status Bar Activates/ deactivates the Status Bar in the Trunk-Navigator window.

Center system position Centers all configured system to the middle of the map. Useful if a system was

created outside the display area.

Show mapping table Only used for Trunking with Telex™. Shows the mapping and addresses of both

systems per object.
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Admin

Figure 849: Trunk-Navigator – drop-down menu "Admin"

Connect to Artist system ... Allows a new Artist system to be connected.

Connect to Telex System Connect to a RTS- TELEX™ Trunk Controller via serial connection. 

Only 1 Telex™ system can be trunked (USB-Dongle with "Actor" License

required!).

Remove system Removes an existing Artist system.

Trunkline setup... Opens the trunkline setup window.

Select Background... Selects a different background image.

Show trunkline usage in percent Shows trunkline usage in percent or available/used lines.

Write TL usage to log The current usage of the trunklines is stored in a log-file if this function is

enabled. The log-file is located in the same folder like the Trunk-Navigator.

Cancel all Artist trunk requests Ends all active Artist trunk calls between Artist systems.

Cancel all Artist -> Telex requests Ends all active Artist trunk calls to Telex™ systems.

Clean Telex mapping table Deletes the current Telex mapping table.

Dump routing core Requests the internal trunkline information.
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Help

Figure 850: Trunk-Navigator – drop-down menu "Help"

About Trunk-Navigator ... Displays the software version of Trunk-Navigator.

Figure 851: Trunk-Navigator – About Trunk-Navigator
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12.3.5 Redundancy mode of the Trunk-Navigator

Since Trunk-Navigator requires a permanent connection for trunking functionality, there is the possibility to connect

several Trunk-Navigators. This means that another instance of Trunk-Navigator that runs on a separate PC (USB-Dongle

required) seamlessly takes over the routing management if the primary Trunk-Navigator is no longer online. The only

requirement is that the second PC with Trunk-Navigator must be also connected via IP to the local trunk controller

node. 

Maximum 4 Trunk-Navigator software instances can be connected to the local Artist systems. The switch-

over between the Trunk-Navigators is managed by the Local Trunk-Controller Node automatically. 

Please pay attention that a Node, and also the local trunk controller node can handle maximum 4 software

instances at a time. Also every Director software is using one "slot". So if you want to connect for example

3 Trunk-Navigators, only 1 additional Director can be connected to the Local Trunk-Controller Node. 

Up from version 6.50 all connected Trunk-Navigators are automatically managing which Trunk-Navigator is Active and

which one is in Standby mode. The first Trunk-Navigator that is connecting successfully to the local trunk controller

node becomes the active one. The actual status is shown in the status field on the bottom right side of the Trunk-

Navigator software window. 

Figure 852: Trunking – Status ACTIVE

Now start another Trunk-Navigator on a different PC that is also connected via IP to the local Trunk-Controller Node. 

As long on this Trunk-Navigator are no systems and trunklines configured, the status shows "Undefined", because this

Trunk-Navigator doesn't know yet, where to connect to.

Figure 853: Trunking – Status UNDEFINED

Now create also on this Trunk-Navigator the connected systems and configure the same Trunklines than on the Active

Trunk-Navigator. For details see chapter "Connect Trunk-Navigator to an Artist system" and "Defining Trunklines".

As soon the configuration is done, the Trunk-Navigator is connecting to the Local Trunk-Controller Node. The Node is

telling this Trunk-Navigator, that already another instance is currently "Active". So this Trunk-Navigator is changing his

mode automatically to "Standby". 

Figure 854: Trunking – Status STANDBY

If the active Trunk-Navigator does not communicate with the local trunk controller Node anymore (for example,

because the program was closed or the PC crashed), the standby Trunk-Navigator automatically takes over all routing

functions. The Status Bar of this Trunk-Navigator is now showing "ACTIVE". 

Active audio connections between the trunked systems are interrupted for a short moment, during a

switch over process. 

When now the previous Active Trunk-Navigator software is restarted, it now automatically changes to Standby mode. 
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12.3.6 Telex-Artist Mapping Table

Trunking allows combining up to 50 Artist-Ring systems. The identification of each port in the various Artist-Rings is

given by a unique net and port address. Therefore, the Trunking-Address consists of a dual number: the net-address

and port-address (xxx.yyy).

The allocation of the net-addresses can be found in chapter "Preparing the configuration".

The allocation of the port-addresses can be found in chapter "Preparing individual ports for trunking".

A Telex™ system is able to use up to 960 ports that are identified by a single number (1–960). 

If a Telex™ system is combined in the Artist Trunking, the existing Artist Trunking addresses (xxx.yyy) must be supplied

to the Telex™ system in this single address range (1–960).

This mapping is done in the Telex-Artist Mapping Table, that is opened in the menu "View" > "Show mapping table".

Figure 855: Telex-Artist Mapping Table

The mapping procedure renumbers the first 960 Trunking ports of the various Artist-Rings and writes the result in the

mapping table. Further ports will be discarded, because the Telex™ system is not able to handle more than 960 ports.

The mapping table can be directly edited by clicking on the respective Telex-Number.

The Telex-Number must be unique. If the number is already used, a failure message will be prompt.

Figure 856: Telex-Artist Mapping Table – Edit – unable to set the value
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The mapping table can be also edit with a user preferred text editor.

Therefore the two buttons  and  are in the Trunkline setup (menu Admin > Trunkline setup).

Figure 857: Trunkline setup – Export / Import CSV (example)

The export of the mapping table is done by clicking the button .

After exporting the trunk list the CSV-file can be edited with the desired text editor.

The single parameters are separated by a ";" semicolon.
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The following table shows a part of the Trunkline setup in the figure above.

TL_FILE_VERSION=5

TRUNK_LINE_COUNT=4

From_

NetTrAddr

From_

NetName

From_

PortTrAddr

From_

PortName

To_

NetTrAddr

To_

NetName

To_

PortTrAddr

To_

PortName

CascEn

92 Artist92 55 TL9255 90 ArtistS90 55 TL9055 0

92 Artist92 56 TL9256 90 ArtistS90 56 TL9056 0

90 ArtistS90 57 TL9057 88 ArtistS88 57 TL8857 0

90 ArtistS90 58 TL9058 88 ArtistS88 58 TL8858 0

TRUNK_REQ_OFF_DELAY_MS=0

MAPPED_PORT_COUNT=29

Telex

Number

Artist

NetAddr

Artist

PortAddr

18 90 58

1 88 3

15 90 6

...

MAPPED_IFB_COUNT=17

Telex

Number

Artist

NetAddr

Artist

IfbAddr

1 88 10

15 88 8

12 88 15

...

MAPPED_CONF_COUNT=9

Telex

Number

Artist

ConfAddr

1 300003

9 123456

6 300002

...

MAPPED_GROUP_COUNT=2

Telex

Number

Artist

GroupAddr

1 1

2 300001

In the upper part is the Trunkline setup located. Here the local and remote Trunklines are allocated.

Below are 2 parts: Port and Ifb. Here the Telex™ numbers are allocated to the respective net and port addresses.

At last are 2 parts: Conf and Group. Here the Telex™ numbers are allocated to the conference respectively group

addresses.



570

Director 7.20 User Manual A10

The following table explains all available parameters of the 5 parts:

Part Parameter Remark

Trunklines TL_FILE_VERSION=5 Compatibility version of the file.

TRUNK_LINE_COUNT=4 Amount of configured Trunklines (i.e. =4).

From_NetTrAddr Net-Address of the source port.

From_NetName Net-Name of the source port (maximum 8 characters).

From_PortTrAddr Port-Address of the source port.

From_PortName Port-Name of the source port.

To_NetTrAddr Net-Address of the destination port.

To_NetName Net-Name of the destination port (maximum 8 characters).

To_PortTrAddr Port-Address of the destination port.

To_PortName Port-Name of the destination port.

CascEn for internal use – please do not change

TRUNK_REQ_OFF_DELAY_MS=0 Hold time in ms (Trunk request off delay in the Trunkline setup) 

(i.e. =0).

Ports MAPPED_PORT_COUNT=29 Amount of Trunkports (i.e. =29).

TelexNumber Unique Telex-Address.

ArtistNetAddr Net-Address of the Artist-Port.

ArtistPortAddr Port-Address in the Artist system.

IFBs MAPPED_IFB_COUNT=17 Amount of Trunk-IFBs (i.e. =17).

TelexNumber Unique Telex-Address.

ArtistNetAddr Net-Address of the Artist-IFB.

ArtistIfbAddr IFB-Address in the Artist system.

Confs MAPPED_CONF_COUNT=9 Amount of Trunk-Conferences (i.e. =9).

TelexNumber Unique Telex-Address.

ArtistConfAddr Conference-Address in the Artist system.

Groups MAPPED_GROUP_COUNT=2 Amount of Trunk-Groups (i.e. =2).

TelexNumber Unique Telex-Address.

ArtistGroupAddr Group-Address in the Artist system.

Please note the following point if the mapping table is edited. Failures in syntax or logic are not tolerated. 

If a failure occurs, the import will be canceled.

· Do not change the file version "TL_FILE_VERSION=5".

· The amount of Trunklines defined in the file must match the value of the parameter "TRUNK_LINE_COUNT=4" 

(i.e. =4).

· The amount of Ports (IFBs, Confs and Groups) defined in the file must match the parameter "MAPPED_Ports (IFBs,

Confs and Groups)_COUNT=xx".

· The Telex-Addresses must exist only once in each part.
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After editing and saving the mapping table, click the button  to start the import.

Please note that the current configuration in the Trunkline setup will be overwritten.

Thus, a confirmation dialog must be confirmed by clicking the  button.

Figure 858: Trunkline setup – Import CSV  confirmation prompt

If a failure occurs, the import will be canceled and prompt with following message.

The current configuration will remain in the Trunkline setup and no values will be overwritten.

Figure 859: Trunkline setup – Import CSV  failure prompt

The configuration is imported successfully in the Trunkline setup if no error message appeared.

Finally, click the  button to apply the user defined configuration to the Trunk-Navigator.
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12.4 Configuring Trunkcalls in Director

As soon as the Trunk-Navigator is set up and online with the system, the individual trunking calls in each system can be

configured. 

"Call to Port", "Call to Group", "Call to IFB" and "Call to Conference" commands can be configured to trunking destinations.

Up from Director Version 6.20 it is now possible also to create a "Listen to" command to a trunked port 

Open the  tab in each Director configuration. All of the available destinations in the trunked systems will be

listed. 

Normally Trunking calls are configured online. Both, Director and the Trunk-Navigator must be connected

to the local trunk controller Node. The  tab is empty in offline mode. If only the Trunk-Navigator

is inactive, the list will only show the local trunk ports. 

Because also the Local Trunk-Controller Node can handle maximum 4 connected software instances

simultaneously, you have to define during the system set up which Director PCs and which Trunk-

Navigators are allowed to connect to the Local Trunk Controller Node simultaneously. 

Since version 6.20 it is possible to configure Trunk calls offline if the destinations Trunk addresses are known. For

details refer chapter "Offline configuration of Trunkcalls".

12.4.1 'Call to Port' (Trunking)

To create a "Call to Port" command to a trunking destination, the Navigation Bar in Director must be open to the

 tab. 

Figure 860: Trunking – Director
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Clicking the  symbol shows all trunking destinations in all of the systems. The trunk addresses of all trunking objects

are shown in ( ).

Figure 861: Trunking – Director – Viewing all trunk ports

Open a local port in the Workspace and drag the trunking destination to a key or Virtual Function using drag & drop. 

Figure 862: Trunking – Director – Drag & Drop "Call to Port" to trunking destinations
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12.4.2 'Listen to Port' (Trunking)

To configure a "Listen to" to a trunkport it is not possible to use the Drag&Drop method. To use "listen to" for a trunk

member, you have to know the Trunking-Address of the destination port you want to listen to. 

Create a standard "listen to" function on a local key or virtual function. The "Properties" window of this function will

open automatically. Now select "Trunking-Address" as "Source" . 

Enter the NET and Port-address of the trunkport you want to listen to. 

You can find the Trunking-Address of the trunked port in the  tab. The address is shown in ( ) behind the port

name. 

Figure 863: Trunking – Creating a "Listen to" Trunkport function

This method is identically to the offline-configuration of trunkcalls. See chapter "Offline-configuration of

Trunkcalls" (new in Director 6.20). 

In Online-Mode the labels are automatically applied to the keys. In the Offline-Modes the labels are not available. Thus,

the key will show "LstnTR ?" in the display. 

To label the key, you can disable the function "define automatically" in the  tab of the key properties and enter a

name manually. You can also use the function "Edit" > "Update Trunking key labels" once when you finished all listen to

configurations and when the Trunk-Navigator and Director is online. Then the labels will be updated (see chapter

"Trunking: Changing port names").

 > 

Figure 864: Trunking – "Listen to Port" key text
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12.4.3 'Call to Group Conference' (Trunking)

To use groups or conferences via trunking, you need to configure a group resp. a conference in all trunked systems you

want to use for this functionality. The group resp. conference in the different systems has to use the same Trunking-

Address. Then the Trunk-Navigator knows which groups/conferences are linked together. 

Create a new group resp. conference in the local system (see chapter "Create and manage Groups and Conferences")

and open the properties of the new group/conference. Enter any Trunking-Address for this conference/group. 

The Trunking-Address for groups and conferences is independent of the trunk addresses of single ports.

So a Trunking-Address of a group/conference can be the same then the address of a single port. 

Figure 865: Trunking – Call to Group/Conference – Trunking-Address

Now create also a group resp. a conference in the configurations of the trunked systems and set the same Trunking-

Address for the group/conference like in your local system. The long-, and. 8-char labels of the group/conference can

be different in every system. 
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To now configure calls to a trunked groups resp. conferences to local ports, you have to Drag&Drop the needed

groups/conferences from the  list to local keys or virtual functions. 

Therefore the  tab and the local port need to be opened. 

Figure 866: Trunking – Drag&Drop of groups and conferences

Groups and conferences are created automatically if the local configuration also contains a group or

conference with the same Trunking-Address. The groups and conferences of the various systems are

connected to another via this Trunking-Address. 



577

Director 7.20 User Manual A10

12.4.4 'Call to IFB' (Trunking)

To configure a call to an IFB of a trunked system, this IFB have to be enabled for trunking before. Please see chapter

"Preparing IFBs for Trunking".

All trunk-enabled IFBs of all systems will show up in the trunking list .

Now you can easily move a trunked IFB from the  list with Drag&Drop to panel keys or virtual functions of the

local system. Download the changes to your system. Then you can call to this trunked IFB also with activating the

dimming of the "Mix Minus" to the configured output in the trunked system. 

Figure 867: Trunking – configure "Call to IFB"

Please note if an "Input" port for the used IFB is configured, the trunked port will also receive the incoming

audio of this input as soon it is activated. This will then occupy one trunkline to the trunked system. 
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12.4.5 'Monitoring' (Trunking)

Up from Version 6.70 it is also possible to monitor ports (Panels or 4-wires) of a trunked system. This means, as soon a

monitored port starts a conversation, you will get a "copy" of this audio. 

There is no special Trunking configuration required. It is only necessary, that in the "Panel properties" > "Details 1" one

function key assignment is changed to the monitoring function (see also Monitoring for details).

Figure 868: Trunking – Panel Properties – Detail 1 – Fn key assignment

To monitor a trunked port is the same behavior then monitoring a local port. Just press the assigned FN-key and then

the key of the trunked port. The monitoring marker will show you, that monitoring is activated. 

>

Figure 869: Trunking – Activating the monitoring function

As soon the monitored panel in a trunked system is starting a conversation, for example to the local Director, your key

shows an incoming call + monitoring activated marker and you can hear the audio coming from the monitored panel.

By pressing the key you can normally talk directly to this port. 

Figure 870: Trunking – Incoming call of a monitored port

Be aware off that every activated monitoring function over trunking occupies a trunkline from the trunked

to the local system, every time the monitored port(s) starts to talk to somewhere. There are no trunk-

priorities available for the monitoring. 
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If all trunk lines are already used when the monitored panel activates a local call, the key with the monitoring function

will show the message "TL Busy" and a yellow flashing marker. 

The monitoring function will automatically be deactivated for these keys. 

>

Figure 871: Trunking – Monitoring when all trunklines are busy

12.4.6 'Changing Port Names' (Trunking)

If you change Net-, Port- or Display names of trunk enabled ports in your local configuration, send these changes with

 to the local system. The Trunk-Navigator will take over these changes and forward them to all connected

Directors. After a while, the Trunking-list in the  tabs will be updated with all new names in all Directors. It

can take up to 1 minute until all lists are up to date. To overtake all new labels to the other local configurations, activate

the function "Update Trunking key labels" in the "Edit" menu in all other connected Directors. All local key labels,

configured with a trunking function that have been changed, will be updated to the latest. An Info-window will show

the numbers of changed labels in the local configuration. Now send the configuration with to the local systems. 

 > 

Figure 872: Trunking – Director – Update Trunking key labels

Therefore the Director and Trunk-Navigator need to be connected online to the systems. 
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12.4.7 Offline Configuration (Trunking)

Up from Director Version 6.20 it is possible, to configure Trunkcalls also in offline mode. 

That means, no Trunk-Navigator or Artist needs to be connected. Therefore you need to know the trunk addresses of

the called trunkport and also the Trunking-Address of the trunked system. You can figure out these addresses for

example by opening the configuration of the trunked system in another Director instance (writing Log files need to be

disabled in Director to open another instance on the same computer (see chapter "Options – Logging"). 

You can figure out the "Trunking Net address" in the properties of the web of the configuration. Open "Properties" of

the "WEB" in the  tab.

Figure 873: Trunking – Director – Properties of the NET

Figure 874: Trunking – Director – Trunking NET address
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To find out the Trunking-Address of a single port, you have to open the "Properties" of the port and go to the

 tab. In "Trunking-Address" you can figure out the Trunking-Address of the port. 

Figure 875: Trunking – Director – Trunking-Address of a Ports

To configure offline a trunkcall to a local port, just add with "Add function" a new "Call to Port" or "Listen to Port"

command on a key or a virtual function. Now open the "Properties" of this function and select 

instead of "local Port" and enter the Net-, and Trunking-Address of the trunked destination port. 

Figure 876: Trunking – Director – Call to Port – Trunking-Address

Use the same procedure also for a "Listen to Port" command. 
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Because an automatic takeover of the trunkport-labels is not working in Offline-Mode, the key will show "LstnTR ?" resp.

"CallTR ?" in the display. 

To label the key, you can disable the function "define automatically" in the  tab of the key properties and enter a

name manually. You can also use the function "Edit" > "Update Trunking key labels" once when you finished all listen to

configurations and when the Trunk-Navigator and Director is online. Then the labels will be updated (see chapter

"Trunking: Changing port names").

 > 

Figure 877: Trunking – Offline configuration – key display

12.4.8 Trunking Priorities

Each trunking call can be assigned one of 3 different trunking priority levels. The priorities allow the most important

calls to be given a higher priority in the face of limited trunkline capacity. The three priorities are: "Low", "Standard", and

"High". 

All new trunk calls are first created with the priority "Standard" by default. To change the priority of a trunking call, open

the properties of the trunking call and change the priority under "Trunkcall priority". 

Right mouse click on the key or Virtual Function and select the "Edit". Select the desired trunking call. 

Figure 878: Trunking – Director – Editing a trunking call
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Change the priority of the call under "Trunkcall priority". 

Figure 879: Trunking – Director – Selecting the trunk call priority

The maximum number of simultaneous calls in a trunked system is dependent on the number of trunklines available. 

For example, as soon as the trunkline capacity is used up by calls with a "Standard" priority and a call with a "High"

priority is activated, one of the standard calls will be terminated. If calls with priorities "Standard" and "Low" are active

at the same time, the call with the lowest priority will be ended to allow the higher priority call to use the trunkline. 

As soon as an active trunking call is ended by a call with a higher priority, this will be indicated on the affected control

panel keys. 

Active Trunking Call: Trunking call ended by a call with a higher priority:

Figure 880: Trunking – Markers Panel key
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12.5 Displaying Trunkcalls

The Trunk-Navigator software displays the current status of the trunkline capacity in % or the number of available and

used trunklines for each direction. In "Admin" > "Show trunkline usage" you can choose which type you want to see. 

Figure 881: Trunk-Navigator – Capacity used on the

trunkline

Figure 882: Trunk-Navigator – Number of used trunklines

If all trunklines per direction are used, the usage display changes to red. 

In addition, the trunkline area of the Trunk-Navigator software lists which trunklines are being used and in which

direction. 

Figure 883: Trunk-Navigator – Active trunklines

The exact details of which trunk port of a system activated a certain call and the destination for the call are listed in the

trunk call area. 

Figure 884: Trunk-Navigator – Active source and destination ports

All trunk call connections are also listed in the log area along with the exact time they took place. The log file is saved as

a .txt file in the same directory as the Trunk-Navigator. 

Figure 885: Trunk-Navigator – Log entries of an active trunk call

Since the trunkline capacity is dependent on the source being used, multiple direct calls can be activated

at the same time from a single source. The distribution to the ports in the destination system is handled by

the CPU in the remote system. 
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As soon as a trunkline has reached its maximum capacity, this will be indicated by "100%" being displayed in red. 

Figure 886: Trunk-Navigator – 100% use of a trunkline

If another trunk member tries to activate a trunk call with the same priority, this person will see a busy signal on the

corresponding control panel key when they press it. 

Figure 887: Trunking – Panel key display Trunkline busy

If a trunkline or an entire trunked system is offline, it will be displayed red in the Trunk-Navigator. 

Figure 888: Trunk-Navigator – Trunkline offline

If a user tries to make a call, the caller will see an error message when the key is pressed. 

Figure 889: Trunking – Panel key display Trunkline or trunk system not available
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12.6 Connecting Trunk-Navigator to a Telex System

Up from version 6.60 the Trunk-Navigator contains functionality of Trunk-Navigator and Riedel Actor Software. To use

the Actor functionality, a connected USB-Dongle with an Actor License is required. 

With this software it is possible to connect a trunked Artist system to a Telex™ system. In this constellation the Trunk-

Navigator simulates to be a single Telex™ system on the interface to the Telex™ Trunkmaster. 

Compatible with RTS/Telex™ Trunkmaster 8.7.1. Newer Versions are NOT supported right now.

Advantages of this solution:

· Both trunking worlds (Artist, Telex™) are independent. Comms between Artist only rely on Trunk-Navigator. Comms

between Telex™ only rely on Trunkmaster.

· Trunk-Navigator could be extended with new functionality without any conflict with Telex™ Trunkmaster.

· Conferences between Artist systems do not need any workaround and do not allocate a permanent trunkline.

· Trunk-Navigator supports redundant setups.

· Individual volume control between Artist systems.

Trunking Artist <> Telex™

Figure 890: Trunking Artist<>Telex™ – overview
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· All Artist systems appear as one ADAM™ system on the interface to the Telex™ Trunkmaster. 

· All Telex™ systems are individually visible in the Director as well as in the Trunk-Navigator. 

· The trunklines from/to the Artist systems appear as if they are all going to one system. In effect they could interface

to different Artist and Telex™ systems. 

· The maximum count of visible trunked Telex™ ports is 960 (the maximum of a single ADAM™ system). 

· Call to port: The destination of a call to port command can be a port the other system. 

· Listen to port: The referenced audio source can be a port the other system. 

· Call to IFB. The targeted IFB can be in the other system. 

· Group / special list. From Telex™ you can talk into an Artist group. From Artist you can talk into a Telex® special list.

This is achieved by creating a corresponding mirror group in Artist. 

· Conference / Party line: From Telex™ you can talk/listen into an Artist conference. 

· From Artist you can talk/listen into a Telex™ party line. This is achieved by creating a corresponding mirror

conference in Artist. 

· Cascading trunks: Multiple Telex™ system cannot be cascaded. The number of hops is limited to 1. 

· The maximum count of connected Artist networks is 50. 

· The maximum count of connected Telex™ systems is 31. The maximum count of connections the Trunkmaster can

handle is 32 and one connection goes to Trunk-Navigator. 

· Trunk priorities are not supported since the concepts of Artist and Telex™ are incompatible. 

· Trunklines are allocated on enabled listens. Therefore conferences will take a permanent trunkline when the listen

flag of an Artist member is set. 

· Trunkline optimization: Calls from different source ports to the same destination port are sharing the same

trunkline. 

· Volume control: Since multiple source ports are sharing the same trunkline, individual volume control is not

possible. 

To add a Telex™ Trunkmaster, just select "Connect to Telex system" in the "Admin" menu and then select the serial port

the PC should use to connect to the Telex™ Trunkmaster. 

Figure 891: Trunking – Adding a Telex™ Trunkmaster
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The Telex™ Trunkmaster will show up as the "T" symbol in the overview. 

 – not connected

 – connecting  – connected

Figure 892: Trunking – Telex™ Trunkmaster in Trunk-Navigator

A connected Telex™ Trunkmaster will only be shown as the symbol within the Trunk-Navigator MAP view.

It is NOT showing connection lines and usage per direction. 

The single ADAM™ Frames, connected to the Trunkmaster with their trunk-enabled ports will show up in the Trunk-

Navigator and also in the "Trunking" tab in the Director. 
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By just drag and drop an ADAM™ port to an Artist panel key or function you can create a "call to Port" to this Adam

port. 

Figure 893: Trunking – Artist and Telex™ Trunkports in Director

When you want to use "Listen to", "Call to Group", Call to Conference" or "Call to IFB" in combination with a

trunked Telex™ system, you have to do some special configurations beforehand within the Trunkmaster.

Please contact your system administrator and customerservice@riedel.net for further details. 
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13 Appendix

13.1 Troubleshooting

Problem Possible Cause Potential Solution

Director cannot connect to

Artist.

Network is not activated. Press the network button in Director.

Incorrect IP address in Director. Enter the correct IP address.

Network cable is not connected. Connect the network cable to the 10BaseT

port on the CPU rear card.

Ethernet is only connected to the

redundant PC.

Connect the Ethernet cable to the active

CPU, or use a switch or Ethernet hub to

connect to both CPUs at the same time.

Wrong Ethernet cable. Direct connection PC->Artist:

10BaseT X-Over ; Hub/Switch: 1:1.

IP address of the PC is not in the same

subnet mask as Director.

Make sure that the PC is in the same

subnet as Artist (Ex. 192.168.42.x).

A firewall is blocking the network

connection.

Deactivate the firewall or unlock port

8192.

Windows Network ARP cache problem after

changing the IP address.

Execute the DOS command "arp –d *" :

Reset the ARP cache

There are already 4 software instances

connected to this node.

Disconnect other unused Software

connections.

Unstable IP-connection

(interruptions during

firmware update or

downloading configurations).

Wrong speed setup of your PC network-

card.

Set the speed of your network-card in

your Windows device manager to "Auto

detection" or "10Mbit half-duplex".

2 or more nodes are

connected via fiber, but only 1

node is visible in the online

bar.

Fiber connection is not working. Clean the fiber connectors and check the

cable (see CPU-LEDs).

Fiber is not connected correctly. Make sure that the node 1 downstream

TX is connected to the upstream RX of the

next node, and vice versa.

Node addresses are the same. Change the node address of a node.

The systems are running different software

versions.

Update/downgrade all systems to the

same software version.

Wrong fiber cable type or fiber transceiver

installed.

Check the hardware for which fiber type

should be used.

It is not possible to read out

the configuration from the

system.

Network is not active. Press the network button in Director.

The Director version is newer / older than

the firmware in the system.

Open the version of Director that matches

the firmware installed.

The system was not used for a long period

.The CPU has therefore lost the

configuration.

Open the configuration from the hard

drive and send it to the system

(afterwards reset the system).

You do not have the user rights to read out

the configuration from the system.

Contact your system administrator.

It is not possible to send a

configuration to the system.

Network is not active Press the network button

Configuration contains an error. Check the "Cfg errors" tab in Director for

undefined entries.

The version of Director is newer/older than

the Artist firmware.

Use the correct version of Director that

matches your firmware.

The node address in the configuration is not

the same address as the system.

Adjust the node addresses, either in the

configuration or on the node itself.

You do not have the necessary user rights

or have clicked "Cancel" in the Log-in

window.

Contact your system administrator, or

click "Ok" when logging in.
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Problem Possible Cause Potential Solution

Panel / Port does not boot. The connection to Artist is faulty. Check the cabling.

The Artist CAT5 cable is connected to the

"Expansion" port.

Connect the CAT5 cable to the "Matrix"

connector.

The panel has no power. Check the power cable

The yellow LED on the corresponding client

card is active, > all 8 ports are not working.

The client card is not configured or it has

the wrong firmware.

The panel is connected to the second

channel of a stereo port / an AES signal is

not working.

Always connect a panel or AES signal to

the even numbered port of a stereo port.

Cable is too long. Check whether the maximum cable length

of approx. 300m has been reached.

The panel crashed. Reset the panel by cycling the power or

with a software reset.

ECP 10xx/20xx does not work. The ECPs address is incorrect. Check the address in Director and on the

dip switch on the ECP.

GPI card does not work. The jumper setting on the GPI card is

incorrect.

Check the bay and jumper setting on the

GPI card (see the sticker on the GPI card).

The complete system has

crashed or does not boot.

The CPUs make a clicking

noise.

The HDLC cable on the CPU rear cards is

defective or not present.

Connect the HDLC cable to the "HDLC"

connector on both CPU rear cards.

Clicks in the digital 4-wire

audio

There is no Ring Clock Master in the Artist

ring / the Ring Clock Master is set for

external sync, but no sync signal is present.

Set a node in the ring as the Ring Clock

Master ( > Online bar > Node properties) /

connect a valid sync signal to the sync

module.

No audio, wrong signalization,

no reply function at some

panels, N/A at working

ports, ...

The configuration contains hardware

changes (a configuration is send to the

system) without rebooting the system.

Perform a Node reset (Director -> "Extras"

> "Reset all Nodes").
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13.2 Glossary

AVB Audio Video Bridging

AVR Audio Video Router

Bay Slot for CPU-, Client- and GPI cards in the Artist mainframe

COS Class Of Service

Crosspoint The virtual intersection in the matrix where sources are mixed and routed to a destination

Destination Matrix output, for example a control panel or 4-wire output

DHCP Dynamic Host Configuration Protocol – Network devices can get IP-address, Subnet mask and DNS-

Server automatically from a DHCP Server in the Network

DiffServ Differentiated Services – networking architecture that specifies a mechanism for classifying IP packets.

DNS Domain Name System – allows identifying a network user by a unique name.

The associated IP-Address is stored in a DNS-Server.

DSCP Differentiated Services Code Point – is used in the IP header for packet classification purposes.

DSP Digital Signal Processor. A fast central processing unit especially for digital audio applications.

Ethernet 10BaseT Ethernet Network Interface of the Mainframe, 10Mbit half-duplex.

FOM Fiber Optic Modem (also known as SFP)

GPI General Purpose Interface (Inputs and Outputs).

An interface for electrical signals (contact information, e.g. Relays).

GUID Globally Unique Identifier is a unique reference number used as an identifier.

IFB Interruptible Foldback. A particular audio signal (ex. program audio) sent to a port is dimmed or muted

if the port receives a call from another source

IGMP Internet Group Management Protocol – communications protocol to establish multicast group

memberships.

ISDN Integrated Services Digital Network – Digital Telecommunication Standard.

ISO Isolated call, a private, point-to-point communication between a source and destination where all other

calls to that destination are muted or dimmed

Matrix The digital signal processing platform comprising of one or more frames. See Node and Net

Multicast Transfer from one source to multiple destinations.

Net The complete local matrix that is made up of either a single node or multiple nodes connected by fiber

Node A single mainframe that provides audio connections, general-purpose input/output interfaces and fiber

links

Panel The device that allows end users to route audio and send other commands to the intercom system.

Panels are connected to digital client cards.

Port-Pool A group of destinations that have the same physical connection on the system. Used for remote

destinations such as ISDN panels and 4-wires.

PC Personal Computer

PSTN Public Service Telephone Network – the standard analog telephone service

PTP The Precision Time Protocol is used to synchronize multiple devices.

Port Analogue or digital interface on the matrix for the connection of panels or 4-wires

QoS Quality of Service – is the performance of a computer network.

RTP / RTSP Real-Time Transport Protocol / Real-Time Streaming Protocol

SDP Session Description Protocol

SFP Small Form-factor Pluggable transceiver – extractable optical or electrical transmitter/receiver module

SIP Session Initiation Protocol – is a Network protocol to connect, control and disconnect a communication

session between one or more subscriber (common protocol by IP phones).

Source Audio source, for example a panel or a 4-wire input

SSRC Synchronization Source

TCP/IP Transmission Control Protocol/Internet Protocol, standard network protocol that is the basis for the

internet
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UHF Ultra High Frequency – section of the radio spectrum that is used for, among other things, many two-

way radios (403–470MHz)

VHF Very High Frequency – section of the radio spectrum that is used for, among other things, many two-

way radios (30–300MHz)

Vox Voice Operated Switch. Triggered when an incoming audio signal exceeds a set threshold, causing an

event in the matrix without a key press

Web Artist System Network
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13.3 Service

If you have any further questions, we offer comprehensive customer service options for this product including:

· Telephone Service

· Email Service

· Fax Service

· Configuration Support

· Trainings

· Repair

Your primary point of contact for any service issues is your local dealer.

In addition, Riedel Customer Service in Wuppertal, Germany is also available to assist you.

Telephone: +49 (0) 202 292 9400

(Monday - Friday, 8am – 5pm, Central European Time)

Fax: +49 (0) 202 292 9419

Or use the contact form on our website:

www.riedel.net > Company > Contact > Wuppertal (Headquarters)

For repairs, please contact your local dealer. Your dealer will be able to help process your repair as fast as possible

and/or arrange for the delivery of spare parts.

The address for repairs sent directly to Riedel Communications GmbH is:

Riedel Communications GmbH & Co. KG

- Repairs -

Uellendahler Str. 353

D-42109 Wuppertal

Germany

Please add a completed repair form to all your repairs.

The form can be found at the Riedel website:

www.riedel.net > Services > Repairs
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Index

- 1 -
1000 series (Port types)     51

1100 Series - Screensaver     342

1100 series (Port types)     52

- 2 -
2000 series (Port types)     53

2300 series (Port types)     54

- 3 -
3000 series (Port types)     55

- 4 -
4-Wire (Port types)     56

4-Wire-Properties     344

- 5 -
5000 series (Port types)     55

- 8 -
8-char Label     388, 391

8-char Label Local     397

- A -
About     219

About Artist     14

About Trunk-Navigator     563

Action when muted key is pressed     234, 352

Activate Speaker Dim     234

Activating a GPI Output of a RIF Interface     433

Activating Director for the Scheduler     524

Add     393

Add Function     97, 101

Add or Change Users     30

Adding a Codec to the Configuration     405

Adding a GPI Card     68

Adding a New Matrix Card     47

Adding a New Node     32

Adding a New Port     51

Adding a New Scroll-List     151

Adding Members to a Conference     141

Adding Members to a Group     140

Adding the Audio Video Router (AVR) to Director     529

Adding the Events / Scheduler add-on     507

Adding the MCR     470

Adding/Deleting/Connecting Nodes in a Network     31

Address     230, 243

AES67     284

AES67 - Client Card Properties     287

AES67 - SmartPanel Properties     289

AES67 Card-Properties     250

AES67 Defaults tab (Net-Properties)     238

AES67 Input tab (Port/Panel-Properties)     273

AES67 Output tab (Port/Panel-Properties)     275

AES67 Statistic     209, 221, 293

AES67 tab (Port/Panel-Properties)     272

AES67 Trunkline tab (Port/Panel-Properties)     277

AES67-108 G2 firmware update     292

Alarms     209, 221, 226

Alias     255, 344, 391

Alias Labels     85

Allow Load (All) Offline     400

Allow Open File from Disk     400

Allow PF Configuration     400

Allow Save Changes to ARTIST(merge)     400

Allow Save Configuration to Disk     400

Allow Save Partial File to Disk     400

Allow Save to ARTIST (overwrite)     400

Allow System Resets     400

Allow the "Set Input/Output Gain" function to adjust the

source port from this panel     356, 361

Allow Update (All)     400

Alphabetical Search     156

Always     89, 101

Amplifier (Audiopatch)     112

Apply Defaults to all existing Objects     117

Apply Defaults to Configuration Objects     205, 208

Artist - Online View     227

Artist G2 32, 64, 128 (Client Cards)     48

Artist M (Client Cards)     49

Artist Online View     209

Artist S (Client Cards)     50

Ask for confirmation when saving the configuration to Artist

with overwrite     214

Assign new Configuration ID     216

Assign New Configuration-ID     217

Assigned GPI Out     388, 391

Assigning a 4-Wire Port to a Conference     142

Assigning a Function to a Key     98

Assigning a Panel to a Conference     141

Assigning a Scroll-List to a Control Panel     154

Assigning Actions to a Logic Function     163

Assigning Functions to a GPI     135

Assigning Memers to a Conference     489

Assigning Virtual Functions     101

Audio Bitrates required by the Codecs     304

Audio IN A,B     428

Audio OUT A,B     428

Audio Patches     95
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Audio Video Router Interface     209, 221

Audiopatch     364

Audiopatch (Amplifier)     112

Audiopatch (Bandpass)     112

Audiopatch (Compressor/Limiter)     113

Audiopatch (Cough or Mic-Mute)     107

Audiopatch (Crosspoints)     114

Audiopatch ('Headset' for 3000 series control panels)     109

Audiopatch (Mic Pre-amp)     111

Audiopatch (Panel Mic/Headset Switch)     111

Audiopatch Crosspoint Level     440

Audiopatch Input Amplifier Gain     440

Audiopatch Input Compressor Attack     440

Audiopatch Input Compressor Ratio     440

Audiopatch Input Compressor Release     440

Audiopatch Input Compressor Threshold     440

Audiopatch Input High Pass Filter Cut-Off     440

Audiopatch Input Limiter Attack     440

Audiopatch Input Limiter Out-Level     440

Audiopatch Input Limiter Release     440

Audiopatch Input Limiter Threshold     440

Audiopatch Input Low Pass Filter Cut-Off     440

Audiopatch Input Mic Pre-Amplifier Gain     440

Audiopatch OUTPUT     428

Audiopatch Output Amplifier Gain     440

Audiopatch Output Compressor Attack     440

Audiopatch Output Compressor Ratio     440

Audiopatch Output Compressor Release     440

Audiopatch Output Compressor Threshold     440

Audiopatch Output High Pass Filter Cut-Off     440

Audiopatch Output Limiter Attack     440

Audiopatch Output Limiter Out-Level     440

Audiopatch Output Limiter Release     440

Audiopatch Output Limiter Threshold     440

Audiopatch Output Low Pass Filter Cut-Off     440

Audiopatch parameters     110

Auto     352, 353

Auto Listen Off     88

Auto Reverse Talk for 4-Wire     214

Autolisten (Call to Port)     357

Autolisten from Destination     356

Autolisten Off     382

Automatic connection using the Magic Wand     34

Automatic IP-Address - DHCP     299

Automatically adjust speaker dim and key mode     214

Autosave online/working configuration     213

AVB     329

AVB-Manager     330

AVR Configuration     531

- B -
Background color     241

Bandpass (Audiopatch)     112

Bandwidth (AES67)     286

Bandwidth calculation     304

Base color     241

Bay     592

Beep destination on call     356, 360

Beep On Call Duration     231, 256, 440

Beep Panel     88, 375

Beep tab (4-Wire-Properties)     349

Beep tab (Port/Panel-Properties)     268

Beep Volume     231, 256, 440

Before beginning the update     189

Belated Changing of Partial Files     455

Bolero tab (Port/Panel-Properties)     278

Brightness of LEDs / Displays     232, 256, 440

Building a Logic Function     161

- C -
Calculation Example for a VoIP SIP-Port     306

Call Defaults tab (Net-Properties)     235

Call Priority     235

Call to Conference     88, 358

Call to Conference (Event)     511

Call to Group     88, 359

Call to Group (Event)     514

Call to Group Conference (Trunking)     575

Call to IFB     88, 360

Call to IFB (Trunking)     577

Call to Port     88, 356

Call to Port (Event)     516

Call to Port (Trunking)     572

Cancel all trunk requests     563

Card-Properties     248

CCP-1116     428

Center system position     563

Cfg Errors     223

Changing a 4-Wire I/O Gain Level     495

Changing Default Text Color for all 1100/2300 Panels     335

Changing Markers     437

Changing Port Names (Trunking)     579

Changing Port-list entries directly with keyboard     83

Changing the background image (Trunk-Navigator Software)  

  556

Changing the View     23

Character set     233

Checking the Node IDs in the Configuration     39

CL (Clear)     378

Client Card B     244
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Client Card Bay 1-16     244

Client Card Bay X-Y     244

Client Card Properties (VoIP)     297

Client Cards (Artist G2 32, 64, 128)     48

Client Cards (Artist M)     49

Client Cards (Artist S)     50

Client Cards (Performer 32-16, 32-80)     50

Client mode     212, 453

Client Update     193

Client/Server Mode     461

Client-Card Mode     183

Clip label to 6 characters (only 1100 series)     352

Clone Output Port     88, 376

Close     456

Codec-Channel     413, 414

Colors     210, 215

Command-line arguments     219, 220

Commentary Audiopatch Settings     428

Compare     199, 203

Compressor (Audiopatch)     113

Conference     236

Conference-Properties     391

Config Transfer Toolbar     209

Configuration     95

Configuration (Ports and Panels)     88

Configuration of a CCP-1116 Commentary Panel     422

Configuration of Pool-Ports     325

Configuration of Ports and Panels     82

Configuration of the "Edit IFB" Function     147

Configuration of the CONNECT IPx2/x8     307

Configuration of the VoIP-Ports in Director     313

Configuration parse error     244

Configuration Software     17

Configuration Support     594

Configuration using Drag & Drop (Event)     519

Configuration VCP-10xx in Director     318

Configure a "NET"     31

Configuring a 2-Channel 4-Wire Port (AES only)     66

Configuring a 2-Channel Panel     64

Configuring a RIF-1032 as a Panel Expansion     431

Configuring a RIF-1032, Connected to a DIF-1000     430

Configuring a RIF-2064     432

Configuring an AVB port in Artist     330

Configuring the MCR     472

Configuring the Scheduler     525

Configuring Trunkcalls in Director     572

Connect (Network On/Off)     210

Connect to Artist system     563

Connecting Director to the DMX Driver     530

Connecting Multiple Nodes     33

Connecting the fiber cabling     40

Connecting Trunk-Navigator to a Telex System     586

Connecting Trunk-Navigator to an Artist system     557

contact     594

Control Audiopatch     88, 365

Control Panel Workspace     95

Copy     205

Copy Panel     115, 205, 207

Copy Panels and apply Default Parameters     115

Copy Reply     261

Copying and Moving Keys     100

Cough (Audiopatch)     107

Create an associated logic source for MCR use     391

Create and Manage Groups and Conferences     137

Create and Manage Scroll-Lists     151

Create children     400

Creating a Makro     166

Creating a New Configuration     24

Creating a new group or conference     139

Creating a Partial File Mask     448

Creating Events     508

Creating MCR Members     473

Creating MCR Presets     483

Creating of Pool-Ports     322

Creating Partial Files     446

Creating the MCR Conferences     471

Creating VoIP Ports     302

Crosspoint     592

Crosspoint level color     241

Crosspoint View     176, 209, 221

Crosspoints (Audiopatch)     114

Cut     205

- D -
DANTE     295

DANTE Card-Properties     253

Decentralized matrix structure     14

Default     440

Default Gateway     250

Default Settings     440

Definieren der Trunklines     548

Defining a Node as Ring Clock Master     38

Defining the Trunk-Controller (Trunking)     545

Delete     393

Delete children     400

Delete Function     97, 101

Deleting Nodes     35

Description     400

Destination     356, 358, 359, 362, 368, 373, 374, 375, 592

Details 1 tab (4-Wire-Properties)     345

Details 2 tab (4-Wire-Properties)     346

Details tab (Codec-Properties)     407
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Details tab (Port/Panel-Properties)     256

DHCP     592

Dial and Hang up     379

Dial only     379

Dialing a connection with a fixed number     415

Dim by     374

DIM Crosspoint On Call     121

DIM Crosspoint triggered by Priorities     123

Dim lower Prios     233, 440

Dim Panel Speaker     88, 373

Dim speaker by     373

Dim the panel speaker     352, 393

Dim XP Level     88, 374

Director     17

Director Layout     21

Director Log (Logging System Activity)     167

Director Update     190

Director-Installation     18

Disable Crosspoint volume adjust     361, 362

Disable Crosspoint volume adjust at Destination     356, 359,

360

Disabled     211

Disk logging     211

Display Icons on 1100/2300 Keys     339

Display of Time Controlled Conferences     499

DisplayH     378

Displaying Trunkcalls     584

DisplayL     378

Distribute a Panel / 4-Wire with CONNECT IPx2/x8     307

DMX Driver (Audio Video Router)     528

DNS     297, 592

DNS (VoIP)     300

Do not show the configuration transfer dialog for short,

successful updates     214

Dock Navigation Bar left     209, 221

Dock Navigation Bar top     209, 221

Download a Partial Configuration File     452

Drag & Drop Programming     99, 101

DSCP     250

DSP     592

Dump routing core     563

- E -
Edit     205, 400

Edit Conference     88, 371

Edit Conference Function     144

Edit Definition     240

Edit Function     97, 101, 393

Edit IFB     88, 372

Edit IFB Function     147

Edit Marker     241

Edit Scroll-List Entry     393

Edit XY-Matrix setup     456

Edit-Conference Function     144

Editing Scroll-List entries and Functions     152

Editing the Marker-Definition     433

Eeprom writeable     244

Email     594

Enable 2nd audio channel     255, 344, 406

Enable Auto Reverse Talk option     103

Enable for Master Control Room use     391

Enable for Trunk call     347, 388, 391, 407

Enable In-Use Indication     232

Enable In-Use Indication...if Panel makes a call     256, 346

Enable In-Use Indication...if Panel receives a call     256, 346

Enable Mute Function     232, 256

Enable Partial Files     400

Enable Reply for calls from conference     369

Enabling/disabling Network Access     70

Error during bootup     244

Error mask tab (Node-Properties)     244

Ethernet     592

Ethernet Link Mode     252, 297

Ethernet Link Mode (VoIP)     301

Ethernet Protocol     305

Events     221

Events - Online View     209

Events / Scheduler     507

Example: Audiopatch 'Cough' or 'Mic-Mute'     107

Exit     199, 563

Expansion Panel     368

Expansion Panels     62

External MIC,OUT     428

Extras     216

- F -
Fax     594

Fiber transmission error     244

Fiber Up-/Downstream     244

File     199

File name prefix     213

Firmware Update     191

Firmware Update of AVB Devices     333

First steps     18

Flash     241

Flash to color     241

Font Rotation (Expansions)     256

Frame length     249, 282

From 2nd channel (instead of 1st)     361, 362

Full log (recommended)     211

Function-Key Assignment     231, 256, 258

Functions and Features in Details     199
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- G -
Gain tab (4-Wire-Properties)     348

Gain tab (Port/Panel-Properties)     267

Gain values set by...     348

General     282

General (Audio Video Router)     528

General Information (AES67)     284

General tab (4-Wire-Properties)     344

General tab (Codec-Properties)     406

General tab (Conference-Properties)     391

General tab (GPI In-Properties)     396

General tab (GPI Out-Properties)     397

General tab (Group-Properties)     388

General tab (Net-Properties)     230

General tab (Node-Properties)     243

General tab (Port/Panel-Properties)     255

General tab (Scroll-List-Properties)     393

General tab (User Rights)     400

Glossary     592

GPI     223, 592

GPI In-Properties     396

GPI Out-Properties     397

GPIO Functions     426

GPIO Out Off Delay     440

GPIO tab (Port/Panel-Properties)     264

GPI-Out     363

Group     236

Group-Properties     388

Groups + Confs     223

Groups + Confs - Tab     137

- H -
Handle EditConf requests triggered from panel keys     214

Handle MCR operations triggered by Panels / Logic Sources    

214

Handle Partial File Trigger     453

Handle Partial Files Trigger operations initiated by Logic

Sources     212

Handle the Scheduler     214

Hang up only     379

Hang up timeout     413, 414

Hardware     256

Hardware Configuration of a Node     45

Hardware mismatch     244

Headset (Audiopatch for 3000 series control panels)     109

Headset A,B     428

Headset Mode     256

Headset Switch (Audiopatch)     111

Help     219

Hot Mic     367

How to     21

- I -
Icon (only for 1100/2300 series available)     352

Identify connected Devices (AVB)     331

IFB     221, 592

IFB-Table: Online View     131

IGMP Snooping (AES67)     286

Import     199

Initial conference volume     231, 256, 345, 440

Initial single volume     231, 256, 345, 440

Initial Tab in Panel View     214

Input Gain     348, 440

Installation (Director)     18

Installation of the VCP-1004/VCP-1012 Softpanel     315

Interfacing and connectivity     14

Interrupted Foldback (IFB)     120

Interruptible Foldback (IFB)     209

Invert Expansion Marker Position     256

Invert Marker Position     256

IP address of local Node     210

IP Addresses     20

IP Protocol     305

IP Statistic     293, 327

IP-Address     250

IP-Address of Local Node     210

ISDN     592

ISO     592

Isolate (self)     356

Isolated Calls (ISO)     133

- J -
Jitter     305

- K -
Kanji Support of 1100/2300 Series and Director     341

Key     368

Key Assignment     96

Key Assignment Commentator A/B     423

Key Defaults tab (Net-Properties)     234

Key Functions     88

Key Label     352, 393

Key Mode     234, 393

Key Modes     352

Key Modes (Key - Properties)     353

Key Page     368

Key Properties     352

Key text color     256

keypad digits (0 - #)     378

Keypad shortcut     393

Kill Partyline Mic     88, 381
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- L -
Labeling Trunkports     550

Labels for Net and Nodes     35

Labels for the Web and the Network     25

Latching     352, 353

Latching Timeout     352, 353, 393

Latching Timeout (mode)     234

LED state     241

Limiter (Audiopatch)     113

Limits     219

Listen privilege     358

Listen to Port     88, 361

Listen to Port (Event)     517

Listen to Port (Trunking)     574

Live     400

Live State     95

Load All Offline     456

Load Offline     456

Local     255, 344

Local IFB     360

Local Port     356, 361

Lock the Key     368

Log     223

Log Command Port     211

Log Configuration changes     211

Log Errors     211

Log Matrix Activity     211

Log MCR Panel Operation Engine     211

Log Node Handler/Artist Config Update     211

Log Panel active/online     211

Log Scheduler Engine     211

Log Settings     168

Log Special Interfaces     211

Log Warnings     211

Logging     211

Logging System Activity (Director Log)     167

Logic     88, 223, 380

Logic Functions     158

Logic Gates     160

Logic Source (Event)     518

Logic Status Live View     164

Logic Workspace     158

Login     29

Login as a Predefined User     28

Long Name     230, 243, 255, 344, 388, 391, 393, 396, 397, 400,

406

- M -
MADI     281

MADI - Client Card Properties     282

MADI Card-Properties     249

MADI Channels     249, 282

MADI Up/Down Interface     249, 282

Manual Activation Key     444

Manual C     33

Manually dialing a telephone number with a built-in keypad  

  419

Manually dialing a telephone number without a built-in

keypad     416

Marker-Definition     205, 206

Marker-Definition tab (Net-Properties)     240

Master Control Room     221

Master Control Room (MCR)     469

Matrix     592

Matrix Ch. 1,2     428

Matrix Input Monitor     182, 209, 221

Matrix Input Monitor (Range of Functions)     182

Maximum     440

Maximum Size of each log file     211

MCR - Online View     209

MCR - Overview     488

MCR Conference (Event)     510

MCR Setup - Layouts     477

Members     393

Members tab (Group-Properties)     389

Menu Bar     199, 216, 219

Merging separate Configurations into a single Configuration  

  42

Method 1: DIM Crosspoint On Call     121

Method 2: DIM Crosspoint triggered by Priorities     123

Method 3: Using the IFB-Tables (recommended)     125

Mic Pre-amp (Audiopatch)     111

Mic-Mute (Audiopatch)     107

Min. Headset     231, 256

Min. Headset Vol.     440

Min. Speaker Vol.     231, 256, 440

Minimum     440

Minimum XP Volume     440

Miscellaneous     214

Miscellaneous (Port types)     57

Momentary (PTT)     352, 353

Monitor 'Live State'     171

Monitoring (Trunking)     578

Monitoring Function     259

Monitoring Setup     480

Move up/down     393

Multiple Assignments of a single Key     100

Mute again on key deactivation     352

Muted crosspoint level color     241

- N -
Navigation     134
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Navigation Bar     22, 209, 223

Navigation in the Ports Tab     91

Navigation via the Network Tab     90

Net     221, 592

Net Eigenschaften     231, 236

Net Properties     230

Net Workspace     41

Network     223

Network cabling and adaptors     19

Network Configuration     19

Network mask     250

Networking     17

Netzwerkverbindung     69

New     199, 221

New Functions     13

No Volume change on key activation/deactivation     352

NOA     243

Node     592

Node and Client Logging     169

Node Properties     228

Node Update     192

Node-Properties     243

Number of rotating     213

- O -
Obtain DNS server address automatically     252

Obtain IP address automatically     252

Off Delay     397

Offline Configuration of Trunkcalls     580

On Call     89, 101

On-Air Audio Routing     427

Online View     221

Online View (IFB-Table)     131

Online-View     227

onnection     33

Open     199, 221

Open a Configuration     27

Open a File     27

Open folder     213

Open Online Configuration (from Artist)     222

Open Partial Configuration     199

Open Partial Files     453

Operate VCP-10xx on the PC     320

Operating System     18

Operating the "Edit Conference" Function     146

Operating the "Edit IFB" Function     149

Options     210

Other Settings (Misc)     485

Output Gain     348, 440

Overview     14

Overview of Functions (Commands)     355

Owner     400

- P -
Panel     364, 592

Panel Audio I/O     89

Panel Audiopatch     105

Panel default (only for 1100/2300 series available)     352

Panel GPI     104

Panel GPI functions     89

Panel MIC     428

Panel Mic (Audiopatch)     111

Panel Update     194

Parameter     440

Partial Files     212

Partial Files - XY Matrix     221

Partial Files Trigger     209, 221, 464

Partial Files XY-Matrix     209

Password     400

Paste     205

PC     592

PC requirements     18

Performer 32-16, 32-80 (Client Cards)     50

Persistance Timeout     241

Phone No     378

Phone No. (incoming, to dial)     413, 414

Point of contact     594

Pool Panel - 4-Wire properties     413

Pool Panel - Panel properties     414

Port     236, 592

Port Defaults 1 tab (Net-Properties)     231

Port Defaults 2 tab (Net-Properties)     232

Port Name     82

Port Settings tab (Net-Properties)     233

Port Short Lists     94

Port to Port (Event)     515

Port types (1000 series)     51

Port types (1100 series)     52

Port types (2000 series)     53

Port types (2300 series)     54

Port types (3000 series)     55

Port types (4-Wire)     56

Port types (5000 series)     55

Port types (Miscellaneous)     57

Port/Panel-Properties     254

PortPool     592

Port-Pool tab (Codec-Properties)     408

PortPool tab (Port/Panel-Properties)     265

Ports     223

Power Supply 1, 2     244

Preface     12

Preparing groups and Conferences for Trunking     551
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Preparing IFBs for Trunking     553

Preparing Individual Ports for Trunking     549

Preparing the configuration (Trunking)     546

Press the Key     368

Preview level     240

Print     199, 201, 221

Priority     241, 356, 358, 359, 361, 362, 369

Programmierung der GPIs     134

Properties     97, 101

Properties (Event)     508

Protection Mode     563

Protocol     413, 414

PSTN     592

PTP (AES67)     286

PTP Domain     250

PTP Priority 2     250

PTP Role     250

Purpose (Partial Files)     446

- Q -
QoS     297

QoS (VoIP)     301

Quality of Service (AES67)     285

- R -
Radio Button     352

Range of Functions (Matrix Input Monitor)     182

Recommended Switches (AES67)     286

Redundancy mode of the Trunk-Navigator     566

Redundant Controller     244

Register Special Features     216, 218

Relay 1 mask tab (Node-Properties)     245

Relay 2 mask tab (Node-Properties)     246

Relocating a Port     67

Remote     400

Remote Control     17, 95

Remote Control of a Port     173

Remote Key     88, 368

Remove system     563

Removing a Member from a Conference     492

Repair     594

Repeat Password     400

Reply     88, 369

Reply Key Timeout     440

ReplyH     378

Reply-Key Timeout     233

ReplyL     378

Requirements (Trunking)     544

Reset     348

Reset all Nodes     216

Reset Tree     216, 217

Resolving Configuration Errors     170

Response Timeout     256, 407

Response Timeout ISDN     440

Response Timeout Telephone Codec     232

Response Timeout VoIP Port     232

Restart latching timer     352, 353

Restore system from snapshot file     79, 199

Restore volume level     234, 352

Restrict crosspoints     212, 453

Restrict Properties for AV-Router     400

RIF in general     430

RIF to RIF GPIO     439

Right Mouse Click Menus     97

Rights     352

Rights (Key - Properties)     353

Rights (Virtual Functions - Properties)     354

Rights tab (4-Wire-Properties)     351

Rights tab (Codec-Properties)     412

Rights tab (Conference-Properties)     392

Rights tab (GPI In-Properties)     396

Rights tab (GPI Out-Properties)     398

Rights tab (Group-Properties)     390

Rights tab (Net-Properties)     242

Rights tab (Node-Properties)     247

Rights tab (Port/Panel-Properties)     280

Rights tab (Scroll-List-Properties)     395

Room-Code     255, 344, 406

Room-Codes     143

Route Audio     88, 362

Router-IF destination tab (AVR)     534

Router-IF ext. Lines tab (AVR)     537

Router-IF external Lines defaults tab (AVR)     540

Router-IF Objects tab (AVR)     531

Router-IF Source tab (AVR)     533

Routing the Streams     332

RSP-2318 - Update with AVB-Manager     196

RSP-2318 - Update with USB-Stick     198

- S -
Same as Screen logging     211

Save     221

Save (as)     199

Save Changes to ARTIST (merge)     199, 222

Save Partial Configuration as     199

Save Partial Mask as     199

Save system snapshot to file     76, 199

Save to ARTIST (overwrite)     199, 222

Saving a Configuration     75

Scheduler     221, 524

Scheduler - Online View     209

Scheduler Manager     400
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Screen logging     211

Scroll enable     234, 352

Scroll-List     255

Scroll-List-Properties     393

Scroll-Lists     223

Scroll-Lists - Panel Operation     156

Select Audiopatch     88, 364

Select Background     563

Selection by Function Type     157

Selection via Keypad     156

Send a Configuration to Artist     72

Send Configuration to Artist / Load from Artist     17

Send String     88, 387

Server IP to connect to     212, 453

Server mode     212, 453

Service     594

Set Default Gateway     228

Set Ethernet Address     228

Set Ethernet Hub feature to     228

Set Gain value     348

Set Input/Output Gain     88, 383

Set IP Address     228

Set key text     368

Set local Trunk Controller to     228

Set Node Address     228

Set Ringclockmaster to     228

Set Subnet Mask     228

Set Synchronise to External Clock     228

Set System-Time on all Nodes     216

Set the Signaling Marker     368

Set to default     213, 240

Setting the IP Address of the Local Node in Director     69

Setting the Net and Node Addresses     36

Setting up a Panel to use a CONNECT/SIP Codec     415

Setting up a Remote Panel using CONNECT DUO/TRIO (ISDN)

    420

Setting up and Using the MCR Interface from a Control Panel

    502

Setting up CONNECT Codecs and Remote Panels     404

Setting up Multi-Node Systems     36

Setting up the MCR and Panels     502

Setting up the XY-Matrix Client PC     463

Setting up the XY-Matrix Server PC     462

Setting up trunklines     559

Setup Default Text Color for a single Panel     337

Setup in Director (Trunking)     545

Setup Individual Text Color for single Buttons     338

Setup VCP-1004/VCP-1012     316

Setup/Change the IP Address in Artist Nodes     71

Shift Key Mode     256

Show crosspoint level in foreground     241

Show incoming Marker / Enable volume adjust     359

Show legacy Panels     214

Show live status in the panel and GPI lists     214

Show on Reply     256

Show panel key mode     214

Sidetone     88, 386

Single-Port Mode     188

SIP     592

SIP Phone - Basic Setup     321

SIP Phone Connection tab (Port/Panel-Properties)     271

SIP Port     297

SIP Port (VoIP)     300

SIP TCP/UDP port     250

SIP Telephony     321

Slot Arrangement of Artist Frames     46

SmartPanel basic settings     290

SOA     243

Softpanel VCP-1004/VCP-1012     315

Software Updates     189

Source     361, 362, 374, 592

Speaker     428

Speaker Dim Level     231, 256, 440

Special Interfaces     205

Specifications / System Limits     442

Split into number of rotating files     211

Standalone mode     212, 453

Standard Toolbar     209

Starting and Stopping Events     522

Status Bar     209, 225

Statusbar     563

Stop Connection     379

Stop Protection     563

Support     219

Switch GPI Out     88, 363

Switch RIF GPI Outputs by Command     435

System Features     14

System Overview     14

System Snapshots     76

- T -
Talk privilege     358

TCP     592

TCP/IP     592

Telephone     594

Telephone Dial / Hang up     88, 379

Telephone Dial Keypad / Display     88, 378

Telephone number 1st/2nd Channel     411

Telephone Number tab (Codec-Properties)     411

Telephone Number tab (Port/Panel-Properties)     266

Telex-Artist Mapping Table     567

Testing the AVR     541
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Text color (only for 1100 series available)     352

Text Color, Fonts and Icons on 1100 & 2300 series Panels    

335

The Alarms window should automatically pop up for new

important alarms     214

The destination conference on this command can be

changed by Edit Conference     358

The Web and the Network     24

Time interval     213

Title bar     214

To 2nd channel     356

To 2nd channel (instead of 1st)     362

Toolbar     221, 563

Trainings     594

Transferring Port Names from an Excel® List     86

Troubleshooting     590

Trunkcall priority     356, 358, 359

Trunking     223, 543, 563

Trunking (net, port) address     356

Trunking Address     347, 360, 361, 388, 391, 407

Trunking Defaults tab (Net-Properties)     236

Trunking Labels     85, 347

Trunking Priorities     582

Trunking tab (4-Wire-Properties)     347

Trunking tab (Port/Panel-Properties)     263

Trunkline     236

Trunkline setup     563

Trunk-Navigator Details     563

Trunk-Navigator Software     555, 563

Type     396, 397

- U -
UDP     592

UDP Protocol     304

UHF     592

Undo Changes     498

Unlocking Software Add-ons     444

Unmute on key activation     352

Update (All)     456

Update Bar     222

Update Firmware     229

Update Trunking Key Labels     205, 208

Upload a Configuration from Artist     74

Usage tab (4-Wire-Properties)     351

Usage tab (Conference-Properties)     392

Usage tab (GPI Out-Properties)     398

Usage tab (Group-Properties)     390

Usage tab (Port/Panel-Properties)     279

Usage tab (Scroll-List-Properties)     395

Usage tab (User Rights)     403

USB Dongle     445

Use 2nd audio channel on this port (instead of the 1st)     358

Use 2nd channel on this port (instead of the 1st) as the audio

destination     361

Use 2nd channel on this port (instead of the 1st) as the audio

source     359

Use 2nd channel on this port as the audio source     356, 360

Use the following DNS server address     252

Use the following IP address     252

Use this command to select the destination conference

during an Edit Conference operation     358

Used as trunkline     346, 347

USER     400

User Account Manager     400

User Login     199, 221

User Management     17

User Rights     399

User-defined name     241

Users     223

Using 4-Wires in Multiple Conferences     475

Using a GPI Input of a RIF Interface     436

Using a Partial File Mask     450

Using an Alias Name     493

Using IFB-Table to create Audio Routes with direct XP-Gain    

132

Using Presets     491

Using the IFB-Tables (recommended)     125

Using the MCR     487

Using the MCR from a Control Panel     505

Using the Monitor Function     496

Using/Configuring the RIF as a GPIO Expansion     433

- V -
Verifying a successful Network Connection     70

VHF     592

View     209

Virtual Functions - Properties     354

Virtual Keys tab (4-Wire-Properties)     350

Virtual Keys tab (Port/Panel-Properties)     269

Virtual Port Functions     89

VoIP     296, 297, 300, 301

VoIP Card-Properties     252

VoIP Port Defaults tab (Net-Properties)     237

VoIP Statistic     209, 221, 327

VoIP tab (Port/Panel-Properties)     270

Vox     89, 101, 592

Vox (Hold Time, On/Off Threshold)     232, 256, 346, 440

- W -
Web     592

What's needed     18

Windows     18

Workspace     22, 224

Write Log Data     229
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- X -
XY-Matrix     456
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